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Preface

Thank you for selecting the MONITOUCH V10/V9 series.
For correct setup of the V10/V9 series, you are requested to read through this manual to understand more about the product.
For details on other operating procedures for the V10/V9 series, refer to the following related manuals.

For details on devices including PLCs, inverters, and temperature controllers, refer to the manual for each device.

Manual Name Contents Reference 
No.

V10/V9 Series 
Reference Manual 1

Explains the functions and operation of the V10/V9 series. 1065NE

V10/V9 Series 
Reference Manual 2

1066NE

V10/V9 Series
Setup Manual

Explains the installation procedure of V-SFT version 6, the creation process of 
simple screen programs as well as how to transfer a created screen program using 
V-SFT version 6.

1067NE

V10 Series 
Unit Operation / Local Mode / 
Error Screen Manual

Explains the operating procedures, Local mode screens, and error list for the
V10 series.

1093NE

V9 Series 
Troubleshooting/Maintenance 
Manual

Explains the operating procedures, Local mode screens, and error list for the
V9 series.

1068NE

V10/V9 Series Training Manual  
Beginner’s Guide

Explains the screen creation process for the V9 series using V-SFT version 6 with 
examples.

1069NE

V10/V9 Series Training Manual 
Practical Guide

1070NE

V10/V9/X1 Series 
Macro Reference

Provides an overview of macros of V-SFT version 6 and explains macro editor 
operations and macro command descriptions in detail.

1071NE

V10/V9 Series
Operation Manual

Explains the configuration of V-SFT version 6, the editing process of each part and 
limitations regarding operation in detail.

1072NE

V10/V9 Series
Connection Manual 1

Explains the connection and communication parameters for the V10/V9 series and 
controllers in detail.

2210NE

V10/V9 Series
Connection Manual 2

2211NE

V10/V9 Series
Connection Manual 3

2212NE

V10 Series Hardware Specifications Explains hardware specifications and precautions when handling the V10 series. 2025NE
V9 Series Hardware Specifications Explains hardware specifications and precautions when handling the V9 series. 2023NE

Notes:

1. This manual may not, in whole or in part, be printed or reproduced without the prior written consent of Hakko Electronics 
Co., Ltd.

2. The information in this manual is subject to change without prior notice.
3. Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and other countries.
4. All other company names or product names are trademarks or registered trademarks of their respective holders.
5. This manual is intended to give accurate information about MONITOUCH hardware. If you have any questions, please 

contact your local distributor.





Notes on Safe Usage of MONITOUCH
In this manual, you will find various notes categorized under the following levels with the signal words “DANGER” and “CAUTION”.

Note that there is a possibility that items listed with  may have serious ramifications.

DANGER Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury and could 
cause property damage.

• Never use the output signal of the V10/V9 series for operations that may threaten human life or damage the system, such as signals 
used in case of emergency. Design the system so that it can cope with a touch switch malfunction. A touch switch malfunction may 
result in machine accidents or damage.

• Turn off the power supply when you set up the unit, connect new cables, or perform maintenance or inspections. Otherwise, 
electrical shock or damage may occur.

• Never touch any terminals while the power is on. Otherwise, electrical shock may occur.
• Always close the terminal covers before turning the power on and operating the unit. Otherwise, electrical shock may occur.
• The liquid crystal in the LCD panel is a hazardous substance. If the LCD panel is damaged, do not ingest the leaked liquid crystal. If 

leaked liquid crystal makes contact with skin or clothing, wash it away with soap and water.
• Never disassemble, recharge, deform by pressure, short-circuit, or reverse the polarity of the lithium battery, nor dispose of the 

lithium battery in fire. Failure to follow these conditions will lead to explosion or ignition.
• Never use a lithium battery that is deformed, leaking, or shows any other signs of abnormality. Failure to follow these conditions will 

lead to explosion or ignition.
• Switches on the screen are operable even when the screen has become dark due to a faulty backlight or when the backlight has 

reached the end of its service life. If the screen is dark and hard to see, do not touch the screen. Otherwise, unintended operations 
may occur resulting in machine accidents or damage.

• Tighten the mounting screws on the fixtures of the V10/V9 series uniformly to the specified torque indicated below. 
Excessive tightening may cause deformation, breakage, or malfunction of the touch switch, which may result in damage to the 
machine or an accident. Insufficient tightening may cause the unit to fall down, short-circuit, or malfunction
- V1015, V1010, V1008, V9 series: 5.31 lbf-in (0.6 N·m)
- V1012: 7.97 lbf-in (0.9 N·m)

• Check the appearance of the unit when it is unpacked. Do not use the unit if any damage or deformation is found. Failure to do so 
may lead to fire, damage, or malfunction.

• For use in a facility or as part of a system related to nuclear energy, aerospace, medical, traffic equipment, or mobile installations, 
please consult your local sales representative.

• Operate (or store) the V10/V9 series under the conditions indicated in this manual and related manuals. Failure to do so could cause 
fire, malfunction, physical damage or deterioration.

• Observe the following environmental restrictions on use and storage of the unit. Otherwise, fire or damage to the unit may result.
- Avoid locations where there is a possibility that water, corrosive gas, flammable gas, solvents, grinding fluids, or cutting oil can 

come into contact with the unit. 
- Avoid high temperatures, high humidity, and outside weather conditions, such as wind, rain, or direct sunlight.
- Avoid locations where excessive dust, salt, and metallic particles are present.
- Avoid installing the unit in a location where vibrations or physical shocks may be transmitted.

• Protective functions may not function properly if a device is not used as specified by the manufacturer.
• Equipment must be correctly mounted so that the main terminal of the V10/V9 series will not be touched inadvertently. Otherwise, 

an accident or electric shock may occur.
• Check periodically that terminal screws on the power supply terminal block and fixtures are firmly tightened. Loosened screws or 

nuts may result in fire or malfunction.
• Tighten the terminal screws on the power supply terminal block of the V10/V9 series uniformly to the specified torque indicated 

below. Improper tightening of screws may result in fire, malfunction, or other serious trouble.
- V10 series: 7.1 lbf-in (0.8 N·m)
- V9 series: 7.1 to 8.8 lbf-in (0.8 to 1.0 N·m)

• The V10/V9 series has a glass screen. Do not drop or give physical shock to the unit. Otherwise, the screen may be damaged.
• Correctly connect cables to the terminals of the V10/V9 series in accordance with the specified voltage and wattage. Overvoltage, 

overwattage, or incorrect cable connection could cause fire, malfunction, or damage to the unit.

CAUTION

DANGER

CAUTION



[General Notes]
• Never bundle control cables or input/output cables with high-voltage and large-current carrying cables such as power supply cables. 

Keep control cables and input/output cables at least 200 mm away from high-voltage and large-current carrying cables. Otherwise, 
malfunction may occur due to noise.

• When using the V10/V9 series in an environment where a source of high-frequency noise is present, it is recommended that the FG 
shielded cable (communication cable) be grounded at each end. However, when communication is unstable, select between 
grounding one or both ends, as permitted by the usage environment.

• Be sure to plug connectors and sockets of the V10/V9 series in the correct orientation. Failure to do so may lead to damage or 
malfunction.

• If a LAN cable is inserted into the MJ1 or MJ2 connector, the device on the other end may be damaged. Check the connector names 
on the unit and insert cables into the correct connectors.

• Do not use thinners for cleaning because it may discolor the V10/V9 series unit surface. Use commercially available alcohol.
• Clean the display area using a soft cloth to avoid scratching the surface.
• If a data receive error occurs when the V10/V9 series unit and a counterpart unit (PLC, temperature controller, etc.) are started at the 

same time, read the manual of the counterpart unit to correctly resolve the error.
• Avoid discharging static electricity on the mounting panel of the V10/V9 series. Discharging static electricity on the mounting panel 

may cause malfunction to occur due to noise.
• The V10/V9 series is identified as a class-A product in industrial environments. In the case of use in a domestic environment, the unit 

is likely to cause electromagnetic interference. Preventive measures should thereby be taken appropriately.
• The signal ground (SG) and frame ground (FG) are connected inside the V9150 series unit. Take care when designing systems.
• The V10/V9 series is equipped with a battery that contains lithium metal and therefore observance of transport regulations is 

necessary. Hakko Electronics ships V10/V9 series units packed in accordance with transport regulations. If there is a need to transport 
a V10/V9 series unit after it is once unpacked, transport the unit in accordance with the IATA Dangerous Goods Regulations, 
International Maritime Dangerous Goods (IMDG) Code, and transport regulations of the countries concerned.
Ask your forwarding agent for details of transport regulations.

• Always ground the V10/V9 series. The FG terminal must be used exclusively for the V10/V9 series with the level of grounding 
resistance less than 100 Ω. Otherwise, you may sustain an electric shock, a fire may occur, MONITOUCH may not recognize touch 
operations, and malfunctions may occur.

• Prevent any conductive particles from entering the V10/V9 series unit. Failure to do so may lead to fire, damage, or malfunction.
• After wiring is finished, remove the paper used as a dust cover before starting operation of the V10/V9 series. Operation with the 

dust cover attached may result in accidents, fire, malfunction, or other trouble.
• Do not attempt to repair, disassemble, or modify the V10/V9 series unit yourself. Contact Hakko Electronics or the designated 

contractor for repairs.
• Do not repair, disassemble, or modify the V10/V9 series unit. Hakko Electronics Co., Ltd. is not responsible for any damages 

resulting from repair, disassembly, or modification of the unit that was performed by an unauthorized person.
• Do not use sharp-pointed tools to press touch switches. Doing so may damage the display unit.
• Only technicians are authorized to set up the unit, connect cables, and perform maintenance and inspection.
• Lithium batteries contain combustible material such as lithium and organic solvents. Mishandling may cause heat, explosion, or 

ignition resulting in fire or injury. Read the related manuals carefully and correctly handle the lithium battery as instructed.
• Take safety precautions during operations such as changing settings when the unit is running, forced output, and starting and 

stopping the unit. Any misoperations may cause unexpected machine movement, resulting in machine accidents or damage.
• In facilities where the failure of the V10/V9 series could lead to accidents that threaten human life or other serious damage, be sure 

that such facilities are equipped with adequate safeguards.
• When disposing of the V10/V9 series unit, it must be treated as industrial waste.
• Before touching the V10/V9 series unit, discharge static electricity from your body by touching grounded metal. Excessive static 

electricity may cause malfunction or trouble.
• Insert an SD card into the unit in the same orientation as pictured on the unit. Failure to do so may damage the SD card or the slot 

on the unit.
• The SD card access LED flashes red when the SD card is being accessed. Never remove the SD card or turn off power to the unit 

while the LED is flashing. Doing so may destroy the data on the SD card. Check that the LED has turned off before removing the SD 
card or turning off the power to the unit.

• Be sure to remove the protective sheet that is attached to the touch panel surface at delivery before use. If used with the protective 
sheet attached, MONITOUCH may not recognize touch operations or malfunctions may occur.

• When using V10 series and an analog resistive-film type V9 series unit, do not touch two positions on the screen at the same time. 
If two or more positions are pressed at the same time, the switch located between the pressed positions may be activated.

• When using a capacitive V9 series unit, take note of the following cautions.
- Use a Class 2 power supply for a 24-VDC unit. If an unstable power supply is used, MONITOUCH may not recognize touch 

operations or malfunctions may occur.
- Capacitive touch panel types support two-point touch operations. If a third point is touched, the touch operation will be 

cancelled.
- Capacitive touch panel types are prone to the influence of conductive material. Do not place conductive material such as metals 

near the touch panel surface and do not use the panel if it is wet. Otherwise, malfunctions may occur.

CAUTION



[Notes on the LCD]
Note that the following conditions may occur under normal circumstances.

• Avoid prolonged display of any fixed pattern. Due to the characteristic of liquid crystal displays, an afterimage may occur.
If prolonged display of a fixed pattern is expected, use the backlight auto OFF function.

• The response time, brightness, and colors of the V10/V9 series unit may be affected by the ambient temperature.
• Tiny spots (dark or luminescent) may appear on the display due to the characteristics of liquid crystal.
• Unevenness in brightness and flickering may occur depending on the screen display pattern due to the characteristics of liquid crystal.
• There are variations in brightness and color between units.
• Display colors may vary depending on the viewing angle because a converging lens is used in the backlight unit.

[Notes on Capacitive V9 Series]
• Touch panel operability may not be optimal if used with dry fingers or skin. In such a case, use a capacitive stylus pen.
• Periodically clean the touch panel surface for optimum touch operations.

When cleaning, take note of the following points.
<When cleaning>

- he panel surface is made of glass. Be sure to clean the surface gently with a cloth or sponge. Otherwise, you may scratch or 
damage the glass.

- Take care not to let cleaning detergent to seep into the touch panel unit.
Do not directly apply or spray cleaning detergent on the panel surface.

[Notes on Wireless LAN]
For details regarding supported wireless LAN standards, radio law certifications, and countries where wireless LAN can be used, refer to 
the “About Wireless LAN on V10 Series” / “About Wireless LAN on V9 Advanced Model” / “About Wireless LAN on V9 Standard Model” 
manual provided with the V10/V9 series unit at delivery.
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1.1 Video/RGB Display
1.1.1 Overview

Video Display
• NTSC, NTSC Square Pixel, and PAL signal images can be displayed.

By using the optional GUR-00, GUR-04, or GUR-10 unit, a video screen can be shown by simply placing and setting a 
video/RGB display part.

• By using the optional GUR-00 or GUR-10 unit, video display from multiple channels can be shown simultaneously on a 
single screen.

RGB Input Display
• RGB input images can be displayed. 

By using the optional GUR-01, GUR-10, or GUR-11 unit, an RGB screen can be shown by simply placing and setting a 
video/RGB display part.

• By using the optional GUR-10 unit, video display and RGB display from multiple channels can be shown simultaneously 
on a single screen. The GUR-11 unit can show two channels of RGB display on a single screen.

Compared to a single channel, simultaneously showing multiple channels slows the display speed slightly.
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Snapshot Function
The currently displayed video/RGB screen can be saved to a storage device as a JPEG file. Double-tap on the displayed 
video/RGB screen or execute a snapshot macro command. There are three snapshot types.

• Single Snap
One snapshot of the currently displayed video/RGB image is taken.
Execute the background SNAP macro command to take a snapshot even when the video/RGB screen is not displayed. For 
details, refer to the Macro Reference Manual.

• Periodical Snap
The currently displayed video/RGB image is captured continuously at regular intervals.

• Strobe Snap
A total of 16 screenshots of the currently displayed video/RGB screen are taken in succession by continuous shooting.

JPEG Display
• Snapshot images saved to a storage device can be displayed on the screen using a JPEG display item.

For details, refer to “1.3 JPEG Display” page 1-48.

Video

Take a snapshot

Video

Video

Execute strobe snap
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Operation by Double-tapping
• The operation that is performed when the displayed video image is tapped can be set.

Video

Double-tap on the screen Enlarged display
(Double-tap again to reset the size.)
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1.1.2 Specifications
Applicable Models

Video/RGB Input Specifications

* Only when using the optional GUR-10 or GUR-11 unit.

Display Size
Video and RGB images are displayed on a placed display area. However, the displayed image may vary depending on the 
input signal size, the size that can be displayed on the V9 series unit, and the size of the display area placed on the screen.

Display sizes

* If the display size is smaller than the input signal size, the area that is to be displayed on the V9 series unit can be 
adjusted by adjusting the image clip start position on the V9 series unit. For details, refer to “Clip start position” 
page 1-5.

Model Optional Unit Video Input RGB Input V9 Series Unit Version
V910xiWRLD
V910xiWLD
V9150iX
V9150iXD
V9120iS
V9120iSD
V9100iS
V9100iSD
V9080iSD

GUR-01 - 1CH Program Ver. 1.070 or later
OS Ver. 1.50 or laterGUR-04 1CH -

GUR-00 4CH -

Program Ver. 1.210 or later
OS Ver. 2.40 or later

GUR-10 2CH 1CH

GUR-11 - 2CH

Item
Specifications

Video Input RGB Input
Type Composite video signal Analog RGB
Input Signal NTSC

NTSC Square Pixel
PAL

Analog straight polarity 0.5 V to 1.0 Vp-p
(75 Ω terminating resistance)

Operation Mode NTSC   ITU-R BT. 601
NTSC   Square Pixel
PAL    ITU-R BT. 601

-

Sampling Frequency 13.5 MHz -
Display Size (Refer to the following “Display Size” section.)
Colors GUR-00, GUR-04, 

GUR-10, GUR-11 16,777,216 colors  256-level grayscale
16,777,216 colors  256-level grayscale

High-speed mode: 
65,536 colors  64-level grayscale *

GUR-01 - 65,536 colors  64-level grayscale
External Connection BNC co-axial connector D-sub 15-pin (mini)

For details, refer to “Video/RGB Settings” page 1-10.

Input Signal Input Signal Size Display Size
(= image clip size) Clip Start Position *

Video NTSC  ITU-R BT. 601 720 × 485 640 × 480 (40, 0)
NTSC  Square Pixel 640 × 485 640 × 480 (0, 0)
PAL  TU-R BT. 601 720 × 578 720 × 578 (0, 0)

RGB Input VESA 640 × 480 60 Hz 640 × 480

(0, 0)
72 Hz
75 Hz
85 Hz

800 × 600 56 Hz 800 × 600 (0, 0)
60 Hz
72 Hz
75 Hz
85 Hz

1024 × 768 60 Hz 1024 × 768 (0, 0)
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• NTSC  ITU-R BT. 601
An image clipped to the display size from the input signal size is displayed. Therefore, the captured image is smaller than 
the actual video image. The start position for capturing (the clip start position) can be adjusted.

• PAL  ITU-R BT. 601
The input signal image is scaled down to fit the display size and displayed.

Clip start position
If the image is displayed at the default clip start position when the display area is smaller than the display size, the image may 
not fit within the display area or may not be centered.

To show a certain portion of the video/RGB image in the display area (at the clip size), change the default clip start position 
and adjust the size of the display area part. Use the “CLIP_POS“ macro command to adjust the clip start position.

485

720

640

480
NTSC

Display size (image clip size)
Input signal sizeClip start position

= (40, 0)

578

720

640

480PAL

Display size (image clip size)Input signal size

400

320

Clip start position = (40, 0)

[Display Size per Channel]: Free
[Fit to display area]: Unselected

Adjust the display area to the size of the 
image you want to clip.

An image of the display area size is captured and displayed 
with respect to the clip start position.

400

320

Clip start position = (120, 70)
* Change using a macro command.

[Display Size per Channel]: Free
[Fit to display area]: Unselected

Adjust the display area to the size of the 
image you want to clip.

An image of the display area size is captured and displayed 
with respect to the clip start position.
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1.1.3 Detailed Settings
Channel

Item Description
Number of Channels 1, 2, 4 Specify the number of channels to be displayed simultaneously on the display area part.
Display Size per Channel *1 Free,

160*120, 320*240, 
640*480, 640*240

Specify the display size for one channel.
When [Free] is selected, the display size can be set as required.
When the display size is [640*240], the display can be switched to either the upper or 
lower half using the internal device memory $s957.
The available size setting range depends on the number of display channels.

Fit to display area *1 This setting is available when [Display Size per Channel] is set to [Free].

Unselected
The video/RGB screen is displayed according to the setting made for [Display Size per 
Channel].

Selected
The video/RGB screen is automatically scaled to fit within the “Y” size of the placed display 
area part. *2

For details, refer to “Display example” page 1-7.
Channel Select Area 1

Area 2
Area 3
Area 4

Specify the channel to be displayed in each video/RGB display area part.

CH1 to 4 (Video)/CH5, 6 (RGB)
The optional units and channel number assignments are shown below.

Number of Channels Size
1 Free, 160*120, 320*240, 640*480, 640*240
2 Free, 160*120, 320*240, 640*240
4 Free, 160*120, 320*240

1 CH1 (Video)
2 CH2 (Video)
3 CH3 (Video)
4 CH4 (Video)
5 CH5 (RGB)
6 CH6 (RGB)

1

1
2

34

1
2

5

5

65

GUR-04 GUR-00 GUR-10

GUR-01 GUR-11
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*1 Display example
• [Display Size per Channel]: 160 * 120, 320 * 240, 640 * 480, 640 * 240

The image size is reduced to fit the display area.

• [Display Size per Channel]: Free

* To change the display size during video/RGB display, use the [Enlarge] display function (fixed to 640 × 480 dots) or use a video overlap 
display part. For details on video overlap display parts, refer to “1.1.8 Video Overlap Displays” page 1-27.

*2 The image is rounded to the following multiples for the display area. Fractions are displayed in black.
- Landscape: Round to the nearest multiple of 16 (width) and 8 (height).
- Portrait: Round to the nearest multiple of 8 (width) and 16 (height).

640

480

[Display Size per Channel]: 160 * 120

Display size (image clip size)
[Display Size per Channel]: 320 * 240

[Display Size per Channel]: 640 * 240

[Display Size per Channel]: 640 * 480

* The display can be switched to either the upper or lower 
half using the internal device memory $s957.

640

480

640

240

Display size (image clip size)
When showing the image in a display area 
as shown below:

[Fit to display area]: Unselected [Fit to display area]: Unselected

The image is displayed 
in its original size 
without fitting to the 
display area.

The image size is reduced to fit within the vertical 
dimension of the display area.
(Blank parts of the display area are displayed in black.)

Black
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Operation Select
Select the action to be performed by a double-tap operation on the area.

Item Description
None No action
Display Priority When placing multiple display areas (parts) on a single screen, the double-tapped area is 

prioritized for display.
Enlarge/Resize *1 Enlarge the display size to 640 × 480 dots and reset to the original display size.
Snap Take a snapshot of the displayed image and save as a JPEG.

Save location *4: (storage device)\EXT0000\SNAP
File Name Set the name of the file.

AUTO (0 to 255):
Save using sequential numbers from “VD00000.jpg”.
Set the action to perform when the maximum number of snapshots is reached using [Snap 
Setting] under “Video Type” page 1-10.

Specify (0 to 32767):
Save using the specified file number. If the specified file already exists, it is overwritten. *5

Periodical Snap *2 Take snapshots of the displayed image at the set interval and save each image as a JPEG.
Save location *4: (storage device)\EXT0000\SNAP

Total Time Specify the duration for taking periodical snapshots.
1 to 180 sec

Intervals Specify the time interval between taking each snapshot.
1 to 255 sec

File Name Set the name of the file.
AUTO (0 to 255):

Save using sequential numbers from “VD00000.jpg”.
Set the action to perform when the maximum number of snapshots is reached using [Snap 
Setting] under “Video Type” page 1-10.

Specify (0 to 32767):
Save using the specified file number. If the specified file already exists, it is overwritten. *5

Strobe Snap *3 Take screenshots of the displayed image in succession by continuous shooting
Take 16 snapshots (160 × 120 dot resolution) and save as one JPEG file (640 × 480 dots).
Save location *4: storage device\EXT0000\SNAP
The JPEG file is displayed once the individual snapshots are all taken.
By double-tapping again, the display is reset to the original video/RGB display.
When taking strobe snapshots, other operations or macro commands are not possible.

Strobe Speed Specify the speed for taking strobe snapshots.
100 ms to 25.5 sec

File Name Set the name of the file.
AUTO (0 to 255):

Save using sequential numbers from “VD00000.jpg”.
Set the action to perform when the maximum number of snapshots is reached using [Snap 
Setting] under “Video Type” page 1-10.

Specify (0 to 32767):
Save using the specified file number. If the specified file already exists, it is overwritten. *5

Superimpose (Single Click) Displays an overlap for the video menu.
An overlap can be registered by pressing the [Register] button.

Configure this setting according to the blend value located at [Screen Setting] → [Screen 
Setting] → [Others] → [Overlap Transparency Setting] for each screen.
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*1 Enlarge/Resize

*2 Periodical Snap
When set as [Total Duration: 10 sec] and [Interval: 5 sec], three snapshot files are saved.

*3 Strobe Snap
When set as [Strobe Speed: 1 sec], images for a duration of 16 seconds are taken and saved as one file.

*4 Save location

*5 When a screen program contains both the [AUTO] and [Specify] snap settings, specify a number in the range of 256 to 32767 to prevent 
the files of [Specify] from being overwritten with those of [AUTO]. When [AUTO] is selected, the number of the last snapshot is stored in 
system device memory $s932.

Video

Video

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

Order of strobe snapshots

ALARM

RECIPE

BITMAP
DSP
HDCOPY
JPEG
LIST
LOGGING
MEMO
MSG
OPELOG

SCRN

EXT0000

TEST
DEMO

SNAP
SRAM
WAV

(Access folder) *

* Access folders can be given any name for each 
screen program data file.

(Access folder) *
(Access folder) *

(Storage device)
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Video Type

Video/RGB Settings

Item Description
Video/RGB Setting Displays the [Video/RGB Setting] configurations.

Any changes to settings can be made from the [Change] button.

Item Description
Video 
Setting

Input Signal Select the video input signal.
NTSC
NTSC Square Pixcel
PAL

Snap File 
Setting

Maximum Number of 
Snap Files in Auto

Specify the number of times to automatically save snapshot files.
1 to 255

When the Limitation is 
Exceeded

Specify the action to perform when the maximum number of snapshots ([Maximum 
Number of Snap Files in Auto]) is exceeded.

[Stop]: When the maximum number of snapshots has been taken, 
snapshot taking stops.

[Overwrite]: When the maximum number of snapshots has been taken, new 
snapshots are saved by overwriting from the first file.

Snap File Compression 
Rate

Specify the compression rate for snapshot files.
[High]: File size is small but image quality is lowered.
[Middle]: File size and image quality are at a medium level.
[Low]: File size increases with improved image quality.
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Style

Show/Hide
Set the show and hide settings of graphic items.

RGB 
Setting

at full-screen Specify the action to perform when the screen size is larger than the input size.
[Same size]: The input image is displayed in its original size.
[Enlarge]: The input image is enlarged and displayed to fit the screen size.

High Speed Mode
(GUR-10 and GUR-11 only)

Select the RGB input display colors and drawing speed.
When this checkbox is selected, RGB display uses 65,536 colors.
(Default: selected)

* Disabled when displaying two or more channels, even if the checkbox is 
selected.

RGB Input Control Device An RGB input screen can be displayed without using a video/RGB display part.
It can be displayed on any screen.

On: Display
Off: Not displayed

RGB Input Information Output Device The current display status of the RGB input is output to the specified device 
memory.

On: Display
Off: Not displayed

Item Description
Additional Parts List Select an operation switch.

Pause The video display is paused as a still image.
Restart The paused state of the video display is cleared.

Adjust Position Display the window for adjusting the placement position of each part. Part size can also be changed.
Select from catalogs Set the part design from the catalog.
Parts Design Set the design and color of parts.
Edit Selected Parts Configure the part selected in the [Additional Parts List] or preview pane.

For details, refer to “14 Item Show/Hide Function“ in the Reference Manual 1.

Item Description

Number of Channels per Screen Selected Unselected
1 channel 65,536 colors

(high-speed mode 
enabled)

16,777,216 colors

2 or more channels 16,777,216 colors * 16,777,216 colors
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Detail

* Enlarged Display Position

Item Description
Display Enlarged Display 

Position *
Centering, Upper Right, Lower Left
Specify the display position of the video when it is enlarged by double-tapping or by the ZOOM 
macro command.
Enlarged size: 640 × 480 dots

Use priority display When placing multiple display areas (parts) on a single screen, the set area is prioritized for display. 
If no checkbox of any area is selected, the area placed in the foreground is prioritized for display.
Only one part can be specified per screen.

Coordinate Start X/Start Y Specify the coordinates of the display area.
Width/Height Set the size of the display area.

Others ID Set an ID number.

[Centering]

Video enlarged display

[Upper Right]
Video enlarged display

[Lower Left]

Video enlarged display
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1.1.4 Video Display
Display Method
Using a video/RGB display part
Click [Parts] → [Image Display] → [Video/RGB Display] and place a part.

Using a video overlap display part
When intending to change the display size of the video while it is displayed, use a video overlap display part.

For details on the settings, refer to “1.1.3 Detailed Settings” page 1-6.

For details on video overlap display parts, refer to “1.1.8 Video Overlap Displays” page 1-27.
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1.1.5 RGB Input Signal Display
Display Method
Using a video/RGB display part (displaying within the display area)
Click [Parts] → [Image Display] → [Video/RGB Display] and place a part.

Using an RGB input control device memory 
(displaying the RGB input signal on the entire screen)
An RGB input screen can be displayed without using a video/RGB display part.
When the bit is turned ON, the RGB input screen is displayed regardless of what screen is currently displayed.

• Location of settings: [System Setting] → [Unit Setting] → [Video/RGB]
[1] (ON level): RGB input screen is displayed.
[0] (OFF level): RUN mode screen is displayed.

* The RGB input information output device memory stores the current display status of the RGB input screen.

For details on the settings, refer to “1.1.3 Detailed Settings” page 1-6.
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Using a macro command (displaying the RGB input signal on the entire screen)
Switch to the RGB input screen using the “SYS (SET_RGB)“ macro command.
For details, refer to the Macro Reference Manual.

RGB Adjustment
Check the frequencies and adjust the display position in the [I/O Check] → [RGB Adjustment] tab window in Local mode on 
the V9 series unit.
If two types of output frequencies are used, configure both [Setting 1] and [Setting 2]. If only one type is used, configure 
either [Setting 1] or [Setting 2].

The procedure for adjusting the Windows screen with [Setting 1] is described below.

1. Display the Windows screen on the computer.
2. Switch to Local mode on the V9 series unit and make adjustments in the [I/O Check] → [RGB Adjustment] tab window.
3. Check that the frequencies for [Setting 1] are shown in black. If shown in red, the frequencies are not supported by the V9 

series and cannot be used for display. In this case, change the output frequencies of the counterpart unit.

4. Press the [Adjustment] switch for [Setting 1] to switch to an RGB display of the Windows screen.

Switching RGB input parameters
As adjustment parameters for RGB input signals, [Setting 1] and [Setting 2] can be configured.
If the frequencies configured for [Setting 1] and [Setting 2] differ, the V9 series unit will automatically recognize and switch to either 
[Setting 1] or [Setting 2]. If the frequencies do not change, the [Setting 1] adjustment parameters are used. If the frequencies do not 
change but the adjustment parameters differ, switch between [Setting 1] and [Setting 2] using a macro command.
Use the “SYS (CHG_RGB)“ macro command to switch the RGB input parameters.
For details, refer to the Macro Reference Manual.

The measured frequencies are displayed.
Black value: RGB display available
Red value: RGB display unavailable

Red values are frequencies that are not supported by 
the V9 series and cannot be used for display. In this 
case, change the output frequencies of the counterpart 
unit.

RGB Adjustment screen RGB screen display
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5. With a Windows screen displayed, adjust the display position and size.
• V9 Advanced models

Press the top, bottom, left, and right sides of the screen to adjust.

• V9 Standard models
Adjust using the function switches.

6. Finishing position adjustment
When the position has been adjusted, display the RGB Adjustment screen again. The [Used] lamp for [Setting 1] lights up.
• V9 Advanced models

Press the center of the screen to finish adjustment.

• V9 Standard models
Press the [SYSTEM] switch to finish adjustment.

Press the areas indicated with squares 
( ) to adjust the vertical and 
horizontal positions of the screen.

Press the bottom right corner 
to reduce the display size.

Press the bottom left corner to 
enlarge the display size.

Cancel the adjustments.

[F4]: rightward[F3]: leftward

[F1]: upward

[F2]: downward

Adjust the display 
position.

[F1]: upward
[F2]: downward
[F3]: leftward
[F4]: rightward

Adjust the display size.
[F5]: enlarge
[F6]: reduce

[F7]: Cancel adjustments.

Adjustment of screen display position is completed RGB Adjustment screen

ROM PCI/ISA BIOS (2A69KA1E)
        COMS SETUP UTILITY
     AWARD SOFTWARE, INC.

LOAD SETUP DEFAULTS
LOAD BIOS DEFAULTS
PASSWORD SETTING
IDE HARD DISK DETECTION
SAVE & EXIT SETUP
EXIT WITHOUT SAVING

CPU Name, Type. Speed...

Esc : Quit
F10 : Save & Exit Setup

↑↓→← : Select Item
(Shift)F2 : Change Color

I I CPU SOFT MENU
STANDARD CMOS SETUP
BIOS FETUREES SETUP
CHIPSET FETURES SETUP
POWER MANAGEMENT SETUP
PNP, PCI & ONBOAD I/O

Adjustment of screen display position is completed RGB Adjustment screen
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7. Press the [Save] switch to save the settings. Settings are stored in the flash ROM, so they will be retained even when the 
power is turned off and on again.

Touch Switch Emulation
• Using this function, the Windows screen displayed on the V9 series unit can be operated by touch operations without 

using a mouse. This function is available regardless of the display size.
• Connect the computer to the modular jack (MJ1 or MJ2) on the V9 series unit.

Touch panel driver

Limitations
• DOS application software which run on the MS-DOS prompt window cannot be operated by touch operations.
• A PS/2 compatible mouse can be used in combination with touch operations. However, some pointing devices such as 

those provided on laptop computers may not.
• The DMC touch panel driver “DMT-DD” may not be recognized depending on the manufacturer and model of the 

USB-to-serial converter.
- Models with which operation is confirmed by Hakko Electronics

Manufacturer Type Version Applicable OS

GUNZE TPDD 3.00 Non-supported version
Product version Windows 7(32bit) / Vista(32bit) / XP

DMC DMT-DD
2.05
2.11 Product version

Windows 10(32bit/64bit)

2.14 Windows 11(64bit) / Windows 10(32bit/64bit) 

Manufacturer Model
BUFFALO BSUSRC06

SRC06USB

Setting is completed

MJ1

V-CP

RGB-IN
(CH5)

GUR-01 GUR-10 GUR-11

RGB-IN
(CH5) (CH6)

RGB-IN1
(CH5)

RGB-IN2

(optional unit)
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V-SFT settings
1. Double-click on [Hardware Setting] → [TouchSW(CH5)] and set the [Target Port No.] on V-SFT.
2. Click [Finish] to display the [Touch Switch Properties] window.

Set [Use Default Communication Settings] to [Yes].

* Install the touch panel driver on the computer to be connected to the V9 series unit.
For the installation procedure, refer to the installation manual provided by the manufacturer.

Item Description
Connection Device 
Selection

Target Port No. Select the port to connect the computer.
The selected port is used to send the output touch switch coordinates to the 
computer.

MJ1/MJ2
Touch Switch Properties Use Default 

Communication Settings
Select [Yes].

For details on the touch panel driver, refer to page 1-17.
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Touch switch emulation setting example
This section describes the procedure for adding the touch switch emulation function in an RGB input environment.

<Settings on the V9 series unit>
1. Switch the V9 series unit to an RGB input screen (a Windows screen is displayed).
2. Start V-SFT and open the file currently transferred to the V9 series unit.
3. Click on [System Setting] → [Hardware Setting] → [TouchSW(CH5)] and set the [Target Port No.] to [MJ2].
4. Click [Finish] to display the [Touch Switch Properties] window.

Set [Use Default Communication Settings] to [Yes].
5. Save the file and transfer it to the V9 series unit.
6. The V9 series unit switches to RUN mode. Switch to an RGB input screen (a Windows screen is displayed).
7. To perform touch switch emulation, connect the COM1 communication port of the computer and MJ2 (for touch switch 

operation) of the V9 series unit using a V-CP cable (refer to item 5 in “Notes“ described later).

<Settings on the computer>
• For the DMC touch panel driver “DMT-DD” (Windows 10 supported)

1) Switch the V9 series unit to an RGB input screen.
2) Download the “DMT-DD” touch panel driver for Windows 10 (32-bit/64-bit) from DMC’s download web page and 

extract the files to a drive on the computer.
Install the driver according the DMC manual included in the folder.

3) Start DMT-DD from the shortcut created on the desktop or from the start menu.
4) Select [COM Port (COMx) TSC Controller] at [Device Addition] → [Touch Panel Device List] and then click [Install].

When the driver is successfully installed, the name changes to [TP Driver (COMx) ID:x].

5) Reboot the computer.

If [COM Port (COMx) Unconnected] is indicated, the V9 series unit is not recognized. 
Check the following.

• Check that the V9 series unit is switched to an RGB input screen.
• Check that a V-CP cable is used for connection.
• If using a USB serial converter, check operation with a different manufacturer or 

model.
(Refer to “Models with which operation is confirmed by Hakko Electronics” page 
1-17.)

V9

MJ1

MJ2

COM1V-CP

Computer

Touch switch

Driver 
installation
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6) Start DMT-DD. At [Basic Setting] → [Software Setting] → [Calibrate], select [4Point] or [9Point] and perform calibration 
using the RGB input screen on the V9 series unit. (Refer to item 3 in “Notes” described below.)

7) To display the mouse cursor on the RGB input screen of the V9 series unit, select “Mouse.mfd” from the pull-down 
menu at [Basic Setting] → [Configuration File].

This completes the necessary settings.

• For the Gunze touch panel driver “TPDD”
1) Switch the V9 series unit to an RGB input screen.
2) Download the “TPDD” touch panel driver from Gunze’s download web page and extract the files to a drive on the 

computer. Double-click the included “setup.exe” file.
3) Proceed through the windows as follows: [Welcome TPDD] → [Select Language] (select “ENGLISH”) → [Select 

Controller] (select “4/8 Wire-Type Touch Panel”) → [Select Clone File] (leave deselected) → [License Agreement] → 
[Select Folder] → [Installing TPDD] (click [Finish] after installation).

4) Reboot the computer.
5) Make TPDD settings.

After rebooting the computer, click the start button and open the [Touch Panel Device Properties] window from 
[Programs] → [Gunze TPDD] → [Adjust Setting].

6) Click the [Device] tab in the [Touch Panel Device Properties] window and click the [Add] button.
7) The [New Pointer Device] window is displayed. Select “Gunze AHL, Serial“ and select “COM1“ for [Select COM port]. 

Then click [Next].
8) The [New Pointer Device] window is displayed. Select “Whole Desktop“ and click [OK].
9) When the [Touch Panel Device Properties] window is displayed again, click the [Apply] button and then the [Calibrate] 

button.
10) The calibration program starts up. Configure calibration settings (refer to item 3 in “Notes“ described below).

This completes the necessary settings.

Mouse cursor
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Notes
1. It is not possible to switch to Local mode when a Windows screen is displayed on the V9 series unit.
2. When installing the TPDD touch panel driver, select “Auto Detect” for [Serial Setting]. When “Auto Detect” is selected, the 

COM port, address, and IRQ of the computer connected to the V9 series unit are automatically detected and set. 
Therefore, the V9 series unit must be connected with the computer with a V-CP cable in RUN mode before starting up the 
computer.
Note that the following communication settings are fixed: [Baud Rate: 9600BPS], [Parity: None], [Data Length: 8-Bit], [Stop 
Bit: 1-Bit].

3. Correct the touch operation points and mouse cursor display position using the calibration software.
Precisely touch the “×” mark displayed in order from the top left corner of the screen. Be sure to touch all marks. If 
calibration does not end successfully, perform again. Otherwise touch operations are not possible.

4. If the display size is changed in Local mode, always display the RGB input screen and then start the calibration software. 
Then correct the touch operation points and mouse cursor display position.

5. Once the touch panel driver is installed, the set serial port cannot be used for other applications unless the driver is 
uninstalled (for TPDD, the port can also be freed by changing the setting for [Adjustment Setting]).

6. For details of the [Adjustment Setting] window of TPDD, refer to the Gunze help menu. For details of DMT-DD, refer to the 
manual provided by DMC. (Normally, default settings can be used.)

7. Display an RGB input screen on the V9 series unit before starting the computer. If the V9 series unit is in Local mode, the 
COM port will not be recognized.
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1.1.6 Macro Commands
Macro commands can be used for operations and color adjustment of video/RGB displays.

Default Video Display Settings
When no macro command is used, the video screen is displayed under the default settings.

Video/RGB Display Macro Commands
The “VIDEO2“ type macro commands are available for video/RGB display parts.

Command selection

Item Type Default Value
Brightness 0 (dark) to 31 (bright) 16
Contrast 0 (weak) to 31 (strong) 16

Color intensity 0 (light) to 31 (dark) 16

“VIDEO“ macro commands are available only for video overlap displays.
For details, refer to “1.1.8 Video Overlap Displays” page 1-27.

Name
Auxiliary Settings

Description
SNAP Channel: [Auto], [CH1 to 6]

File No.: [AUTO], [No. designation (0 to 32767)]
Executes a “single snap“ in the background.
When using a storage device, the method for saving snapshot images can be specified.

STROBE Channel: [Auto], [CH1 to 6]
File No.: [AUTO], [No. designation (0 to 32767)]
Executes a “strobe snap“.
When using a storage device, the method for saving snapshot images can be specified.
This command is ignored if a video/RGB image is not displayed on the screen.

RE_SIZE Resets the size of the video/RGB display that was enlarged by double-tapping on the display item or using the 
ZOOM macro command, or the video display that was enlarged by taking a strobe snapshot.
An enlarged display size can be reset by double-tapping on it without executing this command.

ZOOM Channel: [Auto], [CH1 to 6]
Position: [Centering], [Upper Right], [Lower Left]
Enlarges the video/RGB screen to 640 × 480 dots.
If this command is executed continuously, the previous operation is automatically cleared.

BRIGHT Channel: [Auto], [CH1 to 4]
Brightness: 0 to 31
Adjusts the brightness of the video image (not available for RGB images).

CONTRAST Channel: [Auto], [CH1 to 4]
Contrast: 0 to 31 
Adjusts the contrast of the video image (not available for RGB images).

COLOR Channel: [Auto], [CH1 to 4]
Color: 0 to 31
Adjusts the color of the video image (not available for RGB images).

VIDEOINF Channel: [Auto], [CH1 to 6]
Video/RGB display status: [SAVE], [DEFAULT]
Saves the current state of the video/RGB display or resets to the default settings.
When [SAVE] is selected, the current video display state is saved so that even if a power failure occurs, the 
video/RGB image can be displayed in the same state as before.
When [DEFAULT] is selected, the display state is reset to default.
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Specification by device memory: Video2 MEMORY F1
• Available device memory

• F1 details

PAUSE Channel: [Auto], [CH1 to 6]
Pauses the video/RGB display of the specified channel.
The size cannot be changed while paused.

RESTART Channel: [Auto], [CH1 to 6]
The video/RGB display that was paused with the PAUSE command is released.

DELETE File No.: 0 to 32767
Deletes a JPEG file (filename: VDxxxxx.jpg) that was saved to a storage device by a snapshot function.

SNAP_SEQ Channel: [Auto], [CH1 to 6]
Start/stop: 0 = stop, 1 = start
Starts or stops periodical snap.

CLIP_POS Channel: [Auto], [CH1 to 6]
Clip Start Position: X coordinate, Y coordinate
Changes the clip start position.

CLIP_SIZE Channel: [Auto], [CH1 to 6]
Image clip size change:  Width, Height
Changes the image clip size.

MODE Channel: [All], [CH1 to 4]
Display field: odd- and even-numbered fields, odd-numbered fields
Sets the operation mode.

For details, refer to the Macro Reference Manual.

Internal Device 
Memory PLC Device Memory Constant Memory Card Indirect Designation

F1

n Command No.
n + 1 CH No./File No.
n + 2 Setting value

n
Command Name

n + 1
Command No.

n + 2
CH No./File No. Setting Value

SNAP 0 1 to 6 (CH), -1 (AUTO) 0 to 32767 (File No.) / -1 (AUTO)
STROBE 1 1 to 6 (CH), -1 (AUTO) 0 to 32767 (File No.) / -1 (AUTO)
RE_SIZE 2 
ZOOM 3 1 to 6 (CH), -1 (AUTO) 0 to 2 (Centering, Upper Right, Lower Left: for SVGA only)
BRIGHT 4 1 to 4 (CH) 0 to 31
CONTRAST 5 1 to 4 (CH) 0 to 31
COLOR 6 1 to 4 (CH) 0 to 31
VIDEO_INF 7 1 to 6 (CH) 0 : SAVE, 1 : DEFAULT
PAUSE 8 1 to 6 (CH), -1 (AUTO)
RESTART 9 1 to 6 (CH), -1 (AUTO)
DELETE 10 0 to 32767 (File No.)
SNAP
(background)

11 1 to 6 (CH) 0 to 32767 (File No.) / -1 (AUTO)
(n + 3)
0: 160 * 120, 1: 320 * 240
2: 640 * 480, 3: 640 * 240

SNAP_SEQ 12 1 to 6 (CH), -1 (AUTO) 0: stop, 1: start
CLIP_POS 13 1 to 6 (CH), -1 (AUTO) 0 and up (up to the maximum screen resolution)
CLIP_SIZE 14 1 to 6 (CH), -1 (AUTO) 1 and up (up to the maximum screen resolution)
MODE 15 1 to 4 (CH), -1 (All) (n + 3)

0: odd- and even-numbered fields, 1: odd-numbered fields

Name
Auxiliary Settings

Description
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• [AUTO] setting
When setting a macro, [AUTO] can be selected for the channel number (CH) and file number.
• When the channel number is set to [AUTO]:

[SNAP] [STROBE] [ZOOM] [BRIGHT] [CONTRAST] [COLOR] [VIDEOINF] [PAUSE] [RESTART] [SNAP_SEQ] [CLIP_POS] 
[CLIP_SIZE]

*1 During “ZOOM“, the relevant channel number is automatically set.
*2 When a channel with a high display priority is shown, the relevant channel number is automatically set.
*3 When neither *1 or *2 is applicable, it depends on the number of displayed channels.

If multiple channels are displayed, the above commands are not executed.

• When the file number is set to [AUTO]:
[SNAP] [STROBE]
When no file exists, the command creates files starting from No. 0. When there are existing files, the command creates 
files starting from the number incremented from the largest file number (not exceeding the number set for [Maximum 
Number of Snap Files in Auto]).
When the maximum number is reached, the operation taken depends on the [When the Limitation is Exceeded] setting. 
If set to [Stop], the command stops, but if set to [Overwrite], the command starts creating files from No. 0.

RGB Macro Commands
The macro commands that are available only for video/RGB display parts that are displaying RGB input are “SYS (SET_RGB)“ 
and “SYS (RGB_CHG)“.

SYS (SET_RGB) F1
• Available device memory

• F1 details

SYS (RGB_CHG) F1
• Available device memory

• F1 details

For details on [Maximum Number of Snap Files in Auto] and [When the Limitation is Exceeded], refer to page 1-10.

Internal Device 
Memory PLC Device Memory Constant Memory Card Indirect Designation

F1

F1 Value F1 + 1 Value Operation
0 - Clears the RGB screen.
1 - Displays the RGB screen.

2 File number
(0 to 32767, -1 [AUTO])

Displays the RGB screen and takes a snapshot.

3 File number
(0 to 32767)

Delete the JPEG file of a snapshot.

4 to 7 Reserved for system -

8 CH No.5, 6 Specifies the channel number to be displayed or not displayed, or the channel 
number for touch switch emulation.

Internal Device 
Memory PLC Device Memory Constant Memory Card Indirect Designation

F1

F1 Value F1 + 1 Value Operation
0 Setting 1 Sets the clip start position with the value of [Setting 1].
1 Setting 2 Sets the clip start position with the value of [Setting 2].

For details, refer to the Macro Reference Manual.
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1.1.7 System Device Memory ($s)
The video display state is output to system device memory ($s).

Address Description Type
910 Video CH1 Brightness

← V

911 Video CH1 Contrast
912 Video CH1 Color intensity
913 Video CH1 Operation mode (GUR-00/GUR-10)

915 Video CH2 Brightness
916 Video CH2 Contrast
917 Video CH2 Color intensity
918 Video CH2 Operation mode (GUR-00/GUR-10), see $s913
920 Video CH3 Brightness
921 Video CH3 Contrast
922 Video CH3 Color intensity
923 Video CH3 Operation mode (GUR-00), see $s913
925 Video CH4 Brightness
926 Video CH4 Contrast
927 Video CH4 Color intensity
928 Video CH4 Operation mode (GUR-00), see $s913
930 Video Status

931 Snapshot function  Composition of superimpose screen
0: Video/RGB display only
1: Video/RGB display + superimposing (transparency setting blend value: enabled)

→ V

932 Automatic Stores the snapshot file number.

← V
934 Stores the channel number (1 to 4) corresponding to the location touched in the display area.  Default: 1
935 Video Brightness of the selected video area
936 Video Contrast of the selected video area
937 Video Color intensity of the selected video area
957 Video Display change (640 × 240 dots only)

The display can be switched to either the upper or lower half.

→ V

961 Video Standard size setting (for V9150iX only)
Specify with the initial macro.
The display area size is set to 640 × 480.

→ V

0: Odd/even-numbered fields
1: Odd-numbered field

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Reserved for system (set to “0”)

1: Taking a snapshot

1: Video board error 1: Maximum snapshot files

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0

MSB LSB

Reserved for system

1: Displaying input image1: Snapshot error
1: Display error

Reserved for system

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0

0: Upper half display
1: Lower half displayNot used

MSB LSB

CH1CH2CH3CH4

00: 640 × 480
01: 800 × 600
10: 1024 × 768

Not used

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
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962 Number of periodic snapshots executed
Cleared to 0 when taking of snapshots starts.

← V
966 Video Current clip start position (X coordinate at the top left corner)
967 Video Current clip start position (Y coordinate at the top left corner)
968 Video Current image clip size (width)
969 Video Current image clip size (height)
970 RGN IN Limit on number of snapshot executions using “SET_RGB“ macro

Setting value: 0 to 255
→ V971 RGB IN Processing to perform when the number of snapshot executions exceeds the limit specified with 

$s970
0: Stop
1: Overwrite

Address Description Type
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1.1.8 Video Overlap Displays
When intending to change the display size of the video while it is displayed, use a video overlap display part.

Location of Settings
• [System Setting] → [Unit Setting] → [Video/RGB] → [Video/RGB Settings] window
• [Parts] → [Image Display] → [Video Overlap]

Settings Window

For details on [Operation Select] and [Video Type] settings, refer to “1.1.3 Detailed Settings” page 1-6.
This section describes the settings which are different from those of a video/RGB display part.

Video Display Settings (Macro Commands)
The size and color of the video display can be specified using video macro commands.
When no macro command is used, the video display is displayed according to default settings.
When a macro command is executed, the macro command takes priority.

Default video display settings
The default settings are shown below.

The video display state is output to internal system device memory ($s).
The output is as shown below.

Menu Item Description
Channel Number of Channels This is fixed to “1“.

Channel Select Specify the video channel to be displayed.
CH1 to 4 (Video)
Switching with a macro is also possible. For details, refer to “Changing default settings” 
page 1-28.

Detail Coordinate Specify the video display position.
The video display is displayed with its upper left corner aligned to these coordinates.

Overlap ID Specify the overlap area (ID 0 to 9) to where a video display is to be called.

Item Type Default Value
Size 160 × 120, 320 × 240, 640 × 480, 640 × 240 320 × 240
Display channel CH1, CH2, CH3, CH4 1 (CH)
Brightness 0 (dark) to 255 (bright) 183
Contrast 0 (weak) to 255 (strong) 48
Color intensity 0 (light) to 255 (dark) 1

Address Description
$s170 Channel No.
$s171 Dither (fixed to 1 (yes))
$s172 Brightness
$s173 Contrast
$s174 Color intensity
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Changing default settings
Settings can be changed using macro commands. The size, channel number, brightness, contrast and color intensity of the 
video display can be set.
Select the “Video“ macro command. The following window is displayed.

• Command selection

• Example
Channel No.: 1 (CH1)
Size: 640 × 480 dots
The macro commands to change to these conditions is as follows:

Video SEL_CH  1 → CH1 selection
Video SIZE  640 × 480 → Size selection
Video_INF SAVE → Saving the state to device memory

• Specification by device memory: Video MEMORY F1

Command Name Description
SIZE (160 × 120, 320 × 240, 640 × 480, 640 × 240)

Specifys the video window size.
SEL_CH (1 to 4)

Specify the channel number of the input port.
BRIGHT (0 to 255)

Specify the brightness of the video image.
CONTRAST (0 to 255)

Specify the contrast of the video image.
COLOR (0 to 255)

Specify the color intensity of the video image.
VIDEO_INF (SAVE, DEFAULT)

Save the current state of the video display or reset to the default settings.
When [SAVE] is selected, the current video display state is saved so that even if a power failure occurs, the 
video image can be displayed in the same state as before.
When [DEFAULT] is selected, the display state is reset to default.
The V9 series unit may stop for a second when this command is executed.

n Command No.
n + 1 Setting Value

Command Name Command No. Setting Value
SIZE 0 0: 160 × 120, 1: 320 × 240, 2: 640 × 480, 3: 640 × 240
SEL_CH 1 1 to 4
BRIGHT 3 0 to 255
CONTRAST 4 0 to 255
COLOR 5 0 to 255
VIDEO_INF 6 0: SAVE, 1: DEFAULT
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• Example
Channel No.: 1 (CH1)
Size: 640 * 480 dots
The macro commands to change to these conditions with the “Video MEMORY“ macro command set as [F1: $u00100] 
is as follows:

Selecting channel number 1
$u00100=1(W) → Command (SEL_CH) selection
$u00101=1 (W) → 1CH selection
Video MEMORY  $u00100 → Command execution

Changing the window size
$u00100=0(W) → Command (SIZE) selection
$u00101=2 (W) → 640 * 480 dots selection
Video MEMORY  $u00100 → Command execution
Saving in memory
$u00100=6(W) → Command (Video_INF) selection
$u00101=0(W) → SAVE selection
Video MEMORY  $u00100 → Command execution

Show/Hide Video Overlap Displays
A video overlap display can be shown or hidden by the following three methods.

Internal command
• Switches

Switches can be used to show and hide video overlap displays.
The following switches can be used.

• Macro commands
A macro command can be used to show and hide video overlap displays.
Use the “OVLP_SHOW“ macro command.
The display position can be specified as well (using the “OVLP_POS“ macro command).

Method Details Refer to
Internal command Switch Function: Overlap Display Subsequent explanation

Macro OVLP_SHOW
OVLP_POS Macro Reference Manual

External command Control device memory 0: Hide, 1: Show Subsequent explanation

Operation Switch Function Auxiliary Settings

Show Overlap Display
Overlap ID 0 to 9
Action = ON
Overlap ID 0 to 9
Action = ALT

Hide Overlap Display
Overlap ID 0 to 9
Action = OFF
Overlap ID 0 to 9
Action = ALT

For details on switch settings, refer to the Reference Manual 1.

For details, refer to the Macro Reference Manual.
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External command
Commands from the [Control Device] can be used to show and hide video overlap displays. *

* Bit ON/OFF recognition
The method used for bit status recognition differs depending on the setting of [Display Overlap during bit ON] on the 
[General Settings] tab accessible by clicking [System Setting] → [Unit Setting] → [General Setting].
• Unselected

The change (edge) from 0 to 1 or 1 to 0 is used to recognize the bit status.
• Selected

Level recognition is used to determine the bit status.
For example, an overlap display is shown on the screen using an external command, the screen is switched to another 
screen, and then the first screen is displayed again. In this case, the overlap display that corresponds to the bit being 
turned ON appears on the screen.

Notes on showing an overlap display using a control device memory
A switch set as [Function: Overlap Display = OFF] can be used to hide the overlap display.
Using this type of switch hides the overlap display with the bit of the control device memory still turned ON. To show 
the overlap display again, the bit needs to be turned OFF and ON again.
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1.1.9 Notes
• If the system menu, status bar or communication error display (only [Comm. Error handling: Continue]) overlaps with a 

video/RGB input display area, if the screen is scrolled, the video/RGB input display is hidden.

• When an RGB input screen is displayed using RGB input control device memory or a “SYS (SET_RGB)“ macro command, 
the system menu, status bar, and communication error display (only [Comm. Error handling: Continue]) cannot be 
displayed.

• Other items cannot be displayed on a video/RGB display. Video/RGB displays are shown in the foreground of the screen.
• When displaying an overlap over a video/RGB display, select the [Validate superimpose when displaying over the 

video/RGB image (V8 compatible)] checkbox in the general settings.
To make the overlapping area transparent, also add the following settings.
- [Overlap] → [Style] → [Make display area transparent] checkbox: Unselected
- [Overlap] → [Style] → [Color]: Black
- [Overlap] → [Detail] → [Transparency Display] checkbox: Selected, [Blend]: 255

• If the size of the video/RGB display is smaller than the display area, the margins of the display area are displayed in the 
display area color.

• When an RGB input screen is displayed but there is no RGB input signal (such as when the cable is not connected), the 
RGB input screen is displayed black.

• Zooming in/out and scrolling using pinch-in and pinch-out gestures is not supported. (V9 Advanced, capacitive)
• When displaying multiple channels simultaneously, the display speed is faster when a single part is used with multiple 

display channels, instead of using multiple parts.

* When the screen is scrolled, the display area turns black.

Example: Video display of channels 1 to 4

Placing four parts on the screen and displaying a 
channel on each part
Size: 320*240 dots each

Placing one part on the screen and displaying 
channels 1 to 4
Size: 640*480 dots

Display speed is faster than the method on the left.

1CH 2CH

3CH 4CH

1CH 2CH

3CH 4CH
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1.2 USB Camera Display
1.2.1 Overview

Real Time Display
• Camera video can be displayed on the V10/V9 series unit by connecting a USB camera.

Video playback can be paused and resumed using a switch function or by double-tapping the display area.

• A snapshot can be taken from the currently displayed camera video. (in JPEG format)
To take a snapshot, either double-tap the display area or run the “USBCAM” macro command. (Refer to page 1-44.)
A snapshot can also be taken during video recording without interrupting the recording.

• USB camera resolution and V10/V9 series unit display

*1 For details, refer to “ Port” page 1-40.
• When using a USB camera, always used a USB hub with an external power supply. Also, always use port 1 of the USB hub. 

The camera feed will not be displayed if the camera is connected to a port other than port 1.

USB Camera Resolution Display Size Display on V10/V9 Series Unit
320 × 240 160 × 120 Reduced display

 320 × 240 Actual size
640 × 480 / 800 × 600 / 1024 × 768 Enlarged display

Free Depends on display size*1

640 × 480 160 × 120 / 320 × 240 Reduced display
640 × 480 Actual size

800 × 600 / 1024 × 768 Enlarged display
Free Depends on display size*1

Monitor Monitor

Monitor

EXT0000
SNAP
VD00000.JPG

Take a 
snapshot

(Example)

HUB

1

2

3

4

Monitor

USB camera cannot connect
to port 2 and higher
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Video Recording (Event Recording Function)
• Video can be saved to a video file (extension: .mp4) upon error occurrence and reset by using the alarm function.
• The event recording function allows video to be recorded continuously regardless of whether alarms occur. Video can be 

saved immediately after an error occurrence and reset, which facilitates cause analysis.
If the event recording function is not used, video is saved immediately after an error occurrence and reset.

• Video files of up to 180 seconds (up to 90 seconds before and 90 seconds afterwards) can be saved.
• A timestamp can be added to the video file. However, note that the frame rate will suffer due to the superimposition 

processing of the timestamp.

Play
• Saved video files can be played using the video player. *
• The date and time of saving can be checked during playback of timestamped files.

* When the event recording function is used, video is recorded continuously during RUN mode and the video player is unavailable.
In order to use the video player, stop recording video by using the “USBCAM_REC STOP” macro command or switch to Local mode and 
then play back a video file.

For details on the video player, refer to “15.1 Video Player”.

EXT0000
ALARM

ALARM00_001_A_20190415113025.mp4
ALARM00_001_R_20190415114253.mp4

Error

0 2030
sec

0 2020

201904
20190415

sec

50 seconds before and 
after occurrence

Error bit

Occurrence

Event recording function

Port 1

Reset

40 seconds before and
after reset

Continuous recording

Video file saving

19/ 4/ 1 15:09:30

19/ 4/ 1 15:09:30
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1.2.2 Specification
Applicable Models

*1 V9 Advanced (capacitive type switch: V9101iW/V9071iW) is not supported.
*2 V10 series supports USB3.0 (V9: USB2.0). 

USB Camera/USB Hub Specifications

* In some cases, operation cannot be guaranteed on the V10/V9 series unit due to insufficient power supply to the USB camera. For this 
reason, always used a USB hub with an external power supply.

V10/V9 Video Recording Specifications

*1 File sizes differ depending on the camera and recorded video.
*2 In the following cases, video is recorded to a single file. This means that there are cases when the duration of video recording is extended. 

However, note that since the maximum duration of video recording is 180 seconds, video recording ends upon reaching 180 seconds.
- When both occurrence and resetting are set, the end of video recording for occurrence overlaps with the start time of video recording 

for resetting (filename set to date and time of occurrence).
- Multiple alarms occur at once (filename is set to the first date and time of occurrence).

*3 If the storage device is full, operation is performed according to the setting of [Delete folders from the oldest when the remaining 
storage space is less than 100 MByte.] at [System Setting] → [Unit Setting] → [General Setting].

Model V9 Series Unit Version Port Used Number of USB Camera 
Connections

V10 Program Ver. 1.000 or later
OS Ver. 1.00 or later

USB-A*2 1 with USB hubV9 Advanced (analog switch) *1
V9 Standard
V9 Lite

Landscape Program Ver. 2.000 or later
OS Ver. 3.60 or later

Portrait
(Left 90° / 
Right 90°) 

Program Ver. 2.400 or later
OS Ver. 3.60 or later

Item Specification Remarks
USB camera Interface USB3.0, USB2.0

Communication 
standard

UVC (USB Video Class) support

Resolution 320 × 240
640 × 480

USB cameras that do not support 320 × 240 
or 640 × 480 resolutions cannot be 
connected.

Frame rate Max. 30 FPS
Output format RAW

USB HUB * Interface USB3.0, USB2.0 A camera connected to port 1 of the USB 
hub is recognized. Ports 2 and higher 
cannot be used.Power supply External power supply support

USB cable Cable length USB 3.0 standard:  Max. 3 m
USB 2.0 standard:  Max. 5 m
CE standard:  Max. 3 m

Item With Event Recording Function Without Event Recording Function
File type MPEG-4 (extension: .mp4)
Resolution 320 × 240, 640 × 480
File size *1 320 × 240: Approx 5.4 MB/180 seconds, 640 × 480: Approx. 36 MB/180 seconds
Max. duration of video recording 90 seconds *2 180 seconds
Storage destination Drive *3 Drive selected at [System Setting] → [Other] → [Storage Setting] → [Storage Connection 

Target].
Storage target folder Dated folders in ALARM folder

File Name ALARMxx_nnn_XX_YYYYMMDDHHMMSS.mp4

xx:  Block number
nnn:  Alarm number
XX:  A = occurrence, R = reset, AR = occurrence and reset
YYYYMMDDHHMMSS:  Year, month, day, hour, minutes, seconds

Sound None

EXT0000
ALARM

Year and month
Year, month, and day

(Access folder)
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1.2.3 Setting Example
Real Time Display
Display 640 × 480 video from the USB camera connected to port 1 on a screen of size 640 × 480.

1. Select [System Setting] → [Hardware Setting] → [Other Devices] → [USB Camera].
2. Select “640 × 480” for [Camera Resolution] in the [USB Camera Properties] window.

3. Close the [Hardware Setting] window.
4. Click [Parts] → [Image Display] → [USB Camera Display] and place a USB camera display part on the screen.

5. Set [USB Camera Display] → [Port] → [Display Size per Port] to “640 × 480”.

This completes the configuration of settings. Always connect the USB camera to port 1 of the USB hub.

Port 1
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Recording: Event Recording Function
Record video (640 × 480) when an alarm occurs and save the video to the SD card.

- Immediately before occurrence: 30 seconds
- Immediately after occurrence: 20 seconds

1. Select [System Setting] → [Hardware Setting] → [Other Devices] → [USB Camera].
2. Configure the settings under [Port 1 Setting] in the [USB Camera Properties] window.

Camera Resolution: 640 × 480
Use Event Record Function: Yes

3. Close the [Hardware Setting] window.
4. Select “Built-in Socket” for [Storage Connection Target] at [System Setting] → [Other] → [Storage Setting].
5. Configure the video recording settings at [System Setting] → [Alarm Server].

Record occurrence, Before: 30 seconds, After: 20 seconds

The necessary settings have been completed.
For details on alarm server video recording settings, refer to “1.2.6 Alarm Server (Recording)”.
For details on other alarm server settings, refer to the Reference Manual 1.

EXT0000
ALARM

ALARM00_001_A_20190415113025.mp4

Error

0 2030 s

201904
20190415

50 seconds before and 
after occurrence

Error bit

Error occurrence

Event recording function

Port 1

Continuous recording

Video file saving
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1.2.4 Hardware Settings
Configure the settings at [System Setting] → [Hardware Setting] → [Other Devices] → [USB Camera].

USB Camera Properties

Item Description
Recording/display 
setting

Drive for Output Set the destination for storing video files.
Storage Setting

Video files are saved on the drive selected at [System Setting] → [Other] → [Storage 
Setting] → [Storage Connection Target].

Camera Resolution Set the resolution of the USB camera.
320 × 240
640 × 480

Timestamp Set the timestamp settings.
A timestamp is added to the video so that the date and time of the video recording is 
superimposed on the video when the video file is played back.
The system font is used for the timestamp.
Refer to page 1-38

Use Info Output Device Store the camera status. Refer to page 1-39.
Alarm Settings Use Event Record 

Function
Select to use this function in conjunction with the alarm function when recording video 
immediately before an error occurrence and immediately before resetting an error.
Alarm server recording settings must also be configured.
In RUN mode, video is recorded continuously regardless of whether alarms occur.
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Timestamp
Save the date and time of the video recording together with the video. A timestamp will be shown on the video during video 
file playback.
Note that the frame rate will suffer due to the superimposition processing of the timestamp.

Item Description
Character 
properties

Char. Color
Transparency
Point (8 to 16)

Set character properties.
Point is displayed for fonts other than bitmap.

Position Setting Set the display position of the timestamp.
Upper Left, Top, Upper Right, Lower Left, Bottom, Lower Right

Display Format Date
Year Digits
Zero Suppress for Year
Zero Suppress for 
Month-Day

Select this checkbox to display the date.
Set the date display format.

Time Select this checkbox to display the time.
Set the time display format.

Data to Display Display the system calendar Display the date and time of the system calendar.
Display the value of the 
designated device

Time Display Format 
Setting

Display a user-formatted calendar.
Display the consecutive values from the specified device memory address as the calendar.

19/ 4/ 1 15:09:30

19/ 4/ 1 15:09:30

Video player
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Information output device
The status of the camera and event recording function is stored.
The value for bits 0, 1, 2 and 4 is stored at the following timings.

• When processing for recording video occurs
• When a screen containing a USB camera display part is displayed

The value for bit 5 (setting status of event recording function) is stored when the V10/V9 series unit starts up and when the 
unit switches from Local mode to RUN mode.

* The connected state of the USB camera can also be checked in the [I/O Check] window in Local mode.

Device Memory Description

n

n+1 Reserved for system

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0

MSB

Reserved for system

LSB

Connection status of USB 
camera *

0: Disconnected
1: Connected

1: Video file creation in progress
1: Error occurrence

Setting status of event recording 
function
0: Not set
1: Set
Status of event recording function
0: Functioning
1: Stopped Reserved for 

system
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1.2.5 USB Camera
This item is used to display USB camera video in real time.

Port

*1 [Display Size per Port]: Free

*2 The image is rounded to the following multiples for the display area. Fractions are displayed in black.
- Landscape: Round to the nearest multiple of 16 (width) and 8 (height).
- Portrait: Round to the nearest multiple of 8 (width) and 16 (height).

Item Description
Display Size per Port 160*120

320*240
640*480
800*600
1024*768

Select a display size.
Enlarged/actual size/reduced display is achieved depending on the combination with the 
[Hardware Setting] → [USB Camera Properties] → [Camera Resolution] setting.

Fit to display area *1 This setting is available when [Display Size per Channel] is set to [Free].

Unselected
Blank parts of the display area are displayed in black.

Selected
The camera screen is automatically scaled to fit within the “Y” size of the placed display area part. *2

Camera Resolution Display Size Display on V10/V9 Series Unit
320 × 240 Free*1 Depends on the setting

160*120 Reduced display
 320*240 Actual size

640*480 / 800*600 / 1024*768 Enlarged display
640 × 480 Free*1 Depends on the setting

160*120 / 320*240 Reduced display
640*480 Actual size

800*600 / 1024*768 Enlarged display

640

480

640

240

Display size (image clip size)
When showing the image in a display area 
as shown below:

[Fit to display area]: Unselected [Fit to display area]: Unselected

The image is displayed 
in its original size 
without fitting to the 
display area.

The image size is reduced to fit within the vertical 
dimension of the display area.
(Blank parts of the display area are displayed in black.)

Black
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Operation Select
Select the action to be performed by a double-tap operation on the area. This operation does not affect video recording in 
progress.

*1 A timestamp is not added. A snapshot can be taken only while recording video.
*2 When a screen program contains both the [AUTO] and [Specify] snap settings, specify a number in the range of 256 to 32767 to prevent 

the files of [Specify] from being overwritten with those of [AUTO]. When [AUTO] is selected, the number of the last snapshot is stored in 
system device memory $s932.

Style

Item Description
None No action.
Pause/Cancel Pause Pause and resume video playback.
Snap Settings Take a snapshot of the displayed video and save as a JPEG file.*1

Save location: (storage device)\EXT0000\SNAP
File Name Set the name of the file.

AUTO (0 to 255):
Save using sequential numbers from “VD00000.jpg”.
Set the action to perform when the maximum number of snapshots is reached from [Snap 
File Setting].

Specify (0 to 32767):
Save using the specified file number. If the specified file number already exists, it is 
overwritten. *2

Snap File
Setting

Configure snapshot file settings.

Item Description
Additional Parts List Select an operation switch.

Pause Pause the camera video as a still image.
Restart Resume the camera video from the still image.

Adjust Position Display the window for adjusting the placement position of each part. Part size can also 
be changed.

Select from catalogs Set the part design from the catalog.
Parts Design Change the part design and settings selected in the [Additional Parts List] or preview 

pane.Edit Selected Parts
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Show/Hide
Set the show and hide settings of the USB camera part.

Detail

For details, refer to “14 Item Show/Hide Function” in the Reference Manual 1.

Item Description
Coordinate Start X/Start Y Set the part coordinates.

Width/Height Set the part size.
Others ID Set an ID number.
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1.2.6 Alarm Server (Recording)
Configure an alarm server in conjunction with the alarm function when recording video when an alarm occurs and when 
resetting an alarm.

*1 This setting is only available when “Yes” is selected for [Use Event Record Function] at [System Setting] → [Hardware Setting] → [USB 
Camera Properties].
Since video is recorded continuously in RUN mode, the video player is unavailable.
In order to use the video player, stop recording video by using the “USBCAM_REC STOP” macro command or switch to Local mode and 
then play back a video file.

*2 In the following cases, video is recorded to a single file. This means that there are cases when the duration of video recording is extended. 
However, note that since the maximum duration of video recording is 180 seconds, video recording ends upon reaching 180 seconds.

- When both occurrence and resetting are set, the end of video recording for occurrence overlaps with the start time of video recording 
for resetting.

- Multiple alarms occur at once.

Item Description
Setting Enabled
Record occurrence

Before *1
After

Select this checkbox to record video when an alarm occurs. Set the duration of video recording immediately 
before and immediately after an alarm occurs.
A total of 180 seconds of video can be saved. *2

0 to 90 sec
Record resetting

Before *1
After

Select this checkbox to record video when an alarm is reset. Set the duration of video recording immediately 
before and immediately after an alarm is reset.
A total of 180 seconds of video can be saved. *2

0 to 90 sec
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1.2.7 Macros
Command list

Macro Commands
USBCAM_REC START
Function: Event recording function start
Supplementary information

• If an error during execution occurs, $s1061=-1 is stored. 
The value at the address is not updated even when the execution of the macro is normally complete after that. 
Therefore, resetting the value of $s1061 to zero is recommended before macro execution.

USBCAM_REC STOP
Function: Event recording function stop
Supplementary information

• While the recording file is being saved, the file saving is terminated. A file shorter than the set time is created.
• The real-time display will not display anything.
• If an error during execution occurs, $s1061=-1 is stored.

The value at the address is not updated even when the execution of the macro is normally complete after that.
Therefore, resetting the value of $s1061 to zero is recommended before macro execution.

USBCAM SNAP F1 F2
Function: Single snapshot
This macro command is used to save a snapshot of video from the port number specified in [F1] to a storage device using the 
file number specified in [F2].

Range

* The number of a file created under the “Auto” setting is stored in $s932. If there are no files on the storage device, files are numbered by 
incrementing, starting from “0”. If there are files in the storage device, files are numbered by incrementing the existing largest file number. 
When the incremented value reaches [Maximum Number of Snap Files in Auto] in the [Video/RGB Setting] window, the subsequent action 
depends on the option selected for [When the Limitation is Exceeded]. With [Stop] selected, any further execution of the macro command 
is invalid. With [Overwrite] selected, the incremented value will be reset to “0” and the files will be overwritten.

Operation example
• Saving a snapshot as “VD00005.JPG” to the “SNAP” folder on the storage device

USBCAM SNAP PORT 1 VD00005
Supplementary information

• The macro command is valid when USB camera video is displayed (real-time display) and a storage device is connected to 
the V10/V9 series unit.
It is not possible to take a snapshot as a background operation.

• A timestamp is not added. A snapshot can be taken only while recording video.
• Bit 0 of $s930 turns ON while taking a snapshot.
• If an error occurs during macro command execution, “-1” is stored in $s1061. This value is not updated even if the macro 

command ends successfully afterwards. It is therefore recommended to store “0” in $s1061 before executing the macro 
command.

Category Command Name Mnemonic Description

USB Camera

USBCAM_REC
USBCAM REC START Event recording function - start
USBCAM REC STOP Event recording function - stop

USBCAM

USBCAM SNAP F1 F2 Single snapshot
USBCAM CLIP_POS F1 F2 F3 Change the clip start position: X/Y coordinate
USBCAM CLIP_SIZE F1 F2 F3 Change the image clip size: width, height
USBCAM MEMORY F1 Device memory designation

• F1=4   Single snapshot
• F1=8   Change the clip start position: X coordinate, Y coordinate
• F1=9   Change the image clip size: width, height

Value
F0 SNAP
F1 1: Port 1 (fixed)
F2 00000 to 32767: Number designation

Auto *
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USBCAM CLIP_POS F1 F2 F3
Function: Change the clip start position

This macro command is used to change the coordinates for starting clipping (clip start position) of the image of the 
port specified in [F1] (Port 1 fixed) according to [F2] and [F3].

Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

Operation example
• Change the clip start position coordinates to (100, 150)

USBCAM CLIP_POS Port 1 100 150
Supplementary information

• Only the [Initial Macro] can work.
• Valid only for [Display Size per Port: Free].

USBCAM CLIP_SIZE F1 F2 F3
Function: Change the image clip size

This macro command is used to change the size for clipping (image clip size) the image of the port specified in [F1] 
(Port 1 fixed) according to [F2] and [F3].

Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

Operation example
• Change the clip start position coordinates to (100, 150) and the image clip size to 400 x 300 dots

USBCAM CLIP_POS Port 1 100 150
USBCAM CLIP_SIZE Port 1 400 300

Supplementary information
• Only the [Initial Macro] can work.
• Valid only for [Display Size per Port: Free].

USBCAM MEMORY F1 (Device Memory Designation)
Function: Single snapshot / Change the clip start position / Change the clip start position

This macro command is used to set the operation for camera image at the port specified in [F1+1] (Port 1 fixed) 
with [F1].

Range

Internal PLC 1 to 8 Constant
F1

Value
F0 CLIP_POS
F1 1: Port 1 (fixed)
F2 0 to 639: Starting X coordinate
F3 0 to 479: Starting Y coordinate

Internal PLC 1 to 8 Constant
F1

Value
F0 CLIP_SIZE
F1 1: Port 1 (fixed)
F2 1 to 640: Width
F3 1 to 480: Height

Value
F0 MEMORY
F1 4: SNAP

8: CLIP_POS
9: CLIP_SIZE

F1+1 1: Port 1 (fixed)
F1+2 and after Depends on the setting of [F1]

For details, refer to Macro Reference Manual.
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1.2.8 System Device Memory ($s)
The snapshot function status for the USB camera is output to system device memory ($s).

1.2.9 Notes
Real time display

• Only one USB camera item can be placed per screen. If two or more are placed, they will not function correctly.
Take this into account when placing on screen libraries and overlaps.

• A USB camera item cannot be placed on the same screen as a video/RGB item or video overlap.
• If a USB camera item is placed on an overlap, the overlap’s [Transparency Setting] value becomes invalid.
• When there is no signal or a signal is lost during display, the display area becomes hidden (the background becomes 

visible).
• When an overlap is displayed over a USB camera item, select the [Validate superimpose when displaying over the 

video/RGB image (V8 compatible)] checkbox in the general settings.
To make the overlapping area transparent, also add the following settings.
- [Overlap] → [Style] → [Make display area transparent] checkbox: Selected
- [Overlap] → [Detail] → [Transparency Display] → [Blend]: 255

• The USB camera display becomes hidden (the background becomes visible) when the following items overlap with the 
display area of the USB camera.
System menu, status bar, communication error display (only [Comm. Error handling: Continue]), screen scrolling

• When printing a hard copy, a USB camera image is also output.
• USB camera video cannot be displayed via RGB output (GUR-02) or on VNC viewer screens.
• During USB camera display, the RGB full screen and video overlap displays cannot be displayed correctly. The USB camera 

cannot be displayed correctly even by hiding the RGB full screen and video overlap displays.
• Video with significant changes in the image may be affected by flickering; however, this does not affect the video 

recording.
• A timestamp is not added to snapshot files.

Recording
• When the event recording function is selected, video is recorded continuously in RUN mode.

USBCAM_REC macro command is used for pausing/restarting recording. The event recording function will not work if left 
stopped. Make sure to restart recording.

• With the event recording function selected, saving of video starts if an alarm is occurring when Local mode is switched to 
the RUN mode. However, note that no video recording data is saved in Local mode.

• Displaying the Local mode screen during video recording stops video recording.
• When using the event recording function, screen changes may be slower. Also, since video is not recorded during a screen 

change, the duration of video recording may differ from the set duration.
When switching screens, it is recommended to stop the event recording function with the USBCAM_REC command and 
restart after switching screens.

• If alarms occur consecutively, there are instances when video files are not created. Set video recording for important 
alarms.

• Adding a timestamp display will slow down screen display.
• Depending on the timing of an alarm and processing for recording, recording may start up to 0.03 seconds earlier than 

the set time.
In such a case, the timestamp is earlier than the set time by one second.

Address Description Type
930 Snapshot function status output

← V

932 Automatic  Stores the snapshot file number. ← V
966 Current clip start position (X coordinate at the top left corner) ← V
967 Current clip start position (Y coordinate at the top left corner) ← V
968 Current image clip size (width) ← V
969 Current image clip size (height) ← V

1752 Stores the port number corresponding to the display area that was tapped. ← V

1: Taking a snapshot

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Reserved for system
1: Maximum snapshot files
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Playing videos
• When the event recording function is used, video is recorded continuously during RUN mode and the video player is 

unavailable.
In order to use the video player, stop recording video by using the “USBCAM_REC STOP” macro command or switch to 
Local mode and then play back a video file.

• Video files are saved to the “ALARM” folder of the drive specified at [System Setting] → [Other] → [Storage Setting] → 
[Storage Connection Target].
The video player accesses the “VIDEO” folder of the drive specified at [Video Player Settings] → [Storage Connection]. To 
play back a video file, switch to the “ALARM” folder using the video player.
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1.3 JPEG Display
1.3.1 Overview

JPEG File Display
• Display JPEG files saved to a storage device.
• JPEG files with a resolution up to 1024 × 768 can be displayed.

Note that when changing [Screen Size] for the display size setting using the [Scroll] function, the set resolution can also 
be displayed.

• There are three ways to load JPEG files.
- Filename specification
- File number specification (fixed)
- File number specification (PLC device memory)

Network Camera Image Display
• Display network camera snapshot images saved to a storage device.
• Two methods of specifying a file number and designating a file number from the PLC are available.

PLC

D100=5 D100=2

Error Error

Take a 
snapshot

Factory
JPEG
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1.3.2 Detailed Settings
Operation Select

*1 Display example

Item Description
Target Select Select a display target.

JPEG Display a JPEG file prepared in advance.
Filename: JPxxxxx.jpg (xxxxx: 00000 to 32767)
Any filename (maximum of 64 one-byte numerals or uppercase alphabetic characters)

Video Snap Display a video snapshot image.
Filename: VDxxxxx.jpg (xxxxx: 00000 to 32767)

Select File Select the file specification method.
File No. Specify the “xxxxx” part of “JPxxxxx.jpg” or “VDxxxxx.jpg” with a file number from 0 to 

32767.
File Name Specify a filename. Maximum of 64 one-byte numerals or uppercase alphabetic characters
Device *1 Set the device memory address that specifies the “xxxxx” part of “JPxxxxx.jpg” or 

“VDxxxxx.jpg” with a file number from 0 to 32767.
This allows the JPEG file to be changed in RUN mode.

Display Operation Fit to display area *2 Unselected: Actual size
Selected: Automatically enlarge or reduce the display according to the size of the 

display area.
The level of display detail can be specified at $s1008 when enlarging or reducing the 
display.

$s1008 Detail Speed
0 Coarse Fast
1 Fine Slow

PLC

D100 = 2 D100 = 0

JP00000 . JPG JP00001 . JPG JP00002 . JPG

JPEG JPEG
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*2 Display example
- Checkbox: unselected

The image is displayed at its original size with respect to the top left corner of the display area. If the JPEG image is larger than the 
display area, the part of the image outside the display area is not shown. Note that the color of the display area is visible when the JPEG 
image is smaller than the display area. It is recommended that users match the display area color with the background color of the 
image.

- Checkbox: selected
The image is enlarged or reduced with respect to the top left corner of the display area. The image is enlarged or reduced using the 
same factor for width and length.

Use a color that matches the background color.

Same size

Size is smaller than the displayed image

Size is larger than the displayed image

Reduction

Enlargement
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Style

*1 Display example
- When the [+100] switch is pressed while file No. 800 is displayed, a search is conducted for file No. 900 or later and the file is displayed.

When a search has been conducted to No. 32767, it is continued moving back to No. 0.

Item Description
Additional Parts List Displays a list of JPEG display switches.

Parts can be added to the list using the [Add Parts] button.
Target file

+ Block Display the JPEG file corresponding to the next file number.
JPxxxxx.jpg
VDxxxxx.jpg− Block Display the JPEG file corresponding to the previous file number.

File Call Load the JPEG file corresponding to the specified file number.
File Delete Delete the JPEG file that is currently displayed. VDxxxxx.jpg
JPEG Search Set an increment or decrement value to use to search for and display a 

JPEG file *1.
JPxxxxx.jpg
VDxxxxx.jpg

Adjust Position Displays the window for adjusting the placement position of each part.
The size of parts can also be changed.

Select from catalogs Set the part design from the catalog.
Parts Design Set the design and color of parts.
Edit Selected Parts Configure the part selected in the [Additional Parts List] or preview pane.

+100 -100 +100-100

Function: Search for the 
JPEG file and display
Increment/Decrement: 
-100

(1) No. 800 = JP00800.jpg is displayed.
(3) A search is conducted and No. 900 

= JP00900.jpg is displayed.

Function: Search for the 
JPEG file and display
Increment/Decrement: 
100

(2) Press the [+ 100] switch.
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- When the [−100] switch is pressed while file No. 800 is displayed, a search is conducted for file No. 700 or prior and the file is displayed.
When a search has been conducted to No. 0, it is continued moving back to No. 32767.

Show/Hide
Set the show and hide settings of graphic items.

Detail

For details, refer to “14 Item Shown/Hide Function” in the Reference Manual 1.

Item Description
Coordinate Start X/Start Y Set the placement position and size of the display area.

Width/Height *1

Others Process Cycle Set the cycle for the V10/V9 series to read PLC data.
File No. Output Device Output the file number of the currently displayed image.
ID Set an ID number.

-100 -100 +100+100

(1) No. 800 = JP00800.jpg is displayed.
(3) A search is conducted and No. 700 

= JP00700.jpg is displayed.

(2) Press the [-100] switch.
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1.3.3 JPEG File Location
The JPEG display function loads and displays the files in the following location.

Display Target Filenames File Location
JPEG JPxxxxx.jpg (xxxxx: 00000 - 32767)

xxxxxxx.jpg (maximum of 64 one-byte numerals or 
uppercase alphabetic characters)

(access folder)\JPEG folder

Video Snap VDxxxxx.jpg (xxxxx: 00000 - 32767) (access folder)\SNAP folder
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1.4 Network Camera
1.4.1 Overview

• Images from network cameras can be displayed on the V10/V9 series unit. All V10/V9 series models support this function 
because cameras are connected using an Ethernet connection.

• Up to four camera images can be displayed simultaneously using both the screen and overlaps. When a fifth camera 
image is displayed, the display of the oldest area in the placement order is stopped.

• Camera operation
Using a command device memory or an operation switch on the screen allows network cameras to be easily controlled 
from a remote location.

Note that some network cameras cannot be controlled remotely. See the specifications of your network camera.

Example: Monitoring the conditions in the factory

Factory A

Ethernet

Factory B

Network camera

Factory A Factory B
Factory B

Ethernet
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• Snapshot function
The currently displayed image can be saved to a storage device as a JPEG file when the bit of a command device memory 
changes to ON or by double-tapping the display area.

1.4.2 System Requirements
Applicable Models

Available Network Cameras or Sensors

*1 No image is displayed upon initial connection.
To display an image, sensor memory PI10000-00 (Trigger) must be change from “0” to “1” (leading edge). When accessing sensor 
memory from the V10/V9 series unit, select [System Setting] → [Hardware Setting] → [Maker: BANNER].

1.4.3 Required Settings
V-SFT Settings

• Settings in network camera display items → “1.4.4 Detailed Settings” page 1-56

Network Camera Settings
• AXIS models → “1.4.5 AXIS Settings” page 1-60
• Panasonic models → “1.4.6 Panasonic (Example: BB-HCM580)” page 1-69
• BANNER models → “1.4.7 BANNER (Example: PresencePLUS P4 OMNI)” page 1-79

PASS POWER
READY

FAIL ERROR
TRIGGER

Ethernet

Vision sensor

Double-tapping the display area 
saves an image to the “SNAP” 
folder on the storage device.

MONITOUCH Models Connection Port Remarks
V10/V9 LAN (built-in) Not available with LAN2, WLAN, or CUR-03

Manufacturer Type Protocol
Axis

MOTION-JPEG
(video)

HTTP protocol communication 
(TCP/IP)Panasonic BB series

BL series
BANNER PresencePLUS P4 OMNI Bitmap

(still image) *1 Dedicated protocol
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1.4.4 Detailed Settings
Device Setting

Item Description
Network Camera Setting Select the network camera specification method.

Network Camera Table 
No.

Select one registered camera in the table. One camera is always displayed.

Command Device *1 Select one registered camera in the table using a value stored in a device memory. Three words 
are used.
This method allows switching between multiple camera images. In addition, camera operation 
can be controlled using a value stored in a device memory.

Setting Display the [Network Camera Table Setting] screen to perform camera registration. Refer to 
page 1-58.

Info Output Device Output the state of the network camera. Four words are used.

Capture a snapshot *2 *3 *4 Save the displayed image as a JPEG file by double-tapping on the display area.

Save location: (storage device)\EX0000\SNAP
Snap file naming Set the filename to use when saving a snapshot.

AUTO (0 to 255):
Save using sequential numbers from “VD00000.jpg”.
Set the action to perform when the maximum number of snapshots is reached using [Snap 
File Setting].

Specify (0 to 32767)
Save using the specified file number. If the specified file already exists, it is overwritten.

Snap File Setting Configure snapshot file settings.

Memory Description Applicable Models
n Table number specification AXIS, Panasonic, BANNER

n+1 Camera operation AXIS, Panasonic, BANNER (snapshot only)
n+2 Operation input AXIS

Memory Description
n Bit 0 Connected state 0: Connected 1: Disconnected

Bit 1 Pan angle state 0: Normal 1: Abnormal
Bit 2 Tilt angle state 0: Normal 1: Abnormal
Bit 3 Zoom state 0: Normal 1: Abnormal

n+1 Camera pan angle
n+2 Camera tilt angle
n+3 Zoom position
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*1 Command device memory
- n: Table number specification

- n+1: Camera operation

- n+2: Operation input (AXIS only)

*2 Setting Examples
- When [Snap file naming] is “AUTO”, [Maximum Number of Saves] is “10”, and [Action when Limitation is Exceeded] is “Overwrite”

Snapshot files ranging from “VD00000.jpg” to “VD00009.jpg” are created in sequence. When the file “VD00009.jpg” is created, the 
previous files will be overwritten from “VD00000.jpg”.

- When [Snap file naming] is “Specify” and [No. to Assign to Filename] is “30”
The file “VD00030.jpg” is created and always overwritten.

*3 When a screen program contains both the [AUTO] and [Specify] snap settings, specify a number in the range of 256 to 32767 to prevent 
the files of [Specify] from being overwritten with those of [AUTO]. When [AUTO] is selected, the number of the last snapshot is stored in 
system device memory $s932.

*4 Snapshots can be rotated using system device memory ($s976) and then saved.

* If any value other than the above is specified, the snapshot will be saved with 0° rotation.

$s976 Rotation Direction
0 0°

1 Clockwise by 90°

2 180°

3 Counterclockwise by 90°

Table numbers 0 to 255Not used

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0

MSB LSB

Not used

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0

MSB LSB

Pan right
Pan left
Tilt up
Tilt down
Zoom (optical zooming only)
Wide
Snapshot

Bit 0 to 1: Execute

Memory Operation Setting Value Remarks
n+2 Up/down/left/right Angle: −18000 to 18000 (±180 

degrees)
Effective to the first decimal place

Zoom in/zoom out Magnification: 0 or higher Depends on the maximum value in the 
camera specifications.

Snapshot Not used Rotation direction can be specified 
using $s976. (Refer to *4.)

VD00000.jpg
VD00001.jpg
VD00002.jpg

VD00008.jpg
VD00009.jpg

Sequential 
numbering

When reaching the limit number, 
the files are overwritten from the 
first file.
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Network camera table settings
Register the IP address, port number, and other information regarding network cameras.

*1 For details on setting IP addresses, refer to the user’s manual of the network camera.

*2 BANNER: No configuration required
*3 BANNER: Selection not possible
*4 The size of the display area can be set as required. This cannot be selected for a BANNER camera.

*5 Panasonic, BANNER: Cannot set to 90, 270

Item Description
Maker Select the manufacturer of the network camera.

AXIS, Panasonic, BANNER
IP Address *1 Specify the IP address of the network camera.
Port No. Specify the port number of the network camera.

1 - 65535

Basic Authentication *2 Select this checkbox to use basic authentication for the network camera.
This enables user ID and password settings. For details, refer to your network camera settings.

User ID Enter the user name and password registered in the network camera settings.
For details, refer to your network camera settings.Password

Item Resolution Set the size of the display area. The specified area size is automatically updated to the screen.
160*120, 192*144 *3, 320*240, 640*480, Specify *4

The display area is automatically enlarged or reduced on the V10/V9 series unit when a resolution that 
differs from [Camera Resolution] is selected.

Camera Resolution Set the output resolution of the network camera.
To improve performance, set a lower resolution.

Rotate (Item) Rotate the display area on the V10/V9 series unit.
Rotate (Camera) *5 Set the rotation angle of the image output from the network camera. Select an angle appropriate for the 

mounting orientation of the network camera.
0, 90, 180, 270

Manufacturer Model Remarks
Axis 214PTZ Use AXIS’s dedicated tool when changing the default IP address.

Default: 192.168.0.90
Panasonic BB-HCM580 Use the CD-ROM provided with the network camera when changing the 

default IP address.
Default: Automatic setupBANNER PresencePLUS P4 OMNI

Maker Default Remarks
Panasonic 80
BANNER 20000 Sensor range: 20000 to 20009
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Style

*1 Note that some network cameras cannot be controlled remotely. See your network camera specifications. (No BANNER products support 
these functions.)

*2 If the [Delay] → [ON repeat] setting is configured in the switch settings window, the function performed by the switch is repeated while 
the switch is held down.

*3 Optical zooming only. Digital zooming is not supported.

Show/Hide
Set the show and hide settings of JPEG display items.

Detail

Item Description
Additional Parts List Select an operation switch. *1 *2

Step Left Pan the camera left.
Step Right Pan the camera right.
Step Up Tilt the camera up.
Step Down Tilt the camera down.
Zoom In *3 Zoom in on the camera image.

Zoom Out *3 Zoom out of the camera image.
Focus Far Focus the camera on a distant point.
Focus Near Focus the camera on a nearby point.
Pause Pause video display.
Restart Resume video display.

Parts Design Set the design and color of parts.
Edit Selected Parts Configure the part selected in the [Additional Parts List] or preview pane.
Adjust Position Displays the window for adjusting the placement position of each part.

The size of parts can also be changed.

Refer to “14 Item Shown/Hide Function” in the Reference Manual 1.

Item Description
Coordinate Start X/Start Y Specify the coordinates of the display area.
Other Process Cycle Set the cycle that the V10/V9 series unit accesses the camera.

ID Set an ID number.
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1.4.5 AXIS Settings
Access from the Computer (Example: AXIS 214PTZ)
1. Start up Microsoft Internet Explorer on your computer.
2. Enter the IP address of the network camera in the address field.

3. The following dialog is displayed when using basic authentication. Enter a registered user name and password, and click 
the [OK] button.
If basic authentication is not used, proceed to step 4.
For details on basic authentication, refer to page 1-62.

4. The [Live view] window is displayed.

http://xxx.xxx.xxx.xxx
Network camera IP address
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Network Camera Settings
Checking and changing the IP address
1. Display the [Setup] window.

* If basic authentication is not used, pressing the [Setup] button displays the dialog box shown in step 3 of “Access from the 
Computer (Example: AXIS 214PTZ)” page 1-60. Enter a user name and password.

2. On the menu on the left of the screen, click [Basic Configuration Instructions] → [2. TCP/IP].
3. Check and change the network camera IP address, subnet mask, and gateway settings as required.

4. Click the [Save] button to save any changes.

HTTP settings
1. Display the [Setup] window.

* If basic authentication is not used, pressing the [Setup] button displays the dialog box shown in step 3 of “Access from the 
Computer (Example: AXIS 214PTZ)” page 1-60. Enter a user name and password.

2. On the menu on the left of the screen, click [System Options] → [Security] → [HTTPS].
3. Select “HTTP” for the options under [HTTPS Connection Policy]. (“HTTP” is selected as default.)
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Basic authentication settings
Basic authentication is provided to permit or prohibit access from guest users.
Use basic authentication to prohibit access from guest users.

1. Display the [Setup] window.
* If basic authentication is not used, pressing the [Setup] button displays the dialog box shown in step 3 of “Access from the 

Computer (Example: AXIS 214PTZ)” page 1-60. Enter a user name and password.
2. On the menu on the left of the screen, click [Basic Configuration Instructions] → [Users].
3. If the checkmarks are not selected for the options under [User Settings], basic authentication is required for the network 

camera.

* When using basic authentication, make the following settings in the V-SFT software. As shown below, select the [Basic 
Authentication] checkbox and enter a registered user ID and password in the [Network Camera Table Setting] window. For 
details on registered user names and passwords, refer to “Checking and registering user names and passwords” page 
1-63.
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4. If basic authentication is not necessary, select the [Enable anonymous viewer login (no user name or password required)] 
checkbox under [User Settings] and click the [Save] button.

* When performing camera lens operations from the V10/V9 series unit or PLC, select the [Enable anonymous PTZ control 
login (no user name or password required)] checkbox and click the [Save] button. For details, refer to “Operating the 
Camera Lens from the V10/V9 Series Unit” page 1-64.

Checking and registering user names and passwords
1. Display the [Setup] window.

* If basic authentication is not used, pressing the [Setup] button displays the dialog box shown in step 3 of “Access from the 
Computer” page 1-69. Enter a user name and password.

2. On the menu on the left of the screen, click [Basic Configuration Instructions] → [Users].
3. If users have been registered, they are displayed under [User List].
4. To add a new user, click the [Add...] button. To modify an existing user, click the [Modify...] button.

5. The [User Setup] window is displayed.
Enter the desired name for [User name] and enter the same password for [Password] and [Confirm password].

6. Click [OK] to accept the settings.

There may be a [HTTP/RTSP Password Settings] setting depending on the type of camera.
Always set [Allow password type] to “Unencrypted only”.

Check [Administrator] for [User group].
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Operating the Camera Lens from the V10/V9 Series Unit
The camera lens can be operated using switches and command device memory addresses on the V10/V9 series unit.

With basic authentication
Display the [User Setup] window* and select the [Enable PTZ control] checkbox.

* For details on how to display the [User Setup] window, refer to “Checking and registering user names and passwords” 
page 1-63.

Without basic authentication
Display the [Users] window*. Select both checkboxes under [User Settings] and click the [Save] button.

* For details on how to display the [Users] window, refer to “Basic authentication settings” page 1-62.
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How to access a camera from a computer (Example: AXIS P1435-LE)
1. Open your PC’s web browser.
2. Enter the IP address of the network camera into the address bar.

3. The following dialog appears. Enter the username and password then click [OK].

4. The [Live View] page opens. Click [Settings] to start configuration.

http://xxx.xxx.xxx.xxx
Network camera IP address
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Network Camera Settings
IP address settings
Go to [SYSTEM] → [TCP/IP] to set the IP address, subnet mask, and default router.

Security settings
Go to [SYSTEM] → [Security] → [HTTP and HTTPS] and select the “HTTP” option.
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Plain Config
1. Go to [SYSTEM] → [Plain config] → [Network] → [HTTP] and select the “Basic” option.

2.  Go to [SYSTEM] → [Plain config] → [Layout] → [Default video format] and select the “Motion JPEG” option.
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Username and password settings
1. Go to [SYSTEM] → [Users] to create a user. [Role] must be set to [Administrator].

* On the V-SFT, go to [Network Camera Table Setting] and check [Basic Authentication] then enter the username and 
password that you created. 

Resolution settings
Go to [Stream] and set the [Resolution] option.
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1.4.6 Panasonic (Example: BB-HCM580)
Access from the Computer
This network camera can be accessed from a computer using the CD-ROM included with the network camera or via a web 
browser.

* Select the method using the CD-ROM when setting up the network camera for the first time.

CD-ROM
1. Load the CD-ROM included with the network camera into your computer.
2. The [Network Camera] window is displayed. Click [Search for Cameras] to search for the network camera connected to the 

computer.

3. If the following message appears, click [OK].

4. When the target network camera is found, information regarding the network camera, such as MAC address and IP 
address, is displayed in the [Easy Setup] window. Click [Access Camera] *.

* If the IP address of the network camera does not exist in the network group of the computer, click the [Network Settings] 
button. In the window to be displayed, change the IP address of the network camera so that it belongs to the network 
group of the computer.
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5. When connecting a factory-default network camera to your computer, the [Initial Authentication Setting] screen appears.
Register a user name and password for the administrator. (If a user is already registered, proceed to step 6.)
For details, refer to the user’s manual of the network camera.

6. The authentication dialog box is displayed. Enter an administrator-level user name and password and click [OK].
* When [Permit access from guest users] is checked on the [Administrator] page, the [Top] tab window is displayed. Click 

the [Login] tab. For details, refer to “Authentication settings” page 1-73.

7. The [Top] tab window is displayed.
(This tab window is displayed when login authentication is performed with an administrator-level user name and 
password. When a general or guest user logs in, the menus in the displayed tab window vary slightly.)

The password registered in this step is required for access to the network camera.
Take appropriate measures to avoid forgetting the password.
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Web browser (Microsoft Internet Explorer)
1. Start up Microsoft Internet Explorer on your computer.
2. Enter the IP address and port number of the network camera in the address field.

* When using the factory-default port number of 80, the entry of the port number may be omitted.

3. The authentication dialog box is displayed. Enter an administrator-level user name and password and click [OK].
* When [Permit access from guest users] is checked on the [Administrator] page, the [Top] tab window is displayed. Click 

the [Login] tab. For details, refer to “Authentication settings” page 1-73.

4. The [Top] tab window is displayed.
(This tab window is displayed when login authentication is performed with an administrator-level user name and 
password. When a general or guest user logs in, the menus in the displayed tab window vary slightly.)

http://xxx.xxx.xxx.xxx
Network camera IP address

:Port number/



1  Image Display

1-72

Network Camera Settings
Checking and changing the IP address

* Login with an administrator-level user name and password is required to proceed to the following tab window 
settings.

1. Click the [Setup] tab.
2. Check that [Network (IPv4)] is selected in the [Basic] menu at the left of the window. Next, go to the [Connection Mode] 

area and click [Static].

3. Configure the network camera port number*, IP address, subnet mask, and gateway settings.
* The default port number is 80. Enter a port number between 1 and 65535.

* Also enter the port number for [Port No.] in the [Network Camera Table Settings] window in V-SFT. Refer to page 1-58.

4. Click [Save] to save the settings made in the previous steps.
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The IP address can be checked or changed using the CD-ROM included with network camera or via the [Network Settings] 
button in the [Easy Setup] window.

Authentication settings
Authentication settings are provided to permit or prohibit access from guest users.
These settings disallow access to guest users.

* Login with an administrator-level user name and password is required to proceed to the following tab window 
settings.

1. Click the [Setup] tab.
2. Click [Administrator] at the left of the screen.
3. In the [General Authentication] area, select either [Permit access from guest users] or [Do not permit access from guest 

users].

Permit access from guest users This option allows anyone to access the network camera without a registered user name and 
password.

Do not permit access from guest users Whenever access to the network camera is attempted, the authentication dialog box appears. 
Access is granted to the network camera by entering a registered user name and password.
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* When the [Do not permit access from guest users] checkbox is selected, configure the following settings in the V-SFT 
software. As shown below, select the [Basic Authentication] checkbox and enter a registered user ID and password in the 
[Network Camera Table Setting] window. For details on registered user names and passwords, refer to “Checking and 
Registering User Names and Passwords” page 1-77.

4. Click [Save] to save the settings made in the previous steps.
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Registering and changing the settings of general users
When users other than the administrator need access to the network camera, general user registration is required.

* Login with an administrator-level user name and password is required to proceed to the following tab window 
settings.

New general user registration
1. Click the [Setup] tab.
2. Click [General User] on the left of the screen.
3. Click [Create].

4. The [New General User Registration] page is displayed. Configure the settings as specified below.

5. Click [Save] to save the settings made in the previous steps.

The password registered in this step is required for access to the network camera.
Take appropriate measures to avoid forgetting the password.
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Changing guest user settings
The following settings can be configured when the [Permit access from guest users] checkbox is selected.
Configure the functions available when the network camera is accessed without authentication with a user name and 
password in the following tab window.

1. Click the [Setup] tab.
2. Click [General User] on the left of the screen.
3. Check that [Guest User] is selected and then click [Modify].

4. The [Modify Guest User] page is displayed. Configure the settings as specified below.

5. Click [Save] to save the settings made in the previous steps.
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Checking and Registering User Names and Passwords

In a case when the [Do not permit access from guest users] checkbox is selected in the [General Authentication] area, the user 
name and password registered for the administrator or a general user in the network camera setting tab window must be set 
in the V-SFT software.
For details on the authentication settings, refer to “Authentication settings” page 1-73.

* Login with an administrator-level user name and password is required to proceed to the following tab window 
settings.

Administrator
1. Click the [Setup] tab.
2. Click [Administrator] at the left of the screen.
3. Check the settings in the [Input User Name and Password] area.
4. If any changes are made to these fields, click [Save] to save the changes.

General users
1. Click the [Setup] tab.
2. Click [General User] on the left of the screen.
3. Select the target user name from the [User ID List].
4. Click [Modify].

When a password has already been registered, the [Password] field is blanked out.
Take sufficient care when managing passwords. If you forget the password, a password newly registered is 
usable for authentication.
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5. Check the settings in the [Input User Name and Password] area.

6. If any changes are made to these fields, click [Save] to save the changes.

Image Display Settings
* Login with an administrator-level user name and password is required to proceed to the following tab window 

settings.

1. Click the [Setup] tab.
2. Click [Image Display] at the left of the screen.
3. Configure the settings as specified below.

* Note that these settings will be overwritten while the V10/V9 series unit is communicating with the network camera. 
Because overwriting is likely to be time-consuming, it is recommended to configure these settings in advance.

4. Click [Save] to save the settings made in the previous steps.
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1.4.7 BANNER (Example: PresencePLUS P4 OMNI)
Access from the Computer
When accessing a sensor from a computer, use the “PresencePLUS” dedicated sensor software.
The CD-ROM provided with the sensor includes this software. Load the CD-ROM into the computer and install the software.
For details on the installation procedure, refer to the manual issued by BANNER.

1. Start the “PresencePLUS” software.
2. The [System Setup] window is displayed. When a connected sensor is found, the information on the sensor, including IP 

address and MAC address, appears in the window. Select the desired sensor listed under [Sensor Neighborhood] with the 
cursor and click [Change Sensor IP Address].

3. The [Select Ethernet Adapter] window is displayed. Select the Ethernet adapter of the computer and click [Next].
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4. The [Set Sensor IP Address] window is displayed. Change the sensor’s IP address and subnet mask settings as necessary 
and click [Finish].

5. Click [OK] in the [System Setup] window to close the window.
6. When a connection between the computer and the sensor is established, the monitor screen is displayed on the 

computer.

The sensor is reset in this step.

* Make sure that the computer network 
group and the sensor IP address are on 
the same network.
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Sensor Settings
Port number setting
1. Click the [Tools] menu button.
2. Click the [Analysis] tab → [Communication].

3. The [Communication Tool] menu opens. Enter an arbitrary name for [Name] and select [Image] under [Select].

4. In the [Connection(s)] section, select an Ethernet socket number. The sensor port number corresponding to the selected 
socket number is used for connection with V10/V9 series unit.
To see more information on each Ethernet socket number, display the [Connection Detail] window by clicking [View 
Settings].

Socket No. Port No. (Fixed)
Ethernet socket 1 20000
Ethernet socket 2 20001
Ethernet socket 3 20002
Ethernet socket 4 20003
Ethernet socket 5 20004
Ethernet socket 6 20005 * The sensor port number corresponding to each 

Ethernet socket number is fixed.Ethernet socket 7 20006
Ethernet socket 8 20007
Ethernet socket 9 20008
Ethernet socket 10 20009
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5. In the [Resolution] section, select the size of the image to be displayed on the V10/V9 series unit.

* The size of images captured with the sensor is based on 640 x 480 pixels (default). When changing the size, refer to the manual issued by 
BANNER.

6. Click [Next] to exit the menu.
* Repeat steps 2 to 5 when connecting multiple V10/V9 series units. (Maximum of 10 sensors.) Only one V10/V9 series unit 

can be connected per sensor port number.

RUN
1. Click the [Run] menu button.

2. The [Save Inspection] window is displayed. Select “Sensor” for [Save in].
Enter an [Inspection Number] and [Inspection Name] for registration and click [Save].

Resolution Description *

1:1 Display at actual size (640 × 480 pixels)
4:1 Display at a half of the size (320 × 240 pixels) of the width and height of 1:1 resolution
16:1 Display at a quarter of the size (160 × 120 pixels) of the width and height of 1:1 resolution
64:1 Display at an eighth of the size (80 × 60 pixels) of the width and height of 1:1 resolution

Example
Inspection Number: 3
Inspection Name: LINE.ins
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3. Click the [Select] tab in the [Run] menu, go to [Hardware Input], and select the name that was entered for [Inspection 
Name] in step 2.

4. Click the [Monitor] tab → [Start].

The settings in the [Run] menu are complete.
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1.4.8 System Device Memory ($s)
Snapshots taken with a network camera can be rotated using system device memory ($s) and then saved.

* If any value other than the above is specified, the snapshot will be saved with 0° rotation.

1.4.9 Restrictions
All Manufacturers

• Up to four camera images can be displayed simultaneously using both the screen and overlaps. When a fifth camera 
image is displayed, the display of the oldest area in the placement order is stopped.

• The resolution of snapshot files saved on the V10/V9 series unit depends on the [Snap Setting] setting in the network 
camera display settings window.

AXIS
• The focus and brightness of images displayed by a network camera are automatically adjusted.
• The display size and rotation of images on the V10/V9 series unit differs depending on the combination of network 

camera and the basic authentication settings in V-SFT.
• Only optical zooming is possible for zoom operations from the V10/V9 series unit. Digital zooming is not supported.

Panasonic
• The focus and brightness of images displayed by a network camera are automatically adjusted.
• The display size and rotation of images on the V10/V9 series unit differs depending on the combination of network 

camera and the authentication settings in V-SFT.
• Only optical zooming is possible for zoom operations from the V10/V9 series unit. Digital zooming is not supported.

BANNER
• Focus and brightness of sensor images are not automatically adjusted. Sensors do not support these automatic 

adjustments.

Address Description Type
976 Rotation of snapshots

0: 0°
1: Clockwise by 90°
2: 180°
3: Counterclockwise by 90°

→ V

Basic Authentication Settings
V10/V9 Series Unit Display

Network Camera
V-SFT

Network Camera 
Table Settings

Not configured Not configured The previously configured size and rotation settings take effect for the 
display of images captured with the network camera.

Configured The configured size and rotation settings take effect for the display of 
images captured with the network camera.

Configured Not configured Camera display is hidden.
Configured The configured size and rotation settings take effect for the display of 

images captured with the network camera.

Authentication Settings
V10/V9 Series Unit Display

Network Camera
V-SFT

Network Camera 
Table Settings

Not configured Not configured The configured size and rotation settings take effect for the display of 
images captured with the network camera.Configured

Configured Not configured Camera display is hidden.
Configured The configured size and rotation settings take effect for the display of 

images captured with the network camera.
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2.1 Overview
2.1.1 Before Use

Applicable Models
Only the V9 Advanced (V910xiW) and V10/V9 Standard models support the audio playback function.
These models have a built-in stereo mini jack port (AUDIO) for audio playback.

Audio Specifications

Preparation
Prepare the following items to use the audio playback function.

• V10/V9 series unit
• Connected amplifier and external speaker
• Audio file (WAV)

Item Specifications
External Connection Terminal φ3.5-mm stereo mini jack
Max. Output Voltage 2.1 Vrms (0 db)
Connected Amplifier Input impedance of 1 kΩ or more
Playable Files Sound Synthesis PCM (WAV file)

Sampling Frequency 8 KHz / 16 KHz / 32 KHz / 44.1 KHz / 48 KHz / 96 KHz / 192 KHz
Quantization Bit 8 bit / 16 bit / 24 bit
Audio Source Monaural / Stereo

Volume Control 8 levels
(The volume can be changed in 3-dB steps from -21 dB to 0 dB using macro 
commands.)
Default: -6 dB

V9100iS
V9080iS

AUDIO port

Example:
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2.1.2 Overview
Audio files can be played over the connected external speaker using the V10/V9 series unit by turning bits ON and OFF.

The functions that can play audio are listed below.
• Local playback: Settings are required for each screen.

- Audio item
- Animation

• Global playback: Settings apply to the entire file.
- Alarm Server

Machine operation will
stop soon.

Notification Machine operation will
stop soon.

It is possible to play an audio file of the message displayed 
on the screen through the speaker by recording an audio file 
version of the message in advance.
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2.2 Playing Audio Using Sound Parts
2.2.1 Setting Examples

Prepare the following audio files.

Configure the following settings using the above files.

2.2.2 Conceptual Operation
Operation is performed in the following manner when the unit is running with the above settings.

File Description
WA0000.WAV Line A
WA0001.WAV Line B
WA0002.WAV error
WA0003.WAV occurred.
WA0004.WAV recovered.

Item Description
File Select Play Order 0 Display Method Device memory address: D100

1 Display Method File No. 2
2 Display Method File No. 3

Play Monitoring 
Device

M100

Line A error 
occurred.

D100 = 0
M100 = ON

Line B error 
occurred.

D100 = 1
M100 = ON
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2.3 Detailed Settings
2.3.1 Sound Part

Click the [Screen Setting] menu → the [Sound] button.
The [Sound] settings window is displayed.

File Select
Click the [Add] button to add audio to the list under [Order].

Item Description
Play Order *1 This is the order in which audio files are played.
Specification Method Select the audio file specification method.

File No. Specify the audio file to be played using a number.
The format of audio filenames that can be specified for [File No.] is shown below. No 
files in any other name format can be played.

WA xxxx .WAV (xxxx: 0000 to 1023: audio file number)
File Name Specify the filename of the audio file to be played.

The format of audio filenames that can be specified for [File Name] is shown below. No 
files in any other name format can be played.

xxxxxxxx .WAV (xxxxxxxx: maximum of 64 one-byte numerals or uppercase alphabetic 
characters)

* Filename specification is only available when the audio file is stored on a storage 
device.

Device Select this option to switch between audio files for playback during RUN mode.
Specify the device memory address where the audio file number is stored.
The format of audio filenames that can be read using a device memory 
address is shown below. No files in any other name format can be played.

WA xxxx .WAV (xxxx: 0000 to 1023: audio file number)

* When “Device” is selected, always include the audio file in the screen program file.
For details on including files, refer to “Methods for Storing Audio Files” page 2-7.

Detail Information corresponding to the method selected for [Display Method] is displayed.
Play WAV File This button is only available when “File No.” is selected for [Display Method].

Press this button to play the selected file on the PC.
Add Click to add an entry to the list.
Delete Select an entry number to delete and click this button to delete the selected entry from 

the list.
Replace with the above/Replace with the below Select an entry in the list and click the desired button to change the order of the entry in 

the list.
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*1 For details on the order of audio file playback, refer to “2.5.1 Audio File Playback Priority” page 2-10.

Play

Detail

Edit Select an entry in the list and click this button to configure the [Specification Method] 
settings. The window shown below is displayed.

Item Description
Monitoring Device Specify the bit memory address to use to play/stop the audio file set in the [File Select] settings (refer to 

the previous page).

Play: [0] → [1]
Stop: [1] → [0] (stops even while the file is playing.)

Repeat playback Select this checkbox to play the audio file repeatedly.
Priority (0 to 511) When multiple audio items are placed on the screen, set the priority for playing for each item. When 

multiple bits are set to ON simultaneously, the audio file with the higher priority is played.
However, if an audio file linked to an alarm server starts playing, the audio item will stop playing because 
the alarm server audio has a higher priority.

Item Description
Process Cycle Set a cycle for the V10/V9 series to read the PLC data while it is communicating with the PLC.
ID Set the ID.

For details on IDs, refer to the Operation Manual.

Item Description
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2.3.2 Animation
Click the [Screen Setting] → [Animation] button.
The [Animation] settings window is displayed.

For details on linking audio files, refer to “11.2 Animation” in Reference Manual 1.

2.3.3 Alarm Server
Click the [System Setting] → the [Alarm Server] button.
The [Alarm Server] settings window is displayed.

For details on linking audio files, refer to “8 Alarm” in the Reference Manual 1.
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2.4 Methods for Storing Audio Files
Audio files can be handled by either of the following two methods. Settings in the screen program and the location for 
storing audio files differ between these methods.

• Method 1: Including audio files in the screen program file
• Method 2: Storing audio files on a storage device of the V10/V9 series unit

Including Audio Files in the Screen Program File
PC for editing a screen program
Save the audio files for use to the “WAV” folder in the “USER” folder, which is located in the “MONITOUCH” folder on the drive 
to which V-SFT version 6 is installed.
Audio files are transferred as part of the screen program when the screen program is transferred to the unit.

* Note that the space available for the screen program will decrease by the space consumed by audio files that are 
included.

C:\MONITOUCH COMMON

USER

V9EMULATOR

V-SFT V6

DATA

JPEG

PARTS

PICTURE

SPLASH

WAV

WEBSERV

← Store audio files in this folder.
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• Deselect the [Store WAV File in storage] checkbox at [System Setting] → [Other] → [Storage Setting]. If the 
checkbox is selected, audio files cannot be included in the screen program file.

• If an audio file number is specified using a device memory address, be sure to select the [System Setting] 
→ [Unit Setting] → [Sound] → [Import All Files from WAV folder] checkbox.
All WAV files in the “WAV” folder will be transferred to the V10/V9 series unit when the screen program is 
transferred.

Device memory specified

Setting to check: [Screen Setting] → [Sound]
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Storing Audio Files on a Storage Device of the V10/V9 Series Unit
Store audio files on a storage device of the V10/V9 series unit.

V-SFT-6
1. [System Setting] → [Other] → [Storage Setting]

Select which storage device of the V10/V9 series unit to use and also select the [Store WAV File in storage] checkbox.

2. If settings are configured for audio files to be stored on a storage device, audio files are not automatically stored when 
the screen program is transferred.
Use either Windows Explorer or the storage manager function to store the audio files on a storage device.
For details, refer to “8.3.8 Storing Audio (WAV) Files” page 8-22 in “8 Storage Device”.

SD SDDATA

JPEG

PARTS

PICTURE

SPLASH

WAV WA0000.WAV
WA0001.WAV
WA0002.WAV
WA0003.WAV

Store audio files using 
Windows Explorer or the 
storage manager.

Access folder name

Insert the SD card containing the 
audio files into the unit.
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2.5 Notes
2.5.1 Audio File Playback Priority

The following describes the playback priority for audio files.

Order of File Playback According to Audio Item
The order of playback can be set for each audio item. If the bits of all items turn ON at the same time, the item with the lowest 
order number is played.

If items have the same order number, the file of the item whose bit turned ON last is played.

Order of File Playback According to Part Type
Audio playback for audio items and animation is regarded as local playback.
If an alarm server causes global playback of an audio file during local playback, the audio of the alarm server takes priority 
and local playback stops.

Audio item playback order: 0

Audio item playback order: 1

Audio item playback order: 2

Play

Audio item playback order: 0

Audio item playback order: 0

Audio item playback order: 0

Play

Play

Play
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2.6 System Device Memory
Sound information is output to internal device memory ($s).

• $s1000
This device memory address stores the number of seconds until the currently playing WAV file will finished playing.

• $s1001
This device memory address stores the adjusted volume value of channel L.

• $s1002
This device memory address stores the adjusted volume value of channel R.
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3.1 Overview
3.1.1 Scheduler

The scheduler function executes specific operations at the specified times.
Operations include turning bits ON/OFF, writing data, and macro execution, and up to 64 schedules can be registered.
Registered schedules can be checked in a list.

• Schedules can be executed according to a specified date and time or day of the week.

• CSV output from a logging server can be easily executed using the scheduler function.

• Schedules can be executed at any time by setting an operation time to a device memory address.

• An interlock can be set to a schedule to control execution permission using bit status.

For setting examples, refer to “3.2.1 Trigger Settings” page 3-3.

For setting examples, refer to “3.2.2 Operation Settings” page 3-8.

For setting examples, refer to “Designation: Device” page 3-7.

For details, refer to “Others” page 3-15.

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

Every night, 00:00
15th of every month, 08:00

Monday to Friday of every week on every hour
First and third Wednesday of every month, 17:00

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100 PLC

OFF ON OFF

SD File
.CSV

M100 turns ON

Pressed for 3 seconds

Example: Storage output bit  M100

Monday to Friday of 
every week on every hour
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3.1.2 Operation Specifications
Execution Timing (Trigger)
There are two types of execution timings that can be specified: start time, and start time and end time.

• Start
Perform operation once at start time.

• Start and end
Perform an operation once at the start time and another operation at the end time.

Operation Item
• Bit output
• Word writing
• Macros

Start operation

Start 
time

Time

Start 
time

Start 
time

Start 
time

Time

Start 
time

Start 
time

End 
time

End 
time

Start operation
End operation

ON duration OFF duration ON duration OFF duration
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3.2 Setting Example
3.2.1 Trigger Settings

Specification Method: Direct
Set the operation time of the schedule to the screen program.
There are two general methods for setting the operation time: date specification and day of the week specification.

Date specification
• “Execution Every Month with Date Specifications” page 3-3 (Example: Execution on the 15th of every month at 08:00)
• “Execution Every Day with Time Specifications” page 3-4 (Example: Execution every night at 00:00)

Day of the week specification
• “Execution Every Month with Day of the Week Specifications” page 3-5 (Example: Execution on the first and third 

Wednesday of every month at 17:00)
• “Execution Every Week with Day of the Week Specifications” page 3-6 (Example: Execution at every hour, Monday to 

Friday of every week) 

Execution Every Month with Date Specifications
This section explains the setting procedure for execution on the 15th of every month at 08:00.

1. Click [System Setting] → [Scheduler].

2. Click [New].

3. Register the schedule name for [Settings] on the [General] tab window.

4. Configure the following settings on the [Trigger] tab window.

This completes the necessary settings.
Operation settings are described next.

For operation setting examples, refer to “3.2.2 Operation Settings” page 3-8.

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

15th of every month, 08:00

Scheduler execution

Example: 08:00

Example: 15th of every month

Trigger: Start
Designation: Direct
Action: 15th of every month
Time: 08:00
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Execution Every Day with Time Specifications
This section explains the setting procedure for execution on every night at 00:00.

1. Click [System Setting] → [Scheduler].

2. Click [New].

3. Register the schedule name for [Settings] on the [General] tab window.

4. Configure the following settings on the [Trigger] tab window.

This completes the necessary settings.
Operation settings are described next.

For operation setting examples, refer to “3.2.2 Operation Settings” page 3-8.

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

Every night, 00:00

Scheduler execution

Example: 00:00 at night

Example: Every day

Trigger: Start
Designation: Direct
Action: Every day
Time: 0 hour, 0 minutes, 0 seconds
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Execution Every Month with Day of the Week Specifications
This section explains the setting procedure for execution on the first and third Wednesday of every month at 17:00.

1. Click [System Setting] → [Scheduler].

2. Click [New].

3. Register the schedule name for [Settings] on the [General] tab window.

4. Configure the following settings on the [Trigger] tab window.

This completes the necessary settings.
Operation settings are described next.

For operation setting examples, refer to “3.2.2 Operation Settings” page 3-8.

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

First and third Wednesday of every month, 17:00

Scheduler execution

Example: 5:00 p.m.

Trigger: Start
Designation: Direct
Action: First and third Wednesday of every month
Time: 17:00

Example: First and third Wednesday 
of every month
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Execution Every Week with Day of the Week Specifications
This section explains the setting procedure for execution on Monday to Friday of every week on every hour.

1. Click [System Setting] → [Scheduler].

2. Click [New].

3. Register the schedule name for [Settings] on the [General] tab window.

4. Configure the following settings on the [Trigger] tab window.

This completes the necessary settings.
Operation settings are described next.

For operation setting examples, refer to “3.2.2 Operation Settings” page 3-8.

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

Monday to Friday of 
every week on every hour

Scheduler execution

Example: Every hour

Example: Execution on Monday to 
Friday of every week

Trigger: Start
Designation: Direct
Action: Monday to Friday of every week
Time: [Every hour] checkbox selected
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Designation: Device
Set the operation time of the schedule to the screen program using a device memory address. (The date and time are set to 
all devices memory address.)
The date and time is specified and the schedule is executed in RUN mode.
The setting procedure is described below.

1. Click [System Setting] → [Scheduler].

2. Click [New].

3. Register the schedule name for [Settings] on the [General] tab window.

4. Configure the following settings on the [Trigger] tab window.

This completes the necessary settings.
Operation settings are described next.

The schedule is started by setting the operation time to [Time Setting Device] on MONITOUCH.

For details, refer to “Designation: Device” page 3-12.

For operation setting examples, refer to “3.2.2 Operation Settings” page 3-8.

For details on the time specification method, see “3.4 Example of Date and Time Specification by 
Device Memory (Designation: Device)” page 3-16.

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

PLC

D1000

D1002

0

15
D1003 8

D1001 0

0
D1004
D1005

0

15th of every month, 08:00

Scheduler execution

The operation date and time is assigned 
consecutively from the [Time Setting Device].
The number of words used differs depending on 
the [Trigger] setting.

• [Start]: 6 consecutive words
• [Start and end]: 9 consecutive words

Example: 6 words from 
D1000 to D1005
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3.2.2 Operation Settings
This section explains the setting procedure for turning ON the M100 bit at the specified time.
The M100 bit is turned OFF after three seconds.

1. Set “1” for [Number of Outputs] under [Action] → [Output Setting] in the schedule.

2. Configure the operation settings as shown below.

This completes the necessary settings.

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100 PLC

OFF ON OFF

SD File
.CSV

M100 turns ON

Pressed for 3 seconds

Example: CSV output bit  M100

Specified time

Example: Turn OFF the M100 bit 
after three seconds

Output Action: Momentary (ON)
Output Target Memory: M100
Reset Time: 30 * 100 ms (3 seconds)
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3.3 Detailed Settings
Location of settings: [System Setting] → [Scheduler].

Schedule List

General

Item Description
New Create a new schedule. A maximum of 64 schedules can be registered.
Delete Delete the selected schedule.
Preview Currently registered schedules can be checked in a list.

Schedules registered with component parts are shown with an asterisk (*) on the left of [No.].

Item Description
Schedule Name Register the schedule name. 256 characters maximum

List of currently
registered schedules
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Trigger

Item Description
Trigger Start

Perform operation once at the start time.

Start and end
Perform the start operation at the start time and the end operation at the end time.

Designation Direct
Set a specific date and time.

Device
Set the entire date and time using device memory.

Start operation
Time

Start time Start time

Time

Start time End time

Start operation End operation

ON duration OFF duration
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Designation: Direct
Item Description

Action Date Every day
Execute every day.

Every month, x day
Execute on the specified day.

Week Every week
Execute every week.

1st, 2nd, 3rd, 4th, Last
Execute on the specified day of the week (Sunday to Saturday) on the specified week. The first week at 
the start of each month corresponds to [1st].
Multiple checkboxes can be selected.

Hour, 
minutes, 
and 
seconds

Specify the execution time of the schedule.

Sun Mon Tue Wed Thu Fri Sat
1 2

3 4 5 6 7 8 9
10 11 12 13 14 15 16
17 18 19 20 21 22 23
24 25 26 27 28 29 30
31

1st 1st to 7th
2nd 8th to 14th
3rd 15th to 21st
4th 22nd to 28th
Last 25th to 31st Monday 25th 

corresponds to both 
4th and Last

Fridays in this month
1st 1st
2nd 8th
3rd 15th
4th 22nd
Last 29th
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Designation: Device

Details of Time Setting Device

Item Description
Time Setting Device Specify the device memory address to use to set the time. The time is assigned consecutively starting from 

this address.
The number of words used differs depending on the [Trigger] setting.

• [Start]: 6 consecutive words (n to n+5)
• [Start and end]: 9 consecutive words (n to n+8)

Input Type Select the code to use when reading data from the PLC device memory. BCD, DEC, FLOAT

Device Memory Description

Control Device n Bit 0 Contents control device memory addresses n to n + 8 are determined by a 0 → 1 
change in bit status and then the settings take effect.

* When this bit is 1 at startup, the settings take effect.
Action
Bit 5

Specify a date or day of the week.

Bit 4

Bits 1 to 3 When executing every hour, minute, or second, the corresponding bit is set to 1.
When a bit is 0, the time is specified with n+3 to n+8.

Example: 6 words from 
D1000 to D1005

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0

0 → 1: Confirm
1: Every second
0: Second can be 

specified
1: Every minute
0: Minute can be specified

1: Every hour
0: Hour can be specified

Action

Not used (always set to “0”)

MSB LSB

Date Setting 05 04
Every month, date, time 0 0
Every day, time 0 1
xth week, day of the week, time 1 0
Every week, day of the week, time 1 1
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“n”th Week n+1

Specify when control device memory n is set to the following.

When setting the ordinal week number of a day of the week, the corresponding bit is set to 1.
Multiple selections can be made.

Day/Week n+2

The setting differs depending on the status of bits 4 and 5 of the control device memory.

• Date specification
Set control device memory n to the following value.

- 1 to 31: Date
- 99: Last day of each month

• Day of the week specification
Multiple days of the week can also be set.
Set control device memory n to the following value.

Start Action: Hour n+3 Used when bit 3 of the control device memory is 0 (hour specifiable). 0 to 23
Start Action: Minute n+4 Used when bit 2 of the control device memory is 0 (minute specifiable). 0 to 59
Start Action: Second n+5 Used when bit 1 of the control device memory is 0 (second specifiable). 0 to 59

End Action: Hour n+6 Used when bit 3 of the control device memory is 0 (hour specifiable). 0 to 23
End Action: Minute n+7 Used when bit 2 of the control device memory is 0 (minute specifiable). 0 to 59
End Action: Second n+8 Used when bit 1 of the control device memory is 0 (second specifiable). 0 to 59

Device Memory Description

Date Setting 05 04
xth week, day of the week, time 1 0

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0

1: 1st
1: 2nd

1: 3rd
1: 4th

1: Last

Sun Mon Tue Wed Thu Fri Sat
1 2

3 4 5 6 7 8 9
10 11 12 13 14 15 16
17 18 19 20 21 22 23
24 25 26 27 28 29 30
31

1st 1st to 7th
2nd 8th to 14th
3rd 15th to 21st
4th 22nd to 28th
Last 25th to 31st Monday 25th 

corresponds to both 
4th and Last

Fridays in this month
1st 1st
2nd 8th
3rd 15th
4th 22nd
Last 29th

Date Setting 05 04
Every month, date, time 0 0

Date Setting 05 04
xth week, day of the week, time 1 0
Every week, day of the week, time 1 1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0

1: Sunday
1: Monday

1: Tuesday
1: Friday

1: Saturday

1: Thursday
1: Wednesday
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Action
Output Setting

* When [Momentary] is set multiple times, [Reset Time] is used for all instances.

Item Description
Output device to edit This setting is available when [Start and end] is selected for [Trigger]. Select the operation for the start time 

and end time.
Number of Outputs Set the number of bits to output. 1 to 16
Output Target Specify the output device memory address.
Action Momentary (ON) *

Turn the bit ON, and then turn it OFF after the time set for [Reset Time] elapses.
[Reset time]: 1 to 300, units: 100 ms

Momentary (OFF) *

Turn the bit OFF, and then turn it ON after the time set for [Reset Time] elapses.
[Reset time]: 1 to 300, units: 100 ms

Set
Turn the bit ON.

Reset
Turn the bit OFF.

Alternate
Alternate the bit between ON and OFF.

Writing in Words
Write the data value to the device memory.
Set the data length of the value for writing using [Data Length]. 1-Word/2-Words (real numbers use 
2 words)
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Macro

Others

Item Description
Macro to Edit This setting is available when [Start and end] is selected for [Trigger]. Select the operation for the start time 

and end time.
If settings exist, an asterisk (*) is shown.

Use Scheduler macros Register a macro for execution using [Edit]. All macros can be deleted at once using [Delete].
Specify the macro block 
number

Select the macro block number using the pull-down menu. The selected macro block number can be edited 
using [Edit].

Preview Displays the details of the currently selected macro.

For details on macros, refer to the Macro Reference Manual.

Item Description
Acknowledgment Bit This bit changes to 1 when the schedule is executed.
Interlock Control the execution permission of the start operation.

1: Permitted
0: Prohibited

* Even if the interlock bit changes to 0 (prohibited) during schedule operation, the end operation is 
performed.

Execute start operation even 
if the start time is exceeded 
at startup/calendar change

This setting is available when [Start and end] is selected for [Trigger].
Set the operation to perform when the time after startup or a calendar change is within the start/end time 
range (ON time).

Selected
The start operation is performed.
No operation is performed if the end time is reached but the next start time is not (OFF time).
When [Device] is selected for [Time Settings], the start operation is performed only when bit 0 
(acknowledgment) of control device memory n is ON.

Unselected
The start and end operations are not performed. Operations are performed from the next start time.

Save an operation log This setting is available when the [Scheduler] checkbox is selected at [System Setting] → [Other] → 
[Operation log Setting] → [Log objects]. Save a log of schedule execution.

Preview

Available when [Start and 
end] is selected for 
[Trigger].

Available when using the operation log.
Location of setting:
[System Setting] → [Other] → [Operation log Setting] 
→ [Log objects] → [Scheduler]
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3.4 Example of Date and Time Specification by Device Memory 
(Designation: Device)
If the schedule operation time is set to a device memory address, the schedule will start at the time specified in the device 
memory.
This section explains the command method with an example where the time setting device memory is D1000.
There are two general methods for setting the operation time: date specification and day of the week specification.

Date specification
• “Execution Every Month with Date Specifications” page 3-16 (Example: Execution on the 15th of every month at 08:00)
• “Execution Every Day with Time Specifications” page 3-17 (Example: Execution every night at 00:00)

Day of the week specification
• “Execution Every Month with Day of the Week Specifications” page 3-18 (Example: Execution on the first and third 

Wednesday of every month at 17:00)
• “Execution Every Week with Day of the Week Specifications” page 3-19 (Example: Execution at every hour, Monday to 

Friday of every week)

Execution Every Month with Date Specifications
This section explains the setting procedure for execution on the 15th of every month at 08:00.

1. Set address D1000 to 0H.

2. Specify “15” for the date in address D1002.
3. Specify the start time in addresses D1003 to D1005.

4. Change bit 0 of address D1000 from 0 to 1.

This completes the necessary settings.
The scheduled operation is performed at the specified time. Perform steps 1 to 4 to change the settings.

Item Device Memory Setting Value Remarks
Start Action: Hour D1003 8 When D1000 bit 3 = 1 (every hour), disabled

Start Action: Minute D1004 0 When D1000 bit 2 = 1 (every minute), disabled
Start Action: Second D1005 0 When D1000 bit 1 = 1 (every second), disabled

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

15th of every month, 08:00

Scheduler execution

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0: Second can be specified
0: Minute can be specified

0: Hour can be specifiedDate Setting
00: Every month, date specification

Not used (always set to “0”)

MSB LSB

If every hour, every minute, or every second is 
specified, these change to 1.
Example: Every hour: 0008H

Every hour, every minute: 000CH

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Acknowledgment
0 → 1

Not used (always set to “0”)

MSB LSB
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Execution Every Day with Time Specifications
This section explains the setting procedure for execution on every night at 00:00.

1. Set address D1000 to 10H.

2. Specify the start time in addresses D1003 to D1005.
(When [Start and end] is selected on the [Trigger] tab window, specify the end time in addresses D1006 to D1008.)

3. Change bit 0 of address D1000 from 0 to 1.

This completes the necessary settings.
The scheduled operation is performed at the specified time. Perform steps 1 to 3 to change the settings.

Item Device Memory Setting Value Remarks
Start Action: Hour D1003 0 When D1000 bit 3 = 1 (every hour), disabled

Start Action: Minute D1004 0 When D1000 bit 2 = 1 (every minute), disabled
Start Action: Second D1005 0 When D1000 bit 1 = 1 (every second), disabled

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

Every night, 00:00

Scheduler execution

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0

0: Second can be specified
0: Minute can be specified

0: Hour can be specifiedDate Setting
01: Every day

Not used (always set to “0”)

MSB LSB

If every hour, every minute, or every second is 
specified, these change to 1.
Example: Every hour: 0008H

Every hour, every minute: 000CH

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0

Acknowledgment
0 → 1

Not used (always set to “0”)

MSB LSB
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Execution Every Month with Day of the Week Specifications
This section explains the setting procedure for execution on the first and third Wednesday of every month at 17:00.

1. Set address D1000 to 20H.

2. Specify 5H for address D1001 so that execution occurs on the first and third weeks.

3. Specify 8H for Wednesday in address D1002.

4. Specify the start time in addresses D1003 to D1005.
(When [Start and end] is selected on the [Trigger] tab window, specify the end time in addresses D1006 to D1008.)

5. Change bit 0 of address D1000 from 0 to 1.

This completes the necessary settings.
The scheduled operation is performed at the specified time. Perform steps 1 to 5 to change the settings.

Item Device Memory Setting Value Remarks
Start Action: Hour D1003 17 When D1000 bit 3 = 1 (every hour), disabled

Start Action: Minute D1004 0 When D1000 bit 2 = 1 (every minute), disabled
Start Action: Second D1005 0 When D1000 bit 1 = 1 (every second), disabled

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

First and third Wednesday 
of every month, 17:00

Scheduler execution

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0

0: Second can be specified
0: Minute can be specified

0: Hour can be specified

Not used (always set to “0”)

MSB LSB

If every hour, every minute, or every second is 
specified, these change to 1.
Example: Every hour: 0008H

Every hour, every minute: 000CH

Date Setting
10: Day of the week specification

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 1

1: 1st1: 3rd

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0

1: Wednesday

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Acknowledgment
0 → 1

Not used (always set to “0”)

MSB LSB
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Execution Every Week with Day of the Week Specifications
This section explains the setting procedure for execution on Monday to Friday of every week on every hour.

1. Set address D1000 to 38H.

2. Specify 3EH for Monday to Friday in address D1002.

3. Specify the start time in addresses D1003 to D1005.

4. Change bit 0 of address D1000 from 0 to 1.

This completes the necessary settings.
The scheduled operation is performed at the specified time. Perform steps 1 to 4 to change the settings.

Item Device Memory Setting Value Remarks
Start Action: Hour D1003 - When D1000 bit 3 = 1 (every hour), disabled

Start Action: Minute D1004 0 When D1000 bit 2 = 1 (every minute), disabled
Start Action: Second D1005 0 When D1000 bit 1 = 1 (every second), disabled

4 April 2014
Sunday Monday Tuesday WednesdayThursday Friday Saturday

1 2 3 4

109876

5

11 12

1716151413 18 19

2423222120 25 26

30292827

0

20

40

60

80

100

Monday to Friday of every 
week on every hour

Scheduler execution

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 1 1 1 0 0 0

0: Second can be specified
0: Minute can be specified

1: Every hour

Not used (always set to “0”)

MSB LSB

If every hour, every minute, or every second is 
specified, these change to 1.
Example: Every hour: 0008H

Every hour, every minute: 000CH

Date Setting
11: Day of the week, 

every week 
specification

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 1 1 1 1 1 0

1: Monday
1: Tuesday

1: Friday
1: Thursday

1: Wednesday

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Acknowledgment
0 → 1

Not used (always set to “0”)

MSB LSB
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3.5 System Device Memory ($s)
The following describes the system device memory associated with the scheduler function.

Device Memory Description
$s1650 After specifying device memory addresses n to n + 8 for operation time, the result is output when bit 0 

(acknowledgment bit) of control device memory n changes from 0 to 1.
When an invalid value is specified, the bit is 1.

1: Error
0: Normal

Example: Invalid values include 40th day, 100 seconds etc.

* When a valid time is set, the bit is 0.

$s1651
$s1652
$s1653

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

1: Error
0: Normal

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
47 46 45 44 43 42 41 40 39 38 37 36 35 34 33 32

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
63 62 61 60 59 58 57 56 55 54 53 52 51 50 49 48

Bit number
Schedule number

Bit number
Schedule number

Bit number
Schedule number

Bit number
Schedule number

$s1650

$s1651

$s1652

$s1653
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3.6 Notes
Date and Time Settings

• The start time and end time cannot be set to the same value.
• When specifying a date, operation is not performed if the date does not exist in the particular month.

- Example:
When the 31st is specified, operation is not performed for February, April, June, September, or November. In this case, 
operation at the end of the month can be performed by selecting “Last day”.

• Specify the end time within 24 hours of the start time. If the end time is before the start time, the end time will be set on 
the next day.
- Example:

When set as for “every day, start time: 23:00, end time: 01:00”, operation starts from 23:00 on the first day and ends at 
01:00 on the second day, and starts from 23:00 on the second day and ends at 01:00 on the third day, etc.

Changing the Built-in Calendar
• If the time is corrected backward due to a date change (automatic correction), the scheduler is only executed once. If the 

time is corrected forward, the number of schedules that were skipped are executed.
• If the time is corrected using the following method, schedule operations are performed based on the corrected time.

- Execute the calendar reading bit (location of setting: [System Setting] → [Hardware Setting] → [Control Area])
- SYS (SET_CLND) macro command 
- SYS (SET_SYS_CLND) macro command 

If the time is corrected backward, operation differs depending on the setting of [Execute start action even if the start time 
is exceeded at startup/calendar change].

Using a Time Setting Device Memory (Designation: Device)
• Operation continues unaffected if the time setting device is changed (acknowledgment bit: 0 → 1) during scheduled 

operation. Subsequent operations are performed at the changed time after the current operation is complete.
• If the time setting device memory is changed after a start operation completes, the end operation is not performed. The 

subsequent start operation is performed at the changed time.

Other
If multiple schedule times (start or end times) overlap, operations start in order from the lowest schedule number.
If the scheduled time of a subsequent operation is reached during execution of an operation within the same schedule 
number, the subsequent operation is not executed until the current operation is complete. Therefore, the subsequent 
operation is delayed.

For details, refer to “Others” page 3-15.

For details on the acknowledgment bit, refer to “Designation: Device” page 3-12.
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4.1 Overview
4.1.1 Operation Log

Operation Overview
The operation log function stores screen operation history records (operation logs) in the SRAM area. When the SRAM area 
becomes full, logs can be output to an SD card.
In the event of an error, these stored logs allow previous operations to be examined in order to determine the cause of the 
error. Also, when used in conjunction with the security function, operator names can also be recorded.
Remote operation using the VNC server function enables users to record the username of the VNC user and  MAC address of 
the terminal device. 

Operation Log Viewer
Operation history records (operation logs) stored in the SRAM area can be displayed on MONITOUCH using the operation log 
viewer.
The details of operations that were performed when an error occurred can be easily examined in order to determine the cause 
of the error.

SD

SD
35.2

DATA ENTRY

0 . +/- ENT

1 2 3 CLR

4 5 6 DW

7 8 9 UP

SD
1 4

2 5

3 6

MENU

10.5

DATA ENTRY

0 . +/- ENT

1 2 3 CLR

4 5 6 DW

7 8 9 UP

SRAM

1 Power ON

2 Screen changeover

3 Numerical data entry

Screen 0

Screen 5

1 20140601085506 Start
2 20140601090320 Screen change  Entry screen  05   
3 20140601090510 Update of the displayed 5 data items   

Numerical data display  DEC   10.5   35.2

Double-tap

Log details are displayed.
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Use the [Set] switch in the log viewer screen to show/hide items, set the number of characters, and change the date/time 
format. Use the search switch to select and search for items.

Log Storage
When the SRAM area becomes full, logs are written to an SD card. In addition to the logs stored in the SRAM area, the log 
files output to an SD card can also be displayed in the log viewer.
Log files written to an SD card are database format files. A dedicated tool “LogToCsv” will be available to convert such log files 
to CSV files so their contents can be viewed.

For details on the log viewer, refer to “4.5 Operation Log Viewer”page 4-12.

Tap the [Set] 
switch.Tap the search 

switch.

SD
1 4

2 5

3 6

MENU

OPELOG.DB
Operation log viewer

Tap the file change switch to switch the 
display from data in SRAM to backup data on 
the SD card.

Database files are backed up to the SD card according 
to the time they were output and saved.

Database format files in SRAM 
are output to the SD card.

A dedicated “LogToCsv“ tool can be used 
to convert log files to CSV files.
For details, refer to “4.6.3 Importing Log 
Data to Computer (Conversion to CSV 
Files)” page 4-18.
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4.2 Using the Operation Log Viewer
4.2.1 Conceptual Operation

4.2.2 Setting Procedure
Configuring the Operation Log
1. Click [System Setting] → [Other] → [Operation log Setting]. The [Operation log setting] window is displayed.
2. Select the [Use operation log function] checkbox and select the checkboxes of the relevant items under [Log objects].

3. Set the number of logs to save in SRAM with [SRAM save number].
4. Select the how to connect the SD card with [Storage Connection Target].
5. Set any other relevant settings and then click [OK].

* When [Switch] or [Data display update] are selected under [Log objects], the [Save an operation log] checkbox must be 
selected in the settings window of switches, numerical data displays, and character displays targeted for logging.

Operation log viewer

Press the switch that displays 
the operation log viewer.

The operation log viewer is displayed.
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Operation Log Viewer Settings
1. Place a switch for displaying the operation log viewer.
2. Select [Operation Log Viewer Display] in the [Function] settings.

This completes the necessary settings. The screen program can be transferred to MONITOUCH.

4.2.3 Operating Procedure
Displaying the Operation Log Viewer
1. Display the screen that contains the switch configured above on MONITOUCH.
2. Press the switch to display the operation log viewer.

* The operation log viewer can be displayed in both RUN mode and Local mode.

Settings Menu
1. Press the [Set] switch. The window shown below is displayed.

2. Change the order of titles, hide unnecessary display items, and change the date and time format as desired.
3. To hide log items, switch to the [Log Display Settings] tab window.

For details on other log viewer settings, refer to “4.5 Operation Log Viewer”page 4-12.
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4.3 Applicable Items
4.3.1 Applicable Items and Saving

Applicable Items and Timing of Saving
The table below shows the items that can be saved to operation logs and when saving to SRAM takes place.

*1 Logging does not take place when transferring system programs of MONITOUCH.
*2 Logs can be saved for switches, numerical data displays, and character displays when the [Save an operation log] checkbox is 

selected in the [Detail] settings of the item’s settings window. (Default: selected)

*3 Table data display is not supported.

Items Timing of Saving
Start When power is turned ON
Transfer When transferring a screen program or the I/F driver *1

Transfer method When transferring a screen program or the I/F driver *1
* Valid when [Transfer] is selected as a logging item.

Mode changeover When changing between RUN mode and local mode
Screen changeover When changing between screens
Language changeover When changing between languages
Switch When a switch with any of the following functions is pressed. *2

Data display update *2 *3 When updating numerical data/character displays in entry mode (Write/↓/↑ keys)
Log destruction When newly storing log data after clearing the SRAM area due to the reasons below:

• SRAM data corruption
• Failure to output to SD card

Scheduler When the scheduler starts or ends

With output device memory Momentary, Set, Reset, Alternate, Momentary W, 
Word Operation

Function Standard Screen, overlap display, multi-overlap display, reset, 
card formatting, card removal, language changeover

Entry Delete (alarms only)
Card Card formatting, transfer from card to PLC, transfer 

from PLC to card
Digital switch Digital switch +, digital switch −
JPEG File deletion
Security Login/Logout
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Saved Items (Titles)
The following item types are saved.

Start

Details of items are as follows:

Transfer

Details of items are as follows:

Mode Changeover

Details of items are as follows:

Saved Item (Title) Description Max. No. of Characters 
(Bytes)

Log No. - -
Date/Time Date/time of log acquisition -
Screen No. Screen number (0 to 9999) -
User ID User ID registered in security settings 8
Security Level Security level (0 to 15) -
Transfer method Transfer source device (PC, SD card or USB flash drive) 3
VNC user The username of the VNC client 16
MAC address The MAC address of the VNC client 6
Action (Differs depending on the log item. For details on the saved content for each item, 

refer to the sections below.)
-

Function (Differs depending on the log item. For details on the saved content for each item, 
refer to the sections below.)

-

Comment Comments on screens and parts 32
Display Format Display format of numerical data displays -
Value (Before) Value before change -
Value (After) Value after change -

Date/
Time

Screen 
No. User ID Security

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

- - - - - - - - - - -

Action Start

Date/
Time

Screen 
No. User ID Security

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

- - - - - - - - -

Transfer method Transfer source device (PC, SD card or USB flash drive)
Action Transfer
Function Screen program

Driver, expansion program

Date/
Time

Screen 
No. User ID Security

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

- - - - - - - - - -

Action Mode changeover
Function Change to RUN mode

Change to Local mode
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Screen Changeover

* Only when [Switch function: Screen Change-over] is executed. SYS(SET_SCRN) command of ON/OFF macro is not supported.
Details of items are as follows:

Language Changeover

* Only when [Switch function: Language change-over] is executed. SYS(CHG_LANG) command of ON/OFF macro is not supported.
Details of items are as follows:

Date/
Time

Screen 
No. User ID Security

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

- -  *  * - -

Action Screen changeover
Comment The comment entered in the [Screen Setting] → [Screen Setting] window is stored. When no comment is 

entered, the [Comment] field is blank.

Value (Before) Stores the screen number before changeover.
Value (After) Stores the screen number after changeover.

Date/
Time

Screen 
No. User ID Security

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

- -  *  * - - -

Action Language changeover
Value (Before) Stores the language number before changeover.
Value (After) Stores the language number after changeover.
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Switch

Details of items are as follows:

Data Display Update

Details of items are as follows:

Date/
Time

Screen 
No. User ID Security

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

- - - -

Action Switch operations (Mom)/(Set)/(Rst)/(Alt)/(Word)/(Sample)/(Alm)
Function Screen

Overlap display/multi-overlap display
Word Operation
Reset
Card formatting/card removal
Language changeover
DELETE
Transfer from card to PLC / transfer from PLC to card
Digital switch +, digital switch -
File deletion
Login/Logout

Comment Outputs the comment in the switch settings window.
Data displays/switch comments can be batch changed into device memory notation by clicking [Tool] → 
[Other] → [Convert item comment to device notation].

If the [Comment] field is blank, the text entered on the [Char. Prop.] → [OFF] tab is output.

Date/
Time

Screen 
No. User ID Security

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

-

Action Data Display Update
Function Numerical display

Character display
Comment Outputs the comment in the numerical data display and character display settings window.

Data displays/switch comments can be batch changed into device memory notation by clicking [Tool] → 
[Other] → [Convert item comment to device notation].
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Log Destruction
A log is saved when the SRAM area is cleared and newly saving logs because of SRAM data corruption or failure to output to 
the SD card. The log contains the data items below.

Details of items are as follows:

Scheduler

Details of items are as follows:

Date/
Time

Screen 
No. User ID Security

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

- - - - - - - - - - -

Action Log destruction

Date/
Time

Screen 
No. User ID Security 

Level
Transfer 
Method

VNC
user

MAC
address Action Function Comment Display 

Format
Value 

(Before)
Value
(After)

- - - - - - - - -

Action Scheduler
Function Start operation

End operation
Comment The schedule number (0 to 63) is stored.
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4.4 Detailed Settings
Operation Log Settings
Select the [Use operation log function] to enable the following items.

*1 The required amount of SRAM is automatically secured based on the [SRAM save number] setting.

*2 The maximum value of the [SRAM save number] setting differs depending on whether or not the [Save transfer 
methods] checkbox is selected and the number of languages set in the screen program.
Refer to the chart shown below.

*3 Control Device

- Bit 0: bit for output to card
SRAM log data is output to the card when the bit state changes from 0 to 1.

Item Description
Log objects Select the checkboxes of the items to save to operation logs.

For details, refer to “4.3 Applicable Items” page 4-5.
SRAM save number *1 *2 Set the number of logs to be stored in the SRAM area.
Storage Connection Target Select how to connect the SD card, to which operation logs will be output.
Action to be taken when store target 
capacity is not enough

Select the action to take when the SD card is full.

Control Device *3 Set the device memory for outputting log data to the SD card.
Save comments in the set number of 
languages *1

This setting is available when using the multi-language function and saving items displayed 
under [Log objects] that support comments.
When selected, comments are saved to logs even in multi-language mode (when displaying a 
language other than the primary language).
When using “LogToCsv.exe“, comments can be output to CSV file in the selected language. For 
details, refer to “4.6.3 Importing Log Data to Computer (Conversion to CSV Files)” page 4-18.

Save operation by VNC Select this option to differentiate operation logs for VNC clients.
The log includes VNC username and MAC address.

Use V8-compatible operation log viewer This checkbox is selected automatically when converting from a V8 series screen program.

Number of Languages 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
Maximum 
Number 
of Logs

[Save 
transfer 
methods] 
deselected

512 512 512 437 379 332 300 271 247 228 211 197 185 174 164 155

[Save 
transfer 
methods] 
selected

471 471 471 402 349 305 276 249 227 210 194 181 170 160 151 143

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Control device 
memory

Reserved for system Bit for card output
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*4 Compatible with V9 series OS V3.90 and SYSTEM V2.100. A new log file is created when the settings are changed.

Blank cells are the operation log operated 
through the V10/V9 or a USB mouse.

Operation log viewer
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4.5 Operation Log Viewer
4.5.1 Display Method

The operation log viewer can be displayed in both RUN mode and Local mode.

RUN Mode
Press a switch configured with [Operation Log Viewer Display] for [Function] to display the operation log viewer.

Local Mode
Press the [SYSTEM] button to display the system menu.
Tap the [Operation Log] switch to display the operation log viewer.
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4.5.2 Function
Showing/Hiding Items
Tap the [Set] switch in the operation log viewer. The settings window shown below is displayed.

Select the [Log Display Setting] tab to check a list of items that can be displayed in the operation log viewer.
Deselect the checkbox of items to hide and click [OK] to only display items with a selected checkbox.

The settings made in this window are stored in SRAM and therefore are retained even if the power is turned off and on.
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Changing Order of Display
Tap the [Set] switch in the operation log viewer. The settings window shown below is displayed.

Select the title to move on the [Item Display Setting] tab window and press the [↑] or [↓] switch. The display order changes 
accordingly. Items are displayed in this order on the operation log viewer of MONITOUCH

The settings made in this window are stored in SRAM and therefore are retained even if the power is turned off and on.
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Filter
Tap an item in the title bar of the operation log viewer. The following filter window is displayed.

Sort the display using the ascending and descending order switches.
If there are items you wish to hide, deselect the relevant checkbox and click [Close] to only display items with a selected 
checkbox.
To restore the default display settings, tap the [Default] switch or the file change switch, or close and open the operation log 
viewer.

Search
Tap the search switch in the operation log viewer. The following search window is displayed.

Select the item and text to search for and tap [Next]. Cells that match the search are highlighted in green on the viewer.
To clear the highlighted display, tap the [Default] switch or the file change switch, or close and open the operation log viewer.

* The currently displayed items of the current file are searched. Hidden items are excluded.

Tap [Action].
Ascending order Descending order

Tap the search switch.

Green

Tap [Next].
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Changing Between Log Files
Tap the file change switch in the operation log viewer. This switches the display between the log database file in SRAM and 
the log database file on the SD card.

* When the indicator shows “1/n“, this means that the log in SRAM is being displayed.

4.5.3 Note
Display Priority
The operation log viewer is displayed on the screen with the same priority as the system menu. This means it is displayed on 
top of other items.

Language of the Operation Log Viewer
The display language of the operation log viewer depends on the display language of Local mode.
In addition to Japanese, the operation log viewer can be displayed in English, Chinese (Traditional), Chinese (Simplified), and 
Korean.

Tap the file change switch.
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4.6 Log Data
4.6.1 Output Timing

Log data is first output to SRAM. Subsequent log data in SRAM may be output to external media (SD card) depending on the 
condition of SRAM. This section explains the timing of output.

Output to SRAM
For information on the output timing of each item, refer to “Applicable Items and Timing of Saving” page 4-5.

Output to SD Card
Log data in SRAM is output to the SD card at the following timings.

• When the area defined by [SRAM save number] in the [Operation log setting] window is full
• When the “card output bit” defined for [Control Device] in the [Operation log setting] window turns ON
• When a switch with [Storage Removal] set for [Function] is pressed
• When the setting of [SRAM save number] in the [Operation log setting] window is changed
• When the setting of [Interface Language] in the [Font Setting] window for the screen program is changed

4.6.2 Details of Output (File Type)
Output to SRAM
The following file format is output to SRAM.

Output to SD Card
The directory and file type when outputting to an SD card is as follows.

Model File Name Remarks
V10 OPELOG.BIN Binary file
V9 OPELOG.DB Database file

Storage Destination File Name
Access folder\OPELOG\YYMM\YYMMDD OPELOG_hhmmss.DB

Year, month, and dayYear and month Hour, minutes, and seconds
V10: BIN 
V9: DB 

BITMAP

OPELOG

EXT0000

OPELOG_103005.DB
OPELOG_141002.DB
OPELOG_204250.DB

140501

140502
140503

1405

Access folder
SD card

Operation log

* OPELOG file extension
V10: BIN 
V9: DB 

e.g. V9 
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4.6.3 Importing Log Data to Computer (Conversion to CSV Files)
A log file output to a storage device can be converted to a CSV file for viewing using the dedicated “LogToCsv“ tool.
“LogToCsv.exe“ is installed when V-SFT version 6 (Ver. 6.0.8.0 or later) is installed.
If the version of your V-SFT version 6 is an earlier one, download “LogToCsv.exe“ from Hakko Electronics’ website and install.

File Conversion Procedure
1. Click the start button and start “LogToCsv“ from [All Programs] → [V-SFTV6].

2. Click the [Open] button for [Source file] and select the log file to convert.

3. Click the [Open] button for [Target file] and specify the location for storing the CSV file and the filename.

4. Click the [Convert] button. A conversion complete message is displayed and the CSV file is output to the specified 
location.

Select the extension.
V10: (*.bin) 
V9: (*.db) 

Select to output the 
CSV file in English.

Select to convert log data times 
according to the time zone.

For multi-language 
screen programs * The comment is 

output in the selected 
language.

* To display the language selection window for comments, select the [Save comments in the set number of languages] checkbox 
at [System Setting] → [Other] → [Operation log Setting]. For details, refer to “4.4 Detailed Settings” page 4-10.
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5. Open the CSV file.

For multi-language screen programs, comments are output in the 
selected language.

* The text is not Unicode. Check the text in an OS environment 
of the relevant language.
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4.7 System Device Memory
The following describes the system device memory associated with the operation log viewer.

* When the log data in SRAM is displayed, 0 is stored at both addresses $s1365 and $s1366.
When a log file on a SD card is displayed, the files and folders stored on the SD card are numbered sequentially, starting 
at 1, from the file with the most recent datestamp.
The following illustrates the numbering of files and folders.

Addresses Description Remarks
$s1365 File number of currently displayed log data

← V
$s1366 Log folder number being displayed

BITMAP

OPELOG

EXT0000

OPELOG_103005.DB
OPELOG_141002.DB
OPELOG_204250.DB

140501

140502
OPELOG_091050.DB
OPELOG_113821.DB

1405

Folder No.
File No.

SD card

2

1

3
2
1

2
1 * OPELOG file extension

V10: BIN 
V9: DB 

e.g. V9 
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5.1 Overview
Security
Registering user IDs and passwords at the required security levels in advance enables operators to control the display and 
operation of screens in accordance with their corresponding security level.

* Security levels are set on a scale from 0 to 15.

Screen Security Levels
A security level can be set for each screen. An attempt to switch to a higher-security screen will automatically display the login 
screen. The target screen can be displayed by entering a user ID and password at a level equivalent to or higher than the level 
required for the target screen.

For details on the location of settings, refer to “Screen Settings” page 5-6.

Security Level Priority Description
0 Low Screen display and operation permitted at level 0 (no security)
1 Screen display and operation permitted at levels 0 and 1

: :

15 High Screen display and operation permitted at all levels from 0 through 15

MENU
Level 0

Level 5

MENU
Level 0

Change to screen 1

Screen 0: Level 0

Screen 1: Level 5

The login screen appears due to 
the difference in security level.

After operator B (security level 10) logs in, 
the specified screen is displayed.

After operator A (security level 2) logs in, the 
message “Level does not match.” is displayed.

Pressing [CANCEL] returns to the previous 
screen.
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Item Security Levels
Security levels can be set for each item on the screen, such as switches and data displays.
Once security levels are specified for screen items, these items can be shown or hidden based on the security level selected 
when an operator logs into the system. Also, switches can be configured with an interlock setting.

Showing/Hiding Items

Prohibiting Switch Operations

For details on the location of settings, refer to “[Show/Hide] Settings in the Settings Window of Each 
Part” page 5-7.

For details on the location of settings, refer to “[Interlock] Settings in the [Switch] Settings Window” 
page 5-7.

Login

Login

Items at level 10 or lower are shown.

Operator A
Security level 2

Operator B
Security level 10

Login

Level 1 items
Level 10 items

Items at level 2 or lower are shown.
Items at level 3 or higher are hidden.

Items at level 10 or lower are operative.Items at level 3 or higher are inoperative.
Items at level 2 or lower are operative.

Operator A
Security level 2

Operator B
Security level 10

Level 1 items
Level 10 items
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User ID and Password Registration
User IDs and passwords can be set to screen programs in advance, but can also be added from the system menu of 
MONITOUCH (or in Local mode). The system offers the flexibility to add new users in situations where sudden changes are 
required on the factory floor.

Login/Logout
The security level can be changed by logging in or out with the screen that is automatically displayed when a screen change 
occurs as well as from the system menu or a switch.

For details, refer to “5.4 Login/Logout” page 5-8.

System menu

* Only users with administrator privileges can register, edit, and delete user accounts.

Local mode

System menu
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5.2 Security Settings
Location of settings: [System Setting] → [Other] → [Security Setting].

*1 User IDs and passwords can be registered from the system menu (or in Local mode). Only users with administrator privileges can register, 
edit, and delete user accounts. While users without administrator privileges can view a list of all users registered in a screen program, 
editing and deletion is prohibited.

- System menu → [Security] → [User Settings] → enter administrator user ID and password

- Local mode → [User Settings] → [Administrator Authentication] → enter administrator user ID and password

Item Description
Use security function Select this checkbox to use the security function.
UserID *1
Password
Level

Register user IDs, passwords, and security levels using the [Add], [Delete], and [Change] buttons.
A maximum of 64 users can be registered.
Use eight or less one-byte alphanumeric characters. Input is case-sensitive.

* The same user ID cannot be registered more than once. However, the same password can be registered 
for different user IDs.
All users registered to the screen program are granted administrator privileges.

Maintain original security 
level when opening lower 
security level screen(s) than 
original security level *2

Select the operation to perform when a screen change occurs.
Unselected

When switching to a screen with a lower security level, the currently valid security level is also lowered to 
the level of the target screen. When switching to a higher-security screen next, the operator is prompted 
to enter a password.

Selected
The same security level is maintained until the level is changed when another user logs in with a different 
security level or when the user logs out.

Use the login screen which is 
compatible with V8.

When changing from a V8 series screen program, select this checkbox to use the same login screen as the V8 
series.

The currently logged in administrator user’s account can be deleted. After deletion, the screen returns to the administrator 
authentication screen.
Other administrators’ accounts cannot be deleted.
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*2 When the currently displayed screen is switched to a lower-security screen, the security level may be maintained or automatically lowered, 
depending on the selected option.

User registration screen

MENU
Level 0

Level 5

Security level 5 Security level 0

Screen 1: Level 5 Screen 0: Level 0

• Level lowered

Security level 5 Security level 5• Level maintained

* The operator must log in again in order to switch to a higher-security screen.

* The security level is maintained until a login or logout is performed.
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5.3 Security Level Settings
The security level can be set at the following three locations. The setting procedure at each location is different.

• Screen settings (page 5-6)
• [Show/Hide] settings in the settings window of each part (page 5-7)
• [Interlock] settings in the [Switch] settings window (page 5-7)

Screen Settings
Screen switching can be prohibited according to security level.

Location of settings
[Screen Setting] → [Screen Setting] → [Main] tab window → [Security Level] setting
Security level: 0 to 15
Conditions: =, ≥ (up to five AND or OR operators can be selected)
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[Show/Hide] Settings in the Settings Window of Each Part
Screen items can be shown or hidden according to their security level.

Applicable items
The following items can be configured with security level settings.

• Switches, lamps
• Numerical data displays, character displays, message displays (excluding table data displays)
• Graphs, statistical graphs, closed area graphs
• Linked parts
• Grouped items (including graphic items)

Location of settings
In the setting window of each part, set the security level at [Show/Hide] → [Show/hide according to the condition] → 
[Security Level].
Security level: 0 to 15
Conditions: =, ≥ (up to five AND or OR operators can be selected)

[Interlock] Settings in the [Switch] Settings Window
The operation of switches can be prohibited according to their security level.

Location of settings
In the switch settings window, set the security level at [Interlock] → [Security Level].
Security level: 0 to 15
Conditions: =, ≥ (up to five AND or OR operators can be selected)
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5.4 Login/Logout
The security level can be changed by logging in or out with the screen that is automatically displayed when a screen change 
occurs as well as from the system menu or a switch.

Login
The security level can be changed using a switch with [Log In] set for [Function] or from the system menu.

* The system menu is displayed by pressing the [SYSTEM] function switch.

Login is prohibited for users with a security level lower than that of the currently displayed screen.
Any login attempt yields the error message “Level does not match.”

Level 1

Level 4

NG

OK

9999

0

1250

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

9999

0

1250

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

The login screen is displayed.
Enter a user ID and password 
with security level 4.

Press the [Login] switch.

An error message is 
displayed.

Pressing [Cancel] returns 
to the previous screen 
with the security level 
unchanged at level 1.

The security level is raised to 
level 4 and the previous screen 
is displayed again.

Login

Login

or
System menu *
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Logout
The security level is set to zero (0) when a switch with [Log Out] set for [Function] is pressed.

* The system menu is displayed by pressing the [SYSTEM] function switch.

The screen does not change after logging out. When logging out on a low security level screen or using a 
switch, use in conjunction with the SET_SCRN macro (for screen number change) to change the screen when a 
user logs out.

9999

0

1250

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

9999

0

1250

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

Level 4

Level 0

Logout

Security level 4

Logout

Security level 0

When a logout is executed, the security level is set to zero (0).

or

Press the [Login] switch.

System menu *
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Location of Settings
Switch
Configure the following settings at [Parts] → [Switch] → [Function].

System Menu
There are no settings in particular.

Item Description
Function Log In

Display the login screen.

Log Out
Change the security level to zero (0).

The screen does not change after logging out. When logging out on a low security level screen or using a 
switch, use in conjunction with the SET_SCRN macro (for screen number change) to change the screen when a 
user logs out.
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5.5 System Device Memory ($s)
The following system device memory are associated with the security function.

Device Memory Description
$s1360 Stores the current security level (0 to 15) specified when an operator logs into the system.
$s1361

Stores the user ID of the operator who is currently logged into the system.
$s1362
$s1363
$s1364
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6 Ethernet Communication 
Function

6.1 Preface

6.2 V10/V9 Series Unit IP Address Settings

6.3 Screen Program Transfer

6.4 PLC Communication

6.5 Transferring Data Between V10/V9 Series Units (Mac-
ro)

6.6 DLL Communication

6.7 MES Interface Function

6.8 E-mail Notification

6.9 FTP Server

6.10 VNC Server

6.11 Data Transfer Service



6.12 Remote Desktop
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6.1 Preface
6.1.1 List of Functions

The V10/V9 series features the following Ethernet functions.
An IP address for the V10/V9 series unit must be configured in order to use the Ethernet functions. Refer to “6.2 V10/V9 Series 
Unit IP Address Settings” page 6-2.
Other settings differ depending on the function to be used.

*1 For details on selecting TCP/IP and UDP/IP for PLC communication, refer to the Connection Manual.
*2 The network table settings must be configured in the screen program settings.
*3 When using the SEND command, the network table settings must be configured in the screen program settings.

Function
V10/V9

Refer to
LAN LAN2 WLAN CUR-03

Screen program transfer “6.3 Screen Program Transfer”
Simulator Operation Manual

PLC communication *1 TCP/IP Connection Manual
UDP/IP

Ladder transfer “12 Ladder Transfer”

Macro *2 EREAD/EWRITE Macro Reference Manual
SEND
MES “6.7 MES Interface Function”

Macro Reference Manual
DLL communication HKEtn20.dll *3 DLL Function Specifications

VCFAcs.dll
FTP server “6.9 FTP Server”
E-Mail “6.8 E-mail Notification”
Network camera “1.4 Network Camera”
VNC server “6.10 VNC Server”
Data transfer service
Data transfer viewer

“6.11 Data Transfer Service”

Network printer EPSON ESC/P-R
HP HPLIP

Reference Manual 1
16 Printing

Remote desktop “6.12 Remote Desktop”
VPN remote access service
Cloud data service

Web Machine Interface Manual
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6.2 V10/V9 Series Unit IP Address Settings
An IP address for the V10/V9 series unit must be configured in order to use the Ethernet functions. There are two ways to 
configure the IP address of the V10/V9 series unit: setting using the V-SFT editor or setting using Local mode on the unit.

6.2.1 Setting Using the V-SFT Editor
Set the IP address in the screen program.

1. Select [System Setting] → [Ethernet Communication] → [Local Port Address]. The [IP Address Setting] window is 
displayed.

2. Select the [Set IP] checkbox and configure each setting.

* For details on these settings, refer to page 6-6.

3. Click [OK].
4. Transfer the screen program to the V10/V9 series unit.
5. Check the IP address in Local mode on the V10/V9 series unit.

Item Description
Select IP Address from Network Table This setting is available when the IP address of the V10/V9 series unit has been registered 

in the network table. Select a network table number from 0 to 255 to set the IP address.
IP Address * Set the IP address for the V10/V9 series unit.
Default Gateway * Set the default gateway.
Subnet Mask * Set the subnet mask.

When this checkbox is not selected, the subnet mask is automatically assigned based on 
the first byte of the IP address.
When the IP address is “172.16.200.185”, “255.255.0.0” is set.
When IP address is “192.168.1.185”, “255.255.255.0” is set.

Port No. * Set a port number (1024 to 65535). (except for “8001”)
Send Timeout Set a timeout period for transmitting macro commands EREAD, EWRITE, SEND, MES, or 

Ethernet DLL functions.
Retrials 0 to 255

Set the number of retries to be performed when a timeout occurs.
Device Protect

Internal Device
Memory Card Device

Select these checkboxes to write-protect the corresponding device memory from PCs or 
other stations.
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6.2.2 Setting Using Local Mode on the Unit
Set the IP address in Local mode on the V10/V9 series unit.

1. Press the [SYSTEM] switch on the unit to display the system menu at the top of the screen.

2. Press the [Local] switch on the system menu. The Local mode screen is displayed on the unit.
3. Press the [LAN Setting] switch in the left side of the screen to display the [IP Setting] tab window.

When using LAN2 or WLAN, the corresponding IP settings are displayed.

4. Tap an item to change its setting if necessary.
- [IP Setting]

*1 For details on these settings, refer to page 6-6.
*2 This cannot be changed when [Auto (DHCP)] is set on the [Option] tab window.
*3 Set a gateway for only one of the following: [LAN Setting]/[LAN2 Setting]/[WLAN Setting]/[LAN Unit Setting]. If 

multiple gateways are set, the Ethernet communication will not function correctly.

Item Description
IP Address *1 *2 Set the IP address of the V10/V9 series unit.

Sub Net Mask *1 *2 Set the subnet mask.

Gate Way *1 *2 *3 Set the gateway. Always set a gateway when sending e-mail notifications.
External Access Service Port *1 Set a port number (1024 to 65535). (except for “8001”)

Time-Out Set a timeout period for transmitting macro commands EREAD, EWRITE, SEND, MES, or 
Ethernet DLL functions.

Retrials 0 to 255
Set the number of retries to be performed when a timeout occurs.

System menu
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- [Option]

5. Press the [Apply] switch at the bottom right of the screen to accept the settings. When the changes are accepted, the 
[Apply] switch is disabled.

6. Check the IP address in Local mode under [System Information] → [Ethernet Information].

Item Description
Speed Select a baud rate.

Auto: Auto-Negotiation
10Base: Fix to 10Base-T

IP Address Setting Select the method for setting the IP address, subnet mask, gateway, and DNS.
Manual: Set on the [IP Setting] tab window.
Auto (DHCP): Automatically acquire the information necessary to establish an internet 

connection from a DHCP server.
DNS Setting Set the DNS. 

Always set [DNS1] when [Sending Mail Server (SMTP)] is selected on the [E-Mail Setting] window.
The DNS is also set automatically when “Auto (DHCP)” is set for [IP Address Setting].
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Restoring the screen program settings
There is a [Restore Screen Data Settings] switch at the bottom of the [LAN Setting] screen.
Press this switch to disable the settings, such as IP address, configured in local mode and restore the settings of the screen 
program.
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6.2.3 Ethernet Terminology
IP Address
This address is used for recognizing each node on the Ethernet network and must be unique.
An IP address is 32-bit data that consists of a network address and a host address, and is classified as A to C depending on the 
network size.

Notation
Data consisting of 32 bits is divided into four segments in decimal notation and each segment is delimited with a period.

Example: The following class C IP address is represented as “192.128.1.50”.
11000000  10000000  00000001  00110010

Unusable IP addresses
• “0” is specified for the first byte, e.g. 0.x.x.x
• “127” is specified for the first byte (which is reserved as the loop back address), e.g. 127.x.x.x
• “224” or more is specified for the first byte (which is reserved for multi-casting or experiments), e.g. 224.x.x.x
• The host address consists of only “0” or “255” (broadcast address), e.g. 128.0.255.255, 192.168.1.0

Port No.
Multiple applications run on each node and communications are carried out for each application between the nodes. 
Consequently, it is necessary to have a means to identify the application that data should be transferred to. The port number 
works as this identifier. While the range of port numbers is 0 to 65535, the lower port numbers of 0 to 1024 are generally 
reserved for other uses. When assigning port numbers, use numbers higher than 1024.

V10/V9 port numbers
The following port numbers are used on the V10/V9 series unit. When changing any port number, select an unused number 
from the range of 1024 to 65535.

*1 When transferring screen programs over the Internet, specify the router port number in the [Transfer] window of the V-SFT software.

Port No. Setting Range Function Location of Settings
20 Fixed FTP server -
21
502 502,

1024 - 65535
Modbus slave (TCP/IP) -

1024 - 1025 1024 - 65534 Ladder transfer via Ethernet [System Setting] → [Hardware Setting] → [Ladder Transfer]
1969 1024 - 65535 Network camera (BANNER) -
5900 Fixed VNC server -
8001 Fixed Screen program transfer *1 Screen program transfer *1

8020 1024 - 65535 Simulator (Ethernet) -
8050 1024 - 65535 Remote desktop window 

display
[System Setting] → [Other] → [Remote Desktop Table Setting] → [Local 
Port No.]

10000 1024 - 65535 Ethernet macros
EREAD, EWRITE, SEND, 
MES

Set in the editor
“Setting Using the V-SFT Editor” page 6-2

Set on the unit
“Setting Using Local Mode on the Unit” page 6-3Ethernet DLL functions

HKEtn20.DLL
VCFAcs.DLL

10001 - 10008 1024 - 65535 8-way communication [System Setting] → [Hardware Setting] → [PLC Properties] → 
[Communication Setting] → [Port No.]

10021 - 10028 1024 - 65535 8-way communication MITSUBISHI ELECTRIC L series (built-in Ethernet) connections only
A port number that is 20 higher than the port number set at [System 
Setting] → [Hardware Setting] → [PLC Properties] → 
[Communication Setting] → [Port No.] is secured automatically.

50000 - 50002 1024 - 65535 Network camera
(AXIS/Panasonic)

-

64000 1024 - 65535 Multi-link2 (Ethernet), 
1:n multi-link2 (Ethernet)

[System Setting]  → [Hardware Setting] → [PLC Properties] → 
[Multi-link2 (Ethernet)]

0

1 0

1 1 0

Class A Network address 
(7 bits)

Host address (8 bits)

Host address (24 bits)

Network address (14 bits) Host address (16 bits)

Network address (21 bits)

Class B

Class C



6.2    V10/V9 Series Unit IP Address Settings

6-7

1

2

3

4

5

6

7

8

9

10

Default Gateway
A gateway and a router are used for communication between different networks.
The IP address of the gateway (router) should be set to communicate with the node(s) on other networks.

Subnet Mask
A subnet mask is used for dividing one network address into multiple networks (subnets).
A subnet is assigned by specifying a part of the host address in the IP address as the subnet address.

Unusable subnet masks
• When all bits are set to “0”, e.g. 0.0.0.0
• When all bits are set to “1”, e.g. 255.255.255.255

255. 255. 255. 0

1 0

11111111 11111111 11111111 00000000

Class B Host address (16 bits)

Network address Subnet address

Network address (14 bits)

Host address

Subnet Mask
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6.3 Screen Program Transfer
Screen programs can be uploaded and downloaded using Ethernet communication.

6.3.1 Transfer Procedure
Downloading (PC → V10/V9)
1. Click [Transfer] → [Download]. The [Transfer] menu is displayed.

2. Select [Screen Data] for [Transfer Data].
3. Check the [Communication Port] setting.

• If Ethernet is set and the IP address is correct, proceed to the next step.
• If [Serial Port] or [USB] is set, click the [Communication Setting] button and select [Ethernet] under [Communication 

Port].

4. Click [PC →] to start the transfer.

LAN

MONITOUCH

V-SFT

MONITOUCH
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6.4 PLC Communication
• High-speed communication with the Ethernet port of the PLC can be performed at 1000 Mbps (V10 only), 100 Mbps or 

10 Mbps.

• The V10/V9 series unit can open up to eight ports for communication, which means that the unit can simultaneously 
communicate with up to eight types of PLCs.

• When multiple PLCs of the same model are connected, a single port on the V10/V9 series unit can be used to perform 1:n 
communication with these PLCs.

For details on PLC communication, refer to the Connection Manual.

For details on LAN ports available with the V10/V9 series, refer to “6.1.1 List of Functions” page 6-1.

LAN

Ethernet

LAN

・・・
・・・
・・・
・・・

・・・
・・・
・・・
・・・

・・・
・・・
・・・
・・・

・・・
・・・
・・・
・・・

run

ｓｔｏｐ

PROGRAMMER PROGRAMMER PROGRAMMER PROGRAMMER

Port2Port1 Port3 Port4 Port5 Port6 Port7 Port8

Manufacturer A Manufacturer B Manufacturer C Manufacturer D Manufacturer E Manufacturer F Manufacturer G Manufacturer H

Ethernet

LAN
Port1

Manufacturer A
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6.5 Transferring Data Between V10/V9 Series Units (Macro)
• Communication can be performed and data shared between V10/V9 series units on the same LAN using the “EREAD” and 

“EWRITE” macro commands.

• Network table
Register the IP address of the counterpart unit in the [Network Table Edit] window in order to specify the destination 
using a macro.
Click [System Setting] → [Ethernet Communication] → [Network Table].

6.6 DLL Communication
• Ethernet access functions (that support UDP/IP) for executing device memory read and write operations with respect to 

V10/V9 series units from a server and CF card access functions for executing read and write file operations on a storage 
device are provided.
By creating an application on a server using an environment such as Visual C++ 6.0 and Visual Basic, data can be 
collected from V10/V9 series units and transferred to the server.

For details on macros, refer to the Macro Reference Manual.

For details on LAN ports available with the V10/V9 series, refer to “6.1.1 List of Functions” page 6-1.

LAN

• Network table editing
Register the IP address of the 
counterpart unit.

For details on DLL functions, refer to the V Series DLL Function Specifications.

For details on LAN ports available with the V10/V9 series, refer to “6.1.1 List of Functions” page 6-1.

LAN

VB, VC

Ethernet DLL
CF Card DLL

550

Server
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6.7 MES Interface Function
6.7.1 Overview

• The V10/V9 series supports the MES interface function.

• The MES interface function enables the V10/V9 series to add, search, and delete data on databases.
Production control from a PC in the office is made simple by using real-time production information transmitted from the 
factory to the database.

• The V10/V9 series sends commands to V-Server on the PC connected via Ethernet. V-Server sends the commands as SQL 
statements to ODBC, and ODBC accesses the database.

MES: Manufacturing Execution System
MES provides information necessary to optimize production activities (such as quality, yield, time of delivery, and cost) 
throughout processes from order receipt until product completion. Based on real-time information obtained from the 
manufacturing floor, MES serves as a bridge linking management and production, for the purpose of improving 
management in manufacturing.

ODBC: Open DataBase Connectivity
ODBC is the interface between an application (V-Server) and the database.
Because ODBC accommodates the differences in specifications between databases, users only need to create programs 
based on the ODBC-specified procedure in order to access those databases.

Ethernet

V-Server

ODBC

Office

Factory

Macro commands

SQL 
statements

Addition and search
Database

MacrosMacros

V-Server

ODBC
SQL Server

Oracle

MSDE

DB1

DB2

DB3

Data source name

AAA

BBB

CCC

Database name

DB1

DB2

DB3
Links

Application

Database
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• By using LAN2 (additional)/WLAN (wireless)/optional unit, multiple IP addresses can be set for the V10/V9 series so that 
different networks can be established respectively in the factory and office. System configuration is therefore made 
simple in the existing facilities.

• Separate management through multiple V-Servers is enabled.

Ethernet

Ethernet

V8i

V-Server

IP 192.168.1. x

IP 211.13.204. x

ODBC

Office

Factory

Built-in LAN

Database

Ethernet unit

Additional 
LAN

Ethernet

V-Server

ODBC

V-Server

ODBC

Office

Factory

Management of 
daily work report

Management of 
production information

Database Database

Macros
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• Stand-alone MES
The MES interface function can be used with a single V10/V9 series unit. Since the function runs on the V10/V9 series unit 
itself, there is no need for V-Server, ODBC, or Ethernet.
By creating a database on the storage device connected to the V10/V9 series unit, it is possible to add, search, and delete 
records in the database directly from the V10/V9 series unit.
Create a database file (extension: .db) using the “MES WRITE” macro command.

Stand-alone
An environment in which a computer or information device operates alone without connecting to or depending on a 
network, other devices, and software

EXT0000
DATABASE
xxxxxxxxxxxx.db

Factory

Management of 
production 
information

Database

Macros Addition and search
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6.7.2 System Configuration
There are two system configurations for using the MES interface. Configure the necessary settings as described below.

Using a PC as a Server

Required Settings
V10/V9
Configure the required settings for the V10/V9 series in the screen program.

1. Network table editing (page 6-16)
2. IP address settings for the V10/V9 series unit (page 6-2)
3. MES setting (page 6-17)
4. Macro programming (page 6-21)

Server PC
1. V-Server installation (page 6-30)
2. Database installation and table creation (page 6-31)
3. ODBC settings (page 6-44)

Ethernet

V-Server

ODBC

V-SFT

Database

Download

• Network table
• MES settings
• Macros

Server PC * The clock of the PC that is running V-Server is used for 
the date and time in the database.
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Stand-Alone Configuration (Using a Storage Device)

Required Settings
V10/V9
Configure the required settings for the V10/V9 series in the screen program.

1. MES setting (page 6-17)
2. Macro programming (page 6-21)

Storage device
No settings are required.

EXT0000
DATABASE
V9_ProductLine.db

V-SFT

Database

Download

• MES settings
• Macros

Execute the “MES WRITE” macro command.

A database file is created on the storage device.

The database name 
specified in the 
[MES Setting]

* The clock of the V10/V9 series unit is used when recording the date 
and time in the database.
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6.7.3 V10/V9 Series Unit Settings
Network Table Editing
Register the IP address and port number of the PC installed with V-Server in the network table.

1. Click [System Setting] → [Ethernet Communication] → [Network Table]. The [Network Table Edit] window is displayed.

2. Double-click a number in the [No.] column to display the [Network Table Setting] window and configure the following 
settings.

3. Click [OK]. The settings are registered to the network table.
4. If multiple PCs are connected, perform the above registration steps for each PC.

Item Description
Port Name Set the name of the PC.
IP Address Set the IP address of the PC.
Port No. Specify the port number of V-Server. (Default: 8005)

* The port number can be checked in V-Server software via [File] → [V-server Detail Setting] → [Port No.].

Send Timeout
Retrials
Device Protect
Default Gateway
Subnet Mask

Setting these items is not required when registering the IP address of the PC.
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MES Settings
Click [System Setting] → [Other] → [MES Setting]. The [MES Setting] window is displayed.

Common settings

No Item Description
1 No. Switch between MES setting numbers (0 to 255).
2 Skip Unregistered No. Click this button to skip unregistered numbers when switching between MES setting numbers.

3 Copy Copy data associated with the current MES settings to the specified destination.
4 Delete Delete the current MES settings.

5 Comment Enter a comment describing the MES settings. Maximum of 16 one-byte characters (8 two-byte 
characters.)

6

Use as stand-alone A database file is created on a storage device connected to the V10/V9 series unit. Adding, 
searching, and deleting of database records is possible.

File Name
(database name).db (database name.db-journal *1)

Storage location
(output drive)\(access folder)\DATABASE

* Set the output drive and access folder name at [System Setting] → [Other] → [Storage 
Setting].

Execute the “MES WRITE” macro command to create a database file.
The clock of the V10/V9 series unit is used when recording the date and time in the database.

7 Data source Name Specify the data source name of the database. 32 bytes maximum

8
Database Name Specify the name of the database file to create on the storage device.

Maximum of 32 bytes using one-byte alphanumeric characters (uppercase/lowercase) and 
underscore ( _ )

9 Login Name Specify a login name used for accessing the database. 32 bytes maximum
10 Password Specify a password used for accessing the database. 32 bytes maximum
11 Table Name Specify the name of the table in the database. 128 bytes maximum

5

1 2 3 4
• [Use as stand-alone] checkbox: Unselected • [Use as stand-alone] 

checkbox: Selected

8

12

13

6
7
9
10
11 11
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*1 Temporary file created during data update.

12 Required No. of Word Count for 
Macro Command

This area shows the number of words used for each macro command based on the current 
settings. A number of words more than the maximum of 2,000 is highlighted in red. Adjust the 
number of registrations, length of line names, and number of words so that 2,000 words are not 
exceeded.

13 Write
Read
Search 
condition

Add Display the [Detailed setting] window. Enter a line name as targeted for writing and the data type 
in this window.
256 maximum

Change Display the [Detailed setting] window. Change the registered settings.
Delete Delete the registered settings.
Import Import a CSV file into the current MES settings.
Export Export the current MES settings into an CSV file.

No Item Description

Number of words used for Write, 
Read and Search condition

With [ ]: Valid_
Without [ ]: Invalid (always “0”)

Macro commands

Words in total for each macro command
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[Write] tab window
The [Write] tab window is used for adding data to the database.

[Read] tab window
Configure settings for searching the database.

Item Description
Line Name Specify the name of the line to which you will add data. 128 bytes maximum

* The line name must not begin with a one-byte numeral.
* The following characters cannot be used: ~ - ! , { % } ^ ’ & . ( / ) ` space

Device use Specify the data for writing. 256 bytes maximum
• With device memory specification: Set the device memory address to store the data for writing.

• Without device memory specification: Set a constant or fixed string of text.
Data Type
Length
Bytes

Set the data type of the data for writing, data length, and number of bytes.

Item Description
Max Record Specify the maximum number of records to display in the search results. 65536 maximum
Line Name Specify the line name targeted in searching. 128 bytes maximum

* The line name must not begin with a one-byte numeral.
* The following characters cannot be used: ~ - ! , { % } ^ ’ & . ( / ) ` space

Data Type
Length
Bytes

Specify the data type, data length, and number of bytes of the data targeted in searching.

Sort Set an option for sorting the search results.
Non / Up / Down

Device Memory Input Type Text Processing
PLC1 - PLC8 Depends on the input type of each PLC.
Internal DEC LSB → MSB

Data type Length Bytes
DEC- 1 words/2 words -
CHAR 128 word 256 bytes maximum
BCD 1 words/2 words -
FLOAT 2 word -

Data type Length Bytes
DEC- 1 words/2 words -
CHAR 128 word 256 bytes maximum
BCD 1 words/2 words -
FLOAT 2 word -
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[Search condition] tab window
Configure settings for searching the database. This tab is also used to delete data from the database.

Item Description
Line Name Specify the line name targeted in searching. 128 bytes maximum

* The line name must not begin with a one-byte numeral.
* The following characters cannot be used: ~ - ! , { % } ^ ’ & . ( / ) ` space

Search Condition Set the search conditions. When searching based on multiple conditions, use AND.

Device use Specify the data targeted for searching. 256 bytes maximum
• With device memory specification: Set the device memory address to store the data for searching.

• Without device memory specification: Set a constant or fixed string of text.
Data Type
Length
Bytes

Specify the data type, data length, and number of bytes of the data targeted in searching.

Search condition Remarks
Equal (=)
Not equal (!=)
Big (> value)
Small (< value)
Upper (>= value)
Under (<= value)
Include character string Wildcard (%) usable

Example: AA%: Text beginning with AA to be searched
Update Extract records that do not match the data for searching from the 

specified line name.
These records are then replaced as the data for searching.

Device Memory Input Type Text Processing
PLC1 - PLC8 Depends on the input type of each PLC.
Internal DEC LSB → MSB

Data type Length Bytes
DEC- 1 words/2 words -
CHAR 128 word 256 bytes maximum
BCD 1 words/2 words -
FLOAT 2 word -
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Macros
The MES interface function uses the following five types of macros.

MES macro command list

* This command is not used when the [Use as stand-alone] checkbox is selected at [System Setting] → [Other] → [MES Setting].

MES CHECK (F1, F2, F3)
Function: V-server start check

This macro is used to check whether V-Server at the location specified in table No. [F2] is running. The returned value 
specified in [F3] is stored in the memory at the return address of [F1].

Device Memory Used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)

Range

Operation Example
MES CHECK ($u0000, 10, 1)

The above macro checks whether V-Server is running on the PC registered to network table number 10. If V-Server is 
running, a return value of “1” is stored at the return address of $u0000.

Supplementary information
• Execute the macro after setting a value other than the returned value at the return address.
• The execution type of the macro can be set using $s514. For details, refer to page 6-28.

When a macro command is executed, if “1” (other than “0”) is set for $s514 while V-Server is not running, no response is 
given from V-Server and the V10/V9 series unit will enter the standby state. It is recommended to execute this command 
when “0” is set for $s514.

• The result of the macro execution is stored in the device memory address $s515. For details, refer to page 6-28.
• The returned value will not be placed at the [F1] return address immediately. Monitor the [F1] return address using an 

event timer macro, etc.
• If an error occurs when writing the result (return value, data retrieved by a search) of accessing database, the result and 

log data is not output to the V10/V9 series unit.
• This command is not used when the [Use as stand-alone] checkbox is selected at [System Setting] → [Other] → [MES 

Setting].
• Specify the Ethernet communication port at $s512.

0: LAN (built-in)
1: Ethernet unit
2: LAN2 (built-in)
3: WLAN (wireless)

Category Command Name Mnemonic Description Refer to

MES MES

MES CHECK (F1, F2, F3) V-server start check * page 6-21
MES WRITE (F1, F2, F3) Adding data to the 

database
page 6-22

MES READ (F1, F2, F3) Searching the database page 6-23
MES DEL (F1, F2, F3) Deleting data from the 

database
page 6-25

MES UPDATE (F1, F2, F3) Updating the database page 6-26

Internal PLC1 - 8 Constant
F1
F2
F3

Value
F0 MES CHECK
F1 Return address
F2 0 to 255: Network table number
F3 0 to 65535 (-32768 to 32767): Return value

MES setting No. 1
Network table No. 10
Return address
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MES WRITE (F1, F2, F3)
Function: Adding data to the database

This macro command is used to add the data set on the [Write] tab window of MES setting No. [F3] to the database. The 
data is added at the location specified in table No. [F2] via V-Server. The result is stored at return address [F1].
When used in the stand-alone configuration, table No. [F2] is not used. If the database file is not found on the storage 
device, it is newly created.

Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

Operation example
• PC used as server

MES WRITE ($u0000, 10, 0)

The above macro command adds data to the database of the PC specified in network table No. 10. The data to be 
added depends on the settings made for MES setting No. 0. When the data update is completed normally, a return 
value of “0” is stored at the return address $u0000.

• Stand-alone configuration
MES WRITE ($u0000, $M0000, 0)

The above macro command adds a record to a database file on the storage device. The data to be added depends on 
the settings made for MES setting No. 0.
If a database is not found, it is newly created.
When writing of data is completed normally, a return value of “0” is stored at the return address $u0000.

Supplementary information
• The execution type of the macro command can be set using $s514. For details, refer to page 6-28.
• The result of the macro execution is stored in the device memory address $s515.

-40: The [Write] tab window setting is not made in the specified MES setting number, or there is a setting error.
For details on other error numbers, refer to page 6-28.

• On a stand-alone configuration, storage device related errors that occur while a macro command is being executed are 
stored in $s1030 (built-in socket) and $s1035 (USB port).
12: Storage device is write-prohibited or there is not enough free space.
16: Storage device is read-prohibited.

• The returned value will not be stored at return address [F1] immediately. Monitor return address [F1] using an event timer 
macro, etc.

• The primary key for V-Server must be set to the database table. (page 6-41) On a stand-alone configuration, the key is 
registered when a database is created using the “MES WRITE” macro command.

• If an error occurs when writing the result (return value, data retrieved by a search) of accessing the database, the result 
and log data are not output to the V10/V9 series unit.

• Specify the Ethernet communication port at $s512.
0: LAN (built-in)
1: Ethernet unit
2: LAN2 (built-in)
3: WLAN (wireless)

For a stand-alone configuration, the [Use as stand-alone] checkbox must be selected at [System 
Setting] → [Other] → [MES Setting]. For details on the stand-alone configuration, refer to page 6-15.

Internal PLC 1 to 8 Constant Remarks
F1

F2 Invalid with stand-alone 
configuration

F3

Value Remarks
F0 MES WRITE
F1 Return address Return value

0: Successful completion
−1: Ended in error

F2 0 to 255: Network table No. Invalid with stand-alone 
configuration

F3 0 to 255: MES setting No.

MES setting No. 0
Network table No. 10
Return address

MES setting No. 0
Invalid. A free address is specified.
Return address
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MES READ (F1, F2, F3)
Function: Searching the database

This macro command is used to search the line data set on the [Read] tab window of MES setting No. [F3]. The search is 
performed using the search conditions set on the [Search condition] tab window at the location specified in table No. [F2] 
via V-Server. The result is stored in return address [F1].
When used in the stand-alone configuration, table No. [F2] is not used.

Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

Return address
The following data is stored at the addresses starting from return address [F1].

Operation example
• PC used as server

MES READ ($u0000, 10, 0)

The above macro command searches the database on the PC specified in network table No. 10.
The search is performed according to the settings on the [Read] and [Search condition] tab windows of MES setting 
No. 0. When the search is completed successfully, a return value of “0” and the obtained data are stored at the 
addresses starting from the return address $u0000.

• Stand-alone configuration (storage device)
MES READ ($u0000, $M0000, 0)

The above macro command searches the database data on the storage device.
The search is performed according to the settings on the [Read] and [Search condition] tab windows of MES setting 
No. 0.
When the search is completed successfully, a return value of “0” and the obtained data are stored at the addresses 
starting from the return address $u0000.

For a stand-alone configuration, the [Use as stand-alone] checkbox must be selected at [System 
Setting] → [Other] → [MES Setting]. For details on the stand-alone configuration, refer to page 6-15.

Internal PLC 1 to 8 Constant Remarks
F1

F2 Invalid with stand-alone 
configuration

F3

Value Remarks
F0 MES READ
F1 Return address
F2 0 to 255: Network table No. Invalid with stand-alone 

configuration
F3 0 to 255: MES setting No.

Return address Value
n Execution result

Successful completion: 0
Error: Other than 0

n + 1 Number of retrieved records
The number of records that match the search conditions is stored.
If no records are found, “0” is stored. The maximum number of records is set on the [Read] tab window in 
the MES settings.

n+2 - Obtained data 1
The retrieved data is stored in the format specified on the [Read] tab window in the MES settings.

: Obtained data 2
: Obtained data 3
: :
: Obtained data m (maximum number of records)

MES setting No. 0
Network table No. 10
Return address

MES setting No. 0
Invalid. A free address is specified.
Return address
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Supplementary information
• The execution type of the macro command can be set using $s514. For details, refer to page 6-28.
• The result of the macro execution is stored in the device memory address $s515.

-40: The [Read] tab window setting is not made in the specified MES setting number, or there is a setting error.
For details on other error numbers, refer to page 6-28.

• On a stand-alone configuration, storage device related errors that occur while a macro command is being executed are 
stored in $s1030 (built-in socket) and $s1035 (USB port).
12: Storage device is write-prohibited or there is not enough free space.
16: Storage device is read-prohibited.

• The returned value will not be stored at return address [F1] immediately. Monitor return address [F1] using an event timer 
macro, etc.

• If settings are not configured on the [Search condition] tab window for the specified MES setting number, all records are 
extracted as the results of the search.

• If an error occurs when writing the result (return value, data retrieved by a search) of accessing the database, the result 
and log data are not output to the V10/V9 series unit.

• Specify the Ethernet communication port at $s512.
0: LAN (built-in)
1: Ethernet unit
2: LAN2 (built-in)
3: WLAN (wireless)
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MES DEL (F1, F2, F3)
Function: Deleting records from the database

This macro command is used to search the database according to the settings on the [Search condition] tab window of 
MES setting No. [F3]. The search is performed at the location specified in table No. [F2] via V-Server. The records that 
match the conditions are deleted. The result is stored at return address [F1].
When used in the stand-alone configuration, table No. [F2] is not used.

Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

Operation example
• PC used as server

MES DEL ($u0000, 10, 0)

The above macro command searches the database of the PC specified in network table No. 10 and deletes the retrieved 
data. The search is performed according to the settings on the [Search condition] tab window of MES setting No. 0.
When the data is successfully deleted, a return value of “0” is stored at the return address $u0000.

• Stand-alone configuration (storage device)
MES DEL ($u0000, $M0000, 0)

The above macro command searches the database data on the storage device and deletes the retrieved data. The search 
is performed according to the settings on the [Search condition] tab window of MES setting No. 0. When the data is 
successfully deleted, a return value of “0” is stored at the return address $u0000.

Supplementary information
• The execution type of the macro command can be set using $s514. For details, refer to page 6-28.
• The result of the macro execution is stored in the device memory address $s515.

-40: The [Search condition] tab window setting is not made in the specified MES setting number, or there is a setting 
error.

For details on other error numbers, refer to page 6-28.
• On a stand-alone configuration, storage device related errors that occur while a macro command is being executed are 

stored in $s1030 (built-in socket) and $s1035 (USB port).
12: Storage device is write-prohibited or there is not enough free space.
16: Storage device is read-prohibited.

• If an error occurs when writing the result (return value, data retrieved by a search) of accessing the database, the result 
and log data are not output to the V10/V9 series unit.

• Specify the Ethernet communication port at $s512.
0: LAN (built-in)
1: Ethernet unit
2: LAN2 (built-in)
3: WLAN (wireless)

For a stand-alone configuration, the [Use as stand-alone] checkbox must be selected at [System 
Setting] → [Other] → [MES Setting]. For details on the stand-alone configuration, refer to page 6-15.

Internal PLC 1 to 8 Constant Remarks
F1

F2 Invalid with stand-alone 
configuration

F3

Value Remarks
F0 MES DEL
F1 Return address Return value

0: Successful completion
−1: Ended in error

F2 0 to 255: Network table No. Invalid with stand-alone 
configuration

F3 0 to 255: MES setting No.

MES setting No. 0
Network table No. 10
Return address

MES setting No. 0
Invalid. A free address is specified.
Return address
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MES UPDATE (F1, F2, F3)
Function: Updating the database

This macro command is used to search and update the line data set on the [Write] tab window of MES setting No. [F3]. 
The search is performed according to the settings on the [Search condition] tab window at the location specified in table 
No. [F2] via V-Server, and then the database is updated. The result is stored at return address [F1].
When used in the stand-alone configuration, table No. [F2] is not used.

Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

Operation example
• PC used as server

MES UPDATE ($u0000, 10, 0)

The above macro command searches the database on the PC specified in network table No. 10 and updates the database. 
The search is performed according to the settings on the [Write] and [Search condition] tab windows of MES setting 
No. 0.
When the data is successfully updated, a return value of “0” is stored at the return address $u0000.

• Stand-alone configuration (storage device)
MES UPDATE ($u0000, $M0000, 0)

The above macro command searches and updates the database data on the storage device. The search is performed 
according to the settings on the [Write] and [Search condition] tab windows of MES setting No. 0. When the data is 
successfully updated, a return value of “0” is stored at the return address $u0000.

Supplementary information
• The execution type of the macro command can be set using $s514. For details, refer to page 6-28.
• The result of the macro execution is stored in the device memory address $s515.

-40: The [Write] or [Search condition] tab window setting is not made in the specified MES setting number, or there is a 
setting error.

For details on other error numbers, refer to page 6-28.
• On a stand-alone configuration, storage device related errors that occur while a macro command is being executed are 

stored in $s1030 (built-in socket) and $s1035 (USB port).
12: Storage device is write-prohibited or there is not enough free space.
16: Storage device is read-prohibited.

• The returned value will not be stored at return address [F1] immediately. Monitor return address [F1] using an event timer 
macro, etc.

• This macro command cannot be executed when “Update” is set on the [Search condition] tab window.
• If an error occurs when writing the result (return value, data retrieved by a search) of accessing the database, the result 

and log data are not output to the V10/V9 series unit.

For a stand-alone configuration, the [Use as stand-alone] checkbox must be selected at [System 
Setting] → [Other] → [MES Setting]. For details on the stand-alone configuration, refer to page 6-15.

Internal PLC 1 to 8 Constant Remarks
F1

F2 Invalid with stand-alone 
configuration

F3

Value Remarks
F0 MES UPDATE
F1 Return address Return value

0: Successful completion
−1: Ended in error

F2 0 to 255: Network table No. Invalid with stand-alone 
configuration

F3 0 to 255: MES setting No.

MES setting No. 0
Network table No. 10
Return address

MES setting No. 0
Invalid. A free address is specified.
Return address
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• Specify the Ethernet communication port at $s512.
0: LAN (built-in)
1: Ethernet unit
2: LAN2 (built-in)
3: WLAN (wireless)
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System Device Memory ($s)
The system device memory related to MES macro commands are shown below.

*1 Not used in a stand-alone configuration
*2 When requests for MES macro commands (30 maximum) accumulate in the V10/V9 series unit in a stand-alone configuration, the V10/V9 

series unit operates while waiting regardless of the $s514 value.

$s514,515
These device memory addresses are related to MES macro commands and Ethernet macro commands 
(SEND/EREAD/EWRITE).
The settings are applied to the port specified with $s512.

• $s514: This address is used to enable or disable the wait request for executing macro commands.
- [0]: No wait

When executing macro commands, the next macro command is executed without waiting for the completion of the 
current command.

- Other than [0]: With wait
When executing macro commands, the next macro command is put on hold until the current command is completed.

* If accessing the same port on a single macro sheet, always specify a value other than “0” (with wait).
If “0” (no wait) is specified, macro commands issued afterward will not be accepted.

• $s515: This address stores the macro command execution result.
When $s514 is set to “0”, the issuing of a macro command is stored. When $s514 is set to “1”, the response returned for 
the command is stored.

Address Description Remarks
$s512 *1 Ethernet port selection

0: LAN (built-in)
1: Ethernet unit
2: LAN2 (built-in)
3: WLAN (wireless)

→ V

$s514 *2 Macro command: Wait request → V

$s515 Macro command: Wait request execution result V →

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB

Wait request
0: Disabled
1: EnabledReserved for system 

(setting: 0)

LSB

Code *1 Description Solution PC as Server Stand-alone
0 Normal -

200 to 2001 Communication error 
between a device targeted by 
a macro command and a 
connected device
Target device

• V10/V9:
801 (link down)

• V8/TS2060i/V7/V6:
200 to 2001

A communication error code is stored when the device targeted by 
a macro command and a device are connected via Ethernet.
For error contents and solutions, refer to the connection manual of 
the target device.

-

-8 Communication unavailable
Inaccessible

Check whether the counterpart unit is running normally. -

-32 The specified table is not 
used.

Check the network table settings. -

-34 The specified table is in use. Check whether system device memory $s514 is set. 
If it is not to be set, reduce the number of communications. -

-40 Setting data error • Check that [Write], [Read], and [Search condition] settings are 
configured for the specified MES setting number.

• Check that the set data is correct.
-51 Specified address error • Check that the specified address is correct.

• For a $L address, check if the setting is made.
-60 Database access error

• Check if there is enough free space on the storage device. *2
• Check if the storage device to be accessed is connected.

-
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*1 Number of records (lower 10 digits) in the “VsPrimaryKey” database
Depending on when an error occurs, attempts to write a record will be counted even if they are not successful. Therefore, a subsequently 
written record may be numbered non-consecutively.

*2 The required free space is two times the allocation unit size (cluster size) of the storage device.
For example, if the allocation unit size is 32 kB, at least 64 kB of free space is necessary. If there is not enough free space, increase the 
capacity of the storage device or free up space on the storage device by deleting unnecessary files and folders. The “DEL_FILE” macro 
command can be used for deleting. For details, refer to the Macro Reference Manual.

-61 Error during SQL execution • Check that the [Table Name] setting is not left blank in the 
MES settings.

• Check that a schema name is not included in the table name.
-

-62 Database not found • Check that the [Database Name] setting is not left blank in 
the MES settings.

• Check if the database file exists.
If the file is not found, newly create by executing “MES 
WRITE”.

-

-63 Database in use • Check if the storage device to be accessed is 
write-prohibited.

• Check if the database file is corrupted.
-

-64 Database format error Check that the [Line name] contents and number of rows in the 
MES settings are the same as the column in the table that is 
referenced.

-

-65 Folder creation failure • If executing the “MES WRITE” macro command, check if the 
storage device to be accessed is full or write-prohibited.

• If executing a macro command other than “MES WRITE”, 
check if the access folder exists in the storage device to 
access.
Location to check: access folder\DATABASE\

-

Code *1 Description Solution PC as Server Stand-alone

For details on the “VsPrimaryKey” database, refer to page 6-41.

All successful An error has occurred

The preceding “1” is missing.
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6.7.4 V-Server
V-Server
Hakko Electronics V-Server is the software that enables accesses to databases.
Once V-Server is installed on a PC, no additional configuration is needed. The system requirements for V-Server are listed in 
the table below.

System requirements

* Windows XP/XP64 Edition is not supported by TELLUS and V-Server Ver. 4.0.12.0 or later.

Installation
1. Download the V-Server software to your PC from the Hakko Electronics website at the following URL. 
2. Install V-Server on the PC.
3. Start V-Server.

* The message that appears at start-up indicates that V-Server is usable for one hour.
To use V-Server without this limitation, please apply for a software license and obtain a password. For details, refer to the 
TELLUS and V-Server Manual.

Item Description
Computer PC/AT compatible computer running Windows
OS Windows 11(64 bit)/ 10 (32 bit, 64 bit)/ 8.1 (32 bit, 64 bit)/ 8 (32 bit, 64 bit)/ 7 (32 bit, 64 bit)/ 

Vista (32 bit, 64 bit)/ XP/ XP64 Edition/ Server 2016/ Server 2012/ Server 2008 R2
CPU Pentium 4, 1 GHz or higher
Memory Min. 256 MB
Hard disk At installation: 2.5 GB or more
Display resolution XGA (1024 × 768) or higher, Display color: High color (16-bit) or higher
Database SQL Server (Microsoft)

MSDE (Microsoft)
Oracle (Oracle Corporation)
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6.7.5 Database
Types of Databases
The following databases can be used.

• SQL Server: Microsoft
• MSDE: Microsoft
• Oracle: Oracle Corporation

This manual describes an example of configuration using Microsoft SQL Server 2012 Express Edition.

SQL Server 2019 Express Edition
Installation
1. Download SQL Server 2019 Express Edition from Microsoft’s website.
2. Double-click the downloaded executable file.
3. The following window is displayed. Select [Custom].

4. Specify the download target location and click [Install]. The installation package is downloaded.

SQL Server 2012 Express Edition
This is a simplified version of SQL Server 2012. This software can be downloaded free of charge from Microsoft’s 
website.
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5. The [SQL Server Installation Center] window is displayed. Select [New SQL Server stand-alone installation or add features 
to an existing installation].

6. The license terms are displayed. Select the [I accept the license terms and Privacy Statement] checkbox and click the 
[Next] button.

7. The [Product Updates] window is displayed. Proceed by following the instructions.
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8. The [Install Setup Files] window is displayed and installation of setup files starts.

9. The [Install Rules] window is displayed. Proceed by following the instructions.
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10. The [Feature Selection] window is displayed. Select the [Database Engine Services] checkbox and proceed to the next 
screen.

11. The [Instance Configuration] window is displayed. Select the [Named instance] radio button and proceed to the next 
screen.
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12. The [Server Configuration] window is displayed. Click the [Next] button.

13. The [Database Engine Configuration] window is displayed. Select the [Mixed Mode] radio button and enter a password.
Click the [Next] button to start installation.

The password is required when connecting to the database and configuring MES settings in the V-SFT editor. Take care 
managing your password and do not lose it.
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14. The [Complete] window is displayed when installation is finished. Click the [Close] button to exit.

15. Restart the PC.
16. Click the Windows start menu icon → [Microsoft SQL Server 2019] → [SQL Server 2019 Configuration Manager].

17. SQL Server Configuration Manager starts. Check that SQL Server (SQL Express) is running.

This completes the installation procedure.
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Creating an SQL Server Database
An SQL Server database can be created using Microsoft SQL Server Management Studio.

Installation
1. Download SQL Server Management Studio from Microsoft’s website.
2. Double-click the downloaded file.
3. The following window is displayed. Click [Install] to start installation.

4. When installation is complete, the following window is displayed. Click [Restart].

5. The PC reboots.
This completes the installation procedure.

Microsoft SQL Server Management Studio: SSMS
An easy-to-use, graphical management tool intended for management of SQL Server 2019 Express Edition
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Starting SQL Server Management Studio
1. Click the Windows start menu icon → [Microsoft SQL Server Tools 18] → [SQL Server Management Studio].

2. The [Connect to Server] window is displayed. Enter the required information and click [Connect].

Item Description
Server name Select the server name of the SQL Server.
Authentication Select “SQL Server Authentication”.
Login Enter a user name. The user name “sa” is entered in this example.
Password Enter the password.

The password for “sa” was specified on the [Authentication Mode] window displayed during installation of SQL Server 2019 Express Edition 
(see page 6-35).
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3. SQL Server Management Studio starts up.
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Creating a new database
1. Select [Databases] and click [New Database] on the right-click menu.

2. The [New Database] window is displayed. Specify a database name and click the [OK] button.

3. A new database is created.
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Creating a new table
1. Start SQL Server Management Studio.

2. Select the database created in the previous section and click [New Table] on the right-click menu.

3. The table creation screen is displayed. Create a table by registering a line name and data type.

• Always set the primary key for V-Server for a database table to which data will be added.

Line Name Data Type Length Allow Nulls Primary Key
VsPrimaryKey varchar 26 bytes or more No

Example: Database results Lower 10 digits:
Number of records from 0 to 9999999999 (first record is “0”)

- PC as server
Records are numbered consecutively starting from “0” when 
V-Server starts. The numbering is reset to “0” when V-Server is 
terminated. *

- Stand-alone configuration (storage device)
Records are numbered consecutively starting from “0” when the 
V10/V9 series unit enters RUN mode. The numbering is reset to 
“0” when the V10/V9 series unit exits RUN mode. *

* The numbering is also reset to “0” when the maximum number 
“9999999999” is reached.Upper 15 digits: Date and time (March 9, 2021, 14:50:6120)
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• The following data types can be used with the MES interface function. These correspond to the data types in the MES 
settings in V-SFT.

4. When the table settings are complete, close the table. The confirmation dialog box is displayed. Click the [Yes] button.

5. Enter a name and click the [OK] button.

6. The table is created.

Database: Table V-SFT: MES settings
Line Name Data Type Length Allow Nulls Data type Length
(Arbitrary) smallint 1 word Permitted DEC-

BCD
1 word

(Arbitrary) int 2 word Permitted 2 word
(Arbitrary) Float 2 word Permitted FLOAT 2 word
(Arbitrary) varchar Arbitrary Permitted CHAR 256 bytes 

maximum
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Opening a table
The data saved in the database can be checked according to the following procedure.

1. Select a table and click [Edit Top 200 Rows] on the right-click menu.

2. The table is opened. The line name registered when the table was created is displayed. Data is saved in each “NULL” field.
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6.7.6 Data Source (ODBC) Settings
V-Server accesses the database via a data source (ODBC). Data source settings need to be configured to allow V-Server access 
to the database. This manual describes an example of configuration using Microsoft SQL Server 2012 Express Edition.

1. From the Windows [Start] menu, click [Control Panel] to display the Control Panel.
2. Click [Administrative Tools].

3. The [Administrative Tools] window is displayed. Double-click [Data Sources (ODBC)].

ODBC: Open DataBase Connectivity
ODBC is the interface between an application (V-Server) and the database.
Because ODBC accommodates the differences in specifications between databases, users only need to create programs 
based on the ODBC-specified procedure in order to access those databases.

V-Server

ODBC
SQL Server

Oracle

MSDE

DB1

DB2

DB3

Data source name

AAA

BBB

CCC

Database name

DB1

DB2

DB3
Links

Application

Database



6.7    MES Interface Function

6-45

1

2

3

4

5

6

7

8

9

10

4. The [ODBC Data Source Administrator] window is displayed. Select the [System DSN] tab and click the [Add] button.

5. The [Create New Data Source] window is displayed. Select [SQL Server] and click the [Finish] button.

For 64-bit versions of Windows XP/Vista/7/8/10/11
The 32-bit version of ODBC must be used because V-Server is a 32-bit application.

• For Windows 10
Click the Windows start menu icon → [Windows Administrative Tools] → [ODBC Data Sources (32-bit)].

• For Windows XP/Vista/7/8
1) From the Windows [Start] menu, click [Computer], double-click [Local Disk (C:)] → [Windows] → 

[SysWOW64].
2) Double-click the “odbcad32” application. The 32-bit version of ODBC starts up.
3) Press the [Ctrl] + [Shift] + [Esc] keys together to start Windows Task Manager and check which version 

of ODBC is running.
On the [Processes] tab, the 32-bit version is running if “odbcad32.exe *32” is shown in the list.
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6. The following window is displayed. Configure the required settings and click the [Next] button.

7. The following window is displayed.
Select the [With SQL Server authentication using a login ID and password entered by the user] radio button and specify a 
login ID and password.

Item Description
Name Specify a data source name.
Server Specify a SQL Server name.

• The data source name is used in the MES settings in V-SFT.
• The SQL Server name can be checked in SQL Server Management Studio.

Item Description
Login ID Enter a login ID (“sa” in this example).
Password Enter the password.

The login ID (“sa”) and password were specified on the [Authentication Mode] window displayed during installation of SQL 
Server 2012 Express Edition (see page 6-35).
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8. Click the [Next] button. The following window is displayed.

9. Select the [Change the default database to] checkbox and select a database.

10. Click the [Next] button. The following window is displayed.

11. Click the [Finish] button. The following window is displayed.

12. Click the [Test Data Source] button. When a connection has been successfully established, the following window is 
displayed.

13. Click [OK]. The previous screen reappears.

Select the database created using Microsoft SQL Server Management Studio (see page 6-40).
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14. Click [OK]. The data source is registered.

This completes the configuration of settings.
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6.8 E-mail Notification
6.8.1 Overview

• Send e-mail notifications using the alarm function or data transfer service function.
• In the alarm function, e-mail notifications can be sent according to the ON/OFF status of alarm bits. If a problem occurs, 

you can be notified of the fault even at a remote location. A file can be attached to e-mail notifications when an alarm 
occurs.

• E-mail notifications with an attached file can be sent by executing the data transfer service.
• Encrypted communication using TLS 1.3/1.2 or STARTTLS is also supported. 

*1 V9 supports only TLS.1.2 (OS Ver. 4.80 or later)
• When e-mail notifications are sent from multi-language screens by using the alarm function, notification messages are 

sent in all relevant languages. 
For e-mail notifications with an attached file, “Attachment information” is added to the main body. The language of the 
“Attachment information” is the display language of the V10/V9 series unit.

• Supported items and ports used

• Attachable files

Port Item Others
LAN
LAN2
WLAN

Alarm history
Event history
Real time
Data transfer service

• The mail server must reside on the LAN.
• Gateway must be set on the V10/V9 series unit (multiple ports 

cannot be set at the same time).
• Not available with CUR-03.

File Extension (Both Uppercase and Lowercase) Capacity
File used on V10/V9 Text .txt, .csv Max. 10 Mbytes

However, do not exceed the 
maximum capacity of the mail 
server.

Electronic document .pdf
Image .jpg, .bmp, .png
Video .mp4
Sound .wav
Binary .bin
Database .db

Other * .docx, .xlsx, .pptx, .html, .zip, .tar.gz
* Try any unlisted files in your usage environment.

LAN

E-mail

SD

Error
M0

Mail server

Alarm history
Event history
Real time

Data transfer 
service

2014/04/10 18:55:04 <ON>
Apr/10/2014 18:55:04 <ON>
2014/04/10 18:55:04 <ON>
2014/04/10 18:55:04 <ON>
2014/04/10 18:55:04 <ON>
[Attachment information]
Record No.0 Record Name:Logging_CSV
File:3 File size:53KB

Example of e-mail notification main body

The record number and record name are added when 
using records set on the [Data Transfer Service] window.
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6.8.2 Detailed Settings
To send e-mail notifications, IP address settings on the V10/V9 series unit and e-mail settings for registering the mail server 
and recipients of notification must be configured.

IP Address Settings
Decide on one port from LAN/LAN2/WLAN to set for use in sending e-mail notifications. In addition to IP address settings, 
default gateway settings are also required. When using [Sending Mail Server (SMTP)], DNS settings on the V10/V9 series unit 
are also required. 
For information on IP address settings, refer to “V10/V9 Series Unit IP Address Settings” page 6-2.

E-mail Settings
There are two ways to configure e-mail settings: using the V-SFT editor or using local mode on the V10/V9 series unit.

Setting using the V-SFT editor
[System Setting] → [Ethernet Communication] → [E-Mail]

Item Description
Mail server Set the mail server using an IP address or server name.

SMTP IP Address Set the IP address of the mail server.
Sending Mail Server 
(SMTP)

Set the mail server name (within 255 one-byte alphanumeric characters and symbols)
Setting of [DNS Setting] in Local mode on the V10/V9 series unit via [LAN Setting] / 
[LAN2 Setting] / [WLAN Setting] → [Option] is necessary.

Port Setting Set the SMTP port number of the mail server.
0 to 65535 (default: 25)

Example: Port No. 465 for SSL/TLS communication
Port No. 587 for STARTTLS communication

Certify Type Set the authentication method in accordance with the specifications of the mail server.
Select “SMTP-AUTH” when attaching a file.

No authorization No authentication is performed.
POP before SMTP *1 Authentication is performed with the POP3 server. Configure the following settings.

• POP3 IP Address
• Account Name (63 one-byte characters or less)
• Password (63 one-byte characters or less)

SMTP-AUTH *2
LOGIN
PLAIN
CRAM-MD5
DIGEST-MD5 *3

Authentication is performed with the SMTP server. Configure the following settings.
• Encryption Method

- None
- SSL/TLS *4

- STARTTLS  *4
• Account Name (within 63 one-byte characters)
• Password (within 63 one-byte characters)
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*1 POP before SMTP
POP before SMTP uses POP3 authentication that is performed when e-mail is received. SMTP permits the sending of e-mail from the 
authenticated IP address for a limited time.
Since authentication is disabled after a specific time has elapsed, authentication with POP3 will be required again.
In the case of authentication with POP3, a password is sent in plain text. POP before SMTP using APOP is also available. APOP allows a 
password to be sent in encrypted form. Note that the V10/V9 series only supports POP3.

*2 SMTP Authentication
Authentication is performed with the SMTP server. SMTP Authentication is classified into several authentication methods. The V10/V9 
series supports LOGIN, PLAIN, CRAM-MD5, and DIGEST-MD5 methods.
Since the SMTP server automatically performs authentication according to the available method, users are not requested to make 
configurations.
<Automatic authentication steps>
1. Compliant with PLAIN?
2. Compliant with LOGIN?
3. Compliant with CRAM-MD5?
4. Compliant with DIGEST-MD5?
5. Authentication failure
About the authentication methods

- PLAIN
The PLAIN method sends user names and passwords in plain text (not in encrypted form).

- LOGIN
LOGIN is similar to PLAIN but it often sends information, such as USER xxxxx or PASS xxxxxx, separately (as performed with POP3). 
Because the standard specifications of LOGIN are not established, there are e-mail servers that use LOGIN in their own way.

- CRAM-MD5
With CRAM-MD5, the server sends an arbitrary character string (a challenge string) to the client. The client then performs a specific 
computing process called Message Digest 5 (MD5) by using the challenge string and password, and returns the result to the server. The 
server that receives the result also performs the same process. When both results match each other, the server judges that the client 
knows the correct password and grants authorization.

- DIGEST-MD5
DIGEST-MD5, an expanded version of CRAM-MD5, has an enhanced resistance to dictionary attacks and brute force attacks.

*3 Only “auth” mode is supported for “quality protection”. It does not support “auth-int” and “auth-conf” modes.
*4 Verified mail servers that support TLS 1.2 compliant encrypted communication

Sender’s Mail Address Set the sender’s mail address.
It is recommended to create a dedicated account for the V10/V9 on the mail server and to set 
its address here.

Sender’s Name Set the sender’s name. A name consisting of both one- and two-byte characters is not valid.
It is displayed in the “Sender” field in an incoming e-mail.

Subject Set the subject.
It is displayed in the “Subject” field in an incoming e-mail.

Receiver’s Mail Address 8 maximum
Register the recipient mail addresses.
Register all mail addresses to receive notifications from the V10/V9 series unit.

* When creating a screen program and the recipients of e-mail notification is yet to be 
determined, dummy recipients from numbers 0 to 8 can be used instead. The actual 
recipient addresses can be changed later on the V10/V9 series unit in the [E-Mail Setting] 
in Local mode.

Add Register a new recipient address.
Change Change a registered address.
Delete Delete a registered address.

Type Mail Server Encryiption 
Method Port Mail Account (Domain)

Gmail smtp.gmail.com SSL/TLS 465 @gmail.com
STARTTLS 587

Microsoft365
outlook

smtp-mail.outlook.com
smtp.office365.com

STARTTLS 587 @outlook.jp

yahoo mail.yahoo.com SSL/TLS 465 @yahoo.co.jp
BIGLOBE mail.biglobe.ne.jp SSL/TLS 465 @xxx.biglobe.ne.jp
OCN smtp.ocn.ne.jp SSL/TLS 465 @xxx.ocn.ne.jp

* If using Gmail, the following settings are required in the Google account security settings.
- 2-Step Verification: On
- Generate a password from [App passwords] by setting [Select app] to “Mail” and [Select device] to “Other”, and then 

inputting a device name (example: V9).
Register the 16-digit password at [E-Mail Setting] → [Password] for the V10/V9 series unit.

Item Description

16 digits
Register at [E-Mail Setting] → 
[Password] for the V10/V9 series 
unit.
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Setting using Local mode on the unit
1. Press the [SYSTEM] switch on the unit to display the system menu at the top of the screen.

2. Press the [Local] switch on the system menu. The Local mode screen is displayed on the unit.
3. Press the [E-Mail Setting] switch on the left of the screen to display the [E-Mail Setting] screen.

4. Tap an item to change its setting if necessary.

5. Press the [Apply] switch at the bottom right of the screen to accept the settings. When the changes are accepted, the 
[Apply] switch is disabled.

System menu
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Alarm Server
If sending e-mail notifications linked to alarm bits, select the [E-mail Enable/None] setting and recipient e-mail addresses in 
the alarm server settings.
This section describes the settings required for sending e-mail notifications. For details on other settings, refer to “8 Alarm” in 
Reference Manual 1.

1. Click [System Setting] → [Alarm Server] → [Alarm Block] to display [Alarm Device].

2. Select “Enable” for [E-Mail] for the device memory to send e-mail notifications and configure the detailed settings.

Item Description
Send when the alarm occurs Send an e-mail notification when an error occurs.

Attach the specified 
file

Select this checkbox to attach a file. Press the [Edit] button and select a file. For details, refer to File 
attachment settings.

Send when the alarm is reset Send an e-mail notification when the system recovers from an error. A file cannot be attached.
Send to Select the recipient e-mail addresses.

* When creating a screen program and the recipients of e-mail notification is yet to be determined, 
dummy recipients from numbers 0 to 8 can be used instead. The actual recipient addresses can be 
changed later on the V10/V9 series unit in the [E-Mail Setting] in Local mode.

Dummy settings
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File attachment settings
A file can be attached using the data transfer service or set individually using an alarm server.

• When using the data transfer service
Select [Use Transfer Data Settings of Data Transfer Service] and set a record number.

• When not using the data transfer service
Set the transfer condition and configure the transfer data settings.

Item Description
Use Transfer Data Settings of 
Data Transfer Service

Selected

Record No. Set a record number registered in the [System Setting] → [Data transfer service] → [Data Transfer 
Service Settings] → [Record List].

Transfer Condition Displays the settings of the specified record number.
Transfer Data Settings

Item Description
Use Transfer Data Settings of Data 
Transfer Service

Unselected

Transfer 
Condition

Transfer Select the data for transfer. ([Unit]: storage device of V10/V9 series unit)
File-based upload (From unit to server)
Folder-based upload (From unit to server)

Transfer Data 
Settings

Unit Storage Drive 
Select

Select the storage device of the V10/V9 series unit.
C: SD
D: USB (USB flash drive etc.)

Path Specify the path within the storage device of the V10/V9 series unit.
Number of characters for a path: Within 255 one-byte characters (including “:” and “/”) *1 *2

Transfer File
Transfer Folder

Specify the name of the file or folder for transfer. When specifying a file, specify the extension 
as well.
For device memory specification, NULL (0) is the terminator.

Within 256 one-byte alphanumeric characters *2 *3
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*1 There is no path hierarchy limitation. However, note that there are some limitations as described below.
- The path delimiter is a slash “/”. “\” is not supported.
- A delimiter at the end of the path is not required. However, if specifying a root directory, a delimiter is required.
- Two-byte characters are not supported.

*2 The total number of 1-byte characters in the path (server path when downloading) and the path set for the files and folders for transfer 
must not exceed 255.

*3 The following limitations apply. 
- Unsupported characters: \, :, “, <, >, and | 
- Two-byte characters are not supported.

*4 The following limitations apply. 
- Unsupported characters: /, \, :, “, <, >, and | 
- Two-byte characters are not supported.

*5 Supported wildcards: *, ?, and []
*6 If there are multiple files with the same timestamp, all files are attached.

Data Transfer Service
When sending e-mail notifications using the data transfer service, select “E-Mail (SMTP)” for [Server Type] under [Data 
Transfer Service Settings] → [List of Destination Servers]. The server name/connection IP address configured in the [E-Mail 
Setting] window are displayed.

In the [Record List], select the file to attach and server.

For details, refer to “6.11 Data Transfer Service” page 6-87.

Use filter function This can be configured when the transfer mode is set to “Folder-based upload”.
The filter only targets files. Only the files that match the specified keyword are transferred. *4

Wildcards can be specified. *5
For device memory specification, NULL (0) is the terminator.
Within 64 one-byte alphanumeric characters

File Option This can be configured when the transfer mode is set to “Folder-based upload”.
All Files
Latest File *6

Oldest File *6

One previous to latest file *6

Item Description
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6.8.3 System Device Memory ($s)
Information on sent e-mail messages is output to system device memory ($s).

6.8.4 Notes
• The maximum size of file attachments on the V10/V9 series unit is 10 MB. However, depending on the 

settings/specifications of the mail server, the maximum file size may be less than 10 MB.
• FTP, cloud, and SMTP in the data transfer service cannot be used at the same time. These functions are processed one at 

a time in order.
• E-mail notifications cannot be sent in the data transfer viewer.
• File attachments can only be sent when “SMTP-AUTH” is selected for [Certify Type] in the [E-Mail Setting] window.
• Large attachment file sizes may cause temporary increases in processing load, delays in screen refreshes, and affect 

logging.
• If any files for attachment do not exist or could not be attached, “It failed to attach the specified file.” is stated in the main 

body of the e-mail.

$s Description
$s1005 If the V10/V9 series unit receives send requests continually, the number (0 to 16) of e-mail messages waiting to be sent is 

stored.
The V10/V9 series can keep up to 16 e-mail messages. Any more than 16 messages are discarded.

$s1006 Stores error information on e-mail messages.

Error No. Cause
0 Normal -
1 E-mail address error Incorrect recipient mail address
6 Network not connected Incorrect SMTP/POP3 server IP address

SMTP server refusal
Incorrect port number
Incorrect SSL/TLS, STARTTLS settings
Incorrect account name/password

50 SMTP transmission error Authentication method error
Incorrect sender’s mail address
Connection lost
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6.9 FTP Server
6.9.1 Overview

The V10/V9 series can serve as an FTP server.
An FTP client tool installed on the PC can be used to access a V10/V9 series unit over Ethernet and perform reading and 
writing data on a storage device inserted into the V10/V9 series.
A standard FTP tool included with Windows is available for reading, writing, and editing files on a storage device without the 
need for installing any special tool.

6.9.2 Specifications
Functional Capabilities

*1 Maximum of 16 characters when registering in Local mode.
However, a maximum of 8 characters for a name/password common with the security function.

Applicable Models Port Other
V10
V9

LAN
LAN2
WLAN

Storage Device

Ethernet

Ethernet

FTP client tool

FTP server

FTP server

Router

Item Specifications Location of Settings
Protocol TCP/IP (Not available with CUR-03) -
User Name 1 to 12 one-byte alphanumeric characters (case-sensitive) Editor, Local mode *1

Password 1 to 8 one-byte alphanumeric characters (case-sensitive) Editor, Local mode *1

Port number 20, 21 (Fixed)
No. of clients *2 Maximum of 3 clients -
Input supervisory time 1 to 60 minutes (default: 15 minutes) *3 Editor, Local mode
File readout size Unlimited (within the storage capacity) -
File name One-byte alphanumeric characters only -
Requirement Only operable in RUN mode (not operable in Local mode) -
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*2 Clients (FTP clients)
This manual defines a client or FTP client as a PC that transmits commands for reading/writing data to an FTP server. A maximum of three 
client PCs can access a V10/V9 series unit.

*3 If no command is received from the FTP client within the time period specified for [Input Supervisory Period], the V10/V9 series unit 
automatically disconnects the client.

Compatible FTP Client Tools

Supported FTP Commands
The following commands can be used with the FTP server on the V10/V9 series unit.

Tools and Functions Computer OS/Monitouch Series
Command Prompt (included with Windows as standard) Windows XP SP3

Windows 7
Windows 8
Windows 8.1
Windows 10
Windows 11

ftp.exe (included with Windows as standard)
Windows Explorer (included with Windows as standard)
FFFTP (freeware)

Data transfer service V10/V9 Series

Command Name Function Refer to
cd Changing the current directory -
close Closing the connection -
dir Displaying the file information page 6-65
ls Displaying folder and file names page 6-65
put Sending a file page 6-66
get Retrieving a file page 6-66
delete Deleting a file page 6-67
rename Renaming a file page 6-67
pwd Displaying the current folder name -
mkdir Creating a folder page 6-67
rmdir Deleting a folder -
quit Exit the FTP client tool after disconnecting the client. page 6-64

V10/V9

Ethernet

Ethernet

FTP server

FTP client

FTP client FTP client

Router
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6.9.3 Detailed Settings
Click [System Setting] → [Ethernet Communication] → [FTP Server]. The [FTP Server Setting] window is displayed.

* If no command is received from the FTP client within the time period specified for [Input Supervisory Period], the V10/V9 series unit 
automatically disconnects the client.

6.9.4 Specifying File Paths
How to specify file paths

• Drive name
C: Inserted SD card
D: USB-A port (USB flash drive, etc.)

Item Description
Use FTP server function Select this checkbox to use the FTP server function. The FTP server function is not available unless this 

checkbox is selected.
User Name 1 to 12 one-byte alphanumeric characters (case-sensitive)
Password 1 to 8 one-byte alphanumeric characters (case-sensitive)
Input Supervisory Period 1 to 60 minutes (default: 15 minutes) *

Write enable Select this checkbox to allow the FTP client to write, delete, and edit files. When this checkbox is not selected, 
only file reading is possible. (Default: unselected)

Specify a character set Select this checkbox to match with the character code used by the FTP client.
Unselected: UTF-8

Specify access drive Select this checkbox to set the drive for access by the FTP server.
Unselected

Match with the setting of [System Setting] → [Storage Setting] → [Storage Connection Target].
Selected

C: Built-in Socket
D: USB-A Port

Registering user names and passwords
User names and passwords used by the FTP server function can also be registered in local mode on the V10/V9 series unit.
This means FTP users can be added without a PC or the V-SFT version 6 software.
For details on operation in local mode, refer to the following manuals.

- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

C:  V9  JPEG  JP00000.JPG\ \ \

C:  EXT0000  RECIPE  TEST  TYPE0421.CSV\ \ \\

Drive name Access folder name Folder name *1 Filename *1

Maximum number of characters for a path: 
255 one-byte characters (including “:”, “\”, and the file extension)

Maximum number of characters for a path: 
255 one-byte characters (including “:”, “\”, and the file extension)

*1 Maximum number of characters for a filename: 194 one-byte characters
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6.9.5 Login
This section explains the login procedure and how to operate the FTP tools.
Prepare the V10/V9 series unit as instructed below before starting.

1. Transfer the screen program with configured FTP server settings to the V10/V9 series unit.
2. Connect your computer to the V10/V9 series unit via Ethernet.
3. Insert a storage device into the unit and set the unit to RUN mode.

Explorer (or Internet Explorer)
1. Start [Explorer].

2. Enter the FTP command in the [Address] field.
Enter “ftp://user name:password@MONITOUCH IP address” and then press the [Enter] key.

* When using Explorer or Internet Explorer,
specify “ftp://user name:password@MONITOUCH IP address”.
User authentication may not be successful if only “ftp://MONITOUCH IP address” is entered.
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3. The Explorer window is displayed as follows. Login is complete.

4. Explorer allows the contents of the storage device inserted into the V10/V9 series unit to be displayed.

Command Prompt
1. Click [Start] → [Programs] → [Accessories] → [Command Prompt].

A [Command Prompt] screen starts.
2. Enter the FTP command.

Enter “ftp”, a one-byte space, the IP address of the V10/V9 series unit, and then press the [Enter] key.

3. The following message appears.
Enter the user name specified in the [FTP Server Setting] window of the screen program and then press the [Enter] key.

Contents of the storage device inserted 
into the V10/V9 series unit
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4. The following message appears.
Enter the password specified in the [FTP Server Setting] window of the screen program and then press the [Enter] key.
(The password is not shown on the screen.)

5. The following message appears. This message indicates that login is complete.

Causes of login failure
<When the operating system of the V9 series unit is version 4.20 or later>

If the entered password in incorrect, the following message is displayed.

Input “user” and then press the [Enter] key. A message prompting to enter the user name is displayed.
Enter the user name specified in the [FTP Server Setting] window of the screen program and then press the [Enter] key.
Once the message prompting entry of the password is displayed, enter the password specified in the [FTP Server Setting] 
window of the screen program and then press the [Enter] key. (The password is not shown on the screen.)

Login is completed if the correct user name and password are entered.
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<When the operating system of the V9 series unit is version 4.10 or earlier>
If the wrong password is entered, the following message is displayed.

If correct commands are entered after the occurrence of an error, the error message will continue to be output.

In order to proceed, execute the quit command to disconnect the client once and then enter the correct command.
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6.9.6 Log Out
This section explains the log out procedure and how to operate the FTP tools.

Explorer (or Internet Explorer)
To log out when using Explorer, close the Explorer window.

Command Prompt
1. With the client logged into the FTP server, enter “quit” and press the [Enter] key.

2. The following message appears. Logout is complete.

Click the close button to log out.
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6.9.7 Operation Examples
This section provides examples of executing commands in the Command Prompt.

Displaying File and Folder Lists
“dir” command
This command is used to display a list of file and folder information that includes properties, sizes, dates and times of update, 
and names of files and folders.

“ls” command
This command is used to display the names of files and folders.

drwxr-xr-x 1 root root 16384 Apr 16 2014 xxxxxxxxx

• List details

Fixed (Fixed)

Date and time of update
Within 6 months: month day time
Over 6 months: month day year

* The month is shown with three 
alphabetic characters.

Folder name
Filename

d: Folder
-: File Folder size/file size
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Reading and Writing Files
“get” command (reading)
This command is used to retrieve files from the storage device and transfer them to the PC.
When using the Command Prompt, the file is transferred to the specified folder.

“put” command (writing)
This command is used to send files from the PC to the storage device.

In this example, the file is transferred to this location.

“get” command:
get    (file to be read)

“put” command:
put    (file on the PC (example: on drive C)   (file on the storage device (drive C))
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Deleting a file
“delete” command

Renaming a File/Folder
“rename” command

Creating a folder
“mkdir” command

Folder name
prior to renaming

Folder name
after renaming

“mkdir” command
↓

Create the “TEST2” folder 
in the “EXT0000\RECIPE” 
folder.
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6.9.8 Error Display
If an error occurs when accessing the FTP server, the FTP client displays the error message.

Example 1: When attempting to read a file that does not exist

Example 2: When attempting to write to a write-protected file
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6.9.9 Checking the Connection
System Device Memory ($s)
The following describes the system device memory associated with the FTP server.

Checking the Connection State
Create a lamp to which the internal device memory $s1070-00 is assigned, and place it on the screen.
A lit lamp indicates that a client is logged in, i.e. a connection is established.

Addresses Description Remarks
$s1070 Storage of FTP information

* If two or more FTP clients log in to the FTP server, the data stored in the system memory is 
based on the status of all these FTP clients. (Even if only one FTP client is executing a 
command, bit 1 is set to ON.)

← V

$s1071 Number of FTP clients that are logged into the server (maximum of 3 clients) ← V
$s1072 Forced disconnection of FTP connection ← V

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB

FTP client
0: Logged off
1: Logged in

System reserved (setting: 0)

LSB

FTP client
0: Command not being executed
1: Command being executed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB

Connection to FTP client
0 → 1: Forcibly disconnectedSystem reserved (setting: 0)

LSB

$s1070-00

Indicates that a client is logged in.
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Closing the Connection
Automatic disconnection
If no command is received from the FTP client within the time period specified for [Input Supervisory Period] in the [FTP 
Server Setting] window (click [System Setting] → [Ethernet Communication] → [FTP Server]), the V10/V9 series unit 
automatically disconnects the client.

Manual disconnection from the V10/V9 series unit
The connection with the FTP client can be forcibly disconnected by resetting (OFF to ON) bit 0 of $s1072 on the V10/V9 series 
unit.

Disconnection from FTP client
The FTP client is disconnected from the V10/V9 series unit when the FTP client logs out.
For details, refer to “6.9.6 Log Out” page 6-64.

$s1070-00

$s1072-00
Resetting $s1072-00 (OFF to ON) 
changes to the logged off state.

Logoff occurs.
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6.9.10 Restrictions
Number of Simultaneous FTP Client Connections
A maximum of three FTP clients can be connected to one V10/V9 series unit at the same time.
Note that requests from multiple FTP clients cannot be processed at the same time. They are processed one by one. 
Therefore, while an FTP client is transferring a large-size file, another client cannot transfer a file and must wait until the 
current file transfer is completed.

File Property Changes
Changing file properties (such as changing write permissions) is prohibited.

6.9.11 Notes
Notes on FTP Server System Design
1. In the case when an FTP client writes a recipe file to the storage device inserted into the V10/V9 series unit, the recipe file 

from the FTP client and the recipe in operation on the V10/V9 series unit must be in the same format. In the case when a 
recipe file is written from a remote location, make sure that the same format is used at the target location in advance.

2. Before using an FTP client tool, read the provided documentation to understand the functions and operational 
procedures, and also conduct a trial operation. The V10/V9 series (FTP server) may not support some functions 
depending on the type of the FTP client tool used.

Notes on File Transfer
1. If no command is sent from the FTP client within the time period specified for [Input Supervisory Period] in the [FTP 

Server Setting] window, the connection between the FTP server and FTP client will be disconnected automatically.
2. While the V10/V9 series unit is communicating with the FTP client, changing the V10/V9 series unit to Local mode will 

disconnect them.
3. While the V10/V9 series unit is accessing a file, do not allow the FTP client to write to or delete the same file.

If the same file accessed by the V10/V9 series unit is written to or deleted, a malfunction will occur. Deleting a file from 
the storage device, even when the file is not being accessed by the V10/V9 series unit, will cause a file reading error the 
next time the V10/V9 series unit attempts to access the file.
Basically, do not execute the writing and deleting commands with respect to any files relevant to V10/V9 series unit 
operation.

4. When a file on the storage device has been overwritten via the FTP server, check that the data in the file is correct.
If writing to the file ends in an error, the file will be deleted from the storage device. In the event of such a deletion, repeat 
writing from the FTP client.

5. If the FTP client is down, wait until the time for [Input Supervisory Period] elapses and then retry login.
6. While the FTP client is accessing a file on the storage device inserted into the V10/V9 series unit, do not turn off power to 

the V10/V9 series unit. Doing so may corrupt data on the storage device.
7. If the V10/V9 series unit is reset or turned off while connected to an FTP client, the next action that the FTP client takes 

depends on the specifications of the FTP client tool.
With this in mind, select an FTP client tool that can detect when an FTP server goes down and can terminate safely in such 
a case.

8. Depending on the type of FTP client tool, there may be a timestamp mismatches between files on the storage device and 
the PC. If such a mismatch is found, check the configuration of the FTP client tool.
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6.10 VNC Server
6.10.1 Overview

• The V10/V9 series unit supports the VNC server function. This means that the screen of the V10/V9 series unit can be 
monitored and remotely operated with ease from a PC on the network. Settings can also be configured to allow 
monitoring only.

• The V10/V9 series unit to be remotely operated is referred to as the “server” and the PC that performs remote operations 
is referred to as the “client”.
In addition to PCs, smartphones and tablets can also be used as clients.

• Simultaneous access from multiple clients is prohibited. All connections are 1:1.
The priority of the operation (earlier connection /later connection) when connection requests come from multiple clients 
is set by the screen program.

• VNC client software (VNC Viewer) must be installed.
• The V10/V9 series employs password authentication. When a client accesses a V10/V9 series unit, a user name and 

password must be entered.
* If the [Use the VNC server function without user authentication] checkbox at [System Setting] → [Unit Setting] → [General Setting] is 

selected in the screen program, the user authentication screen is not displayed. In this case, screen display is possible without entering a 
user name and password.

LAN/WAN

VNC Server

VNC client: PC

Internet

VNC client software

VNC client: Tablet

VNC client 
software

VNC client 
software

VNC: Virtual Network Computing

VNC client authentication screen
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• There are two ways to register a VNC user: by using the V10/V9 or by configuring through a screen program.
When VNC users are registered through both methods, either user names are available.If the same user name is 
registered using both ways, the one registered through a screen program has priority. 
- Registration from the V10/V9

The VNC server connection can be used by registering on the V10/V9 without setting screen program.
Changing user information is possible from the V10/V9. It is useful for adding functionality to running equipment.

- Registration from a screen program
If the specifications have been determined at the time of screen creation, the VNC server setting can be set in the 
screen program and used immediately after the screen transfer.
Registration from the V10/V9 is not necessary. User information is changed by the screen program.
The connected device can be fixed by registering the MAC address and permission/prohibition of remote operation 
can also be controlled during RUN mode.

• When the VNC client is connected using [Occupancy control device], the VNC side occupies the operation and the 
operation of the V10/V9 (including SYSTEM/Function switches) can be prohibited.

• By registering the MAC address of the VNC client, the connected device is fixed and therefore security can be enhanced.

• Remote operations on the display of the V10/V9 series unit can be performed on all RUN, Local, and error screens.
• If a network camera is connected to the V10/V9 series unit, the network camera image can also be displayed on the VNC 

client.

V10/V9 [User Settings] screen VNC server setting of the V10/V9 screen program

The settings in the box are 
valid for users registered on 
the V10/V9.

RUN STOPRUN STOP

RUN STOP

V10/V9 operation 
prohibited

VNC connected

V10/V9 operation 
allowed

VNC not connected

RUN STOPRUN STOP
MAC:00:1A:2B:3C:4D:5E

MAC:11:AA:BB:CC:DD:EE
MAC:00:1A:2B:3C:4D:5E

Registered MAC addressVNC connected

Unregistered MAC address 
VNC server settings

VNC not connected
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6.10.2 Specifications
V10/V9 Series Unit (Server)

System Devices
Connection status of the VNC client is stored.

*1 An error message appears on the user authentication screen.

Restrictions
• The connection between the V10/V9 series unit and VNC client is 1:1.
• The following operations cannot be performed on the V10/V9 series unit when a VNC client is connected and permitted 

to perform remote operations.
- Local mode → [System Setting] → [Buzzer Setting]
- Local mode → [System Setting] → [Backlight Setting]
- Local mode → [I/O Check] → [Touch switches and media] → [Test] → [Correct]

• The user authentication screen is displayed in the interface language of the V10/V9 series unit.
• The following functions cannot be displayed on the VNC client.

- Video/RGB display
- Video Player
- USB camera (V9 only)

Item Description Remarks
Port used LAN

LAN2
WLAN

Not available with CUR-03.

Port number 5900 Fixed
Number of client connections 1 If the server receives connection requests from multiple clients, the 

V10/V9’s behavior can be set by [VNC Server Setting] → 
[Connection priority].
When [Connection priority] is not set, the client that made a 
subsequent request has a priority to connect.

Authentication method Password authentication Authentication screen will not appear when   [System Setting] → 
[Unit Setting] → [General Setting] → [User the VNC server function 
without user authentication] is checked.

Number of registered users V10/V9 unit:
A maximum of 32 users

Screen program:
A maximum of 32 users

Addresses Description Remarks
$s1590 Details of the VNC client

0: Unconnected
1: Connected, monitor only
2: Connected, remote operation enabled
3: Connected, remote operation enabled (occupied: input from the V10/V9 unit disabled.)
-1: Connection prohibited *1

-2: Connection prohibited due to MAC address control *1

← V

$s1591 - 1598 User name of connected VNC client (16 bytes) ← V
$s1674 VNC client connection status

0: Unconnected
1: Connected

← V

• $s1590=-1

• $s1590=-2
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Status Bar
The connection state of VNC clients can be checked on the status bar. *1

This status bar can also be used to forcibly disconnect VNC clients from the V10/V9 series unit. *2

*1 The status of the VNC client is also output to system device memory ($s).

*2 When “automatic reconnect” is enabled in the settings of the VNC Viewer software, even if a forced disconnection is performed by the 
V10/V9 series unit, the user authentication screen is displayed and cannot be dismissed. In this case, close the VNC Viewer software and 
change the settings.

“System Devices” page 6-74

Status bar details
The status bar allows checking of VNC, LAN, and PLC communication states.

• Display method
Press the [SYSTEM] switch to display the status bar at the bottom right of the screen.

• Constant display
The status bar is automatically hidden after 15 seconds. Press the drawing pin icon to display the status bar at all times.

• Prohibiting status bar usage
The status bar cannot be displayed in RUN mode when the [Status Bar Prohibited] checkbox is selected on the [System 
Setting] → [Unit Setting] → [Switch/Mode Switch] tab window. In this case, press the [SYSTEM] switch in Local mode to 
display the status bar.

For details, refer to the following manuals.
- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

VNC client connected

Drawing pin icon

Hidden 15 seconds after last operation
Always displayed
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6.10.3 Setting Procedure
1. User registration

• Registration with the V10/V9
Local mode → [User Settings]  and register “User Name” and “Password”.

• Registration with a screen program
[System Setting] → [Ethernet Communication] → [VNC Server setting] and register “User Name” and “Password”.

2. Connect the V10/V9 series unit and the VNC client device to the network.
For details on VNC client device settings, refer to the relevant device manual.

3. VNC client settings
- Install the VNC Viewer software.

4. Start the VNC Viewer and perform remote monitoring and operation.

“Registration with the V10/V9” page 6-77

“ Registration with Screen Program” page 6-80

“V10/V9 Series Unit IP Address Settings” page 6-2

“6.10.5 VNC Client Settings/Operations” page 6-81

“Connecting to the VNC Server” page 6-81
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6.10.4 User Registration
There are two ways to register a VNC user: by using the V10/V9 or by configuring through a screen program.
When VNC users are registered through both methods, either user names are available.
If the same user name is registered using both ways, the one registered through a screen program is valid.

Registration with the V10/V9
For user registration, go to [User settings] on the local screen.

* This setting is not valid when [System Setting] → [Unit Setting] → [General Setting] → [User the VNC server function 
without user authentication] is checked.

User Settings
Register the user name and password for accessing the VNC server on the [User Settings] screen in Local mode.

1. Press the [SYSTEM] switch on the unit to display the system menu at the top of the screen.

2. Press the [Local] switch on the system menu. The Local mode screen is displayed on the unit.
3. Press the [User Settings] menu icon to display the [User Settings] screen. A list of registered users is displayed.

* This user settings screen is the same for [Security], [VNC Server], and [FTP Server].
Log in from the VNC Viewer using a user name and password that are allowed by the VNC server.

Item V10/V9 unit
[User Settings]

Screen program
 [VNC Server Setting] Remarks

User Name If the same username is registered, the one registered with 
a screen program has a priority.

Password
MAC address -
Connection permission 
device -

Allow remote operation
Remote operation 
prohibition device - Use this option to switch prohibiting/permitting remote 

operation during RUN mode.

System menu
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4. Press the [Administrator Authentication] switch. The password entry screen is displayed.

5. Enter an administrator-level user name and password. If the entries are correct, the user list in administrator mode is 
displayed. This mode allows adding, editing, and deletion operations.

The user name can also be set in the screen program.
The user set in the screen program always has administrator privileges and it cannot be edited or deleted on 
the [User Settings] screen of the V10/V9 series unit.

[Delete] and [Edit] disabled
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6. Press the [+ Add] switch to display the add user screen. Configure the following settings.

7. Press [OK] to complete registration. The display returns to the [User List (Administrator Mode)] screen.
8. Return to step 5 to perform another registration.

If registration is complete, switch to another screen using the relevant menu icon.

Item Description
User Name Register a user name. 16 one-byte alphanumeric characters

A maximum of 8 characters for a user name common with the security function.
Password Register a password. 16 one-byte alphanumeric characters

A maximum of 8 characters for a password common with the security function.
Grant administrator privileges Select whether to grant administrator privileges to the user.

With privileges: Users can be added, edited, and deleted in the list.
Without privileges: Users cannot be added, edited, or deleted in the list.

VNC Server Allow Allow access from VNC clients.
Allow remote operation Allow operations from VNC clients.

When remote operations are not allowed, only monitoring can be performed.

For details on adding, deleting, and editing user accounts from the [User Settings] screen, refer to the 
following manuals.

- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual
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Registration with Screen Program
You can register a user from [System Settings] → [Ethernet Settings] → [VNC Server Settings] in a screen program.

* Authentication screen will not appear when   [System Setting] → [Unit Setting] → [General Setting] → [User the VNC server 
function without user authentication] is checked.

VNC Server Settings

*1 Compatible with OS V3.90 and SYSTEM V2.100.
*2 The following symbols are available.    space ! “ # $ % & ‘ ( ) * + , - . / : ; < > = ? @ [ ] \ ^ _ ' | ~
*3 If the setting on the VNC client is set to automatically reconnect when disconnected, the connection cannot be disconnected 

normally.

Item Description
Configure VNC server function 
settings *1

Check this option when you set the VNC server function in a screen program.

User settings Up to 32 users can be registered.
User Name Registers a use name. Up to 16 alphanumeric characters. *2

Password Sets a password. Up to 16 alphanumeric characters. *2

MAC address Select this option to register the MAC address of the device.
Connection 
permission device

Select this option to control permission/prohibition of the VNC connection
OFF: connection prohibited
ON: connection allowed

Allow remote 
operation

Select this option to allow remote operation during VNC connection.

Remote operation 
prohibition device

Select this option to control permission/prohibition of remote operation. To always allow 
remote operation, this setting is not required.

OFF: operation prohibited
ON: operation allowed

Connection priority This option sets the priority when connection requests come from multiple clients.
Earlier connection: This option continues current connection.
Later connection: This option disconnects current connection and connect the client that 
made a subsequent request. *3

Occupancy control device Select this option to occupy the operation in the VNC client.
Connections of all the registered users are subject to this option. This option is not valid when 
VNC connection is not established.

OFF: Not occupied (operation is possible for both the V10/V9 and the VNC client) 
ON: Occupied (the V10/V9 is monitor-only mode while the VNC client is operational) 

KeepAlive settings This option sets the connection check settings with the VNC client.
Time-out Time This option sets the time to monitor response reception from a VNC client. If there is no 

response within the set time, it is retried.
1 - 32767 sec  default: 5 sec

Checking Cycle This option sets the interval at which VNC client connections are checked.
1 - 32767 sec  default: 5 sec

Retrials This option sets the number of retries after the timeout period.
1 - 127 times  default: 3 times

The settings in the box are valid for 
users registered on the V10/V9.
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6.10.5 VNC Client Settings/Operations
VNC Viewer Software
The VNC Viewer software must be installed on the VNC client in order to perform remote monitoring and operation of the 
V10/V9 series unit from the VNC client. Install this software in advance.

* For details on the system requirements of each software, visit the software’s website. The method for obtaining the software differs 
depending on the client device. Obtain the software by referencing the specifications of the relevant device.

* Communication may be unstable depending on the OS version of the client, VNC Viewer version, and operating environment. Always 
perform tests in the usage environment.

Connecting to the VNC Server
This section explains connecting to the VNC server with two examples: (1) connecting from a PC on the network using Ultra 
VNC, and (2) connecting from an Android tablet using VNC Viewer Lite.

Software OS Remarks
Ultra VNC Windows 2000 / XP / Server 2003 / Vista / 7 / 8 Free software
Tight VNC Windows XP (32 bit)
Simple Remote Android / iOS 13.2 or later Free software

Hakko Electronics
(dedicated to MONITOUCH)

RemoteToGo Android Free software
bVNC
VNC Viewer iOS Free software
VNC Lite
abtoVNC Viewer Commercial software
Jump Desktop

LAN/WAN

IP192.168.0.5 IP192.168.0.1 IP192.168.0.2

IP192.168.0.10

VNC Server
VNC client

Wireless LAN router

VNC 
Viewer Lite

Ultra VNC

(1)

(2)
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(1) Ultra VNC
Install Ultra VNC on the PC and connect the V10/V9 series unit and PC to the network in advance.
1. Start the Ultra VNC application via Windows Start menu → [UltraVNC] → [UltraVNC Viewer].
2. Enter the IP address of the V10/V9 series unit into the [VNC Server] field and click [Connect].

3. Enter a user name and password on the user authentication screen and click [Connect]. The VNC viewer screen is 
displayed.

4. Operating the VNC viewer screen will change the display on the V10/V9 series unit as well.
* If remote operations are not allowed, operations cannot be performed. The viewer screen changes to reflect operations performed on the 

V10/V9 series unit.

User authentication screen
If the [Use the VNC server function without user authentication] checkbox at [System Setting] → [Unit Setting] → [General Setting] is 
selected in the screen program, the user authentication screen is not displayed. In this case, screen display is possible without 
entering a user name and password.

Set to 0 when using the forced 
disconnection function from the 
V10/V9 series unit.
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(2) Simple Remote
Install Simple Remote, configure Wi-Fi settings, and connect the V10/V9 series unit and tablet to the network.
1. Start Simple Remote.
2. Enter the IP address of the V10/V9 series unit and port No.5900 at [VNC Connection Settings].

3. Enter a user name and password on the user authentication screen and tap [Connect].

4. The VNC Viewer screen is displayed and monitoring/operating is possible.
* If remote operation is not allowed, operations cannot be performed. The viewer screen changes to reflect operations performed on the 

V10/V9 series unit.

User authentication screen
If the [Use the VNC server function without user authentication] checkbox at [System Setting] → [Unit Setting] → [General Setting] is 
selected in the screen program, the user authentication screen is not displayed. In this case, screen display is possible without 
entering a user name and password.

Tap to display 
the keypad.

Hide the keypad.

Tap the screen.
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Simple Remote operation menu
Tap the screen to display a translucent menu.
The main menu items are described below.

Advanced settings menu
View-only mode and mouse cursor show/hide settings can be made from the Simple Remote start screen.
Tap [Show].

Item Description
Move Drag the icon to move the translucent menu.
Show keypad Tap to show the keypad.

To hide the keypad, tap the  at the bottom of the tablet screen.

Settings Tap to display the settings menu.
Input Mode Direct, Swipe Pan A tap gesture is the equivalent of clicking with a mouse and a swipe gesture pans the 

screen.
Direct, Hold Pan A tap gesture is the equivalent of clicking with a mouse and a press-and-hold gesture pans 

the screen.
* Switches with an ON delay setting (turning ON after a set time) cannot be operated.

Simulated 
Touchpad

A tap gesture is the equivalent of clicking with a mouse and a swipe gesture moves the 
mouse pointer.
After moving the mouse pointer to the edge of the screen, swipe again to pan the screen.

Single Handed A tap gesture is the equivalent of clicking with a mouse and a swipe gesture pans the 
screen.
A press-and-hold gesture shows a mode selection menu. Select left, center, or right 
dragging.

Scaling Zoomable The VNC screen is displayed so that pinch-to-zoom gestures can be used to zoom in or out 
on the screen.

Fit to Screen The VNC screen is displayed fitted and centered on the tablet screen.
Zooming in/out is not possible.

One to One The screen is displayed with the same resolution as the MONITOUCH unit that is being 
monitored.

Disconnect Disconnects the VNC.
Send Keys Allows operation of function switches.

For details, refer to page 6-86.
Send Key Again Sends the keys that were sent last time again.

Item Description
View-only mode Select this checkbox to allow only monitoring. Remote operation is disabled.
Cursor Mode Auto The mouse cursor is hidden.

Local The mouse cursor is displayed.

Move Show keypad Show settings

Tap the screen.
Translucent menu

SettingsEnlarged view of translucent menu
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Keyboard Entry
If remote operations are permitted from the VNC client, the following keyboard entry can be performed in addition to 
operations on the viewer screen.

• Entry screens: numerical and text entry
• Text boxes: numerical and text entry
• Function switch operation

Operation example
• When using Ultra VNC

1) With the remote screen displayed using Ultra VNC, press [F8] on the keyboard.

5. The system menu and the status bar are displayed.
This is the same operation as pressing the [SYSTEM] switch on the V10/V9 series unit.

VNC Client Keyboard V10/V9 Function Switch
F1 F1
F2 F2
F3 F3
F4 F4
F5 F5
F6 F6
F7 F7
F8 SYSTEM

F1 F2 F3 F4 F5 F6 F7 F8

Ultra VNC

System menu

Status Bar
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• When using Simple Remote
1) With the remote screen displayed using Simple Remote, tap the screen to display the translucent menu. Then tap the 

settings icon.

2) Tap [Send Keys] to display the following screen.

3) Tap the [ ] icon shown below and select [F8] from the pull-down menu.

4) Make sure that [F8] is selected and then tap [Send]. The system menu and the status bar are displayed.

The key that was sent last time can be sent again by tapping the settings icon → [Send Key Again] on the translucent 
menu.
This menu item is convenient when repeated operation is necessary.

Tap to display settings.
Tap the screen.

Show the pull-down menu.

System menu

Status bar
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6.11 Data Transfer Service
6.11.1 Overview

Data Transfer Service
This function is for uploading (PUT) files and folders saved to the storage device connected to a V10/V9 series unit, and 
downloading (GET) files from the server by accessing the server from the client V10/V9 series unit over Ethernet.
The V10/V9 series can serve as an FTP client.
If the mail server is on the network, files on a storage device can be sent with e-mail in conjunction with the e-mail sending 
function.
The maximum size of file attachments is 10 MB. However, do not exceed the maximum capacity of the mail server.

Since uploading and downloading is performed as a background operation, screen operations are available during the 
transfer.

Transfer Method
Data can be transferred by either using the data transfer viewer or by a command from a PLC.

Data transfer viewer
The viewer can be used to upload and download folders and files.

• Server registration can be performed in the viewer.
• Folders and files can be selected and transferred while viewing the latest information.
• The viewer can be displayed from the system menu, using a switch part, or by a command from a PLC.

For details, refer to “6.11.7 Data Transfer Viewer” page 6-118.

V10/V9 V10/V9

Ethernet

PDF CSV

FTP clientFTP server

FTP server

Download (GET)

Upload (PUT)

Data transfer 
service

E-Mail

SMTP server

Example: Display using a switch with [Function] set to [Data transfer viewer call]
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• The filter function can be used to, for example, only transfer CSV files (by specifying a wildcard) when multiple file types, 
such as CSV and BIN files, exist in a folder.

• The execution results can be checked in a log.

PLC command
Folders and files can be uploaded or downloaded at bit ON or OFF of the PLC.

• The filter function can be used. Filter keywords can be specified using device memory addresses.
• The folders and files for transfer can be specified using device memory addresses.

V10/V9

Ethernet

FTP client
IP192.168.1.50

FTP server

IP192.168.1.10

EXT0000 (Access folder)
ALARM

Upload (PUT) the files in the folder.

20160401

ALARM_00_00_20160401092500.CSV

C:\FTPTEST\

ALARM_00_00_20160401092500.CSV
ALARM_00_00_20160401235900.CSV

201604 (year/month folder)
20160401 (year/month/day folder)

20160402

ALARM_00_00_20160401235900.CSV

ALARM00_20160401092500.BIN
ALARM00_20160401235900.BIN

Filter

Logs

V10/V9

Ethernet

FTP client

FTP server IP192.168.1.10

IP192.168.1.50

EXT0000 (Access folder)
PDF

2) Download (GET) the file.

1) Turn ON M10.

Transfer execution trigger: M10 is turned ON

V9Setup.pdf

3) The “V9Setup.pdf” file 
is updated.

C:\FTPTEST\V9Setup.pdf



6.11    Data Transfer Service

6-89

1

2

3

4

5

6

7

8

9

10

6.11.2 Specifications
V10/V9 Client Specifications

Compatible FTP Servers

Item Specifications Remarks
V10/V9 series Available with built-in LAN ports (LAN, LAN2, WLAN) Not available with CUR-03 communication unit.
Protocol TCP/IP
Number of simultaneous 
connections to server

1 Server connection is automatically established 
at transfer execution and automatically 
disconnected when complete.

Data size Unlimited (within the storage capacity) If data size is large, transfer will take time.
Number of data Unlimited (within the storage capacity)
Data hierarchy No hierarchy limitaiton (Path: within 256 alphanumerics)
Operational requirement Data transfer viewer: Displayable and operable in both 

RUN and Local modes
PLC command: Operable in RUN mode only

Tools and Functions Equipment/OS
FTP server function V10, V9, V8i series
Microsoft Internet Information Services (IIS) OS: Windows 7, Windows 10
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6.11.3 Setting Example: Transfer Using the Data Transfer Viewer
The following settings are required.

• Server settings
• Data transfer viewer call
• Client settings (V10/V9)

For details, refer to “6.11.7 Data Transfer Viewer” page 6-118.
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6.11.4 Setting Example: Transfer Using PLC Commands
Setting Example 1: When the Server is a Computer
This section describes the settings for when the server is a computer.

File-based Transfer
The following is the procedure for updating the “V9Setup.pdf” file by downloading it (GET) from the server.

Server settings
Refer to the manual of the tool to use.

User name FTPUser
Password ftp123
IP Address 192.168.1.10
Port 21 (default)
Server directory C:\FTPTEST

For details, refer to “Server: Computer etc.” page 6-113.

V10/V9

Ethernet

FTP client

FTP server IP192.168.1.10

IP192.168.1.50

EXT0000 (Access folder)
PDF

2) Download (GET) the file.

1) Turn ON M10.

Transfer execution trigger: M10 is turned ON

V9Setup.pdf

3) The “V9Setup.pdf” file 
is updated.

C:\FTPTEST\V9Setup.pdf

Example: Microsoft Internet Information Services (IIS)
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Client settings (V10/V9)
1. Click [System Setting] → [Data transfer service] → [Data Transfer Service Settings] to display the [Data Transfer Service] 

tab window.
2. Configure the following settings. 

Set the same values as the server settings for [Connection Destination] (IP address), [Port No.], [User ID] (user name) and 
[Password].

3. Configure the following settings.

4. Click [OK].

This completes the necessary settings.

Unit operation
Downloading (GET) starts when the M10 bit turns ON.
The “V9Setup.pdf” in the V10/V9 series unit’s PDF folder is updated by overwriting.

* For details on specifying the file for 
transfer using device memory 
addresses, refer to “Setting 
Example 3: Transfer Using PLC 
Commands with Filters” page 6-97.
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Folder-based Transfer
The following is the procedure for updating the “RECIPE“ folder by downloading (GET) it from the server.

Server settings
Refer to the manual of the tool to use.

User name FTPUser
Password ftp123
IP Address 192.168.1.10
Port 21 (default)
Server directory C:\FTPTEST

For details, refer to “Server: Computer etc.” page 6-113.

V10/V9

Ethernet

FTP client

FTP server
192.168.1.10

192.168.1.50

EXT0000 (Access folder)
RECIPE

2) Download (GET) the files in the folder.

1) Turn ON M11.

Transfer execution trigger: 
M11 is turned ON

3) All contents of the 
RECIPE folder are 
updated.

RECIPE
REC0000.csv
REC0001.csv

REC0002.csv

C:\FTPTEST\RECIPE

Example: Microsoft Internet Information Services (IIS)
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Client settings (V10/V9)
1. Click [System Setting] → [Data transfer service] → [Data Transfer Service Settings] to display the [Data Transfer Service] 

tab window.
2. Configure the following settings. 

Set the same values as the server settings for [Connection Destination] (IP address), [Port No.], [User ID] (user name) and 
[Password].

3. Configure the following settings.

4. Click [OK].

This completes the necessary settings.

Unit operation
Downloading (GET) starts when the M11 bit turns ON.
The “RECIPE” folder in the V10/V9 series unit is updated by overwriting with the “RECIPE” folder on the server.

* For details on the filter 
function, refer to “Setting 
Example 3: Transfer Using 
PLC Commands with Filters” 
page 6-97.



6.11    Data Transfer Service

6-95

1

2

3

4

5

6

7

8

9

10

Setting Example 2: When Server is a V10/V9 Unit
The following is the procedure for updating the “RECIPE“ folder on the server by uploading (PUT) from an SD card.

Server settings (V10/V9)
1. Click [System Setting] → [Ethernet Communication] → [FTP Server].

2. The [FTP Server Setting] window is displayed. Configure the following settings.

Use FTP server function *1 Selected
User name monitouch *2

Password 9999 *2

Input Supervisory Period 15 min
Write enable Selected
Specify access drive Selected

C: Built-in Socket
*1 For details on the FTP server function, refer to “6.9 FTP Server”.
*2 User name and password registration

In addition to registration by computer or the V-SFT Ver. 6 screen configuration software, the user name and 
password used by the FTP server function can also be registered in Local mode on the V10/V9 series unit.
For details, refer to the following manuals.
- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

V10/V9 V10/V9

Ethernet

FTP clientFTP server

2) Upload (PUT) the files in 
the folder.

192.168.1.50192.168.1.51

EXT0000 (Access folder)
RECIPE

EXT0000 (Access folder)
RECIPE

Transfer execution trigger: M20 is turned ON

1) Turn on M20.

3) All contents of 
the RECIPE 
folder are 
updated.

REC0000.csv
REC0001.csv
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Client settings (V10/V9)
1. Click [System Setting] → [Data transfer service] → [Data Transfer Service Settings] to display the [Data Transfer Service] 

tab window.
2. Configure the following settings.

Set the same values as the server settings for [Connection Destination] (IP address), [User ID] (user name) and [Password].
Port number is fixed to 21.

3. Configure the following settings.

4. Click [OK].
This completes the necessary settings.

Unit operation
Uploading (PUT) starts when the M20 bit turns ON.
The entire “RECIPE“ folder on the server’s SD card is updated by overwriting.

* Existing files will be overwritten.

(Fixed)

* For details on the filter 
function, refer to “Setting 
Example 3: Transfer Using 
PLC Commands with Filters” 
page 6-97.
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Setting Example 3: Transfer Using PLC Commands with Filters
This section describes the procedure for uploading (PUT) specified CSV files stored in a date folder within an alarm folder 
created as alarm history, to the server.

Server settings
Refer to the manual of the tool to use.

User name FTPUser
Password ftp123
IP Address 192.168.1.10
Port 21 (default)
Server directory C:\FTPTEST

For details, refer to “Server: Computer etc.” page 6-113.

V10/V9

Ethernet

FTP client
IP192.168.1.50

FTP server

IP192.168.1.10

EXT0000 (Access folder)
ALARM

3) Upload (PUT) the files to the folder.

2) Turn ON M21.

Transfer execution trigger: M21 is turned ON

20160401

ALARM_00_00_20160401092500.CSV

C:\FTPTEST\

ALARM_00_00_20160401092500.CSV
ALARM_00_00_20160401235900.CSV

201604 (year/month folder)
20160401 (year/month/day folder)

20160402

ALARM_00_00_20160401235900.CSV

ALARM00_20160401092500.BIN
ALARM00_20160401235900.BIN

1) Use a keypad to input the 
year/month folder and 
year/month/day folder 
names into a character 
display part.
Example: 201604/20160401

Changed to [/]

$u200

Example: Microsoft Internet Information Services (IIS)
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Client settings (V10/V9)
1. Click [System Setting] → [Data transfer service] → [Data Transfer Service Settings] to display the [Data Transfer Service] 

tab window.
2. Configure the following settings. 

Set the same values as the server settings for [Connection Destination] (IP address), [Port No.], [User ID] (user name) and 
[Password].

3. Configure the following settings.

4. Click [OK].

This completes the necessary settings.

Unit operation
Uploading (PUT) starts when the M21 bit turns ON.
The specified date folder in the ALARM folder and the CSV files (not the BIN files) in that date folder are transferred to the 
server.

Files that match with the keyword specified as the filter are transferred maintaining their current path.
Files that do not match and folders that have no matching files are not transferred.

Specify “*.csv” to only 
upload CSV files.
(wildcard specification)
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Setting Example 4: Sending E-mail
This section describes the procedure for sending the latest logging CSV file saved on a storage device using e-mail.

E-mail settings
1. Select [System Setting] → [Ethernet Communication] → [E-Mail].
2. Configure the settings in the [E-Mail Setting] window.

SMTP IP Address
Sending Mail Server (SMTP)

Set the IP address of the mail server or the server name.

Port Setting Set the SMTP port number of the mail server.
0 to 65535 (default: 25)

Certify Type Select “SMTP-AUTH”. Configure the following settings.
• Use SSL/TLS Communication
• Account Name
• Password

Sender’s Mail Address Set the sender’s mail address.
Sender’s Name Set the sender’s name. A name consisting of both one- and two-byte characters is not valid.

It is displayed in the “Sender” field in an incoming e-mail.
Subject This setting is disabled. The record name in the data transfer service settings is used for the subject.
Receiver’s Mail Address Register the recipient mail addresses.

For details, refer to “E-mail Notification” page 6-49.

V10/V9

Ethernet

E-mail
CSV

SMTP server

EXT0000 (Access folder)
LOGGING

E-mail notification

Transfer execution trigger: M30 is turned ON

LOGGING_00_00_20190409192500.CSV
LOGGING_00_00_20190421135900.CSV

201904 (year/month folder)
20190411 (year/month/day folder)

LOGGING_00_00_20190421135900.CSV

LOGGING_00_00_20190421135900.CSV
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Client settings (V10/V9)
1. Click [System Setting] → [Data transfer service] → [Data Transfer Service Settings] to display the [Data Transfer Service] 

tab window.
2. Select “E-Mail (SMTP)” for [Server Type]. The server name or SMTP address configured in the [E-Mail Setting] window are 

displayed.

3. Configure the record settings.

4. Click [OK].
This completes the necessary settings.

Unit operation
An e-mail notification is sent with the latest CSV file from the LOGGING folder attached when the M30 bit turns ON.

Example of e-mail notification

For multi-language screens, the display language of “Attachment information” depends on the display language of the 
V10/V9 series unit.

This is displayed in the “Subject” field 
of the outgoing e-mail.

Select number of the E-Mail (SMTP) 
server under [Server Type].

Configure the file attachment settings.

Specify the execution device memory.

Select “Folder-based upload”.

Set the e-mail address of the recipient.

Sender: V9080
Subject: Logging_CSV
Main body:
2019/04/01 17:04:33  <ON>
[Attachment information]
Files: Size per file: 53 kB

Timestamp Trigger (ON/OFF)
No. of files File size (kB/MB)
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6.11.5 Detailed Settings
Configure settings via [System Setting] → [Data transfer service].

Data Transfer Service Settings
Always configure these settings when transferring using PLC commands. When transferring data using the data transfer 
viewer, although server settings can be configured directly on the V10/V9 series unit, you can also connect by registering 
servers in the following tab window and specifying the registered table number.
Click [System Setting] → [Data transfer service] → [Data Transfer Service Settings].
The [Data Transfer Service] tab window is displayed.
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List of Destination Servers

* Connection mode
Depending on the connection mode setting, the device that sends a connection request changes. When the FTP server is at an external 
location such as on the Internet, an external connection request may not be accepted due to the firewall’s security policy. In this case, use 
the passive mode in which the V10/V9 series unit (client) sends the connection request.

- Active mode

- Passive mode

Item Description Remarks
Delete Delete the selected server.
Delete All Servers Delete all registered servers.
No. Indicates the registration number of the server.

No. 0 to 31
Connection possible by specifying a server 
registration number in the data transfer viewer.

Server Type Specify the type of the server.
FTP/Cloud/E-Mail (SMTP)

For details on cloud support, refer to the Web 
Machine Interface Manual.
For details on e-mail, refer to “E-mail Notification” 
page 6-49.

Connection Mode * Specify the connection mode.
Active mode/Passive mode

The data transfer viewer is fixed to passive mode 
regardless of this setting.

Server Name Specify the name of the server.
Within 32 one-byte characters

Connection Destination Specify the IP address of the server. Set same values as server’s settings.
Port No. Specify the control port number of the server. 

(Default: 21)
Set same values as server’s settings.

User ID Specify the user ID (user name).
Within 16 one-byte characters

Set same values as server’s settings.

Password Specify the password.
Within 16 one-byte alphanumeric characters

Set same values as server’s settings.

V10/V9

Firewall

FTP client

FTP server

1) The V10/V9 series unit connects to the server.
2) The V10/V9 series unit notifies the server of the 

port number for file transfer.

3) The server sends a connection request to the 
V10/V9 series unit.

4) The server’s request may be blocked 
and the connection not established.

Internet

V10/V9

Firewall

FTP client

FTP server

1) The V10/V9 series unit connects to the server.
2) The server notifies the V10/V9 series unit of the 

port number for data transfer.
3) The V10/V9 series unit sends a connection 

request to the server.

Internet
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Data Transfer Service Settings

Info output device
• When [Server Type] is “FTP” or “E-Mail (SMTP)”
Device Memory Description

n

Storage of error information
The bit of the currently occurring error turns ON.

* The client automatically disconnects from the server if the request is not acknowledged within 15 seconds.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0

MSB

Server connection error

Reserved for system 
(setting: 0)

LSB

Server authentication error
Upload error

Download error

Directory creation error

Closing error
Definition error

Transfer record settings error

Item Description Solution
Server connection error Timeout *

The specified server does not 
exist.

Check that the server to connect to exists.
Check that the LAN cable is correctly connected.

Server authentication 
error

User ID and password settings are 
invalid.

Check the ID and password you used for login.

Upload error The save destination path, transfer 
source path, and transfer data 
name for upload/download are 
invalid.

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.

Download error

Directory creation error The specified data name does not 
exist.

Closing error Failed to establish connection with 
the server.

Check that the LAN cable is correctly connected.

Definition error An undefined error occurred. Check that the settings in the record list in the 
[System Setting] → [Data transfer service] → [Data 
Transfer Service Settings] tab window are correct.
Check server settings.

Transfer record settings 
error

The specified path of the data for 
transfer exceeded 256 bytes.

Check the transfer data settings.
Check the device memory for specifying the 
file/folder name for transfer.
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n+1

Storage of error codes
The most critical error code is stored. The next error code will not be saved until the cause of the stored error code is 
resolved.

* The client automatically disconnects from the server if the request is not acknowledged within 15 seconds.

n+2

Storage of the transfer result
The status upon completion of transfer is stored if [Output transfer result] is selected.
The bit of the corresponding status turns ON.
The bit automatically turns OFF when the transfer begins next.

Device Memory Description

Error Code Description Solution
0 No error -

1
Timeout *
The specified server does not 
exist.

Check that the server to connect to exists.
Check that the LAN cable is correctly connected.

2 User ID and password settings are 
invalid.

Check the ID and password you used for login.

3
The save destination path, transfer 
source path, and transfer data 
name for upload are invalid.

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.

4
The save destination path, transfer 
source path, and transfer data 
name for download are invalid.

5 The specified data name does not 
exist.

6 Could not access the data for 
transfer.

Check that the LAN cable is correctly connected.

7
An undefined error occurred. Check that the settings in the record list in the 

[System Setting] → [Data transfer service] → [Data 
Transfer Service Settings] tab window are correct.
Check server settings.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0

MSB

Reserved for system (setting: 0)

LSB

Uploading ended in error
Downloading ended in error

Downloading ended normally
Uploading ended normally
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• When [Server Type] is “Cloud”
Device Memory Description

n

Storage of error information   The bit of the currently occurring error turns ON.

* If a response is not received from the server for 15 seconds, the server will be disconnected.

n+1

Storage of error codes
The most critical error code is stored. The next error code will not be saved until the cause of the stored error code is 
resolved.

* If a response is not received from the server for 15 seconds, the server will be disconnected.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0

MSB

Server connection error
Reserved for system (setting: 0)

LSB

Server authentication error
Upload error

Download error

Directory creation error
Internal error

Item Description Solution
Server connection error Timeout *

The specified server does not 
exist.

Check that the server to connect to exists.
Check that the LAN cable is correctly connected.

Server authentication 
error

Domain and active ID settings are 
invalid.

Check the domain and active ID settings.
Check that the domain and cloud data service 
license are not expired.
Check that the domain and cloud data service 
license are registered.

Upload error The save destination path, transfer 
source path, and transfer data 
name for upload are invalid.
Insufficient cloud server capacity

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.
Check that there is enough space on the cloud 
server.

Download error The save destination path, transfer 
source path, and transfer data 
name for download are invalid.

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.Directory creation error The specified data name does not 

exist.
Internal error A cloud internal error occurred. Contact your local sales representative.

Error Code Description Solution
0 No error -

1
Timeout *
The specified server does not 
exist.

Check that the server to connect to exists.
Check that a connection with the global network can 
be established.
Check that the LAN cable is correctly connected.

2

Domain and active ID settings are 
invalid.

Check the domain and active ID settings.
Check that the domain and cloud data service 
license are not expired.
Check that the domain and cloud data service 
license are registered.

3

The save destination path, transfer 
source path, and transfer data 
name for upload are invalid.
Insufficient cloud server capacity

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.
Check that there is enough space on the cloud 
server.

4
The save destination path, transfer 
source path, and transfer data 
name for download are invalid.

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.

5 The specified data name does not 
exist.

7 A cloud internal error occurred. Contact your local sales representative.
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Command device

* Data transfer can also be cancelled from the status bar.

n+2, n+3

Storage of error detail codes

n+4

Storage of the transfer result
The status upon completion of transfer is stored if [Output transfer result] is selected.
The bit of the corresponding status turns ON.
The bit automatically turns OFF when the transfer begins next.

Device Memory Description

n Forcibly cancels the data transfer. (“E-Mail (SMTP)” for [Server Type] is not supported.)
1: Transfer cancellation

For details, refer to “Status Bar” page 6-129.

Device Memory Description

Error Code
Description

n n+2 n+3
0 0 0 Normal

Bit 0: ON −1 −1 No response

Bit 1: ON
310 0 Authentication failure
320 0 Target domain not registered
330 0 Expired license

Bit 2: ON

6 125 File not specified or file size “0”
9 0 Inaccessible folder specified

20 131 Excessive data size
80 122 Invalid folder path format
80 123 Invalid filename format
81 122 Invalid folder path length
81 123 Invalid filename length

9011 0 File system error

Bit 3: ON

9 0 Inaccessible folder specified
22 124 Folder does not exist.
22 125 File does not exist
80 122 Invalid folder path format
80 123 Invalid filename format
81 122 Invalid folder path length
81 123 Invalid filename length

9011 0 File system error

Bit 4: ON −1 −1 Storage device disconnection during download
Downloading of empty folder attempted

Bit 6: ON

7 0 Invalid request format
90 0 Invalid request received
91 0 Invalid request version

9010 0 Database error
9019 0 Unexpected error
82 132 Invalid upload type

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0

MSB

Reserved for system (setting: 0)

LSB

Uploading ended in error

Downloading ended in error

Downloading ended normally
Uploading ended normally
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Record List

Record editing window

Item Description
Add Add a new record. For details, refer to “Record Editing Window“.
Edit Records Edit the currently selected record number. For details, refer to “Record Editing Window“.
Delete Records Delete the selected record.
Delete All Records Delete all registered records.

Item Description
Operation Setting Record No. Select the record number for editing. 

No. 0 to 255
Record Name Register a record name.

Within 32 one-byte alphanumeric characters
Transfer Select the data to transfer and the direction of the transfer. ([Unit]: storage device of V10/V9 

series unit)
File-based upload (From unit to server)
Folder-based upload (From unit to server)
File-based download (From server to unit)
Folder-based download (From server to unit)

Transfer Condition Device Specify the device memory address that triggers the record.
Trigger Select Specify the bit operation (edge). *1

ON: Execute at OFF → ON.
OFF: Execute at ON → OFF.
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*1 Level recognition is used to judge the bit status and thereby whether to start communication. For example, when [Trigger Select] is set to 
[ON], data transfer is executed when communication is started with the bit on the PLC in the ON status.

*2 There is no path hierarchy limitation. However, note that there are some limitations as described below.
- The path delimiter is a slash “/”. “\” is not supported.
- A delimiter at the end of the path is not required. However, if specifying a root directory, a delimiter is required.
- Two-byte characters are not supported.

*3 The total number of 1-byte characters in the path (server path when downloading) and the path set for the files and folders for transfer 
must not exceed 255.

*4 The following limitations apply.
- Unsupported characters: \, :, “, <, >, and |
- Two-byte characters are not supported.

*5 The following limitations apply.
- Unsupported characters: /, \, :, “, <, >, and |
- Two-byte characters are not supported.

*6 Supported wildcards: *, ?, and []
*7 The filter function can also be used with the data transfer viewer.

*8 If there are multiple files with the same timestamp, all files are attached.

Transfer Data 
Settings

Server Path Specify the path of the server.
Number of characters for a path: Within 255 one-byte characters (including “:” and “/”) *2 *3

Unit Storage Drive 
Select

Select the storage device of the V10/V9 series unit.
C: SD
D: USB (USB flash drive etc.)

Path Specify the path within the storage device of the V10/V9 series unit.
Number of characters for a path: Within 255 one-byte characters (including “:” and “/”) *2 *3

Transfer File
Transfer Folder

Specify the name of the file or folder for transfer. When specifying a file, specify the extension 
as well.
For device memory specification, NULL (0) is the terminator

Within 256 one-byte alphanumeric characters *3 *4

Transfer empty 
folders as well

This can be selected when the transfer mode is set to “Folder-based download”.
When selected, empty folders will also be transferred.

Use filter function *7 This checkbox can be selected when [Transfer] is set to “Folder-based upload” or “Folder-based 
download”.
The filter only targets files. Only the files that match the specified keyword are transferred.  *5
Wildcards can be specified.  *6
For device memory specification, NULL (0) is the terminator.

Within 64 one-byte alphanumeric characters
File Option This can be configured when the transfer mode is set to “Folder-based upload”. Select the file 

for transfer in the transfer folder.
All Files
Latest File *8

Oldest File *8

One previous to latest file *8

Server Settings No. Specify the number registered on the server list.
No. 0 to 31

For details on the operating method, refer to “Filter Function” page 6-124.

Item Description

Example: Transferring to a root directory
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Data Transfer Viewer Settings
Click [System Setting] → [Data transfer service] → [Data Transfer Viewer Settings].
The [Data Transfer Viewer] tab window is displayed.

Data Transfer Viewer

Info output device
• When [Server Type] is “FTP” or “E-Mail (SMTP)”
Device Memory Description

n

Stores the display state of data transfer viewer and error information.
For errors, the bit of the currently occurring error turns ON.

* If a response is not received from the server for 15 seconds, the server will be disconnected.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0

MSB

Server connection error

Reserved for system 
(setting: 0)

LSB

Server authentication error

Upload error

Download error

Directory creation error

Closing error
Definition error

Display state of the 
data transfer viewer
0: Hide
1: Show

Item Description Solution
Server connection error Timeout *

The specified server does not exist.
Check that the server to connect to exists.
Check that the LAN cable is correctly connected.

Server authentication 
error

User ID and password settings are 
invalid.

Check the ID and password you used for login.

Upload error The specified file or folder does not 
exist.

Check that the path of the data for transfer is 
correct.
Check that the data for transfer exists.
Check server settings.
Check that the storage device is connected.

Download error
Directory creation error The specified data name does not 

exist.
Closing error Failed to establish connection with the 

server.
Check that the LAN cable is correctly connected.

Definition error An undefined error occurred. Check server settings.
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• When [Server Type] is “Cloud”

n+1

Storage of error codes
The most critical error code is stored. The next error code will not be saved until the cause of the stored error code is 
resolved.

* If a response is not received from the server for 15 seconds, the server will be disconnected.

Device Memory Description

n

Storage of the display state of the data transfer viewer and error information
For errors, the bit of the currently occurring error turns ON.

* If a response is not received from the server for 15 seconds, the server will be disconnected.

Device Memory Description

Error Code Description Solution
0 No error -

1
Timeout *
The specified server does not 
exist.

Check that the server to connect to exists.
Check that the LAN cable is correctly connected.

2 User ID and password settings are 
invalid.

Check the ID and password you used for login.

3
The save destination path, transfer 
source path, and transfer data 
name for upload are invalid.

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.

4
The save destination path, transfer 
source path, and transfer data 
name for download are invalid.

5 The specified data name does not 
exist.

6 Cannot establish connection 
properly with the server.

Check that the LAN cable is correctly connected.

7 An undefined error occurred. Check server settings.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0

MSB

Server connection error

Reserved for system (setting: 0)

LSB

Server authentication error
Upload error

Download error

Directory creation error

Internal error
Display state of the 
data transfer viewer

0: Hidden
1: Shown

Item Description Solution
Server connection error Timeout *

The specified server does not 
exist.

Check that the server to connect to exists.
Check that the LAN cable is correctly connected.

Server authentication 
error

Domain and active ID settings are 
invalid.

Check the domain and active ID settings.
Check that the domain and cloud data service 
license are not expired.
Check that the domain and cloud data service 
license are registered.

Upload error The save destination path, transfer 
source path, and transfer data 
name for upload are invalid.
Insufficient cloud server capacity

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.
Check that there is enough space on the cloud 
server.

Download error The save destination path, transfer 
source path, and transfer data 
name for download are invalid.

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.Directory creation error The specified data name does not 

exist.
Internal error A cloud internal error occurred. Contact your local sales representative.
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n+1

Storage of error codes
The most critical error code is stored. The next error code will not be saved until the cause of the stored error code is 
resolved.

* If a response is not received from the server for 15 seconds, the server will be disconnected.

n+2, n+3

Storage of error detail codes

Device Memory Description

Error Code Description Solution
0 No error -

1
Timeout *
The specified server does not 
exist.

Check that the server to connect to exists.
Check that a connection with the global network can 
be established.
Check that the LAN cable is correctly connected.

2

Domain and active ID settings are 
invalid.

Check the domain and active ID settings.
Check that the domain and cloud data service 
license are not expired.
Check that the domain and cloud data service 
license are registered.

3

The save destination path, transfer 
source path, and transfer data 
name for upload are invalid.
Insufficient cloud server capacity

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.
Check that there is enough space on the cloud 
server.

4
The save destination path, transfer 
source path, and transfer data 
name for download are invalid.

Check that the transferred data exists and that the 
paths are correct.
Check server settings.
Check that the storage device is connected.

5 The specified data name does not 
exist.

7 A cloud internal error occurred. Contact your local sales representative.

Error Code
Description

n n+2 n+3
0 0 0 Normal

Bit 0: ON −1 −1 No response

Bit 1: ON
310 0 Authentication failure
320 0 Target domain not registered
330 0 Expired license

Bit 2: ON

6 125 File not specified or file size “0”
9 0 Inaccessible folder specified

20 131 Excessive data size
80 122 Invalid folder path format
80 123 Invalid filename format
81 122 Invalid folder path length
81 123 Invalid filename length

9011 0 File system error

Bit 3: ON

9 0 Inaccessible folder specified
22 124 Folder does not exist.
22 125 File does not exist
80 122 Invalid folder path format
80 123 Invalid filename format
81 122 Invalid folder path length
81 123 Invalid filename length

9011 0 File system error

Bit 4: ON −1 −1 Storage device disconnection during download
Downloading of empty folder attempted

Bit 6: ON

7 0 Invalid request format
90 0 Invalid request received
91 0 Invalid request version

9010 0 Database error
9019 0 Unexpected error
82 132 Invalid upload type
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Command device memory

*1 If the display bit is ON when entering RUN mode, the data transfer viewer is displayed.
*2 Data transfer can also be cancelled from the status bar.

Device Memory Description

n

Device memory allocation is as follows.

For details, refer to “Status Bar” page 6-129.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0

Reserved for system 1: Transfer 
cancellation *2

Viewer *1
1 → 0 (edge): Hide
0 → 1 (edge): Show

MSB LSB
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6.11.6 FTP Server Settings
The server must have an FTP server built up. Refer to the following.

Server: Computer etc.
FTP server settings differ according to the FTP server to use and tools. Refer to respective manuals.
This section describes the settings for Microsoft Internet Information Services (IIS) as an example.

Creating a User Account for Logging Onto FTP
This procedure is for creating a new local user account.

1. Double-click [Computer Management] from [Control Panel] → [Administrative Tools].

2. Right-click on [Users] under [Local Users and Groups] and click on [New User].

3. Enter a user name and password repectively. Deselect the [User must change password at next logon] checkbox and then 
click [Create].

4. Click [Close]. A new local user will be added.

This setting is not required if using an existant local user account.
Install IIS.
For details, refer to “IIS installation” page 6-114.

* The user name and password are 
required for using the data transfer 
service function of V-SFT. Take care 
not to lose them.

Deselect
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IIS Settings
This section describes the installation procedure for IIS and FTP server settings.

IIS installation
1. Click on [Turn Windows features on or off] from [Control Panel] → [Programs and Features].

2. Select the [FTP Service] and [IIS Management Console] checkboxes under [Internet Information Services] and click [OK].

FTP server settings
1. Double-click [Internet Information Services (IIS) Manager] from [Control Panel] → [Administrative Tools]. The Internet 

Information Services (IIS) Manager starts up.

2. In the right pane of the window, click [View Sites] → [Add FTP Site].
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3. Fill in the [FTP site name] and [Content Directory] fields and click [Next].

4. Select the IP address of your computer. Then select [No SSL] for [SSL] and click [Next].

5. Configure [Authentication] and [Authorization] as follows.
For [Allow access to], select [Specified users] and input the local user name for logging onto the FTP.

* The IP address and port number 
are required for using the data 
transfer service function of V-SFT. 
Take care not to lose them.

* For details, refer to “Creating 
a User Account for Logging 
Onto FTP” page 6-113.
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6. Click [Finish]. A new FTP server setting is added.
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Checking FTP Server Logon
This section describes the procedure for checking if you can log onto the FTP server by using a Command Prompt window.

1. Click on [Command Prompt] from the computer’s start menu → [All Programs] → [Accessories]. A command prompt 
window opens.

2. In the command prompt window, enter “ftp“, a one-byte space, and the server’s IP address in order and press the [Enter] 
key.

3. Enter the user name for logging onto the FTP and press the [Enter] key.

4. Enter the password for the user name entered in step 3 and press the [Enter] key.

Logon is successful when “230 User logged in.“ is displayed.

Server: V10/V9 Series Unit

When logon doesn’t succeed
• Settings for the IIS, user name and password may be incorrect. Check the settings.
• Firewall may be enabled. Disable firewall and perform the check again.

For details on settings, refer to “Setting Example 2: When Server is a V10/V9 Unit” page 6-95.

* For details, refer to “Creating a User Account for Logging 
Onto FTP” page 6-113.

* Nothing is displayed and the cursor will not move during 
password entry.Example: ftp123

Connection successful
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6.11.7 Data Transfer Viewer
The viewer can be used to upload and download folders and files.

Setting Example
Server Settings
This section describes the settings for when the server is a computer or a V10/V9 series unit.

When the server is a computer
Refer to the manual of the tool to use.

User name FTPUser
Password ftp123
IP Address 192.168.1.10
Port 21 (default)
Server directory C:\FTPTEST

For details, refer to “Server: Computer etc.” page 6-113.

V10/V9
Ethernet

FTP client

FTP server

IP192.168.1.10IP192.168.1.50
Example: When the server is a computer

Example: Microsoft Internet Information Services (IIS)
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When the server is a V10/V9 series unit
1. Click [System Setting] → [Ethernet Communication] → [FTP Server].

2. The [FTP Server Setting] window is displayed. Configure the following settings.

Use FTP server function *1 Selected
User Name monitouch *2

Password 9999 *2

Input Supervisory Period 15 min
Write enable Selected
Specify access drive Selected

C: Built-in Socket
*1 For details on the FTP server function, refer to “6.9 FTP Server”.
*2 User name and password registration

In addition to registration by computer or the V-SFT Ver. 6 screen configuration software, the user name and 
password used by the FTP server function can also be registered in Local mode on the V10/V9 series unit. 
For details, refer to the following manuals.
- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual
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Displaying the Viewer
The viewer can be displayed from the system menu, using a switch part, or by a command from a PLC.

System menu
No settings are required.

Switch
Display the data transfer viewer using a switch placed on the screen.

1. Place a switch from the [Parts] menu.
2. Select [Function] → [Standard] → [Data transfer viewer call].
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PLC Command
Display the data transfer viewer by a command from the PLC.

Click [System Setting] → [Data transfer service] → [Data Transfer Viewer Settings] and set the command device memory 
address.

Set bit 1 of D300 to 
ON (0 to 1).

Command device memory address: D300

Example: D300

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0

Reserved for system 1: Transfer cancellationViewer
1 → 0 (edge): Hide
0 → 1 (edge): Show

Display using bit 1 
of D300
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Client Settings (V10/V9)
1. Display the data transfer viewer.

2. The following [Connect] menu is displayed first. Tap each setting to set the same values as the server settings for 
[Destination IP], [Port No], [User ID] and [Password].

3. Tap the [Connect] button. If a connection is successfully established with the server, the log displays “Successfully logged 
in.” and the [Connect] button changes to an [Unlink] button.

This completes the necessary settings.

For details on the display method, refer to “Displaying the Viewer” page 6-120.

By selecting the [Select from the server table] checkbox, a server can be specified by the table number it is registered in at [System Setting] → 
[Data transfer service] → [Data Transfer Service Settings] → [List of Destination Servers] in the screen program.

If connection with the server fails, the log displays “Cannot find the specified server. Check the setting.”
Check the Ethernet environment and settings and then tap [Connect] again.

For details on the operating method, refer to “Operation Example” page 6-123.

Logs

Logs



6.11    Data Transfer Service

6-123

1

2

3

4

5

6

7

8

9

10

Operation Example
Uploading Folders
This section describes the procedure for uploading (PUT) the “LIST” folder on the client (V10/V9) to the server.

1. Display the data transfer viewer.
2. Select the “LIST” folder in the client (V10/V9) list.

3. Tap [Upload]. A confirmation dialog appears. Tap [OK].

4. The “LIST” folder is uploaded to the server.

* If the same folder name already exists, the folder will be overwritten.

V10/V9 Server (Computer)

* Two-byte characters are 
not supported and cannot 
be displayed correctly.
Uploading/downloading 
cannot be performed when 
such characters are used.
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Filter Function
This section describes the procedure for uploading (PUT) only CSV files in the “ALARM” folder on the client (V10/V9) to the 
server.

1. Display the data transfer viewer.
2. Select the “ALARM” folder in the client (V10/V9) list.

V10/V9

Ethernet

FTP client
IP192.168.1.50

FTP server
IP192.168.1.10

EXT0000 (Access folder)
ALARM

Upload (PUT) the files in the folder.

20160401

ALARM_00_00_20160401092500.CSV

C:\FTPTEST\

ALARM_00_00_20160401092500.CSV
ALARM_00_00_20160401235900.CSV

201604  (year/month folder)
20160401 (year/month/day folder)

20160402

ALARM_00_00_20160401235900.CSV

ALARM00_20160401092500.BIN
ALARM00_20160401235900.BIN

V10/V9 Server (Computer)

* Two-byte characters are 
not supported and cannot 
be displayed correctly.
Uploading/downloading 
cannot be performed when 
such characters are used.
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3. Tap [Filter Setting]. Set the filter menu switch to [ON] and input “*.csv”.

4. Tap [Upload]. A confirmation dialog appears. Tap [OK].

5. All CSV files in the “ALARM” folder are uploaded to the server.

* If the same folder name already exists, the folder will be overwritten.

On the server (computer)
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Configuration of the Data Transfer Viewer

Connect

*1 For details on cloud support, refer to the Web Machine Interface Manual.
*2 The information registered in the specified table number is displayed when the [Select from the server table] checkbox is selected.

Item Description Remarks
Server Type FTP/Cloud *1

Server Name *2 Displays the server name. Only displayed when the [Select from the server 
table] checkbox is selected.

Destination IP *2 Specify the IP address of the server. Set same values as server’s settings.

Port No *2 Specify the control port number of the server.
(Default: 21)

Set same values as server’s settings.

User ID *2 Specify the user ID (user name).
Within 16 one-byte characters

Set same values as server’s settings.

Password *2 Specify the password.
Within 16 one-byte alphanumeric characters

Set same values as server’s settings.

Select from the server table A server can be specified by the table number it is 
registered in at [System Setting] → [Data transfer 
service] → [Data Transfer Service Settings] → [List of 
Destination Servers] in the screen program.

Connect/Unlink Connect to and disconnect from the server.

* The connection mode is 
fixed to passive mode.
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Viewer

*1 For details on cloud support, refer to the Web Machine Interface Manual.

Item Description Remarks
1. Storage device selection Select the storage device of the V10/V9 series unit (client). Client setting
2. Path display Displays the path corresponding to the cursor selection. Client setting
3. File information Displays the folders and files stored in the storage device specified 

at “1.”
Select the folder/file to be transferred.

Client setting

4. Log display Displays the execution result of connection/disconnection and 
transfers.
The message color differs depending on the result.
Green: Success
Blue: Connected/searching
Red: Failed

For details, refer to “Log Display” page 
6-128.

5. Filter setting Displays the filter menu.
A green check mark appears when the filter switch is [ON].

6. Upload Transfers the folder/file selected on the client to the path selected 
on the server.

7. Download Transfers the folder/file selected on the server to the path selected 
on the client.

8. Log clear Clears the log displayed at “4.”
9. Server IP address Displays the IP address of the currently connected server. Server setting
10. Server selection FTP/Cloud *1 Server setting
11. Change directory Move one level up in the hierarchy. Server setting
12. Refresh directory Refresh the directory to the latest state. Server setting
13. Delete Deletes the folder/file selected on the server. Server setting
14. Path display Displays the path corresponding to the cursor selection. Server setting
15. File information Displays the folders and files stored on the server specified at “11.”

Select the folder/file to be transferred.
Server setting

16. Filter switch Select whether or not to use the filter function.
Change the switch to [ON] to use the filter function.

17. Filter keyword The filter only targets files. Only the files that match the specified 
keyword are transferred.
Wildcards can be specified.
Within 64 one-byte alphanumeric characters

Supported wildcards: *, ?, and []

* Unsupported characters: /, \, :, “, 
<, >, and |

* Two-byte characters are not 
supported.

1

3

2

4

12

5

6

7

8

10 11 13

14

15

* Two-byte characters 
are not supported.

9

16 17
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Information
The folder/file currently being transferred and the progress of the data transfer are displayed.

Close
Tapping this button closes the data transfer viewer. The data transfer viewer can be closed while uploading and downloading 
is in progress.

Log Display
The execution result of connection/disconnection and transfers is displayed in the area below the data transfer viewer.
The message color differs depending on the result (green: success, blue: connected/searching, red: failed). If the result is failed 
(red), check the following.

Operation Description Solution
Connect Login failed. Check the ID and password you used for login.

Cannot find the specified server.
Check the setting.

Check that the IP address of the server specified on the [Connect] screen 
is correct.

Information required for connection 
is not entered.

Check that the IP address and port number of the server are entered 
correctly on the [Connect] screen.

Directory change Failed to move the working 
directory.

Check that the specified path exists on the server.

Failed to acquire the list.
Upload [File] Uploading failed. • Check that there are no 2-byte character in the selected folder/file 

name.
• Check whether the specified data exists on the client.
• Check whether the path specified on the server exists.
• Check whether there is enough free space on the server.
• Check the server settings.

[Folder] Uploading failed.

Download [File] Downloading failed. • Check that there are no 2-byte character in the selected folder/file 
name.

• Check whether the specified data exists on the server.
• Check whether the path specified on the client exists.
• Check whether there is enough free space on the client storage device.
• Check the server settings.

[Folder] Downloading failed.

Upload
Download

No directory is selected on the 
server side.

Select a folder or file on the server.

No directory is selected on the 
client side.

Select a folder or file on the client.

Delete [File] Deletion failed. • Check whether the path specified on the server exists.
• Check the server settings.[Folder] Deletion failed.

Transfer quitting Failed to quit transferring. Check the network environment.
Connection/upload/dow
nload/delete/refresh/dir
ectory change

Sending a request to the server.
Try again later.

A folder/file is currently being transferred. Try again after transfer is 
complete.

Connected Connection disconnected. • Check the server settings.
• Check the network environment.

(When a request is sent to the server, the client automatically 
disconnects from the server if the request is not acknowledged within 
15 seconds.)

* [Size to transfer], [Transferred 
size], and [Progress] are shown 
per file.
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6.11.8 Checking the Transfer Status
System Device Memory ($s)
The following describes the system device memory.

* “-1” is stored when the data transfer viewer during transfer.

Status Bar
The status bar displays the current data transfer status. 
Press the icon to check the progress of a transfer or the detailed information of the data for transfer. Cancellation of data 
transfer is also possible.

Progress
The file currently being transferred and the progress of the data transfer is displayed.

Record information
The record number of the current data transfer and its detailed information is displayed.

Address Description Remarks
$s1690 Checking of FTP communication status

0: Not communicating
1: Upload (PUT)
2: Download (GET)

← V

$s1691 * Record number in execution
(only when $s1690 is set to 1 or 2)

← V

$s1692 * Server table number in execution
(only when $s1690 is set to 1 or 2)

← V

Uploading
(V10/V9 → server)

Downloading
(V10/V9 ← server)No transfer

Tap to display a window.
Tap again to hide.

Orange Green

* [Size to transfer], [Transferred 
size], and [Progress] are shown 
per file.

* [Record No.] and [Record Name] 
are not displayed when using 
the data transfer viewer.
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Server information
The information of the server with which the current data transfer is being executed is displayed.

Transfer cancellation
The data transfer is forcibly cancelled.

* Data transfer can also be cancelled by a PLC bit command.

6.11.9 Limitations
• Operation when the same data exists at the transfer destination:

- Download (GET): Overwrite
- Upload (PUT): Depends on server settings

• Files for which transfer was cancelled or failed to transfer are not saved at the transfer destination (when downloading 
only).

• When a transfer is cancelled or Ethernet communication is disconnected, all records currently in queue for transfer are 
cancelled.

• The Local mode screen cannot be displayed during data transfer.
• When a request (connection, upload, download, delete, refresh, or directory change) is sent to the server and it is not 

acknowledged within 15 seconds, processing is forcefully terminated and the client disconnects.

For details, refer to “Command device” page 6-106 under “Data Transfer Service Settings.”
For details, refer to “Command device memory” page 6-112 under “Data Transfer Viewer Settings.”
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6.12 Remote Desktop
6.12.1 Overview

• The remote desktop window display function enables you to view remote computer screens on the V10/V9 series. This 
function serves the purpose of remote monitoring through a V10/V9 series unit connected to, for instance, a server 
(computer) that controls the entire production line or computers that are installed in a clean room where access is limited.

• It is also possible to operate the screens of remote computers from a V10/V9 series unit while you are using a mouse and 
keyboard connected to the V10/V9 series unit. You can easily enter data or read manuals through the V10/V9 series unit 
even if you are at the work site where it is difficult to bring a computer with you.

Refer to “6.12.6 Window Configuration and Operation” page 6-141

Example: Monitoring a server (computer) in clean room B

Ethernet

Clean 
room A Clean 

room B
Clean 

room C

Ethernet

Example: Searching for documents on a computer in the office

Office
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6.12.2 Specifications
V10/V9 Specifications

Server (Computer)

6.12.3 Required Settings
Server (computer) settings

•   Installing and Configuring UltraVNC page 6-133 

V10/V9 series unit settings
No settings are required.

V-SFT settings
•   Remote Desktop Table Setting page 6-135 
•   Remote Desktop Window Display Procedure page 6-136  (three methods)

-   Placement of a display area to show remote desktop window page 6-136 
-   Switch to show/hide remote desktop window page 6-138 
-   Showing/hiding using a macro command page 6-139 

Item Description Remarks
Applicable Models All V10/V9 series models
Port used LAN

LAN2
WLAN

Not available with CUR-03

Display scrolling Possible Implemented using scroll bars. Swipe gestures are 
not supported.

Number of simultaneous computer connections 1
USB mouse Supported The left-click button, right-click button, and wheel on 

USB mice are supported.
USB keyboard Supported
Computer screen rotation Possible 0°, 90°, 270°

Full screen to minimized display Possible 100% (actual) to 1/2, 1/3, and 1/4

Item Description
OS Windows 7/8/8.1/10
Protocol TCP/IP

About VNC (Virtual Network Computing)
This software is developed by AT&T Laboratories Cambridge (U.K.) and designed to operate remote computer screens 
across a network.
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6.12.4 Server (Computer) Settings
Installing and Configuring UltraVNC
This section describes the settings necessary for remote desktop window display using UltraVNC as an example.

1. Access the following URL to download UltraVNC.
https://www.uvnc.com/downloads/ultravnc.html

2. Execute the downloaded file to start the installation process.

3. Read the license agreement and if you agree to the terms and conditions, select [I accept the agreement] option and click 
the [Next] button.

4. Check the information displayed in the window and then click the [Next] button.
5. Select the location to install UltraVNC using [Select Destination Location] and then click the [Next] button.
6. Select [UltraVNC Server] and then click the [Next] button.

7. Specify the name and location to use for registering UltraVNC to the start menu and then click the [Next] button.
8. Select the following checkboxes and then click the [Next] button.

Select this checkbox to register UltraVNC 
Server as a Windows service.

Select this checkbox to start or restart the 
UltraVNC service upon completion of 
UltraVNC installation.
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9. Check the information displayed in the [Ready to Install] window and then click the [Install] button.

10. Check the information displayed in the window and then click the [Next] button.
11. Click the [Finish] button to complete the installation process. The UltraVNC icon is added to the taskbar of your computer.

12. Right-click on the UltraVNC icon on the taskbar to display the right-click menu and select [Admin Properties]. Configure 
the following settings and click [OK].

About the UltraVNC icon
UltraVNC must be running on the connected computer in order to display the remote desktop window.
(Nothing is displayed if UltraVNC is not running.) The UltraVNC icon illuminates orange when a connection with a V10/V9 
series unit is established.

About [VNC Password]
The password set here must be entered in V-SFT when configuring the remote desktop table (refer to Remote Desktop 
Table Setting page 6-135).
Take care not to lose your password.

Connected to a V10/V9 series unit (orange)UltraVNC running (green)

* When establishing connections 
with multiple V10/V9 series units, 
select the [Multi viewer 
connections] → [Keep existing 
connections] checkbox.
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6.12.5 V-SFT Settings
Configure the remote desktop table settings and the display settings.

Remote Desktop Table Setting
Register the computer (server) for connection.
Click [System Setting] → [Other] → [Remote Desktop Table Setting] to display the [Remote Desktop Table Setting] window.

Item Description
Local Port No. Select a local port number for the V10/V9 series unit. 

This port is used as the sending/receiving port for remote desktop window display.

Automatic allocation:
   An unused port number on the V10/V9 series unit is allocated for VNC connections.
Specified number:
   The specified port number is used. (default: 8050, range: 1024 to 65533)

Computer Name Specify the name of the server (computer).
IP Address Specify the IP address of the server (computer).
Port No. Specify the port number of the server (computer). (UltraVNC default: 5900)
Password Specify the password. Typing the password shows eight asterisks.

(one-byte 254 alphanumerics maximum)
Auto-reduction Select this checkbox to use the function that zooms out to show the entire computer screen.
PC resolution When the [Auto-reduction] checkbox is selected, specify the resolution of the computer.

(800*600, 1024*768, 1152*864, 1280*1024, 1600*1200, 1920*1080,
specification (width: 800 to 1920, height: 600 to 1200))

Enter the password set in the [UltraVNC Server Property Page] window on the computer. (Refer to step 12 in “Installing and Configuring 
UltraVNC” page 6-133.)
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Remote Desktop Window Display Procedure
There are three ways to display a remote desktop window.

• Placement of a display area to show remote desktop window → page 6-136
• Switch to show/hide remote desktop window → page 6-138
• Showing/hiding using a macro command → page 6-139

Placement of a display area to show remote desktop window
A display area can be placed on a screen to display the remote desktop window of a connected server (computer).
Click [Parts] → [Image Display] → [Remote Desktop Display] and place the part.

Remote Desktop
• Table Select

• Style

Item Description
Remote Desktop No. Click the [Select] button to display the [Remote Desktop Table Setting] window.

Specify the table number of the server (computer) that has been registered in the [Remote Desktop 
Table Setting] window.

Remote Desktop Table Settings This area summarizes the remote desktop table settings.
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• Show/Hide
Configure the show/hide settings of the remote desktop display.

• Detail

Item Description
Additional Parts List Displays a list of remote desktop-related parts.

Selected: Displayed on MONITOUCH.
Unselected: Not displayed on MONITOUCH.

Connect Connect to the server (computer) and enable display of the remote desktop window.
Disconnect Disconnect from the server (computer) and disable display of the remote desktop window.
Connect/Disconnect Each press of this switch toggles between connecting to the server (computer) and 

enabling display of the remote desktop window and disconnecting from the server 
(computer) and disabling display of the remote desktop window.

Show/hide the scroll bar 
(S menu)

Each press of the switch provided with this function toggles between showing and hiding 
the scroll bars and S menu.
However, this function is disabled when displaying the remote desktop window with 
auto-reduction.

Reduce Display/100% Display Each press of this switch toggles between automatic size reduction and actual size display 
of the remote desktop window.

Adjust Position Display the window for adjusting the placement position of each part. Part size can also 
be changed.

Select from catalogs Set the part design from the catalog.
Parts Design Set the design and color of the part selected in the [Additional Parts List] or preview pane.
Edit Selected Parts Configure the part selected in the [Additional Parts List] or preview pane.

For details, refer to Reference Manual 1.

Item Description
Display Setting Display the PC screen at startup of 

MONITOUCH
Display the screen of the connected server (computer) when the V10/V9 unit starts 
up. *1

Automatically zoom out to display 
the entire PC screen at initial 
connection

Automatically zoom out to display the entire computer screen. *2
This option is only effective for the initial connection. From the second and 
subsequent connections, the computer screen is displayed at the actual size.

Coordinate Start X/Start Y Set the position of the display area using X and Y coordinates.
Others ID (0 to 255) Set the ID.

*1 When this checkbox is deselected, use a switch to display the remote desktop window.
*2 The corresponding [Auto-reduction] checkbox in the [Remote Desktop Table Setting] window must be selected. For details, refer to 

“Remote Desktop Table Setting” page 6-135.
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Switch to show/hide remote desktop window
A switch can be placed on a screen to show or hide the remote desktop window of a connected server (computer) at the 
specified coordinates.
Set the switch function to [Remote Desktop Show/Hide].

* Function switch setting is disabled.

Switch Function/Auxiliary Setting Item Description
Remote Desktop:
Remote Desktop Show/Hide

Each press of this switch toggles between showing and hiding the remote desktop 
window. *1

Specify with Mouse The mouse is used to specify the position where the remote desktop window is 
displayed.

Start X Specify an X coordinate as the start point where the remote desktop window is 
displayed.

Start Y Specify a Y coordinate as the start point where the remote desktop window is 
displayed.

Width Specify the width of the area where the remote desktop window is displayed.
Height Specify the height of the area where the remote desktop window is displayed.
Remote Desktop Table No. Click [Select] to specify the table number of the server (computer) that has been 

registered in the [Remote Desktop Table Setting] window.
Auto-reduction on start-up Automatically zoom out to display the entire computer screen. *2

*1 Use the REMOTEDT_CTL macro command to show/hide the scroll bars (S menu). For details, refer to “Showing/Hiding Using a Macro 
Command” page 6-139.

*2 The corresponding [Auto-reduction] checkbox in the [Remote Desktop Table Setting] window must be selected. For details, refer to 
“Remote Desktop Table Setting” page 6-135.

Select the [Display 
All] checkbox to 
enable selection of 
[Remote Desktop].
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Showing/hiding using a macro command
Command list

• SET_REMOTEDT  F0  F1
Function: Showing/hiding the remote desktop window
This macro command is used to show/hide the remote desktop window of the computer (server) set to remote desktop 
table number [F1], which is specified in the [Remote Desktop Table Setting] window, according to the value specified for 
[F0].

Available device memory

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

Operation example
Display in an area based on the specified coordinates (remote desktop table number 10)

$u00100 = 2 (W) for same-sized display based on the 
specified coordinates
$u00101 = 0 (W) for X coordinate as the start point
$u00102 = 0 (W) for Y coordinate as the start point
$u00103 = 400 (W) for width
$u00104 = 300 (W) for height
SET_REMOTEDT  $u00100 10  

Supplementary information
• The SET_REMOTEDT macro command cannot be used unless the relevant settings are configured in the [Remote 

Desktop Table Setting] window. For details on configuration, refer to page 6-135.
• This macro command is not usable as an initial macro.
• The result of macro execution is stored in $s1063.

Category Mnemonic Description Refer to

Remote desktop
SET_REMOTEDT  F0  F1 Show/hide page 6-139
REMOTEDT_CTL F0 F1 F2 Change the display page 6-140

Internal PLC 1 to 8 Constant
F0
F1

Value Remarks
F0 0: Hide

1 : Actual size
2 : Actual size (based on specified coordinates)
3 : Automatically reduced display
4 : Automatically reduced display (based on specified 
coordinates)

F0+1 X coordinate as the start point Valid when F0 = 2 or 4
F0+2 Y coordinate as the start point
F0+3 Width
F0+4 Height

F1 0 to 255: Remote desktop table number

Code (DEC) Description
0 Normal
-1 Execution error

Start point (0, 0)
(400, 0)

Remote Desktop
Display

(400, 300)(0, 300)

Remote desktop table number 10
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• REMOTEDT_CTL  F0  F1  F2
Function: Switching the display in the remote desktop window
This macro command is used to switch the display of the remote desktop window of the computer (server) set to remote 
desktop table number [F1], which is specified in the [Remote Desktop Table Setting] window, according to the value 
specified for [F0].

Available device memory

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)

Range

Operation example
Hiding the scroll bars (S menu) (remote desktop table number 10)

REMOTEDT_CTL  2  10  0 

Supplementary information
• The REMOTEDT_CTL macro command cannot be used unless the relevant settings are configured in the [Remote 

Desktop Table Setting] window. For details on configuration, refer to page 6-135.
• The scroll bars (S menu) cannot be displayed when the auto-reduction function is used to display the computer 

screen.
• The result of macro execution is stored in $s1063.

Internal PLC 1 to 8 Constant
F0
F1
F2

Value
F0 0 : Computer screen reduction

1 : Computer screen rotation
2 : Show/hide scroll bars (S menu)

F1 0 to 255: Remote desktop table number
F2 (F0 = 0) (F0 = 1) (F0 = 2)

0 : Actual size
1 : 1/4
2 : 1/9
3 : 1/16
4 : Auto-reduction

0 : 0°
1 : 90°
2 : 270°

0: Hide
1 : Always displayed
2 : Automatic *

* About the automatic setting

Resolution Scroll Bars (S Menu)
Computer resolution > V10/V9 series resolution Show
Computer resolution = V10/V9 series resolution Hide
Computer resolution < V10/V9 series resolution Hide

Code (DEC) Description
0 Normal
-1 Execution error

Remote desktop table number 10
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6.12.6 Window Configuration and Operation
Window Configuration
When a connection is normally established between a V10/V9 series unit and the server (computer), the remote desktop 
window of the server is displayed on the V10/V9 series unit. When disconnecting, a [Disconnected.] screen is displayed briefly 
and then disappears.

Example: When the [Auto-reduction] checkbox is not selected

* The scroll bars (S menu) cannot be displayed while the auto-reduction function is used.

Scroll bar
If the resolution of the server (computer) is higher than that of the remote desktop window display area, hidden parts in the 
area can be displayed by scrolling either horizontally or vertically with the relevant scroll bar. Swipe gestures are not 
supported.

[S] switch
Pressing this switch shows or hides the [S] menu.

[S] menu
These are special switches for operating the remote desktop window. They are used to perform operations including rotating 
and reducing the size of the display.

Item Description Item Description
ESC Esc key entry ↓ ↓ key entry
SHFT Shift key entry Up Page-up key entry
CTRL Ctrl key entry Down Page-down key entry
ALT Alt key entry R/L OFF: Equivalent to left-clicking the mouse

ON: Equivalent to right-clicking the mouse
ENT Enter key entry Zin Window enlargement:  1/16 → 1/9 → 1/4 → 100% 

(actual)
← ← key entry Zout Window reduction: 100% (actual) → 1/4 → 1/9 → 

1/16
→ → key entry Rot Window rotation: 0°, 90°, 270°

↑ ↑ key entry

S

Handshaking...

ESC SHFT CTRL ALT ENT Up Down R/L Zin Zout Rot

S menu Scroll bar S switch
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Operation Method
A remote desktop connected to the V10/V9 series is operative from the V10/V9 unit by touch screen operations and using a 
USB mouse and USB keyboard.

USB mouse
The left-click button, right-click button, and wheel on USB mice are supported.

USB keyboard
The keyboard language setting must be set in Local mode on the V10/V9 series unit via [Language Setting] → [Keyboard].

6.12.7 System Device Memory
The following addresses in the system device memory are used to store the data regarding the table number (set in the 
[Remote Desktop Display Setting] window) of the remote desktop window currently displayed and whether connection with 
the remote desktop is established.

6.12.8 Error
[Disconnected.] screen
If connection between the V10/V9 series and a server (computer) fails or is disconnected due to a cable disconnection or an 
error, the [Disconnected.] screen appears in place of the remote desktop window. Check the cable and server (computer) and 
attempt reconnection.

Error number
For details on error numbers that occur during data transfer, refer to the following manuals.

- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

When no USB keyboard is used, the on-screen keyboard can be used instead.
The display method differs depending on the Windows version. Display the on-screen keyboard according to the procedure for the relevant 
Windows version.
Example: Windows 7

[Start] → [All Programs] → [Accessories] → [Ease of Access] → [On-Screen Keyboard]

USB mouseUSB keyboard

$s Description Value
1380 Remote desktop window display Start-up status 0 : Hidden (disconnected)

1 : Shown (connected)
1381 Remote desktop window display Connection status 0 or greater: Remote desktop table number

-1 : Disconnected
-2 : Connection failure
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6.12.9 Limitations
Display Limitations

• Remote desktop window display is only available on screens (screen library) and is unavailable for overlap libraries.
• Multiple remote desktop windows cannot be displayed at the same time. If multiple display areas are concurrently placed 

and the [Display the PC screen at startup of MONITOUCH] checkbox is selected, the display area placed first takes effect.
• While a remote desktop window is displayed, attempting to bring up another window on the same screen will disconnect 

the initial window and switch to the next window.
• While a remote desktop window is displayed, any change to the server (computer) resolution will forcibly disconnect the 

window.
• While a remote desktop window is displayed, you can turn it off via a method that is different from the method used to 

display the window, provided that the same remote desktop table number is specified. However, the [Disconnect] switch 
explained in “Placement of a display area to show remote desktop window” page 6-136 does not work to turn off the 
remote desktop window that was displayed by a switch or macro command.

• The remote desktop window is displayed on top of any items with which it overlaps. 
However, the remote desktop window is displayed as a still screen or hidden when overlapped with certain items *1. The 
remote desktop window becomes operable when the relevant item is hidden.

*1 Applicable items: overlap display, scrolling message, navigation display (enlarging/scrolling), message box

• While a remote desktop window is displayed, any switches placed behind the window are invalid. (However, they become 
valid when the remote desktop window is hidden.)

• The display of a remote desktop window is always based on the upper left corner of the server (computer) screen as the 
start point.

• If a remote desktop window display area shows an image smaller than the area, the margin of the area turns black.
• When a remote desktop window is displayed in a display area, disconnecting it leaves the area in the color set in the 

V-SFT.
• When a remote desktop window is displayed by a switch or macro command, hiding it will clear the window as well as its 

display area.
• When a remote desktop window is initially displayed, the image is scaled to 100%.
• Once a remote desktop window is hidden, any settings made on the [S] menu will return to default.
• If disconnection is performed using a switch or macro, the screen is redrawn. Any displayed overlaps also disappear. 

(However, overlaps do not disappear if the [Display Overlap during bit ON] checkbox located at [System Setting] → [Unit 
Setting] → [General Setting] is selected.)

• While a remote desktop window is displayed, switching to Local mode disconnects the window.
• The scroll bars (S menu) cannot be displayed while the screen of a connected server (computer) is displayed using the 

auto-reduction function.
• For the V10/V9 series, the auto-reduction function is available in the range 800*600 (SVGA) to 1920*1080 (Full HD).
• The auto-reduction function adjusts the display of a computer screen to the display area of the remote desktop window 

on the V10/V9 series, provided that the width and the height of the display area is at the ratio of 4 to 3. (At a ratio other 
than this, a black margin will be left in the display area.)

Other Limitations
• The SET_REMOTEDT macro command for displaying the remote desktop window is not usable as an initial macro.
• When the remote desktop window display function and the touch switch emulation of the RGB display function are used 

at the same time, a USB mouse cannot be used for the remote desktop window.

Remote Desktop Window Display Method Remote desktop Remarks
Display area placement Still screen The display area, S menu, and scroll bars 

are inoperable.
Switch function Display area is hidden
Macro command Display area is hidden
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7.1 Enlarging and Scrolling Screens
7.1.1 Overview

Enlarging the Screen Size
Screen sizes larger than the display size (resolution) of the V10/V9 series unit can be registered. When a display is partially 
off-screen, the display can be scrolled to display the off-screen content. A navigation display (a miniaturized display of the 
entire screen) is shown during scrolling to indicate the current display position.

Location of Settings
• Screen
• Overlap

Enlarged Display
The display of the screen can be enlarged up to 200% by double-tapping on the screen. After enlarging the screen, the display 
can be scrolled to show off-screen content.

* After enlargement to the maximum magnification, the screen display returns to its original size.

For details on settings, refer to “Enlarging the Screen Size” page 7-2.

For details on settings, refer to “Enlarged Display” page 7-3.

MONITOUCH display

Navigation displayScroll

Off-screen area

Off-screen area

Double-tap

Before enlargement After enlargement
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7.1.2 Setting Example
Enlarging the Screen Size
This section explains the settings used when displaying and scrolling a screen that is two times larger in horizontal direction 
than the display of the V10/V9 series unit.

1. Display the scrolling settings
• For screens: [Screen Setting] → [Screen Setting] → [Scroll] tab window
• For overlaps: Overlap setting window → [Scroll] settings

2. Set [Magnification] to “1 times vertical × 2 times horizontal”.

This completes the necessary settings.
The screen size is extended two fold in the horizontal direction.
Scrolling becomes available on the MONITOUCH.

2 times

Screen size

1 times

Display size

Screen size: 2 times horizontal

Display size
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Enlarged Display
This section explains the settings for enlarging the display by double-tapping on the screen.

1. Display the [Screen Setting] → [Screen Setting] → [Scroll] tab window.
2. Select the [Enlarge] checkbox and set a magnification.

This completes the necessary settings.
The magnification switches through 150% → 200% → 100% each time the screen is double-tapped.

When the screen is enlarged, any overlaps displayed on the screen are not enlarged.

Double-tap

Before enlargement After enlargement
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7.1.3 Detailed Settings
Screen
Location of settings: [Screen Setting] → [Screen Setting]

Scroll

Item Description
Screen Size Displays the screen size.
Coordinate Device Stores the coordinates of the current display position (upper left). Two words are occupied consecutively. 

Unit: dots
n: X coordinate
n + 1: Y coordinate
The display position can also be changed by specifying coordinates. However, if a value that exceeds the 
maximum value is specified, the screen is displayed at the maximum value and the maximum value is written 
to the coordinate device memory.

Magnification Set the editing size of the screen.
1 times vertical × 1 times horizontal / 1 times vertical × 2 times horizontal 
1 times vertical × 3 times horizontal / 1 times vertical × 4 times horizontal
2 times vertical × 1 times horizontal / 2 times vertical × 2 times horizontal 
3 times vertical × 1 times horizontal / 4 times vertical × 1 times horizontal

Enlarge Double-tap on the screen to zoom in. The current magnification is output to $s1641. If the enlargement 
setting is not selected, $s1641 always stores “100”.

Example: SVGA, 2 times vertical * 2 times horizontal

Position
(400, 300)

- When n = 400, n + 1 = 300 is specified 
(normal values)

Display position
= max. value
(800, 600)

- When n = 2000, n + 1 = 3000 is specified 
(outside range)

(0, 0) (800, 0) (1600, 0)

(0, 600)

(0, 1200)

(0, 0) (800, 0) (1600, 0)

(0, 600)

(0, 1200)

* 800 is written to “n” and 600 is written to 
“n + 1” in the coordinate device memory.

Example: 1 times vertical × 4 times horizontal
V10/V9 unit resolution: 800 × 600 pixels Screen size: 3200 × 600 pixels
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Display a navigator during 
scroll

Show a miniaturized display of the entire screen when scrolling.

Size Set the size of the navigation window (as a percentage of the screen resolution of the V10/V9 series unit). 
Small (15%), Medium (20%), Large (25%)

Position Set the display position of the navigation window. Lower Right, Lower Left, Upper Right, Upper Left
Display a scroll bar during 
scroll

Display a scroll bar at the right edge and bottom when scrolling. The scroll bar itself cannot be operated.

Enable inertial scrolling Allow scrolling to continue after releasing your finger from the screen when scrolling. The speed of scrolling 
gradually decreases until it stops.

Enable bounce scrolling Scrolling will bounce to indicate that movement in the particular direction has reached its limit. A black bar is 
displayed momentarily.

Apply to all screens Apply the same settings to all screens.

Item Description

Navigation display
Current display position

Scroll and then 
release finger Scrolling continues

Right edge of the screen Black bar Right edge of the screen
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Overlap
Scroll

Item Description
Size Displays the size of the overlap.
Coordinate Device Stores the coordinates of the current display position (upper left). Two words are occupied consecutively. 

Unit: dots
n: X coordinate
n + 1: Y coordinate
The display position can also be changed by specifying coordinates. However, if a value that exceeds the 
maximum value is specified, the screen is displayed at the maximum value and the maximum value is written 
to the coordinate device memory.

Magnification Set the editing size of the overlap.
1 times vertical × 1 times horizontal / 1 times vertical × 2 times horizontal / 
1 times vertical × 3 times horizontal / 1 times vertical × 4 times horizontal
2 times vertical × 1 times horizontal / 2 times vertical × 2 times horizontal / 
3 times vertical × 1 times horizontal / 4 times vertical × 1 times horizontal

Display a scroll bar during 
scroll

Display a scroll bar at the right edge and bottom when scrolling. The scroll bar itself cannot be operated.

Enable inertial scrolling Allow scrolling to continue after releasing your finger from the screen when scrolling. The speed of scrolling 
gradually decreases until it stops.

Example: SVGA, 2 times vertical * 2 times horizontal

Position
(400, 300)

- When n = 400, n + 1 = 300 is specified 
(normal values)

Display position
= max. value
(800, 600)

- When n = 2000, n + 1 = 3000 is specified 
(outside range)

(0, 0) (800, 0) (1600, 0)

(0, 600)

(0, 1200)

(0, 0) (800, 0) (1600, 0)

(0, 600)

(0, 1200)

* 800 is written to “n” and 600 is written to 
“n + 1” in the coordinate device memory.

Example: 1 times vertical × 4 times horizontal
V10/V9 unit resolution: 300 × 200 pixels Overlap size: 1200 × 200 pixels

Scroll and then 
release finger Scrolling continues
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Enable bounce scrolling Scrolling will bounce to indicate that movement in the particular direction has reached its limit. A black bar is 
displayed momentarily.

Item Description

Right edge of the screen Black bar Right edge of the screen
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7.1.4 Notes
• Scrolling cannot be performed at locations where there are switches.
• Magnification defaults to 100% after changing screens or executing the “RESET_SCRN” macro command.
• Navigation items cannot be operated. In addition, items placed under the navigation window cannot be operated.
• Increasing the editing size does not change the number of items that can be placed on the screen.
• The display size of the V10/V9 series unit is the maximum editing size for patterns.
• When an overlap transition is in progress, screen enlargement and scrolling cannot be performed. In addition, if an 

overlap transition is initiated during screen enlargement or scrolling, the transition only starts after the enlargement or 
scrolling operation is finished.
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7.2 Splash Screen
7.2.1 Overview

An image prepared by the user can be used as the splash screen which is displayed while the V10/V9 series unit is starting up.
Images relevant to the usage environment, such as a company logo or precautions can be displayed.
The set image will also be displayed when switching between RUN mode and Local mode.

Startup sequence

Splash Screen
A splash screen is an image displayed on a computer while software is starting up.

Data Loading...

xxxxx

Power ON

RUN mode

Display an image 
prepared by the user.

Possible to show/hide the 
progress bar in the settings.

Splash Screen

V10 V9
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7.2.2 Setting Example
This section explains how to set the following image as the splash screen.

1. Prepare a PNG file, e.g. Splash.png

2. Select the [File] → [Property] → [Splash Screen] → [Specify the splash screen] checkbox.

3. Click [Select from image files] → [Select] and select the PNG file prepared in step 1.

4. Set the display position of the image under [Position Setting].

This completes the necessary settings.

The following image is displayed when the [Specify the splash screen] checkbox is not selected.

Filename: Splash.png

The image is copied to the 
following location when selected.

C:\MONITOUCH\User\Splash

V10 V9
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7.2.3 Detailed Settings
Location of settings: [File] → [Property] → [Splash Screen]

Splash Screen

Item Description
Specify the splash screen Display a user-prepared image on the screen during startup.
Select from image files Select a PNG file from the desired folder. File extension: png

The selected png file is stored at the following location.
C:\MONITOUCH\User\Splash

Select from patterns Select a pattern registered in the screen program.
Patterns are registered at [Home] → [Registration Item ] → [Pattern].

Position Setting Specify the display position of the image.
Fit to Screen/Fit to Width/Fit to Height/Display in Center

Hide progress bar during 
startup

Select this checkbox to hide the progress bar at the bottom of the screen.
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7.2.4 Notes
• Any area outside the image is displayed in black.
• Patterns set to blink are displayed without blinking.
• When a PNG file is modified, it must be reselected from [Select from images] → [Select].
• If opening a screen program in which PNG files are selected on a different computer or reading the screen program from 

the V10/V9 series unit, the PNG file is stored at the following location. If a filename with the same name already exists, it 
is overwritten.  

C:\MONITOUCH\User\Splash
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8.1 Overview
8.1.1 Connections

The SD card interface and USB-A port are provided on the V10/V9 series unit as standard features. Connecting commercially 
available SD cards and USB memory devices (referred to hereafter as storage devices) enables them to be used for a variety of 
functions including screen program transfer, saving of logging data, and saving of screenshot images.

Example: V9100iS rear

8.1.2 Storage Device Specifications
Specifications
The following storage devices can be used with the V10/V9 series.

Notes on Handling Storage Devices
• When inserting an SD card into the unit, make sure to insert it in the correct orientation. Failure to do so may damage the 

SD card or the slot on the unit.
• The SD card access LED flashes red when the SD card is being accessed. Do not remove the SD card while the LED is 

flashing. Doing so may destroy data on the SD card.
• Always remove the SD card with [System Menu] → [Storage Removal] or with the [Storage Removal] switch.
• Do not turn off MONITOUCH during access to a storage device.
• Make a backup copy of storage devices at regular intervals.
• If a disk error occurs and data read/write operation is disabled, execute ScanDisk on Windows and try to restore the disk. 

If the disk cannot be restored, format the storage device. If you format the device, data on the device is completely lost. 
(For details on scanning the disk or Windows operations, refer to the Windows help information.)

• The number of write cycles for a storage device is limited. Consequently, frequent writing at short intervals may shorten 
the service life of storage devices. When using an SD card to save logging/alarm data, be aware of the logging 
time/monitoring frequency setting. Be sure to avoid constantly writing to an SD card with the CYCLE macro command.

• Note that the amount of the data to be written should not exceed the memory capacity of the storage device. In 
particular, when using functions to write data from the V10/V9 series unit to a storage device, such as backing up logging 
data, saving screen programs, saving screenshot images, or transferring recipe data, always consider the capacity limit of 
the storage device. Note that the amount of free space on a storage device can be checked with system device memory.

• If a screen program that uses storage device functions loaded onto the V10/V9 series unit, be sure to insert the relevant 
storage device before running the screen program.

Enlarged view
SD card orientation

SD card 
pictured on 

the unit

USB flash 
drive

Type Capacity File System Connection Port Remarks
SD card Max. 2 GB FAT, FAT32 Built-in SD card socket
SDHC card 4 to 32 GB FAT32
SDXC card 64 GB to 2 TB exFAT V9 is not supported.
USB flash drive Max. 32 GB FAT, FAT32 USB-A
CF card Max. 32 GB USB-A

(Supported by using Hakko Electronics’ CF card 
recorder “USB-CFREC” (hardware version c or 
later) with V9 system program Ver. 1.430 and OS 
Ver. 2.90)
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8.2 Access Folders
8.2.1 Access Folders

• Access folders are folders which are accessed regularly in RUN mode.
An access folder is created when a screen program is written using storage manager.
Access folders are also created when a formatted storage device is connected to MONITOUCH and a writing operation is 
executed.

• The access folder name is specified in the screen program.
Location of setting: [System Setting] → [Other] → [Storage Setting] → [Access Folder Name]

• If creating access folders with names differing by each screen program, multiple screen programs can be saved in 
respective folders as long as there is sufficient capacity on the storage device.

“Storage Device Settings” page 8-3

ALARM

SRAM

BITMAP

DSP
HDCOPY
JPEG

LIST
LOGGING
MEMO

RECIPE

OPELOG

SCRN
SNAP

WAV

EXT0000

MSG

EXT0001

EXT0002

PDF

LADDER

VIDEO

DATABASE

PICTURE

Storage device

Access folder

Access folder
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8.2.2 Storage Device Settings
Settings including the storage connection target, access folder name, and other storage-related items are configured in the 
[Storage Setting] window.
[System Setting] → [Other] → [Storage Setting] 

*1 These are recognized as uppercase characters. If inputting lowercase characters on the editor screen, they are converted into uppercase 
characters when [OK] is clicked, and are recognized as uppercase characters on MONITOUCH.

*2 When using the “HDCOPY3” command with the extension specified in the filename as “*.JPG” or “*.PNG”, data is saved in the format 
specified in the macro.

*3 Old backup files can also be deleted by selecting the [Delete folders from the oldest if Storage is lacking in space for backup] and [Delete 
folders from the oldest when the remaining storage space is less than 100 MByte] checkboxes at [System Setting] → [Unit Setting] → 
[General Settings].

Item Description
Storage Connection Target Select the location of the storage device for access in RUN mode.

Built-in Socket
USB Port

Access Folder Name Set a different folder name for each screen program. (default: EXT0000)
One-byte characters: 64 characters or less (not case-sensitive) *1
Two-byte characters: 32 characters or less

If the same folder name already exists, data will be overwritten.
Range of Patterns to be 
Saved to storage

Store pattern data on the storage device.

Range of Messages to be 
Saved to storage

Store messages on the storage device.

Range of Screens to be Saved 
to storage

Store screens on the storage device.

Store WAV File in storage Store audio files on the storage device.
* Not supported on V9 Lite models

Store 3D Parts in storage Store images for 3D parts on the storage device.
Store Windows Font in 
storage

Store Windows fonts on the storage device.

Store HDCOPY Macro in JPEG 
Format

Set the file format for saving data to a storage device when using the “HDCOPY”, “HDCOPY2”, or “HDCOPY3” 
macro commands (with only filename specified and no extension specified *2).
Unselected

Save as a PNG file.
Selected

Save as a JPEG file.
Use Password When 
Transferring Screen to 
storage from Display

Password: Maximum of 6 one-byte alphanumeric characters
A password can be set for when transferring data from MONITOUCH to storage on the [Storage Transfer] 
screen in Local mode. This setting is valid even if no password is set.

Deletes the backup folder *3 Deletes backup folders older than the set number of days from the V10/V9 series unit calendar.
Setting range: 30 to 2,000 days
Items to delete:

- Items in the “LOGGING” folder for the logging server
- Items in the “ALARM” folder for the alarm server
- Items in the “LIST” folder for outputting datasheet PDFs
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8.2.3 Folder Configuration
The following table lists the folder names and names of files in each folder.

Access folder (EXT0000)
Folder Name Description Filename Transfer Direction Refer to
ALARM Alarm history ALARM00.BIN - ALARM11.BIN *1

ALARM00.BIN-journal -
ALARM11.BIN-journal *2

EVENT00.BIN - EVENT11.BIN *1

EVENT00.BIN-journal - EVENT11.BIN-journal *2
ALARM_aa_bb.CSV *1
(aa: Block No., bb: No.)
(arbitrary filename).CSV *1 *3
ALARMxx_nnn_XX_YYYYMMDDHHMMSS.mp4

V10/V9 ← storage device *7
V10/V9 → storage device

page 8-27

BITMAP Pattern data BMP0000.BIN to BMP1023.BIN V10/V9 ← storage device page 8-19
DATABASE MES database file

(stand-alone configuration)
(arbitrary filename).db *4 V10/V9 → storage device page 8-29

DSP Screen program DSP0000.BIN V10/V9 ← storage device
V10/V9 → storage device

page 8-7

HDCOPY Screenshot image HD0000.PNG - HD9999.PNG
HD000~yy.PNG - HD999~yy.PNG
(arbitrary filename).PNG *3

V10/V9 → storage device page 8-28

JPEG JPEG file JP00000.JPG - JP32767.JPG
(arbitrary filename).JPG *3

V10/V9 ← storage device page 8-23

LADDER Ladder monitor files Differs by PLC *5 V10/V9 ← storage device
V10/V9 → storage device

page 8-27

LIST Data sheet PDF output LISTxxxx.PDF *6
(arbitrary filename)xxxx.PDF*3 *6
(xxxx: Top page number (only when overwriting 
is selected))

V10/V9 → storage device page 8-29

LOGGING Logging data LOGGING00.BIN - LOGGING11.BIN *1
LOGGING00.BIN-journal

- LOGGING11.BIN-journal *2
LOGGING_aa_bb.CSV *1
(aa: Block No., bb: No.)
(arbitrary filename).CSV *1 *3

V10/V9 ← storage device *7
V10/V9 → storage device

page 8-28

MEMO Memo pad data MEM0000.PNG - MEM0007.PNG V10/V9 → storage device page 8-30
MSG Message file MSGxxyyy.BIN

MSGxxyyy.TXT
V10/V9 ← storage device page 8-19

page 8-21
OPELOG Operation log file OPELOG_hhmmss.BIN  (For V10)

OPELOG_hhmmss.DB  (For V9)
V10/V9 ← storage device
V10/V9 → storage device

page 8-28

PDF PDF file PDF00000.pdf to PDF99999.pdf
(arbitrary filename).pdf *3

V10/V9 ← storage device
V10/V9 → storage device

page 8-25

PICTURE Image file PICT00000.JPG to PICT99999.JPG
(arbitrary filename).JPG *3
PICT00000.PNG to PICT99999.PNG
(arbitrary filename).PNG *3
PICT00000.BMP to PICT99999.BMP
(arbitrary filename).BMP *3

V10/V9 ← storage device page 8-24

RECIPE Recipe data REC0000.CSV - REC9999.CSV
(arbitrary filename).CSV *3
REC0000.BIN - REC9999.BIN
(arbitrary filename).BIN *3

V10/V9 ← storage device
V10/V9 → storage device

page 8-27

SCRN Header file SCHEADER.BIN V10/V9 ← storage device page 8-19
Screen file SC0000.BIN to SC9999.BIN
Component parts
(Macro blocks)

MCR0000.BIN to MCR1023.BIN

Component parts
(messages)

MSG0000.BIN to MSG0011.BIN

3D part file 3D0001.BIN to 3D1023.BIN
Windows font file
(for screen creation)

WFS0000.BIN to WFS4095.BIN

Windows font file 
(messages)

WFM0000.BIN to WFM4095.BIN

SNAP Snapshots from video/RGB 
display, network camera, 
and USB camera

VD00000.JPG to VD32767.JPG V10/V9 → storage device page 8-29
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*1 When saving to a backup folder, the year, month, day, hour, minutes, and seconds (_yyyymmddhhmmss) are added to the end of the 
filename.
E.g.: ALARM00_20140320150040.BIN

*2 Temporary file during data update (V9 only)
*3 Filename: 64 or less one-byte uppercase alphanumeric characters or 32 or less two-byte characters
*4 Filename: 32 or less one-byte alphanumeric characters (two-byte characters invalid)
*5 For more information, refer to the Ladder Monitor Specifications manual.
*6 When a timestamp is added, the year, month, day, hour, minute, and second (_yyyymmddhhmmss) are appended to the filename.

Example: LIST0000_20140320150040.PDF
*7 BIN files only

Automatic upload (DSPDEF)

OS update (V10: OSUPDATE_100, V9: OSUPDATE)

SRAM SRAM backup data SRM0000.BIN V10/V9 ← storage device
V10/V9 → storage device

page 8-30

VIDEO Video playback file MOV00000.mp4 to MOV99999.mp4
(arbitrary filename).mp4 *3

V10/V9 ← storage device page 8-26

WAV WAV files for audio output WA0000.WAV - WA9999.WAV
(arbitrary filename).WAV *3

V10/V9 ← storage device page 8-22

Folder Name Description Filename Transfer Direction Refer to
DSP File for automatic uploading DSPDEF.bin V10/V9 ← storage device page 8-9
Other folders Same as the access folder

Description Filename Transfer Direction Refer to
OSUPDATE_100

File for updating the operating system for V10 series

OSUPDATE
File for updating the operating system for V9 series

fw.conf
etc.

V10/V9 ← storage device page 8-11
page 8-15

Folder Name Description Filename Transfer Direction Refer to
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8.3 Function Descriptions
8.3.1 List of Functions

The following table lists the functions used by storage devices. For details, refer to the corresponding reference.
Function Refer to

Saving and transferring screen programs page 8-7
Automatically uploading screen programs page 8-9
Manual OS updating page 8-11
Automatic OS updating page 8-15
Reduction of screen program data size Storing pattern (bitmap) data page 8-19

Storing screen data
Storing 3D parts
Storing Windows fonts
Storing message data page 8-19, page 8-21

Storing audio (WAV) files page 8-22, “2 Sound”
Storing JPEG data (JPEG display) page 8-23, “1.3 JPEG Display”
Storing image files (picture viewer) page 8-24, “16 Picture Viewer”
Storing PDF files page 8-25, “13 PDF Viewer”
Recipe data page 8-27, “15 Recipes” in Reference Manual 1
Saving alarm history page 8-27, “8 Alarm” in Reference Manual 1
Saving logging data page 8-28, “7 Trend” in Reference Manual 1
Operation logs page 8-28, “4 Operation Log”
Saving screenshot images page 8-28, Macro Reference Manual
Storing snapshot images from a video/RGB display, network camera, and 
USB camera

page 8-29, “1.1 Video/RGB Display”, “1.2 USB Camera 
Display”, “1.4 Network Camera”

PDF output of data sheets page 8-29, 16.3 “Printing Data Sheets” in Reference Manual 1
Saving MES (stand-alone) database files page 8-29, “6.7 MES Interface Function”
Memo pad data backup page 8-30, 13.1 “Memo Pad” in Reference Manual 1
SRAM data backup page 8-30, 

V10 Series Unit Operation / Local Mode / Error Screen Manual
V9 Series Troubleshooting/Maintenance Manual
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8.3.2 Screen Program Transfer
Screen programs can be transferred between the V10/V9 series unit and a storage device.
Because multiple screen programs can be saved on a storage device, the screen program for display can be switched as 
required.
This section describes how to read and write data between a PC and a storage device. For details on reading and writing 
between a storage device and the V10/V9 series unit, refer to the following manuals.

- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

PC → Storage Device Writing
1. Start V-SFT.
2. Click [File] → [Storage Manager]. The window for specifying a drive is displayed.
3. Specify the drive where the storage device is inserted and click [OK]. The [Storage Manager] window *1 is displayed.

*1 Storage manager
The storage manager is an application that facilitates writing of V10/V9 screen programs to a storage device, and importing of data from 
a storage device for conversion into other file formats. For details, refer to “8.4 Storage Manager” page 8-31.

4. Click [Storage Setting] → [Write to Storage]. The [Write to storage] window is displayed.
Configure the following settings.

Item Description
Write Data Being Edited Write the screen program that is open (being edited) in V-SFT.

A

B

C

DSP
DSP0000.bin

DSP
DSP0000.bin

DSP
DSP0000.bin

Storage device
Access folder name

Multiple screen programs can be stored using different access folder names.
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5. When the settings are complete, click [OK]. A “DSP0000.BIN” file is saved to “(access folder)\DSP” on the storage device. 
The “DSP0000.BIN” file contains the screen program, system program, fonts, I/F driver etc.

Storage Device → PC Reading
1. Start V-SFT.
2. Click [File] → [Storage Manager]. The window for specifying a drive is displayed.
3. Specify the drive where the storage device is inserted and click [OK]. The [Storage Manager] window is displayed.
4. Check that “DSP0000.BIN” exists in the “DSP” folder in the access folder, and select the file.
5. Right-click on the file and select [Put BIN File Back].

6. The window shown below is displayed. Specify the folder to save in and the filename and click [Save].

Path of Screen Data File to Be 
Converted

Select the screen program for writing to the storage device from the [Open] button.
[Screen Data File (*.V10)], [Screen Data File (*.V9)]

DSP0000.BIN File Comment Add a comment to the screen program file (DSP0000.BIN) written to the storage device.
This comment can be checked via the file’s [Property] window.

Automatic Upload (This is not for screen program transfer.)_
Do Not Overwrite Port No. 
Table/FROM Backup Area

Select this checkbox to prevent existing values in the station number table or existing values in the 
FROM area from being changed when transferring a screen program from a storage device.

Item Description



8.3    Function Descriptions

8-9

1

2

3

4

5

6

7

8

9

10

8.3.3 Automatically Uploading Screen Programs
When a storage device is inserted and the power is turned on, the screen program is automatically uploaded.
This allows the screen program to be easily updated without bothering the operator.

PC → Storage Device Writing
1. Start V-SFT.
2. Click [File] → [Storage Manager]. The window for specifying a drive is displayed.
3. Specify the drive where the storage device is inserted and click [OK]. The [Storage Manager] window *1 is displayed.

*1 Storage manager
The storage manager is an application that facilitates writing of V10/V9 screen programs to a storage device, and importing of data from 
a storage device for conversion into other file formats. For details, refer to “8.4 Storage Manager” page 8-31.

4. Click [Storage Setting] → [Write to Storage]. The [Write to storage] window is displayed.
Configure the following settings.

For the recommended capacity of a storage device, refer to “8.1.2 Storage Device Specifications” page 
8-1.

Data1 Data2
Loading from Storage. 50

120
350

DSPDEF

EXT0000

DSP
DSPDEF.bin

Power OFF Power ON

Insert storage device
and turn DIP switch ON.

When the power is turned 
on, the screen program is 
automatically transferred.

Storage device
Folder for automatic uploading
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5. When the settings are complete, click [OK]. A “DSPDEF.BIN” file is saved to “DSPDEF\DSP”. The “DSPDEF.BIN” file contains 
the screen program, system program, fonts, I/F driver etc.

Operation on the V10/V9 Series
After storing data on the storage device, import the data into the V10/V9 series unit according to the following procedure.

1. Turn off the V10/V9 series unit.
2. Set DIPSW1 on the V10/V9 series unit to ON.
3. Insert the storage device into the V10/V9 series unit.
4. Turn on power to the V10/V9 series unit. After a “Data Loading” message, a “Loading from Storage” message is displayed, 

and then the screen program saved to the storage device is written.
When transfer is complete, the RUN screen (or Local mode) is displayed automatically.

Notes on Write Operations
• When using the “DSPDEF” screen program for automatic uploading, only one type of data can be stored per storage 

device.
• If the storage device is removed after automatic uploading and the power is turned off and on again, the message “Insert 

Storage in V10 (or V9).” is displayed and the V10/V9 series unit does not start correctly. Insert the storage device or set 
DIPSW1 to OFF, and then turn the power off and back on.

• Once automatic uploading has been performed, the screen program that was written to the V10/V9 series unit (including 
I/F drivers, fonts, etc.) is overwritten by the screen program that was automatically uploaded. Note that even if the storage 
device is removed and DIPSW1 is set to OFF again, it is not possible to restore the state before to the upload.

Item Description
Write Data Being Edited Write the screen program that is open (being edited) in V-SFT.
Path of Screen Data File to Be Converted Select the screen program for writing to the storage device from the [Open] button.

[Screen Data File (*.V10)], [Screen Data File (*.V9)]
DSP0000.BIN File Comment Add a comment to the screen program file (DSP0000.BIN) written to the storage 

device. This comment can be checked via the file’s [Property] window.
Automatic Upload Create an automatic upload file.

System Program Transfer Select this checkbox when uploading system program files together with the screen 
program.

Run after System Program 
Transfer

Automatically switch MONITOUCH to RUN mode after automatic upload is complete.

Do Not Overwrite Port No. Table/FROM Backup 
Area

Select this checkbox to prevent existing values in the station number table or existing 
values in the FROM area from being changed when transferring a screen program 
from a storage device.
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8.3.4 Manually Updating the Operating System
This section describes the procedure for manually updating the operating system for operating the V10/V9 series unit.
The operating system version can be checked from the System Information screen in Local mode on the V10/V9 series unit.

Notes
• Before updating the operating system, creating a backup of the screen program and other data such as SRAM data is 

recommended to guard against data loss.
• When the operating system is updated the system program is automatically updated as well.
• It takes approximately a few minutes to update the operating system. During the update, never turn off the power of the 

V10/V9 series unit or remove the storage device.
• When both an SD card and a USB flash drive are connected to the V10/V9 series unit, the SD card takes priority.
• Only one instance of the “OSUPDATE“ folder for V9 or “OSUPDATE_100“ folder for V10, which is used for updating the 

operating system, can be stored per storage device.

PC → Storage Device Writing
1. Start V-SFT.
2. Click [File] → [Storage Manager]. The window for specifying a drive is displayed.
3. Specify the drive where the storage device is inserted and click [OK]. The [Storage Manager] window *1 is displayed.

*1 Storage manager
The storage manager is an application that facilitates writing of V10/V9 screen programs to a storage device, and importing of data from 
a storage device for conversion into other file formats. For details, refer to “8.4 Storage Manager” page 8-31.

For the recommended capacity of a storage device, refer to “8.1.2 Storage Device Specifications” page 
8-1.

EXT0000

OSUPDATE

OSUPDATE_100

Storage device

Local mode 
screen

OS update in progress

V9 series

V10 series



8  Storage Device

8-12

4. Click [Storage Setting] → [Write to Storage]. The [Write to storage] window is displayed.
Configure the following settings.

5. When the settings are complete, click [OK]. The following files are saved to the “OSUPDATE“ folder.

Click on [Property] on the right-click menu of the “fw.conf“ file to view the operating system version.

Item Description
Write Data Being Edited *1 Write the screen program that is open (being edited) in V-SFT.

Path of Screen Data File to Be Converted *1 Select the screen program for writing to the storage device from the [Open] button.
[Screen Data File (*.V10)], [Screen Data File (*.V9)]

Write OS Select this checkbox to enable manual updating.
*1 Selection of a screen program is necessary. Operating system data can only be written together with a screen program.
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Operation on the V10/V9 Series
After writing the data on a storage device, update the operating system according to the following procedure.

1. Turn off the V10/V9 series unit.
2. Connect the storage device to the V10/V9 series unit and turn on power to the V10/V9 series unit.
3. Press the [SYSTEM] switch to display the system menu and then press the [Local] switch. The V10/V9 series unit switches 

to Local mode.
4. Check the [Program Ver.] and [OSVer] on the System Information screen.
5. Press the [OS Update] menu switch on the OS Update screen *1.

*1 The [OS Update] menu switch is displayed at the very bottom of the menu switches only when a storage device 
containing an “OSUPDATE“ folder is connected.

6. The following confirmation dialog appears. Press [Execute]. Updating of the operation system starts.

7. The V10/V9 series unit reboots and the screen will be black for a short while.

While the operating system is being updated, never turn off the power of the V10/V9 series unit or remove the 
storage device.

Black screen
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8. The following screen is displayed while the operating system is being updated.

9. When the update completes without any errors, the following screen is displayed and the V10/V9 series unit 
automatically reboots.

10. Press the [SYSTEM] switch and switch to Local mode from the displayed system menu. Check that the [Program Ver.] and 
[OSVer] have respectively been updated.

V10

V9
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8.3.5 Automatically Updating the Operating System
This section describes the procedure for automatically updating the operating system for operating the V10/V9 series unit. 
The operating system and system program can be updated automatically by connecting a storage device to the V10/V9 series 
unit and turning the power on.
The operating system version can be checked from the System Information screen in Local mode on the V10/V9 series unit.

Notes
• Before updating the operating system, creating a backup of the screen program and other data such as SRAM data is 

recommended to guard against data loss.
• When the operating system is updated the system program is automatically updated as well.
• It takes approximately a few minutes to update the operating system. During the update, never turn off the power of the 

V10/V9 series unit or remove the storage device.
• When both an SD card and a USB flash drive are connected to the V10/V9 series unit, the SD card takes priority.
• If the storage device is removed with DIP switch 1 left ON after automatic updating and the power is turned off and on 

again, the message “Insert Storage in V10 (or V9).“ is displayed and the V10/V9 series unit does not start correctly. If the 
storage device is left connected with DIP switch 1 left ON and the power is turned off and on again, automatic updating is 
performed again. Be sure to set DIP switch 1 to OFF after updating and then turn on the power.

PC → Storage Device Writing
1. Start V-SFT.
2. Click [File] → [Storage Manager]. The window for specifying a drive is displayed.
3. Specify the drive where the storage device is inserted and click [OK]. The [Storage Manager] window *1 is displayed.

*1 Storage manager
The storage manager is an application that facilitates writing of V10/V9 screen programs to a storage device, and importing of data from 
a storage device for conversion into other file formats. For details, refer to “8.4 Storage Manager” page 8-31.

For the recommended capacity of a storage device, refer to “8.1.2 Storage Device Specifications” page 
8-1.

Data1
Loading from Storage. OS Update is completed.

V9 will restart.

DSPDEF

OSUPDATE

DSP
DSPDEF.bin

OSUPDATE_100or

Storage device

Connect storage device
and turn DIP switch 1 ON.

When the power is turned on, 
the operating system, system 
program, screen program, and 
font data is automatically 
transferred.

V9 series V10 series
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4. Click [Storage Setting] → [Write to Storage]. The [Write to storage] window is displayed.
Configure the following settings.

5. When the settings are complete, click [OK]. A “DSPDEF.BIN“ file is saved to “DSPDEF\DSP“. The “DSPDEF.BIN“ file contains 
the screen program, system program, fonts, I/F driver etc.
The following files are saved to the “OSUPDATE“ folder.

Click on [Property] on the right-click menu of the “fw.conf“ file to view the operating system version.

Item Description
Write Data Being Edited *1 Write the screen program that is open (being edited) in V-SFT.

Path of Screen Data File to Be Converted *1 Select the screen program for writing to the storage device from the [Open] button.
[Screen Data File (*.V10)], [Screen Data File (*.V9)]

Automatic Upload Create an automatic upload file.
Transfer OS Select this checkbox when transferring the operating system together with the screen 

program.
The system program is transferred as well.

*1 Selection of a screen program is necessary. Operating system data can only be written together with a screen program.

File for updating the operating system
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Operation on the V10/V9 Series
After writing the data on a storage device, update the operating system according to the following procedure.

1. Turn off the V10/V9 series unit.
2. Connect the storage device to the V10/V9 series unit.
3. Set DIPSW1 on the V10/V9 series unit to ON.
4. Turn on power to the V10/V9 series unit. The following message is displayed.

*  The “Loading from Storage“ message may be displayed.

5. The following message appears.

6. The screen turns black for a short while.

While update is in progress, never turn off the power of the V10/V9 series unit or remove the storage device.

V10

V9

Black screen
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7. The following screen is displayed while the operating system is being updated.

8. When the update completes without any errors, the following screen is displayed and the V10/V9 series unit 
automatically reboots.

9. The “Loading from Storage“ message is displayed again, and then the screen program saved to the storage device is 
written. When transfer is complete, the V10/V9 series unit automatically switches to RUN mode.

10. Switch to Local mode from the system menu. Check that the [Program Ver.] and [OSVer] have respectively been updated.

V10

V9
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8.3.6 Reducing Screen Program Data Size
Part of the screen program data, such as screens, patterns and messages, can be stored to a storage device. This can reduce 
the size of the actual screen program data.

• Pattern files (bitmap)
• Messages (BIN files, TXT files *1)
• Screens (Max. 4000)
• 3D parts
• Windows fonts
*1 Messages can be saved to a storage device as a BIN file or TXT file. For details on saving a TXT file, refer to “8.3.7 Storing 

Messages (TXT Files)” page 8-21.

File Storage Location and Filename

PC → Storage Device Writing
1. Configure the following settings on the screen program in advance. Click [System Setting] → [Storage Setting].

The [Storage Setting] window is displayed.
2. Select the items to save to the storage device. When the settings are complete, click [OK] and save the screen program 

file.

3. Click [File] → [Storage Manager]. The window for specifying a drive is displayed.
4. Specify the drive where the storage device is inserted and click [OK]. The [Storage Manager] window is displayed.

Item Filename Storage Location
Patterns BMPxxxx.BIN (xxxx: 0000 to 1023) (Access folder)\BITMAP
Messages (BIN) MSGxxyyy.BIN

(xx: Language number 00 to 31)
(yyy: Message group number 000 to 127)

(Access folder)\MSG

Screens
3D parts
Windows fonts

Header SCHEADER.BIN (Access folder)\SCRN

Screens - SCxxxx.BIN (xxxx: 0 to 9999)
Component parts 
(macro blocks)

MCRxxxx.BIN (xxxx: 0 to 1023)

Component parts 
(alarm messages)

MSGxxxx.BIN (xxxx: 0 to 11)

3D parts 3Dxxxx.BIN (xxxx: 0 to 1023)
Windows fonts Graphics WFSxxxx.BIN (xxxx: 0 to 4095)

Messages WFMxxxx.BIN (xxxx: 0 to 4095)
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5. Click [Storage Setting] → [Write to Storage]. The [Write to storage] window is displayed.

6. If the screen program is currently being edited, select the [Write Data Being Edited] checkbox.
If the screen program is not the one currently opened with V-SFT, deselect the [Write Data Being Edited] checkbox and 
select the relevant screen program from the [Open] button.

7. When the settings are complete, click [OK]. The file is saved to the access folder.

Operation on the V10/V9 Series
Connect a storage device to the V10/V9 series unit. When opening a screen program on the V10/V9 series unit, the storage 
device will automatically be referred to for showing the screen.

• If screen data is not stored correctly on the storage device or a storage device is not connected to the V10/V9 series unit, 
the V10/V9 series unit will operate as if there is no screen.
If calling a screen using a switch with [Screen Change-over] selected for [Function], a short intermittent beep will sound 
and the request will not be processed. If using a [Displaying Screen Device] from the PLC to specify a screen, the screen 
will not changeover. (If immediately after power-on, the screen with the smallest number will be displayed.)

• If 3D parts are not stored correctly on the storage device or the storage device is not connected to the V10/V9 series unit, 
3D parts will not be displayed.

• If Windows fonts are not stored correctly on the storage device or the storage device is not connected to the V10/V9 
series unit, Windows fonts will not be displayed.

• If patterns are not stored correctly on the storage device or the storage device is not connected to the V10/V9 series unit, 
patterns will not be displayed.

• When both BIN files (MSGxxyyy.BIN) and TXT files (MSGxxyyy.TXT) coexist in the “MSG“ folder on the storage device, 
reference to TXT files takes priority.

• Screen data stored in a storage device takes longer to display than data stored in the MONITOUCH flash memory.

Notes on File Storage
• Up to 512 KB of screen data can be saved to a storage device per screen. The per screen data size can be viewed at [Tool] 

→ [List of Memory Use]. However, the size of the screen data that was selected for storage at [System Setting] → [Other] 
→ [Storage Setting] cannot be viewed on the [List of Memory Use] tab window. We recommend checking the data size 
before configuring [Storage Setting].

• For the restoration of the screen data in the “SCRN“ folder to the original data file (.V10 or .V9), the “DSP0000.BIN“ file in 
the “DSP“ folder is required. However, if data information of “DSP0000.BIN“ in the “DSP“ folder and “SCHEADER.BIN“ in 
the “SCRN“ folder do not match, the compilation of files from these folders does not take place, and thus the screen 
program is created with screen data in the “SCRN“ folder omitted. For details on the conversion procedure, refer to “BIN 
File Conversion” page 8-33.
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8.3.7 Storing Messages (TXT Files)
Messages (in TXT file format) can be stored on a storage device to reduce the size of the screen program.
Since the messages are in TXT file format, they can be edited even without V-SFT.

* Message files can be stored in BIN and TXT file formats. For details on storing BIN files, refer to “8.3.6 Reducing Screen Program Data Size” 
page 8-19.

File Storage Location and Filename

PC → Storage Device Writing (For TXT Files)
1. Configure the following settings on the screen program in advance. Click [System Setting] → [Storage Setting].

The [Storage Setting] window is displayed.
2. Select the [Range of Messages to be Saved to storage] checkbox and specify the range of messages to be stored.

When the settings are complete, click [OK] and save the screen program file.

3. Create files in TXT file format.
Filename: MSGxxyyy.txt (xx: Language number 00 to 16, yyy: Message group number 000 to 127 *1)

*1 TXT files must be created in accordance with the message group numbers specified in the [System Setting] → [Storage 
Setting] window.
Any TXT file with a number not within the specified range will not be recognized.

4. Save “MSGxxyyy.TXT“ files to the “MSG“ folder under the access folder.

Operation on the V10/V9 Series
Connect the storage device to the V10/V9 series unit. When the screen program is displayed, the stored messages are 
displayed accordingly.

* When both BIN files (MSGxxyyy.BIN) and TXT files (MSGxxyyy.TXT) coexist in the “MSG“ folder on the storage device, 
reference to TXT files takes priority.

Item Filename Storage Location
Messages (TXT format) MSGxxyyy.TXT

(xx: Language number 00 to 31)
(yyy: Message group number 000 to 127)

(Access folder)\MSG
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8.3.8 Storing Audio (WAV) Files
There are two methods for storing audio files used by the audio playback function: importing audio into the screen program 
or storing separately on a storage device.
The size of the screen program can be reduced by storing audio on a storage device.

WAV File Storage Location and Filename
Files* saved at the following location can be played.

* For specifications of audio files that can be played, refer to “Audio Specifications” page 2-1.

Storing Files on a Storage Device
Either Windows Explorer or the storage manager can be used to store files.

Windows explorer
1. Select the WAV file in Windows Explorer.
2. Execute [Copy] from the right-click menu.
3. Open the storage device drive using Windows Explorer and paste the file.

Storage manager
1. Store the WAV file to be used in “\MONITOUCH\User\WAV” on the PC in advance.
2. Click [File] → [Storage Manager] and write to storage using [Write to Storage].

Operation on the V10/V9 Series
Insert the storage device into the V10/V9 series unit. Audio playback is available in RUN mode.

Filename Storage Location
WAxxxx.wav (xxxx: 0000 to 1023)
xxxxxxx.wav (64 or less one-byte characters or 32 or 
less two-byte characters)

(Access folder)\WAV

“8.4 Storage Manager” page 8-31

EXT0000
WAV
WA0000.wav
WA0001.wav
WA0002.wav

Playback of a WAV file saved to a storage device.

Notice

Machine operation 
will stop soon.

Machine operation 
will stop soon.

Copy
Paste
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8.3.9 Storing JPEG Files (JPEG Display)
JPEG files can be displayed on the V10/V9 series unit. Always store JPEG files on a storage device.

JPEG File Storage Location and Filename
Audio files are stored in the following location.

Storing Files on a Storage Device
Either Windows Explorer or the storage manager can be used to store files.

Windows explorer
1. Select the JPEG file in Windows Explorer.
2. Execute [Copy] from the right-click menu.
3. Open the storage device drive using Windows Explorer and paste the file.

Storage manager
1. Store the JPEG file to be used in “\MONITOUCH\User\Jpeg” on the PC in advance.
2. Click [File] → [Storage Manager] and write to storage using [Write to Storage].

Operation on the V10/V9 Series
Insert the storage device into the V10/V9 series unit. The JPEG file on the storage device is displayed in RUN mode.

For details on JPEG display, refer to “1.3 JPEG Display”.

Filename File Storage Location
JPxxxxx.jpg (xxxxx: 00000 to 32767)
xxxxxxx.jpg (64 or less one-byte characters or 32 or 
less two-byte characters)

(Access folder)\JPEG

“8.4 Storage Manager” page 8-31

EXT0000
JPEG
JP00000.JPG
JP00001.JPG
JP00002.JPG

Displaying a JPEG file stored on the storage device on the screen.

Copy

Paste
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8.3.10 Storing Image Files (Picture Viewer)
Image files can be displayed on the V10/V9 series unit. JPEG, bitmap, and PNG format files can be displayed. Always store 
image files on a storage device.

Image File Storage Location and Filename
Files are stored in the following location.

Storing Files on a Storage Device
Either Windows Explorer or the storage manager can be used to store files.

Windows Explorer
1. Select the image file in Windows Explorer.
2. Execute [Copy] from the right-click menu.
3. Open the storage device drive using Windows Explorer and paste the file.

Storage manager
1. Store the image file to be used in “\MONITOUCH\User\PICTURE” on the PC in advance.
2. Click [File] → [Storage Manager] and write the selected files to the storage device using [Write to Storage].

Operation on the V10/V9 Series
Connect the storage device to the V10/V9 series unit. The image files saved to the storage device are displayed on the screen 
using the picture viewer.

For details on the picture viewer, refer to “16 Picture Viewer”.

Filename File Storage Location
PICTxxxxx.JPG (xxxxx: 00000 to 99999)
PICTxxxxx.PNG (xxxxx: 00000 to 99999)
PICTxxxxx.BMP (xxxxx: 00000 to 99999)
Or any filename (64 or less one-byte characters or 32 or less two-byte characters)

(Access folder)\PICTURE

“8.4 Storage Manager” page 8-31

EXT0000
PICTURE
PICT00000.PNG
PICT00001.PNG
PICT00002.PNG

Displaying a PNG file stored on the storage 
device on the screen

Copy
Paste
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8.3.11 Storing PDF Files
PDF files can be displayed on the V10/V9 series unit. Always store PDF files on a storage device.

PDF File Storage Location and Filename
Files are stored in the following location.

* For details on specifying the folder path, refer to “13.4 Detailed Settings” page 13-7 in “13 PDF Viewer”.

Storing Files on a Storage Device
Either Windows Explorer or the storage manager can be used to store files.

Windows explorer
1. Select PDF files in Windows Explorer.
2. Execute [Copy] from the right-click menu.
3. Open the storage device drive using Windows Explorer and paste the file.

Storage manager (only when storage location folder path is not specified)
1. Store the PDF files to be used in “\MONITOUCH\User\PDF“ on the PC in advance.
2. Click [File] → [Storage Manager] and write the selected files to the storage device using [Write to Storage].

Operation on the V10/V9 Series
Connect the storage device to the V10/V9 series unit. The PDF files saved to the storage device are displayed on the screen 
using the PDF viewer.

Filename File Storage Location
PDFxxxxx.PDF (xxxxx: 00000 to 99999)
xxxxxxxx.pdf (64 or less one-byte characters or 32 or less two-byte characters) • Storage location folder path* specified

Any folder specified
• Storage location folder path* not specified (default)

(Access folder)\PDF

“8.4 Storage Manager” page 8-31

“13 PDF Viewer”

EXT0000
PDF
PDF00000.pdf
PDF00001.pdf
PDF00002.pdf

Displaying a PDF file stored on the storage device on the 
screen

Copy Paste
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8.3.12 Storing Video Files
Videos can be displayed on the V10/V9 series unit. Always store video files on a storage device.

Video File Storage Location and Filename
Files are stored in the following location.

Storing Files on a Storage Device
Either Windows Explorer or the storage manager can be used to store files.

Windows explorer
1. Select the video files (*.mp4) in Windows Explorer.
2. Execute [Copy] from the right-click menu.
3. Open the storage device drive using Windows Explorer and paste the file.

Storage manager
1. Store the video files to be used in “\MONITOUCH\User\VIDEO” on the PC in advance.
2. Click [File] → [Storage Manager] and write the selected files to the storage device using [Write to Storage].

Operation on the V10/V9 Series
Connect the storage device to the V10/V9 series unit. The video files saved to the storage device are displayed on the screen 
using the video player.

Filename File Storage Location
MOVxxxxx.mp4 (xxxxx: 00000 to 99999)
xxxxxxx.mp4 (64 or less one-byte characters or 32 or less two-byte characters)

(Access folder)\VIDEO

“8.4 Storage Manager” page 8-31

“15.1 Video Player”

EXT0000
VIDEO
MOV00000.mp4
MOV00001.mp4
MOV00002.mp4

Playback of a video file saved to a storage device on the screen

Example: Windows Media Player

Copy

Paste
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8.3.13 Storing Ladder Monitor Files
PLC data (ladder monitor and I/O monitor) can be displayed on the V10/V9 series unit. Always store ladder monitor files on a 
storage device.

8.3.14 Transferring Recipe Data
Recipe files (BIN/CSV) created on the PC can be stored on a storage device and read or written using a transfer command bit 
or a switch with [Recipe] set for [Function].

8.3.15 Saving Alarm History
Alarm history and event history can be saved to a backup folder.
BIN files in the backup folder can be switched between for display on the V10/V9 series unit and CSV files can be readily 
checked and edited on a PC.
The storage targets for the latest history data and backup files can be divided over, for example, an SD card and a USB flash 
drive.

Refer to the Ladder Monitor Specifications manual.

EXT0000
LADDER

1R.qpg
COMMENT.qcd

QCPUTYPE.DAT
param.qpa

PLC1
MELSEC

ST000
CPU0

Displaying a ladder monitor file stored on 
the storage device on the screen

Example: Mitsubishi Electric PLC

Refer to “15 Recipes” in the Reference Manual 1.

SD Read Write

EXT0000
RECIPE

REC0000.csv
REC0001.csv
REC0002.csv

Recipe

Storage target folder

Refer to “8 Alarm” in the Reference Manual 1.

EXT0000
ALARM
ALARM00.BIN
ALARM_00_00.CSV

201404
20140411
20140415

Alarm
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8.3.16 Saving Logging Data
History data that contains numeric values and text can be saved to a backup folder.
BIN files in the backup folder can be switched between for display on the V10/V9 series unit and CSV files can be readily 
checked and edited on a PC.
The storage targets for the latest history data and backup files can be divided over, for example, an SD card and a USB flash 
drive.

8.3.17 Operation Logs
Screen operation history records (operation logs) can be output to a storage device. In the event of an error, these stored logs 
allow previous operations to be examined in order to determine the cause of the error.

8.3.18 Saving Screenshot Images
Screenshot images can be saved to a storage device as PNG files using a macro command.
When it is difficult to connect a printer on the factory floor, screenshot images can be saved to a storage device and printed 
later from a PC.

Refer to “7 Trends” in the Reference Manual 1.

EXT0000
LOGGING
LOGGING00.BIN
LOGGING_00_00.CSV

201404
20140411
20140415

Trend

Refer to “4 Operation Log”.

SD
1 4

2 5

3 6

MENUOPELOG.DB

Refer to the Macro Reference Manual.

EXT0000
HDCOPY
HD0000.png
HD0001.png
HD0002.png

500

230

HDCOPY
Macro command

MONITORING
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8.3.19 Saving Video/RGB and Camera Images
The currently displayed image can be saved to a storage device as a JPEG file. (Snapshot function)
Images can be saved from a video/RGB display, USB camera, and network camera. To save an image, double-tap the display 
area or execute a macro command (for a network camera, turn the command device memory bit ON).

8.3.20 PDF Output of Data Sheets
The current data of numerical data displays or character displays that are registered to a data sheet screen can be output as a 
PDF file to a storage device.

8.3.21 Saving MES (Stand-Alone) Database Files
A database can be created on a storage device connected to the V10/V9 series unit. Adding, searching, and deleting of 
database records is possible without using a network. A production control system can be easily built using only the V10/V9 
series unit.

Refer to “1.1 Video/RGB Display”, “1.2 USB Camera Display” and “1.4 Network Camera”.

EXT0000
SNAP
VD00000.jpg
VD00001.jpg
VD00002.jpg

PASS POWER
READY

FAIL ERROR
TRIGGER

Ethernet
Example: Network camera

Double-tap the display area.

Refer to “16.3 Printing Data Sheets” in the Reference Manual 1.

A

B

C

D

E

F

PDF

EXT0000
LIST

201405

LIST0000_20140420133000.pdf
LIST0000_20140420153000.pdf
LIST0000_20140420173000.pdf

20140420

Storage device PDF fileData sheet screen

Refer to “6.7 MES Interface Function”.

V10/V9
EXT0000

DATABASE
V9_ProductLine.db

Macro command 
execution

Database
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8.3.22 Saving Memo Pad Data
Data from the memo pad function can be saved to a storage device as PNG files.

Memo Pad Data Storage Location and Filename

Operation on the V10/V9 Series
Insert the storage device into the V10/V9 series unit. When using the memo pad in RUN mode, the memo pad data is 
automatically stored on the storage device.

* When the [Store Area for Memo Pad] checkbox is selected on the [SRAM/Clock Setting] screen on the [System Setting] 
menu, memo pad data is stored in SRAM even when a storage device is inserted into the V10/V9 series unit.

Timing of Saving
The timing of writing memo pad data to a storage device is as follows.

• When switching the memo pad display using a switch with [+ Block], [− Block], or [Block Call] set for [Function]
• When the screen is changed

8.3.23 SRAM Data Backup
A backup copy of SRAM data can be saved to a storage device to guard against a case in which data may be lost when 
replacing the SRAM battery.

Refer to “13.1 Memo Pad” in the Reference Manual 1.

Filename File Storage Location
MEMxxxx.png (xxxx: 0000 to 0007) (Access folder)\MEMO

EXT0000
MEMO
MEM0000.png
MEM0001.png
MEM0002.png

Storage deviceMessage board

Refer to the following manuals.
- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual
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8.4 Storage Manager
The storage manager is an application that facilitates writing of data used by the V10/V9 series unit to a storage device, and 
importing of data from a storage device for conversion into other file formats.

8.4.1 Starting and Ending
Starting
1. Start V-SFT.
2. Click [File] → [Storage Manager]. The window shown below is displayed.

3. Specify the drive where the storage device is inserted and click [OK]. The [Storage Manager] window is displayed.

Ending
1. Click the [X] button on the corner of the [Storage Manager] tab.

2. The screen editing window reappears.
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8.4.2 Writing
The procedure for writing data to a storage device is explained below.
Always use the storage manager to write the data in the following table to a storage device. Other files can be copied using 
Windows Explorer.

Writing Procedure
1. Click [Storage Setting] → [Write to Storage].

2. The [Write to storage] window is displayed.

*1 Station number table
The station number of a counterpart device can be changed in RUN mode when connecting to the following models.
• PLC: Mitsubishi QnH (Q) series (Ethernet) (1 : n connection only)
• PLC: Mitsubishi QnA series (Ethernet) (1 : n connection only)
• PLC: OMRON SYSMAC CS1/CJ1 (Ethernet Auto) (1 : n connection only)
• PLC: OMRON SYSMAC CS1/CJ1 DNA (Ethernet) (1 : n connection only)
• Temperature controller: Fuji Electric F-MPC04P (loader)
• Temperature controller: Fuji Electric F-MPC04S (UM03)

*2 FROM backup area
The FROM backup area is where a backup copy of the data in the PLC or internal device memory can be stored. To retain the data, use the 
macro commands “FROM_RD” and “FROM_WR”. For details on macros, refer to the Macro Reference Manual.

3. When the settings are complete, click [OK]. A BIN file is written to each of the folders under the access folder.

Data Extension Remarks
Screen program .V10,  .V9
SRAM backup data .RAM
Text file .TXT

Item Description
Write Data Being Edited Write the screen program that is open (being edited) in V-SFT.
Path of Screen Data File to Be 
Converted

Select the data for writing to the storage device from the [Open] button.
File extensions: [*.V10], [*.V9], [*.RAM], [*.TXT]

DSP0000.BIN File Comment Add a comment to the screen program file (DSP0000.BIN).
This comment can be checked via the file’s [Property] window.

Automatic Upload Create an automatic upload file.
System Program Transfer Select this checkbox when uploading system program files together with the screen program.
Run after System 
Program Transfer

Automatically switch MONITOUCH to RUN mode after automatic upload is complete.

Transfer OS Select to update the operating system automatically.
Refer to “8.3.5 Automatically Updating the Operating System” page 8-15

Do Not Overwrite Port No. 
Table/FROM Backup Area *1 *2

Select this checkbox to prevent existing values in the station number table or existing values in 
the FROM area from being changed when transferring a screen program from a storage 
device.

Write OS Select to update the operating system manually.
Refer to “8.3.4 Manually Updating the Operating System” page 8-11
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8.4.3 BIN Files
Files with the extension “.BIN” are stored under access folders. The storage manager can be used to convert BIN files and 
check file information.

BIN File Conversion
All BIN files can be restored to their original state.
1. Select a file from an access folder.
2. Right-click on the file and select [Put BIN File Back].

3. The window shown below is displayed. Specify the folder to save in and the filename and click [Save].

4. A converted file is created.

Notes
• Note that BIN files in the “BITMAP“, “MSG“, and “SCRN“ folders are required to convert “DSP0000.BIN“ into a V10/V9 file. 

If these files are missing, the V10/V9 file will be created without pattern data and 3D parts.

File Storage target folder Extension After Conversion File Type
DSP0000.BIN DSP .V10,  .V9 Screen program
BMPxxxx.BIN BITMAP .BMP Pattern file
MSGxxyyy.BIN MSG .TXT Message
SRM0000.BIN SRAM .RAM Backup data in SRAM
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BIN File Properties
Information on each BIN file can be checked before conversion.
1. Select a file from an access folder.
2. Right-click on the file and select [Property]. Information on the file is displayed.

• DSP0000.BIN
The file type or system program version of the file can be checked on the [Detail] tab window.

• BMPxxxx.BIN
A bitmap image is displayed.

• MSGxxyyy.BIN
Information on the file is displayed.
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8.4.4 Storage Copy
Copy the data on the storage device.

1. Click [Storage Setting] → [Storage Copy].

2. Specify the storage device drive and click [OK].

3. The following dialog box is displayed. Click [OK].

4. The following dialog box is displayed.
Remove the storage device from the PC and insert another device for saving the copied data. Click [OK].

5. The following dialog box is displayed. Click [OK].

6. When copying is complete, the following dialog box is displayed.
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8.4.5 Storage Device Backup
A backup of data on a storage device can be created.
Any folder can be selected for saving the data.

1. Click [Storage Setting] → [Storage Backup].

2. When the [Copy Target Folder] window is displayed, click [Open] and specify the copy target folder.

Example: When saving in the “Backup” folder in the D drive:

3. Click [OK]. The following dialog box is displayed.

4. Click [OK]. The data on the storage device is copied to the copy target. When copying is complete, the following dialog is 
displayed.

5. Use Windows Explorer to check that the data was copied correctly.

* When copying data from a storage device to the hard disk drive, it can also be copied and pasted using Windows 
Explorer.
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8.5 System Device Memory ($s)
Information about the status and the free space of the storage device inserted into the V10/V9 series unit is stored in system 
device memory ($s).

Addresses Description SD USB-A Device Type
$s497 Storage device error state

*1 *1

← V10/V9

$s498 Free space on storage device (kB)
*1 *1$s499

$s500 [Storage Removal] switch status
*1 *1

$s1030 Storage device error state  $s497 reference -
$s1031 Free space on storage device (kB) -
$s1032
$s1033 [Storage Removal] switch status  $s500 reference -
$s1035 Storage device error state  $s497 reference -
$s1036 Free space on storage device (kB) -
$s1037
$s1038 [Storage Removal] switch status  $s500 reference -
$s1050 Background processing flag

$s1051 Background processing completion flag
When processing has been completed (when $s1050 turns OFF), this turns ON.
When the operation has been verified, the user must clear it to zero.

Value Description
4 Card not mounted
5 Format error
9 JPEG/BMP file read error

12 Card write error
15 Disk error (open failure)
16 Card read error

0: Switch OFF (storage removal prohibited)
1: Switch ON (storage removal permitted)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

System reserved (“0” setting)

Alarm/logging data backup and 
CSV file output
0: Not processed, 1: Being processed

Hard copy macro command
0: Not processed, 1: Being processed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Reserved for system (set to “0”)
Operation log
0: Not processed, 1: Being processed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Reserved for system (set to “0”)
Alarm/logging data backup and 
CSV file output
0: Not completed, 1: Completed

Hard copy macro command
0: Not completed, 1: Completed

Operation log
0: Not completed, 1: Completed
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*1 Information on the specified drive is stored at [System Setting] → [Other] → [Storage Setting] → [Storage Connection Target].

$s1052 Background processing error flag
If an error occurs at the time when processing has been completed (when $s1050 
turns OFF), this turns ON.
When the operation has been verified, the user must clear it to zero.

← V10/V9

Addresses Description SD USB-A Device Type

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Reserved for system (set to “0”)
Alarm/logging data backup and 
CSV file output
0: Normal, 1: Error

Hard copy macro command
0: Normal, 1: Error

Operation log
0: Normal, 1: Error
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9.1 Overview
9.1.1 Fonts

• Select a base language (font) first and then edit the screen using text that can be displayed in the selected font.

• A maximum of 32 languages can be used on the same screen just by switching the text for display.

• Use “Windows fonts” to display two or more languages on a single screen or display Windows-type characters on the 
screen.

For details on font types and supported languages, refer to “9.1.2 Font Types” page 9-2.

For details, refer to “9.1.3 Language Selection” page 9-7.

For details on Windows fonts, refer to the Operation Manual.

Japanese (Gothic) TTF Chinese (Simplified) TTF

Example: Registration of screen program “ABC.V9” in three languages

Japanese Chinese (Simplified)Korean

Japanese

English

Chinese (Simplified)

Korean
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9.1.2 Font Types
Fonts are generally divided into four types.
Because the mixed use of fonts is not permitted on the V10/V9 series unit, select one font type in the [System Setting] → 
[Multi-language Setting] → [Font Setting] window.
However, local screen always uses True type font regardless of the font setting.

Type Size Specification 
Method Features Image

TrueType font Point 
specification

Supports smoothing.

Used on the Local mode 
screen.

Gothic font Supports smoothing.

There are automatic/manual setting restrictions depending on the 
function.

Stroke font

Bitmap font XY magnification 
factor 
specification

Font data designed in sizes of 
16 × 16 dots and 32 × 32 dots 
(two-byte characters).
This font type occupies less 
memory but is not suitable if 
a smoother-line typeface is 
required.

Windows Fonts
No font data is stored on MONITOUCH. Fonts used on Windows, such as “Times New Roman” or 
“Arial”, are used as image data. Settings can be configured for each item.
For details, refer to the Operation Manual.
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Supported Language List
The following table lists the fonts and corresponding languages supported by the V10/V9 series.

Font Setting *1 Supported Language Supported Character Code Remarks
TrueType font Japanese (Gothic) TTF Japanese, English JIS level-1 to level-4 + ANK 

code
8794 not 
displayableJapanese Times TTF

English/Western Europe 
Gothic TTF

English, Icelandic, Irish, Italian, Dutch, 
Swedish, Spanish, Danish, German, 
Norwegian, Portuguese, Finnish, Faroese, 
French

ISO-8859-1: Latin1
(Extended ASCII code)

English/Western Europe 
Times TTF
Chinese (Traditional) TTF Chinese (traditional), English BIG5 code (A141 to F9FE) + 

ASCII code
A344 to A373 
not displayable

Chinese (Simplified) TTF Chinese (simplified), English GB2312 code (A1A1 to F7FE) + 
ASCII code

A021 - A07E
A6A1 - A6B8
A6C1 - A6D8
A7A1 - A7C0
A7D1 - A7F1
A8BB, A8BD, 
A8BE, A8C0
not displayable

Korean TTF Hangul, English KS code (A1A1 to FDFE) + 
ASCII code

A2E6 and A2E7 
not displayable

Central Europe TTF Croatian, Czech, Hungarian, Polish, 
Hrvatska (Croatian), Romanian, Slovakian, 
Slovene

CP1250 code

Cyrillic TTF Russian, Ukrainian, Kazakh, Bulgarian, 
Uzbek, Azerbaijani

CP1251 code

Greek TTF Greek CP1253 code
Turkish TTF Turkish CP1254 code
Baltic TTF Estonian, Latvian, Lithuanian CP1257 code

Bitmap font Japanese Japanese, English JIS level-1 and level-2 + 
ANK code

Japanese 32 JIS level-1 + ANK code
English/Western Europe English, Icelandic, Irish, Italian, Dutch, 

Swedish, Spanish, Danish, German, 
Norwegian, Portuguese, Finnish, Faroese, 
French

ISO-8859-1: Latin1
(Extended ASCII code)

Chinese (Traditional) Chinese (traditional), English BIG5 code (A141 to C67E) + 
ASCII code

Chinese (Simplified) Chinese (simplified), English GB2312 code (A1A1 to FEFE) + 
ASCII code

Korean Hangul, English KS code (A1A2 to C8FE) + 
ASCII code

Central Europe Croatian, Czech, Hungarian, Polish, 
Hrvatska (Croatian), Romanian, Slovakian, 
Slovene

CP1250 code
ISO code
(ISO-8859-2: Latin2) *2

Cyrillic Russian, Ukrainian, Kazakh, Bulgarian, 
Uzbek, Azerbaijani

CP1251 code
ISO code
(ISO-8859-5: Latin5) *2

Greek Greek CP1253 code
ISO code
(ISO-8859-7: Latin7) *2

Turkish Turkish CP1254 code
ISO code
(ISO-8859-9: Latin9) *2

Baltic Estonian, Latvian, Lithuanian CP1257 code
Gothic font Gothic Japanese, English JIS level 1 + level 2 + ANK code

Gothic (IBM Extended 
Character)

Japanese, English JIS level 1 + level 2 + IBM 
extended code (FA40 to FC4B) 
+ ANK code

English/Western Europe HK 
Gothic

English, Icelandic, Irish, Italian, Dutch, 
Swedish, Spanish, Danish, German, 
Norwegian, Portuguese, Finnish, Faeroese, 
French

ISO-8859-1: Latin1
(Extended ASCII code)

English/Western Europe HK 
Times
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*1 The mixed use of fonts is not possible.
*2 Select the [ISO Code] checkbox when selecting the corresponding fonts in the [System Setting] → [Multi-language Setting] → [Font 

Setting] window.

Stroke font Japanese stroke Japanese, English JIS X 0201
JIS X 0208
NEC special characters
IBM extensions
NEC selection of IBM 
extensions

English/Western Europe 
stroke

English, Icelandic, Irish, Italian, Dutch, 
Swedish, Spanish, Danish, German, 
Norwegian, Portuguese, Finnish, Faeroese, 
French

CP1252 code

Chinese (Traditional) stroke Chinese (traditional), English BIG5 code (A141 to F9FE) + 
ASCII code

Chinese (Simplified) stroke Chinese (simplified), English GB2312 code (A1A1 to F7FE) + 
ASCII code

Korean stroke Hangul, English KS code (A1A1 to FDFE) + ASCII 
code

Central Europe stroke Croatian, Czech, Hungarian, Polish, 
Romanian, Slovakian, Slovene, Hrvatska 
(Croatian)

CP1250 code

Cyrillic stroke Russian, Ukrainian, Bulgarian, Kazakh, 
Uzbek, Azerbaijani

CP1251 code

Greek stroke Greek CP1253 code
Turkish stroke Turkish CP1254 code
Baltic stroke Estonian, Latvian, Lithuanian CP1257 code

Font Setting *1 Supported Language Supported Character Code Remarks



9.1    Overview

9-5

1

2

3

4

5

6

7

8

9

10

Checking Fonts on MONITOUCH
The font name is displayed at the following location in Local mode.

The font names that are displayed in the [Font Setting] window and in Local mode are listed below.
Font Setting Local Mode

TrueType font Japanese (Gothic) TTF Jpn. Gothic TTF
Japanese Times TTF Jpn. Times TTF
English/Western Europe Gothic TTF Eng. Gothic TTF
English/Western Europe Times TTF Eng. Times TTF
Chinese (Traditional) TTF Chinese(Trd.)TTF
Chinese (Simplified) TTF Chinese(Smp.)TTF
Korean TTF Korean TTF
Central Europe TTF Central Euro.TTF
Cyrillic TTF Cyrillic TTF
Greek TTF Greek TTF
Turkish TTF Turkish TTF
Baltic TTF Baltic TTF

Bitmap font *1 Japanese JAPANESE
Japanese 32 JAPANESE 32
English/Western Europe ENGLISH
Chinese (Traditional) CHINESE(TRAD.)
Chinese (Simplified) CHINESE(SIMP.)
Korean KOREAN
Central Europe Central Euro.
Cyrillic Cyrillic
Greek Greek
Turkish Turkish
Baltic Baltic

Gothic font *1 Gothic HA Gothic
Gothic (IBM Extended Character) HA Gothic(IBM)
English/Western Europe HK Gothic HK Gothic
English/Western Europe HK Times HK Times

Font name
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*1 TTF display is used on the Local mode screen.

Stroke font *1 Japanese stroke JAPANESE STROKE
English/Western Europe stroke ENGLISH STROKE
Chinese (Traditional) stroke CHINESE(TRD) ST
Chinese (Simplified) stroke CHINESE(SIM) ST
Korean stroke KOREAN STROKE
Central Europe stroke Cent.Eur. STROKE
Cyrillic stroke Cyrillic STROKE
Greek stroke Greek STROKE
Turkish stroke Turkish STROKE
Baltic stroke Baltic STROKE

Multi-language screen (with multiple fonts selected) Multi  Font

Font Setting Local Mode
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9.1.3 Language Selection
• All required fonts can be stored on MONITOUCH in advance and then displayed by changing between character sets.

• The text for display can be changed even when using a single font, such as German ↔ Italian or Japanese ↔ English. 
Using only one font reduces the space required by the screen program.

• When using a Windows font, it is possible to change only the text. The text for display can be changed using a single font.

• To change the language in the RUN mode, use a switch with [Function] set to “Language changeover” or use the 
“CHG_LANG” macro command.

• The following methods are available for language editing.

For details on settings, refer to “9.2 Setting Procedure” page 9-8.

For details on languages that are supported by each font, refer to “Supported Language List” page 9-3.

For details on settings, refer to “9.2 Setting Procedure” page 9-8.

For details on Windows fonts, refer to the Operation Manual.

For details, refer to “9.2.3 Language Selection” page 9-15.

For details, refer to “9.2.2 Language Editing” page 9-9.

For details, refer to “9.4 Convenient Editing Procedures” page 9-22.

Japanese Chinese (Simplified)Korean

Screen program transfer
(required fonts are transferred)

Language 1: Japanese
Language 2: Korean
Language 3: Chinese (Simplified)

Switch function or macro 
used for language selection

Buongiorno Guten Morgen
German Italian

GermanItalianLanguage 1: English/Western Europe
Language 2: English/Western Europe
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9.2 Setting Procedure
This section describes the procedure for configuring settings that allow changing languages that use different fonts when in 
RUN mode.
(The procedure is explained assuming that the setting for Language 1 has been completed.)

1. Font settings (refer to page 9-8)
2. Editing of each language (refer to page 9-9)
3. Language selection using the switch function or “CHG_LANG” macro command (refer to page 9-15)

9.2.1 Font Setting
1. Click [System Setting] → [Multi-language Setting] to display the [Font Setting] window.

2. Set a value for [Interface Language]. (Example: set “3” to allow changing between three languages.)

3. Set [Font Type] to “TrueType font” and set the languages to be displayed.
• Example 1: Changing between Japanese, Chinese (Simplified) and Korean

Language 1: Japanese (Gothic) TTF
Language 2: Chinese (Simplified) TTF
Language 3: Korean TTF

• Example 2:
- Changing between German and Italian

Language 1: English/Western Europe Gothic TTF
Language 2: English/Western Europe Gothic TTF

- Changing between Japanese and English
Language 1: Japanese (Gothic) TTF
Language 2: Japanese (Gothic) TTF

4. Select a language number for [Initial Interface Language] so that the corresponding language is displayed when a screen 
program is transferred.

This completes the necessary settings.

Transfer font setting
Select the checkboxes of the fonts required on the V10/V9 series unit. More fonts selected for transfer results in 
less capacity available for the screen program.
Do not select fonts that are not necessary.
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9.2.2 Language Editing
This section explains the multi-language editing procedure assuming that the version of Microsoft Windows on the PC used is 
capable of editing the required foreign languages. There are three methods for editing languages.

* For details on the settings and notes for editing foreign languages on a Japanese version of Microsoft Windows, 
refer to the Operation Manual.

A. Directly Edit Items
By specifying the interface language number on the [Language] changing menu, text for Language 2 and later can be edited 
on the screen in the same way as Language 1.

* The interface language number can also be changed using the [Display Language] drop-down menu.

Checking the layout
After editing, always check the layout of each language for problems using the [Language] changing menu.
Character properties can be set for each language.
The point size and color settings can be changed for specific languages.

Language 1 Language 2

* Character properties 
(text size and color) can 
be set for each 
language.

• [View] → [Display Environment]• [View] → [Display Change]
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B. Editing in the [Multi-language Edit] Window
Display the text in the screen program edited using Language 1 in the [Multi-language Edit] window and directly enter the 
desired text in another language.
Text can be copied and pasted between the [Multi-language Edit] window and Excel (pasted as “Unicode text” in Excel).

Editing location: [Home] → [Registration Item ] → [Multi-language]

* The [Multi-language Edit] window can be used to register up to 1000 lines (No. 0 to 999) per sheet.
When batch copying over 1000 lines (from the second sheet onwards) for editing in Excel, use the following procedure.

Example: Example: Batch copy of languages 1 to 4, numbers 0 to 4647 (4648 rows) in the [Multi-language Edit] window

1) Click [Edit] → [Block Copy]. The [Copy] window is displayed.
Specify target languages and start/end line numbers to copy, and click the [OK] button.

2) Select a cell in Excel and paste.

3) After editing in Excel, select the multi-language columns for Language 2 through 4 by dragging and copy them.

4) Click [Edit] → [Block Paste] in the [Multi-language Edit] window in V-SFT to display the [Paste] dialog. Select the 
languages for pasting and the starting row number, and click [OK].

This completes the editing.
After editing, always check the layout of each language for problems using the [Language] changing menu.
For details, refer to page 9-9.

Language 1 cannot be edited in the [Multi-language Edit] window. To edit Language 1, edit it directly in the 
item settings.

Language 1 cannot be pasted (edited) to the [Multi-language Edit] window. To edit Language 1, edit it directly 
in the item settings.

Target languages

Used Point

[Multi-language Edit] window

Line No.

Default: Last line No.

Excel

All text in numbers 0 to 
4647 (4648 rows) of 
languages 1 to 4 are 
pasted.

* If text cannot be pasted correctly, click [Paste Special] and select [Paste As: 
Unicode Text] to paste. Default: Unicode text

* If text cannot be pasted correctly, click [Paste Special] and select [Paste As: 
Unicode Text] to paste. Default: Unicode text

Language 2 onwards
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C. Export / Import
Export and import can be performed by compiling all languages in a text file per language.
Using this function allows text to be imported after undergoing translation and editing by viewing multiple languages side by 
side on an Excel spreadsheet.

Outputting a File for Each of the Languages for Switching
Export procedure

1. Select [System Setting] → [Multi-language Setting] to display the [Font Setting] window and click the [Import/Export] tab.

2. Configure the settings as shown below and click [Export].

3. The [Save As] window is displayed.
Enter a filename and click [Save] to output text files.

4. Start Excel and drag and drop the exported text into the Excel window to open it.

5. Register the text in square brackets in column B.

6. After editing, click [File] → [Save As].
Select “Unicode Text (*.txt)” for [Save as type] and save the file using the same filename.

This completes the necessary settings.

Language 1 cannot be pasted (edited) to the [Multi-language Edit] window. To edit Language 1, edit it directly 
in the item settings.

Do not edit column A. Also, do not delete any square brackets in column B. If these are edited or deleted, file 
import will end in failure.

To export to CSV files instead 
of Unicode text files, select 
“*.csv” for [File format].

Language 1

Language 2
Language 3
Language 4

The same number of files 
are created as there are 
languages.

Test_3.txt Drag and drop

Example:

A

Language 3
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Import procedure

1. Click [System Setting] → [Multi-language Setting] to display the [Font Setting] window.

2. Display the [Export/Import] tab and click the [Import] button.

3. The [Open] window is displayed.
Select “Unicode text (*.txt)” for [Save as type] and open each file one at a time.

This completes the file importing process.
After editing, always check the layout of each language for problems using the [Language] changing menu.
For details, refer to page 9-9.

Be sure to save the files for languages 1 to 4 in the same place and using the original filenames. If any file is 
renamed or the Language 1 file is edited or deleted, file import will end in failure.
The Language 1 file cannot be imported.

Language 1

Import languages 2 to 4 in order.Language 2
Language 3
Language 4
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Outputting All Languages to a Single File
Export procedure

1. Select [System Setting] → [Multi-language Setting] to display the [Font Setting] window and click the [Import/Export] tab.

2. Configure the settings as shown below and click [Export].

3. The [Save As] window is displayed.
Enter a filename and click [Save] to output text files.

4. Start Excel and drag and drop the exported text into the Excel window to open it.

5. Register the text in square brackets in column C, D, and E (red frame).

6. After editing, click [File] → [Save As].
Select “Unicode Text (*.txt)” for [Save as type] and save the file using the same filename.

This completes the necessary settings.

Language 1 cannot be pasted (edited) to the [Multi-language Edit] window. To edit Language 1, edit it directly 
in the item settings.

Do not edit the first to fifth rows (header) and columns A/B (language 1). Also, do not delete any square 
brackets from column C, D, or E. If these are edited or deleted, file import will end in failure.

To export to CSV files instead 
of Unicode text files, select 
“*.csv” for [File format].

Languages 1 to 4 One file is created.

Test.txt Drag and drop

Example:

A

Languages 1 to 4

Language 2 Language 3 Language 4
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Import procedure

1. Click [System Setting] → [Multi-language Setting] to display the [Font Setting] window.

2. Display the [Export/Import] tab and click the [Import] button.

3. The [Open] window is displayed.
Select “Unicode text (*.txt)” for [Save as type] and open the file.

This completes the file importing process.
After editing, always check the layout of each language for problems using the [Language] changing menu.
For details, refer to page 9-9.

Languages 1 to 4
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9.2.3 Language Selection
There are two ways to change the language.
Use either a switch function or macro command.

Switch Function
The interface language can be changed using a switch with the function [Language changeover].
Each time a [Language changeover] switch is pressed, the interface language switches in the specified order beginning from 
the [Initial Interface Language]. A desired language can also be displayed by specifying its number with an external command.

Location of Settings
Switch settings window → [Function] → [Function] → [Language changeover]

Redraw Timing
When the interface language is switched, the screen is redrawn. The following actions also take place at the same time.

• Open macro, close macro (screen, multi-overlap library)
• Cycle macro (screen)
• $T device memory zero clear (screen)
• Screen interrupt command transfer (PLC type: universal serial) (screen)

Prevent execution of these operations when redraw occurs by selecting the checkboxes as required.
Location of settings: [Screen Setting] → [Screen Setting] → [Unhide]

Item Description
Fixed Display the interface language of the specified language number.

Language 1 to 32
Auto Change Change the interface language in the specified order beginning from the [Initial Interface Language] set in 

the [Font Setting] window. Languages that are not selected in the window will not be displayed.
Device Designation Display the interface language of the number stored at the specified device memory.

0: Language 1
1: Language 2
2: Language 3

31: Language 32

If a nonexistent language number is specified for display, an error beep sounds and no action takes place.
The number of interface languages can be checked at [System Setting] → [Multi-language Setting] → [Font 
Setting] window.

:
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SYS (CHG_LANG) Macro Command
The “SYS (CHG_LANG)” macro command can be used to change the interface language.
This command is useful when changing the language using the ON macro of a switch or an external command.

Setting Example
Example: Changing the language by switching the screen

1. Configure the switch ON macro as shown below.

2. Set the function of each switch to “Language changeover: 1”.

This completes the necessary settings.

Detail
Device used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

Editing procedure
For details on macro editing, refer to the Macro Reference Manual.

The language is switched over when the screen is changed after the macro command has been executed.
For switching the language on the same screen, use the “RESET_SCRN” macro command.
For details on macro commands, refer to the Macro Reference Manual.

• “Japanese” switch ON macro • “Korean” switch ON macro

Internal Device PLC1 to PLC8 Devices Memory card Constant
F1

Value Remarks
F1 0: Language 1

1: Language 2

31: Language 32

Although the setting range for [Interface Language] in the 
[System Setting] → [Multi-language Setting] → [Font Setting] 
window and [Display Language] in the [Display Environment] 
window is “1” to “32”, the range for “CHG_LANG” is “0” to “31”.

Which language do you prefer?

Japanese Korean

Screen No. 0 Screen No. 1

With either switch, the 
interface language can be 
switched over when screen 
No. 1 is displayed.

Language 1: Japanese
Language 2: Korean

“MOV” macro command
0: Language 1 (Japanese)

“MOV” macro command
1: Language 2 (Korean)

:
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9.3 Detailed Settings
9.3.1 Font Setting

Set the number of languages and fonts for display on the V10/V9 series unit. Display the following window by clicking 
[System Setting] → [Multi-language setting].

*1 Comments are displayed on the [Language Display] menu, multi-language edit sheets, etc.
This is useful when editing multiple languages with the same font setting.

Item Description
Interface Language Set the number of interface languages. 1 to 32

Example: [5]: Languages 1 to 5
Font Type Select either [TrueType font], [Bitmap font], or [Gothic font].
Setting Set the languages to use and comments *1 respectively.
Initial Interface Language Select the language to be displayed immediately after screen program transfer. 1 to 32

Operation is as follows after transfer.

Set the system language 
according to settings in the 
[Multi-language Edit Setting] 
window
(setting available for two or 
more interface languages)

Select this checkbox when setting the interface languages of the following screens. (This setting is 
convenient when all the same fonts are selected using [Setting...].)
The supported languages are Japanese, English/Western Europe, Chinese (Simplified), Chinese (Traditional), 
and Korean.

Local screen, error message screen, ladder monitor, PDF viewer, operation log viewer, data transfer viewer, 
storage viewer, video player

The following settings are required.
• Set each language at [Home] → [Registration Item] → [Multi-language] → [Multi-language Edit] → 

[Multi-language Edit Setting].
• Select the checkboxes of the interface languages at [System Setting] → [Multi-language Setting] → 

[Transfer Font Setting].

Operation Display Language
Power ON The language displayed when the power was turned 

OFF is displayed.
Switching from RUN mode to Local mode The language used in RUN mode is displayed.
Switching from Local mode to RUN mode The language used in Local mode is displayed. *2

In Local mode during screen program 
transfer

The language specified for [Initial Interface 
Language] in the screen program is displayed.

In RUN mode during screen program 
transfer

Font Setting Language Display

Multi-language edit sheet

Display Language
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*2 Exceptions

• Example 1: When the same font is registered multiple times, the language number displayed before switching to Local mode is displayed.

[Interface Language]: 2, [Transfer Font Setting]: Japanese (Gothic) TTF, [Initial Interface Language]: 1
- Language 1: Japanese (Gothic) TTF
- Language 2: Japanese (Gothic) TTF

• Example 2: In the following case, the lowest language number in the font settings is displayed.

[Interface Language]: 3, [Transfer Font Setting]: Japanese (Gothic) TTF, English/Western Europe Gothic TTF, Central Europe TTF, [Initial 
Interface Language]: 1
- Language 1: Japanese (Gothic) TTF
- Language 2: English/Western Europe Gothic TTF
- Language 3: Central Europe TTF

Operation example:
RUN (Japanese (Gothic) TTF)

↓

Local mode (switch from Japanese to English)
↓

RUN (Language 2 is displayed)
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9.3.2 Transfer Font Setting

*1 Languages that can be displayed in Local mode are listed below. Which languages are available for display is determined by selecting the 
corresponding checkboxes on the [Transfer Font Setting] tab.

Item Description
Transfer Font Setting *1 Select the checkboxes of the fonts required on the V10/V9 series unit.

* More fonts selected for transfer results in less capacity available for the screen program. If capacity is 
insufficient, do not select unnecessary fonts.

Font Memory (Used) Displays the total memory size used for the currently selected fonts for transfer.
Screen Memory (Used) Displays the size of the screen program currently being created.
Screen Memory (Available) Displays the space available for the screen program.
Calculate Memory Recalculate the volume of data from the current settings.

Transfer Font Setting Local Mode
Japanese (Gothic) TTF Japanese, English
Japanese Times TTF
English/Western Europe Gothic TTF English
English/Western Europe Times TTF
Chinese (Traditional) TTF Chinese (Traditional), English
Chinese (Simplified) TTF Chinese (Simplified), English
Korean TTF Korean, English
Central Europe TTF English
Cyrillic TTF
Greek TTF
Turkish TTF
Baltic TTF
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9.3.3 Import and Export

Item Description
Export Use this button when editing text for a language other than Language 1 in another application.

For details, refer to page 9-11.
File format Select the type of the file to be exported.
Generate files by language. Set the file creation method used in exporting.

• Selected
The same number of files are created as there 
are languages.

• Unselected
One file is created.

Output strings with [ ]. Selected
Add square brackets to text in output files.

Unselected
Delimit output with commas.
When a file is opened in Excel, some text like the following will not be imported correctly.

Output multiline strings into 
single line.

Set how multiple lines of text located on a switch or lamp are output.

Selected
Lines of text are output in one cell with the line feed code “\n”.

Unselected
Text is output line by line in separate cells.

Import Use this button to import an exported file.
For details, refer to page 9-11.

Language 1

Language 2
Language 3
Language 4

Languages 1 to 4

Leading zeros dropped
Not recognized as a 
character string

Characters on V-SFT Output File
(Standard cell format)

0123 123
+BK #NAME?

Switch Checkbox Output Result
Selected [Error \n Screen]

Unselected [Error]
[Screen]
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9.3.4 Manual Font Setting
[Manual Font Setting] tab appears when gothic font is selected.
There are two types of Gothic fonts: automatic fonts and manual fonts.
Items that are subject to manual fonts setting are mainly “Text display” and “Message display”, which needs to sets the size to 
use on the screen.

For language changeover:
The [1-Byte] setting of each point of the language 1 (e.g.: Gothic) is directly reflected to each setting of the language 2 (e.g.: 
English/Western Europe HK Gothic). Note that if you change the setting in one, the setting in the other also changes.

About automatic fonts
For language changeover, the automatic font of the language 1 is automatically transferred to the V10/V9 when the screen 
program is transferred, but the automatic font is not recognized in the language 2 or later.
For the language 2 and later, consider the automatic fonts as the manual fonts and set it by “Manual Font Settings”.

Refer to “Operation Manual  10. Font”

Language 1: Language 2:
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9.4 Convenient Editing Procedures
9.4.1 Multi-language Batch Change

Overview
Item properties (text color etc.) for multiple languages from language 1 to 32 can easily be changed at once.

Setting Example
The procedure is explained with an example shown below.

Example: Changing the switch properties on screen numbers 1 and 2 
Text color: black to orange, text property: standard to boldface

1. Select [Tool] → [Multi Language] → [Multi Language Batch Change] to display the [Multi Language Batch Change] 
window.

2. Click the [Select] → [Detail] button under [Range Setting] and specify a screen range of 1 to 2. Click the [Select] → [Detail] 
button under [Target Item] and select the [Switch] checkbox.

3. Select the [Target] checkbox under [Font Setting].

4. In the [Setting on Changes] area, select the [Color] checkbox and select orange. Also select the [Property] checkbox and 
select boldface.

5. Review the settings made in the previous steps, and click [OK].

The settings are updated.

Screen No. 1

Screen No. 2

Screen No. 1

Screen No. 2

Batch 
change
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9.4.2 Multi-language Batch Copy
Overview
If exactly the same text, such as text on switches and item numbers, as language 1 is to be used, it can be easily copied at 
once.

Setting Example
The procedure is explained with an example shown below.

In this example, the text and characters on the switches placed on all screens in language 1 are copied to screens in 
language 2.

Language 1: Japanese (Gothic) TTF
Language 2: English/Western Europe Gothic TTF

1. Select [Tool] → [Multi Language] → [Multi Language Batch Copy] to display the [Multi Language Batch Copy] window.

2. Select [All] under [Range Setting] and set the target items to [Select] → [Detail] → [Text] and [Switch].

3. In the [Font Setting] area in the [Multi Language Batch Copy] window, select [Language 1] for [From] and [Language 2] for 
[To].

4. Batch copy in this example targets all properties. In the [Setting on Changes] area, select the [All] checkbox.

5. Review the settings made in the previous steps, and click [OK].

The settings are updated.

Language 1 Language 2 Language 2

Batch copy

• Before copying • After copying
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9.4.3 Multi-language Reordering
Overview
Interface languages from language 1 to language 32 can be reordered easily.

Setting Example
The procedure is explained with the settings shown below as an example.

1. Select [Tool] → [Multi Language] → [Rearrange Language Order] to display the [Rearrange Language Order] window.

2. Select the language number using the pull-down menus next to [Language 1], [Language 2], and [Language 3].

3. Review the settings made in the previous steps, and click [OK].

The settings are updated.

Language 1: Japanese (Gothic) TTF
Language 2: English/Western Europe Gothic TTF
Language 3: Chinese (Simplified) TTF

→
→
→

Language 1: English/Western Europe Gothic TTF
Language 2: Chinese (Simplified) TTF
Language 3: Japanese (Gothic) TTF

Language 1: Japanese (Gothic) TTF

Language 2:
English/Western Europe 
Gothic TTF

Language 3: Chinese (Simplified) TTF

Language 1: English/Western Europe Gothic TTF

Language 2:
Chinese 
(Simplified) TTF

Language 3: Japanese (Gothic) TTF
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10.1 Overview
“Tag editing” is a function used to assign names (tags) to PLC or internal device memory ($u, $L, etc.) used on the V10/V9 
series unit and use these names for screen program creation. Tags can be divided into three general types: device memory 
designated tags, variable designated tags, and array designated tags.

10.1.1 Tag Types
Device Designation
Assign a tag name to a PLC device memory or internal device memory, and set the device memory for the part or item using 
the assigned name.

Variable Designation
Assign a tag name to a variable in the variable area of the V10/V9 unit, and set the device memory variable for parts and items 
using the assigned names. This is useful for specifying a working area for V10/V9 internal processing, such as for macro and 
password functions etc.

For details on the procedure for editing tags, refer to “10.2 Editing Tags” page 10-3.

For details on the editing procedure, refer to “10.2 Editing Tags” page 10-3.

Variables
A “variable” is an area that stores data temporarily. This area is used for temporarily storing data, such as a default value or 
calculated value. The capacity of the variable area is 4096 words for both single words and double words, respectively.
For details, refer to ““Tag” Variable Capacity” page 10-24.

D100
D101

556
600

M0M1

ON Hz

s

Tags
Alarm 1
Frequency
Acceleration 
time

M0

D100

D101

Device memory
Alarm 1

Example: In the [Tag Database Edit] window, register PLC device memory addresses “M0”, “D100” and “D101” with names “Alarm 1”, 
“Frequency” and “Acceleration Time”, respectively.

[Tag Database Edit] window

Set device memory addresses for parts using tags.
Lamp device memory: “Alarm 1” (M0)
Numerical data display device memory: “Frequency” (D100), “Acceleration time” (D101)

Frequency
Acceleration time

Tags

Alarm 1

Frequency

Acceleration time

Example: Variable area in the V10/V9 series unit

SRAM

$L
$LD

DRAM

$u/$s/$T/$P

“Tag” variable

Use this variable area.
(No device is allocated. The variable is 
identified by a name given freely.)
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Array Designation
The array format can be specified for the tag. If there is multiple data of the same type, they can be registered at one time. 
This makes data management and maintenance easier.
For example, when allocating 10 variables that have the same properties (DEC, 1 word) without using the array format, 10 
variables must be registered individually as shown below.

When registering one tag with 10 elements in the array format, 10 variables can be secured in the same way as shown above. 
If there is multiple data of the same type, the array format can be used to make configuration easier.

In the case of the bit variable:

10.1.2 Importing Tags
Tags or system labels registered in PLC software can be imported using V-SFT and used as tags.

10.1.3 Operation and Scaling Functions 
(For Logging Server and Numerical Data Display)

• Operation and scaling functions can be used with respect to tags.
By setting these functions to tags, it is possible to register and edit only tags when there is a need for such operations on 
tags that are used in multiple locations and items, thereby contributing to reduction of work hours.

• These tags can also be used in the logging server. Therefore, even when handling data that requires operation processing 
such as temperatures and rotation speeds, logging and display are possible without operation processing on the PLC or 
using macro commands.

For details on the editing procedure, refer to “10.2.3 Configuring Arrays” page 10-6.

Data 1

Data 2

Data 3

Data 10

Dec

Dec

Dec

Dec

ID0
ID1

ID9

Data 1
Data 2

Data 10

1 word

1 word

1 word

1 word

[Tag Database Edit] window Data  10 pcs.

ID0 Data [10] 
Data [0]
Data [1]
Data [2]

Data [9]

“Data [2]” is automatically 
assigned here.

[Tag Database Edit] window Data [10] = DEC, 1 word

Error 1

Error 2

Error 3

Error 4

Error 5
ID0 Error [5] 

[0] [1] [4] 
[Tag Database Edit] window Error (5) = 1 bit each

“Error [2]” is automatically assigned here.
Array

For details, refer to the following.
• “MITSUBISHI ELECTRIC” page 10-13
• Siemens

- “SIMATIC Manager (Ver. 5.5 / Ver. 5.4)” page 10-17
- “TIA Portal” page 10-20
- “SIMATIC STEP 7-Micro/WIN (S7-200)” page 10-22
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10.2 Editing Tags
Click [Home] → [Registration Item ] → [Tag Database], specify a group number, and register tags in the [Tag Database Edit] 
window.
There are three ways to edit tags.
Refer to the following.

10.2.1 Direct Registration in the [Tag Database Edit] Window
This section describes the procedure for registering “D100” and “D101” (word device memory) and “M0” (bit device memory) 
of the PLC1 device memory using tags.

1. Click the [Tag] field and register a tag name.

2. Click the [Type] field and select a data type from the list.

* To register the same type of data at once with consecutive device memory addresses, use the array format.

3. Click the [Device] field and set a device memory address.

4. Click the [Comment] field and enter a comment describing the tag.

5. To register a new device memory address using a tag, select another ID number and repeat steps 1 to 5.

This completes the necessary settings.
Tags can be specified in the settings window of each part.

“10.2.1 Direct Registration in the [Tag Database Edit] Window” page 10-3

“10.2.2 Editing in a CSV File” page 10-4

“10.5 Importing Tags” page 10-13

For details, refer to “10.2.3 Configuring Arrays”.

• Word designation: • Bit designation:

(Bit device)

(Word Device)
* -xx is the manually entered part of the bit.

xx: 00 - 15, 00 - 31
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10.2.2 Editing in a CSV File
The data registered in the [Tag Database Edit] window for a screen program can be exported to a CSV file. The CSV file can be 
edited on a PC and then imported back into the screen program. In the example below, changes are made to the data 
registered with ID No. 0 in the [Tag Database Edit] window using Excel.

• Tag: Frequency_setup → Run_status
• Device: D100 → D105
• Comment: Inverter Port No. 1 → ON: RUN, OFF: STOP

1. Click [Edit] → [Tag Export].

2. Enter an arbitrary filename in the window, select “Csv File (*.csv)” for the [Save as type] field, and click [Save].

3. Open the CSV file in Excel, edit each field for ID number 0, and save the file.

4. Open the [Tag Database Edit] window and click [Edit] → [Tag Import].

5. Select the CSV file saved in step 3, select “Csv File (*csv)” for the [Files of type] field, and click [Open].

This completes the necessary settings.

For details on the data in CSV files, refer to “CSV File Configuration” page 10-5.

File types

* IDs that already have tags are overwritten with the imported data.
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CSV File Configuration
A CSV file opened in Excel is formatted as shown below.

*1 Data that includes unusable characters cannot be imported. Refer to “Detailed Settings” (page 10-7).

Column Item Description Remarks
A ID 0 - 65535 Numbers within square brackets [ ]: Element No. 0 to 4095 with the use of arrays 1-byte
B Tag *1 Within 100 one-byte characters 1-byte / 2-byte
C Type 0: Bit device memory

1: Word Device memory
2: Double-word device memory
3: Bit variable

4: Integer variable
5: Double-word integer variable
6: Real number variable
7: Real number device memory

1-byte

D Array Setting 0: Not used, 1: Used 1-byte
E No. of 

Elements
1 - 4096 1-byte, only 

when “1” is 
specified for [D. 
Array Setting]

F Address

Example: Specifying PLC1 Mitsubishi D100

1-byte

• 1:1 connection
Word designation: PLC1 [D00100]
Bit designation: PLC1 [D00100-00]

• 1:n connection (port No. 0)
Word designation: PLC1 [0:D00100]
Bit designation: PLC1 [0:D00100-00]

Example: Specifying internal device memory $u100
Word designation: $u00100, bit designation: $u00100-00

Example: Specifying File No. 0, Record No. 0, and Data No. 100
Word designation: [0:0] #0100, bit designation: [0:0] #0100-00

 

Example: Specifying PLC1 Fuji Electric T-link TI00
Word designation: PLC1 [TI00], bit designation: PLC1 [TI00-00]

Common device memory: CW/CB/MW/MB/VW 1-byte, only 
when the 
general-purpos
e FL-Net is 
designated as 
PLC1

G Comment Within 130 one-byte characters 1-byte / 2-byte

[Tag Database Edit] data exported to a CSV file

The number of elements in an array 
must be the same as the number 
shown in [No. of Elements].

* Do not change the header 
information enclosed in the 
red dotted frame. Otherwise, 
the data in the CSV file cannot 
be correctly imported into the 
screen program.

Device memory + address
PLCNo.1 - 8

PLCx [xxxxx]PLC device memory

Device memory + address
xxxxxInternal device memory: 

$u/$T/$s/$L/$LD

Record No. 0 to 4095

[xx:xxxx] #xxxx

File No. 0 to 15 Data No. 0 to 4096
Memory card device

Device memory + address
PLCx [xxxxx]I/O device memory

PLCNo.1 - 8

Device memory + address
PLCx [xxxxx]

PLCNo.1 - 8

Example:
• Specifying CW100

Word designation: PLC1 [CW0100], bit designation: PLC1 [CW0100-00]
• Specifying MW100 (port No. 1)

Word designation: PLC1 [1:MW0100], bit designation: PLC1 [1:MW0100-00]



10  Tag

10-6

10.2.3 Configuring Arrays
This section describes the procedure when “5” is specified for [No. of Elements] for the PLC1 device memory “D200”, and “3” 
for the integer variable in the array format.

1. Select the [Array] checkbox and specify the number for the [No. of Elements] field.

2. Double-click on the ID number and enter a description in the [Comment] field of the [Detail Setting] window.

This completes the necessary settings.
Tag arrays can be specified in the settings window of each part.

10.2.4 Importing Tags
Tags or system labels registered in PLC software can be imported using V-SFT and used as tags.

• A maximum of 4096 elements can be set.
• If the bit variable is specified in the array format, 1 word is occupied in the variable area even if “16” 

or a smaller number is specified for the number of elements.
For details, refer to “Tag Settings” page 10-24.

• Tag [n] (n: number of elements in the array)

 D200 to D204 are used.
 3 words are used in the variable area.

Total [0] (= D200)

Total [1] (= D201)
Total [2] (= D202)
Total [3] (= D203)
Total [4] (= D204)

* The [Detail Setting] window can also be displayed from the [Tag Database Edit] tab or by 
right-clicking and selecting [Detail Setting].

* Manually enter a value for [n].

For details, refer to “10.5 Importing Tags” page 10-13.
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10.3 Detailed Settings
[Tag Database Edit] Window
The [Tag Database Edit] window consists of 256 groups, and 256 lines can be registered per group. Accordingly, a maximum of 
65536 lines can be registered in total.

Location of settings: [Home] → [Registration Item ] → [Tag Database]

Item Description
ID Line No. 0 to 65535
Tag *1 Specify a tag name. Max. 100 one-byte characters (two-byte characters allowed, 

one-byte/two-byte/uppercase/lowercase are treated as different characters.)
Type, Device Specify the data type for the tag.

Array Use an array.
For details on setting arrays, refer to “10.2.3 Configuring Arrays” page 10-6.

No. of Elements When [Array] is checked, specify the number of elements to be used in the array. Max. 4096
Comment Enter a description for the tag. Max. 130 one-byte characters (two-byte characters allowed, 

one-byte/two-byte/uppercase/lowercase are treated as different characters.)
Status of Use *2 If a tag is used as device memory in the screen program, “In use” is indicated.

Click a cell indicating “In use” to show where the tag is set.
Double-click the indicated location field to jump to that location.

Conversion *3 Set alarm, operation and scaling settings. These settings are used for numerical data display parts and the 
logging server.
For details, refer to “Conversion Settings” page 10-8.

No.  256

No.  65280

No.  0

No.255

No.  1

No.  512

[Tag Database Edit] window

Acceleration time word device memory
Frequency word device memory

Alarm bit device memory

Group No. 0
Group No. 1

Group No. 255

Group No. 2

Filter

Device memory Type Data Type
PLC device memory
Internal device memory
Memory card
I/O device memory
Common device memory

Bit 1-bit data
Word 1-word data
Double-word Double-word data
Real number 32-bit single precision real number format

Variable Bit variable 1-bit data
Integer variable 1-word data
Double-word integer variable Double-word data
Real number variable 32-bit single precision real number format
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*1 If an unavailable character is used, the following message box will appear. In this case, perform registration again.

*2 Display example

*3 Not supported if [Type] is set to “Bit” or “Bit Variable”.

Conversion Settings
Operation and scaling functions can be used with respect to device memory addresses of tags. Configure the following 
settings.

• Applicable items:
- Logging server
- Numerical data display

Double-click to jump to the location of use.

Click

Applicable to numerical 
data display parts only

Double-click
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*1 For details, refer to “5.1 Numerical Display” in the Reference Manual 1.
*2 The alarm setting uses the values before operation and scaling.

Logging server
1. Select a tag with [Conversion] settings at [System Setting] → [Logging Server] → [Logging Data].
2. Double-click the [Conversion] cell and select the [Use tag operation/scaling] checkbox.

* Available when [Logging Method] is set to “Trigger” or “Constant Cycle”.

Item *1 Description
Input Type (BCD, DEC, FLOAT) Select the code to use when reading data from device memory.
Display Format Select the format for displaying on the screen.
Alarm *2 Select this checkbox to display data in a different color when it exceeds or falls short of a 

specific range.
When “Entry Target” is selected for [Function], the range of values that can be entered 
using a keypad can be set.

Minimum Set the minimum value used to trigger an alarm.
Use offset value 
designation device

Set the device memory address and code used for storing an offset value for the 
minimum value.

Char. Color Set the color for text.
Background Set the background color of text.

Maximum Set the maximum value used to trigger an alarm.
Use offset value 
designation device

Set the device memory address and code used for storing an offset value for the 
maximum value.

Char. Color Set the color for text.
Background Set the background color of text.

Operation Select this checkbox to perform an operation on the value of the device memory address 
specified in [Contents].

Scaling Select this checkbox to display data after automatically converting the data read from the 
PLC ([Range before Scaling]) to the specified range ([Range after Scaling]).

Range before Scaling Specify the data to be read from the PLC
Range after Scaling Specify the range of data to be shown on MONITOUCH.

Multiplier or divisor (constant)Offset value
(constant)

“×” or “/” (÷)

Device memory specified in [Contents]

4000

100

00

PLC MONITOUCH

(Range before scaling) (Range after scaling)

Double-click

Settings are grayed out and the [Conversion] 
settings are displayed.
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Numerical data display
1. Display the settings window for the numerical data display and select the tag with [Conversion] settings at [Contents] → 

[Device to Display].
2. Select the [Use tag operation/scaling/alarm] checkbox.

Settings are grayed out and the [Conversion] 
settings are displayed.
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10.4 Tag Status List
The tag status list of the entire screen program can be searched and the total word count of tag variables can be checked.
Display method: [Tool] → [Search] → [Tag Use]

Status of Use
Details

Operation Method
The procedure of searching for tags currently in use is explained as an example.

1. Select [In use] from the [ ] filter button on the [Status of Use] list and then click [OK] to display the search results.

2. Selecting a tag displays the location of use. Double-click to jump to the location of use.

No. Item Description
1 Update Updates the display.
2 VIEW JUMP When the cursor is over the [Status of Use] list (4): [Tag Database Edit] window is displayed.

When the cursor is over the [Use Point] area (5): The relevant screen item is displayed.
3 Filter button Set the search conditions.
4 List of Memory Use Displays the search result.
5 Used Point Displays the location of use of the tag selected in the [Status of Use] list (4).
6 Total Word Count of the Tag 

Variables
Displays the status of the variable area.
Max. 4096 words for single and double words

* If the occupied word count exceeds the 4096 words, the value is displayed in red. Set a value 
smaller than 4096 words. For details, refer to “Tag” Variable Capacity page 10-24 .

3.

4.

5.

6.

1. 2.

Double-click to jump to the 
location of use.
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Search
Details

Operation Method
This section describes the procedure for searching for the locations of use of the “alarm” tag as an example.

1. Click the [Search] tab.
2. Enter “alarm” into [Tag Name] and click the [Update] icon to display the search results.

Unused tags are not returned in the search results.

3. Double-click the tag to jump to the location of use.

No. Item Description
1 Update Updates the display.

Set [Tag Name] (4) and [Search Range] (3), and then click this icon.
2 VIEW JUMP Displays the location of use of the tag selected in the search results (6).
3 Search Range Setting Specify the search range.
4 Tag Name Enter a tag name to search. If a search is performed with this field left blank, all tags in use will be 

displayed.
* One-byte and two-byte characters and uppercase and lowercase characters are treated as 

separate characters.
5 Matched completely. Selected: Search for a tag name exactly the same as the one specified for [Tag Name] (4).

Unselected: Search for all tags including characters specified for [Tag Name] (4).
6 Search results Displays the search result.

1. 2. 3.

4.

6.

5.
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10.5 Importing Tags
Tags or system labels registered in PLC software can be imported using V-SFT and used as tags.

Manufacturers of supported PLCs
• “MITSUBISHI ELECTRIC” page 10-13
• Siemens

- “SIMATIC Manager (Ver. 5.5 / Ver. 5.4)” page 10-17
- “TIA Portal” page 10-20
- “SIMATIC STEP 7-Micro/WIN (S7-200)” page 10-22

MITSUBISHI ELECTRIC
Global labels registered in Simple Project (with labels) or Structured Project in MITSUBISHI ELECTRIC’s software GX Works2 
can be registered as system labels in the software MELSOFT Navigator. These system labels can be exported in CSV file 
format. When such CSV files are imported using V-SFT, system labels in the files can be used as tags in V-SFT.

* For details on using PLC software, refer to the relevant PLC manual.

Supported PLC Models

* Importing using V-SFT is allowed provided that [PLC1] and a 1:1 connection mode are set in the [System Setting] 
→ [Hardware Setting] window. Importing is not possible for PLC2 and subsequent PLCs.

When whole program compiling is executed in GX Works2, device memory addresses registered with global 
labels will be reassigned to global labels. If there are global labels with no PLC device memory addresses 
assigned, addresses of such labels will be assigned according to the automatic assignment setting made in GX 
Works2.
Therefore, assigning PLC device memory addresses to global labels is recommended.

Manufacturer PLC Model
MITSUBISHI ELECTRIC QnH (Q) series link

QnH (Q) series CPU
QnH (Q) series CPU (multi CPU)
QnH (Q) series link (multi CPU)
QnH (Q) series (Ethernet)
QnH (Q) series (multi CPU) (Ethernet)
QnH (Q) series (Ethernet ASCII)
QnH (Q) series (multi CPU) (Ethernet ASCII)
QnH (Q) series (CC-LINK)
QnU series CPU
QnU series (built-in Ethernet)
L series link
L series CPU
L series (built-in Ethernet)
FX series CPU
FX2N/1N series CPU
FX1S series CPU
FX series link (A protocol)
FX3U/3UC/3G series CPU
FX3U/3GE series (Ethernet)
FX3U/3UC/3G series link (A protocol)
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Procedure
This section describes the steps to import “Device A” data registered in the system label list into a screen program.

* The following table lists the types of data that can be imported using V-SFT and the data types after importing.

*1 No other types of data can be imported using V-SFT.
*2 With the PLC model QnH (Q) series (CC-LINK), data of the type “Retentive Timer” cannot be imported.

1. Start MELSOFT Navigator.
2. Right-click [DeviceA] under [System Label List], and then click [System Label List] → [Export].

MITSUBISHI ELECTRIC “System Label”
Data Type for Tags in V-SFT

Data Type *1 Length
Bit 1 bit Bit
Word [Signed] 1 word Word
Word [Unsigned] 1 word
Timer 1 word
Counter 1 word
Retentive Timer *2 1 word
Double Word [Signed] 2 words Double-word
Double Word [Unsigned] 2 words
Time 2 words
FLOAT [Single Precision] 2 words Real number

Structure
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3. A message dialog box is displayed. Click the [Yes] button.

4. The [Select Export Destination Folder] window is displayed.
Select “CSV” for [Save as type] and click [Save].

5. Open the destination folder. Check that the CSV file with the same name in the system label list is created.
(Example: DeviceA.csv)

6. Open the screen program in V-SFT. Click [Home] → [Registration Item] → [Tag Database] to display the [Tag Database 
Edit] window.

7. Click [Edit] → [Tag Import].

8. The [Open] window is displayed. Select “MELSOFT Navigator File (*.csv)” for [Files of type]. Select the desired CSV 
filename (e.g. “DeviceA.csv”) and click [Open].

* The dotted line frame indicates the structure. A structure name with a period is added to the top of 
each label name.

Structure.Elements_1

Structure name
Period

Label name

File types

Device A

.CSV
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The contents of the file are registered as tags in the “tag database edit” window. Types ([Type]) are specified for individual 
device memory addresses.
This completes the import procedure.

Notes
Note the following when importing.

• Tag names must be within 100 one-byte characters.
• If a file to be imported includes a tag that is already registered, the existing tag is overwritten. Unregistered tags are 

registered to blank ID numbers (in the [Tag Database Edit] window).
• Only device memory addresses available on the V10/V9 series unit can be imported. For details, refer to the Connection 

Manual.

* Periods “.” cannot be used with tags. If any system label exported from MELSOFT 
Navigator includes a period, the period is converted to an underscore “_”.
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Siemens
Supported PLC Models

* Importing using V-SFT is allowed provided that the PLC is specified at [PLC1] in the [System Setting] → [Hardware 
Setting] window. Importing is not possible for PLC2 and subsequent PLCs.
If the connection mode is “1:n”, importing occurs via port number 0.

SIMATIC Manager (Ver. 5.5 / Ver. 5.4)
When a project file (*.s7p) created in Siemens software “SIMATIC Manager (version 5.5 or 5.4)” is imported using V-SFT, names 
registered in data blocks “DBx” can be used as tags in V-SFT.

Supported data types
The following table lists the data types that can be imported into V-SFT. The corresponding data types in V-SFT are also listed.

*1 No other types of data can be imported using V-SFT.
*2 Data types BYTE and CHAR (bytes) are imported as word device memory. If any odd bytes are registered in the PLC software, the data 

cannot be imported.

Manufacturer PLC Model
PLC Software

SIMATIC 
Manager TIA Portal SIMATIC STEP 

7-Micro/WIN
Siemens S7

page 10-17
page 10-20 -

S7-300/400 MPI
S7-300/400 (Ethernet ISOTCP)
S7-300/400 (Ethernet TCP/IP PG protocol)
S7 PROFIBUS-DP
S7-1200/1500 (Ethernet ISOTCP) -
S7-200 PPI - -

page 10-22
S7-200 (Ethernet ISOTCP) - -

For details on using PLC software, refer to the relevant PLC manual.

Siemens “DBxx”
Data Type for Tags in V-SFT

Data Type *1 Data Length
BOOL 1 bit Bit
BYTE *2 1 byte Word

CHAR *2 1 byte
WORD 1 word
S5TIME 1 word
DATE 1 word
INT 1 word
DWORD 2 words Double-word
DINT 2 words
TIME 2 words
TIME_OF_DAY 2 words
REAL 2 words Real number
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Procedure
This section describes the steps to import a project file (e.g. “test.s7p”), in which data blocks DB1 and DB2 are registered, to a 
screen program.

1. Start V-SFT and open the screen program.
Click [Home] → [Registration Item] → [Tag Database] to display the [Tag Database Edit] window.

2. Click [Edit] → [Tag Import].

3. The [Open] window is displayed.
Specify “Siemens S7 Project File (*.s7p)” for [Files of type].
Select the desired project file (e.g. “test.s7p”) and click [Open].

4. The [Tag List] window is displayed. Select the tags to import.
• [Data Block List]: Displayed block by block (data block “DBx”)

• [Tag List]: All tags displayed_

Double-click

Selected: To be imported
Unselected: Not to be imported

Selected: To be imported
Unselected: Not to be imported
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* When specifying further search criteria, go to [Filter setting]. Only tags that match the specified data type, data block 
name, or tag name will be displayed in the [Tag List] window.

5. Click [OK].
The contents of the file are registered as tags in the “tag database edit” window. Types ([Type]) are specified for individual 
device memory addresses.
This completes the import procedure.

Notes
Note the following when importing.

• Tag names must be within 100 one-byte characters.
• If a file to be imported includes a tag that is already registered, the existing tag is overwritten. Unregistered tags are 

registered to blank ID numbers (in the [Tag Database Edit] window).
• Device memory addresses unavailable on the V10/V9 series unit cannot be imported.

For details on device memory available on the V10/V9 series, refer to the Connection Manual. Data types BYTE and CHAR 
(bytes) are imported as word device memory. If any odd bytes are registered to device memory in the PLC software, the 
data cannot be imported.

Filtering out “a1”

A one-byte space is treated as an OR condition.
(Case-sensitive)

DB1

Example: Only DB1 imported

a1_DB_VAR

Tag name with “_”

Name

* Periods “.” cannot be used with tags. If a period is added to a tag, it is converted to an 
underscore “_”. 
The tag name registered in the SIMATIC Manager data block (DBxx) is prefixed to 
each tag together with an underscore “_”.
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TIA Portal
When a TIA project file (*.ap11 to *.ap17) created in Siemens software “TIA Portal (Ver. 11 to Ver. 17)” is imported into V-SFT, 
the contents of the file can be used as tags.

Supported data types
The following table lists the data types that can be imported into V-SFT. The corresponding data types in V-SFT are also listed.

*1 The “Offset” settings on the PLC must be configured. If the “Offset” settings are not configured, importing cannot be performed.

*2 No other types of data can be imported using V-SFT.
*3 Data types BYTE and CHAR (bytes) are imported as word device memory. If any odd bytes are registered in the PLC software, the data 

cannot be imported.

Procedure
1. Start V-SFT and open the screen program. 

Click [Home] → [Registration Item] → [Tag Database] to display the [Tag Database Edit] tab window.
2. Click [Edit] → [Tag Import].

3. The [Open] window is displayed. 
Specify “Siemens S7-1500 File (*.ap11 to *.ap17)” for [Files of type].
Select the desired project file and click [Open].

4. The [Tag List] window is displayed. Select the tags to import.

For details on using PLC software, refer to the relevant PLC manual.

Siemens “DBxx” *1
Data Type for Tags in V-SFT

Data Type *2 Data Length
BOOL 1 bit Bit
BYTE *3 1 byte Word

CHAR *3 1 byte
WORD 1 word
S5TIME 1 word
DATE 1 word
INT 1 word
DWORD 2 words Double-word
DINT 2 words
TIME 2 words
TIME_OF_DAY 2 words
REAL 2 words Real number

For details on using PLC software, refer to the relevant PLC manual.

A filter can be applied. For details, refer to page 10-19.
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5. Click [OK].
The contents of the file are registered as tags in the tag database edit window. Types ([Type]) are specified for individual 
device memory addresses. This completes the import procedure.
Importing occurs as follows according to the group settings of the TIA project file.

<Example 1: Group settings exist>

<Example 2: Group settings do not exist>

Example of imported tags in V-SFT

- With group settings: group name_data block name_data name
- Without group settings: data block name_data name

*1 Periods “.” cannot be used with tags. If a period is added to a tag, it is converted to an underscore “_”. 
The tag name registered in the SIMATIC Manager data block (DBxx) is prefixed to each tag together with an underscore “_”.

Notes
Note the following when importing.

• Tag names must be within 100 one-byte characters.
• Only tags registered in one-dimensional arrays in TIA Portal can be imported. Multi-dimensional arrays are not 

supported.
• Structures with more than six levels cannot be imported.
• Only comments registered to “Editing language” in TIA Portal can be imported.
• If a file to be imported includes a tag that is already registered, the existing tag is overwritten. New tags are registered to 

blank ID numbers (in the [Tag Database Edit] window).
• Device memory addresses unavailable on the V10/V9 series unit cannot be imported. 

For details on device memory available on the V10/V9 series, refer to the Connection Manual. Data types BYTE and CHAR 
(bytes) are imported as word device memory. If any odd bytes are registered to device memory in the PLC software, the 
data cannot be imported.

Group name

Data block 
name

Data name

Data block 
name

Data name

Example 1
With group settings
Example 2
Without group 
settings
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SIMATIC STEP 7-Micro/WIN (S7-200)
When a CSV file copied from the Symbol Table in the software “SIMATIC STEP 7-Micro/WIN” for Siemens S7-200 is imported 
using V-SFT, the contents in the file can be used as tags.

Procedure
1. Start the software “SIMATIC STEP 7-Micro/WIN” for Siemens S7-200.
2. Open [Symbol Table].

3. Select all columns under [Symbol], [Address], and [Comment]. Right-click and select [Copy] from the right-click menu.

4. Start Excel. Paste the copied data to the worksheet from cell A1.

For details on using PLC software, refer to the relevant PLC manual.

Only device memory addresses available on the V10/V9 series unit can be imported using V-SFT. For details, 
refer to the Connection Manual. Double-word device memory are imported as word device memory.

Device memory: VD → VW, ID → IW, QD → QW, MD → MW, SMD → SMW, SD → SW

Select all.

Tags Device memory Comment

[Tag Database Edit] in V-SFT

* The first row on the Excel sheet corresponds to tag ID No. 0. The copied data on the 
worksheet is imported from its first row to the [Tag Database Edit] window. (65536 
maximum)
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5. Click [File] → [Save As]. The [Save As] window is displayed.
6. Enter a filename. Select “CSV” for [Save as type] and click [Save].
7. Open the screen program. Click [Home] → [Registration Item] → [Tag Database] to display the [Tag Database Edit] 

window.
8. Click [Edit] → [Tag Import].

9. The [Open] window is displayed. Select the CSV file saved in step 6. Specify “Siemens S7-200 File (*.csv)” for [Files of type] 
and click [Open].

The contents of the file are registered as tags in the “tag database edit” window. Types ([Type]) are specified for individual 
device memory addresses.
This completes the import procedure.

Notes
Note the following for importing CSV files.

• IDs that already have tags are overwritten with the imported data.
• Device memory addresses unavailable on the V10/V9 series unit cannot be imported. If such a device memory address is 

included, the row is left blank.
For details on device memory available on the V10/V9 series, refer to the Connection Manual. Note that double-word 
device memory are imported as word device memory.

Device memory: VD → VW, ID → IW, QD → QW, MD → MW, SMD → SMW, SD → SW

File types
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10.6 Notes
Tag Settings
Tags cannot be specified for the following items.

• [Screen Setting] → [PLC Device Transfer]
• Device memory map (transfer source device memory, transfer destination device memory 1, transfer destination device 

memory 2, control device memory)
• Modbus device memory table

“Tag” Variable Capacity
When “tag” variables are registered in the [Tag Database Edit] window, the variable area in the MONITOUCH is used. Since the 
capacity of the variable area is limited, check the word count currently used, and be careful not to exceed the capacity.

Capacity of Variable Area

Checking the Capacity of “Tag” Variable
Check the capacity when the “tag” variables are registered as shown below.

2 words are occupied in the variable area.

= 4096

= 4096

Bit variable

Integer variable

Double-word 
integer variable

Real number variable

Variable Area

Word

Word

Variable Type Data Type Capacity
Bit variable * 1-bit data 4096 word
Integer variable 1-word data
Double-word 
integer variable

Double-word data 4096 word

Real number 
variable

32-bit single precision real 
number format

* If the bit variable is specified in array format, 1 word is occupied in the variable 
area even if “16” or a smaller number is specified for the number of elements.

For details on status list operations, refer to “10.4 Tag Status List”.

The value is indicated in red when it exceeds the maximum value. If the tag indicated in red is used on the 
screen, the message “Error: 46” appears and the unit will not run. Set a value smaller than the maximum.

Integer variable “1” + bit variable “1”

Two words are used per double-word integer variable
Example: A total of four words are used when two 

double-word integer variables are 
registered
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11.1 Overview
• The V10/V9 series unit contains device memory map numbers 0 to 31 (32 total) with respect to a single logical port. 

128 addresses can be registered to a single device memory map and batch transfer of addresses can be performed 
between each equipment.

No. 0
No. 1

No. 30
No. 31

No. 0
No. 1

No. 126
No. 127

No. 0
No. 1

No. 30
No. 31

No. 0
No. 1

No. 126
No. 127

No. 0
No. 1

No. 30
No. 31

No. 0
No. 1

No. 126
No. 127

Data

PLC2

PLC8

PROGRAMMER

F A C T O R Y

A C E

PLC1

PLC1 device memory map Device memory

Device memory

Device memory

PLC2 device memory map

PLC8 device memory map

Device memory map

Registration of PLC1 
device memory

Registration of PLC2 
device memory

Registration of PLC8 
device memory
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• Functions that use device memory maps
- Periodical reading

Data in device memory addresses registered on a device memory map is periodically transferred to other equipment. 
(“11.3 Periodical Reading” page 11-7)

- Periodical writing
Data in other equipment is periodically transferred to device memory addresses registered on a device memory map. 
(“11.7 Control Device” page 11-12)

- Synchronized reading
Data in device memory addresses registered on a device memory map is transferred to other equipment when the 
relevant bit turns ON. (“11.4 Synchronized Reading” page 11-8)

- Synchronized writing
Data in other equipment is transferred to device memory addresses registered on a device memory map when the 
relevant bit turns ON. (“11.6 Synchronized Writing” page 11-11)

- Macros (TBL_READ, TBL_WRITE)
Data in device memory addresses registered on a device memory map is transferred using the “TBL_READ” and 
“TBL_WRITE” macro commands. (“11.8 TBL_READ/TBL_WRITE” page 11-13)“11.9 System Device Memory” page 11-14

No. 0
No. 1

1:#PV
 1:#SV

D500
D501

45
60

1:#PV
1:#SV

45
60

CN1 MJ1

Data

PLC2PLC1

Periodical reading/synchronized reading/TBL_READ

Periodical writing/synchronized writing/TBL_WRITE

PLC2 device memory map number 0



11.2    Editing Device Memory Maps

11-3

11

2

3

4

5

6

7

8

9

10

11.2 Editing Device Memory Maps
11.2.1 Starting

1. Click [System Setting] → [Device Memory Map] → [PLCn].
The [Device Memory Map: PLCn] window is displayed.

2. Select a device memory map number and click [OK].
The [Device Memory Map Edit] window is displayed.

A device memory map has numbers 0 to 31 (32 total) with respect to a single logical port and 128 addresses can be 
registered to each device memory map.

11.2.2 Quitting
Click the close button.

11.2.3 Comment Settings
A comment can be set to each device memory map.
1. With the device memory map displayed, click [Edit] → [Comment]. The [Comment Setting] window is displayed.

2. Enter a comment and click the [OK] button. The comment is displayed.
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11.2.4 Editing the Device Memory Map
Double-click a cell to display the settings window.

1. Device memory entry
Set the device memory for transfer. If the [Device Memory Map Edit] window for PLC2 is open, register PLC2 device 
memory.
The following figure shows the list view.

2. Data type

Item Description

Word Data is handled as single-word numerical data.
Data is transferred based on the [Communication Setting] → [Code] setting of each logical port. *1

Double Word Data is handled as two-word numerical data.
Data is transferred based on the [Communication Setting] → [Code] setting of each logical port. *1

Bit Data is handled as single-word bit information.
Data is transferred as is without conversion. *2

Dummy Word
Dummy Double

The transfer source/target device memory addresses are automatically registered with consecutive numbers. 
If there is an address to be skipped, leaving it not configured (blank) will result in either a dummy word or 
double word being assigned.
When reading:

“0” is always stored in the transfer target device memory. Cannot be used for any other purpose.
When writing:

The transfer source device memory can be used for other purposes.

Device memory entry Data type Device memory map settings

* The [Device Memory Map Setting] window can also be displayed by clicking 
[Edit] → [Device Memory Map Setting] with the device memory map displayed.
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*1 When Word or Double Word is selected:
The internal device memory of the V10/V9 series unit are always handled as “DEC (with sign)”.

*2 When Bit is selected:

3. Device memory map settings
Set the purpose of each device memory map.
• TBL_READ/TBL_WRITE → page 11-13
• Periodical reading → page 11-7
• Synchronized reading → page 11-8
• Periodical writing → page 11-10
• Synchronized writing → page 11-11

BCD

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0

MSB LSB

DEC 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 1 0 1 0

MSB LSB

DEC
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 1 0 1 0

MSB LSB

BCD
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0

MSB LSB

Code

Transfer source 
PLC

V10/V9 internal 
device memory

Transfer target 
PLCm

Bit status

Communication 
setting

Communication 
setting

Communication 
setting

Reading

BCD

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0

MSB LSB

DEC

DEC
BCD

Code

Transfer source 
PLC

V10/V9 internal 
device memory

Transfer target 
PLCm

Bit status
Communication setting

Communication setting

Reading



11  Device Memory Map

11-6

11.2.5 Permitting Interruption
Interruption can be permitted by right-clicking on the relevant device memory map number and selecting [Enabling 
Interruption] on the menu.
When interruption is permitted, an asterisk mark (*) is shown next to the device memory map number. Switch output, cycle 
reading, trend/alarm reading operations can be performed during device memory map processing.

Operation for the following settings
Reading group 0 (numbers 0 to 7)
↓
Switch output, cycle reading, trend/alarm reading
↓
Reading group 1 (numbers 8 to 15)

Group 0

Group 1
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11.3 Periodical Reading
Data in a device memory address registered on a device memory map is transferred to the targeted address at the timing set 
for [Reading Cycle].

Settings
Settings required for periodical reading

• “Editing Device Memory Maps” (page 11-3)
• “Device Memory Map Settings”

Item Description
Function Periodical reading

Reading Cycle

Set the cycle for periodical data reading.

Target Device 1
Target Device 2 Set the device memory address for storing the read data.

Control Device Disabled when [Periodical Reading] is selected.

PLC2 PLC1

Data

MJ CN1

Transferred at 5 second intervals

PLC2 device memory map number 0

Disabled when [Periodical Reading] 
is selected

[High-speed Reading] 
checkbox

Reading Cycle
Setting Range Unit

Unselected 1 - 3600 1s
Selected 1 - 3600 100ms
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11.4 Synchronized Reading
Data in a device memory address registered on a device memory map is transferred to the targeted address when the 
relevant bit changes from 0 to 1.

D100
D101

D200
D201
D202
D203

0
0

D100
D101

D200
D201
D202
D203

216
250

PLC2 PLC1

Data

MJ CN1

Transfer

PLC2 device memory map number 0

Control device memory ON

Verification device memory ON

PLC1

Control Device

Transfer target 
device memory

PLC1

Control Device

Transfer target 
device memory

Data transfer
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Settings
Settings required for synchronized reading

• “Editing Device Memory Maps” (page 11-3)
• “Device Memory Map Settings”

Item Description
Function Synchronized reading
Target Device 1
Target Device 2 Set the device memory address for storing the read data.

Control Device
Set the device memory address that serves as the trigger for synchronized reading.
Four words are used for an address common to device memory map numbers 0 to 31.
For details, refer to “Control Device” page 11-12.
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11.5 Periodical Writing
Data in a source device memory address is transferred to the address registered on the device memory map at the timing set 
for [Writing Cycle].

Settings
Settings required for periodical writing

• “Editing Device Memory Maps” (page 11-3)
• “Device Memory Map Settings”

Item Description
Function Periodical writing

Periodical Writing

Set whether to perform periodical data writing.

Source Device 1
Source Device 2 Set the device memory address of the source data to transfer.

Control Device Disabled when [Periodical Writing] is selected.

PLC2 PLC1

Data

MJ CN1

Transferred at 5 second intervals

PLC2 device memory map number 0

Disabled when [Periodical Writing] 
is selected

[High-speed Reading] 
checkbox

Reading Cycle
Setting Range Unit

Unselected 1 - 3600 1s
Selected 1 - 3600 100ms
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11.6 Synchronized Writing
Data in a source device memory address is transferred to the address registered on the device memory map when the control 
device memory changes from 0 to 1.

Settings
Settings required for synchronized writing

• “Editing Device Memory Maps” (page 11-3)
• “Device Memory Map Settings”

Item Description
Function Synchronized writing
Source Device 1
Source Device 2 Set the device memory address for storing data from the transfer source.

Control Device
Set the device memory address that serves as the trigger for synchronized writing.
Four words are used for an address common to device memory map numbers 0 to 31.
For details, refer to “Control Device” page 11-12.

41003 200

D100

D200
D201
D202
D203

200

D100

D200
D201
D202
D203

200

PLC2 PLC1

Data

MJ CN1

Writing
&

Verification device 
memory ON

Transfer

PLC2 device memory map number 0

Control device memory ON

PLC1

Transfer source 
device memory

Control Device

PLC2 PLC1
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11.7 Control Device
This type of device memory is used when synchronized reading or synchronized writing is performed.
Four consecutive words are used from control device memory n.
The control device memory can also be changed via [System Setting] → [Device Memory Map] → [PLCn] → [Edit] → [Device 
Memory Map Setting].

Reading/Writing Command Device Memory (Control device memory n, n+1)
One bit is assigned to each device memory map.
Reading and writing for the specified device memory map is executed according to the change in bit status from 0 to 1.

Reading/Writing Verification Device Memory (Control device memory n+2, n+3)
One bit is assigned to each device memory map.
The turning ON (0 → 1) of the command device memory is recognized, and when the reading/writing finishes, the 
corresponding bit of the verification device memory turns ON (0 → 1).
Also, when the turning OFF (1 → 0) of the command device memory is recognized, the verification bit of the corresponding 
device memory map number turns OFF (1 → 0).

• Synchronized reading
Only one address needs to be successfully read among the addresses registered on the device memory map for the 
verification device memory to turn ON.
If no addresses were successfully read, the verification bit does not turn ON.

• Synchronized writing
Regardless of whether writing succeeds or fails, the verification bit turns ON after writing is finished.

Control Device Description Device Memory Type
n

Command device memory for reading/writing → V
n+1
n+2

Verification device memory for reading/writing ← V
n+3

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

n

Device memory map numbers 0 to 15

Device memory map numbers 16 to 31

n+1

Bit number

Bit number

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

n+2

Device memory map numbers 0 to 15

Device memory map numbers 16 to 31

n+3

Bit number

Bit number
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11.8 TBL_READ/TBL_WRITE
Data in device memory addresses registered on a device memory map is transferred at once using the “TBL_READ” and 
“TBL_WRITE” macro commands.

Settings
Settings required for device memory map transfer

• “Editing Device Memory Maps” (page 11-3)
• Device memory map settings
• Macros (TBL_READ/TBL_WRITE)

Device Memory Map Settings

Macros
Register a switch ON macro, interval timer etc. For details on macro commands, refer to the Macro Reference Manual.

• TBL_READ
Transfers data in device memory addresses registered on a device memory map to device memory of other equipment.

• TBL_WRITE
Transfers data from other equipment to a device memory address registered on a device memory map.

Item Description
Function TBL_READ/TBL_WRITE

* Transfer is possible using a macro even for device memory maps selected for other functions.
Control Device Disabled when TBL_READ/TBL_WRITE is selected.

Disabled when TBL_READ/TBL_WRITE 
is selected
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11.9 System Device Memory
This section explains the system device memory addresses of the V10/V9 series that are related to device memory maps.

*1 When controlling a device memory map using $s762, $s763, or $s764, set [PLC Properties] → [Detail] → [System memory ($s) V7 
Compatibility] to [Yes] for PLC2. In this case, $P2:493/494/495 cannot be used.

$Pn:493, 495
These system device memory addresses can be used to temporarily stop periodical reading/synchronized reading or 
periodical writing/synchronized writing set in the device memory map.

• Example: Periodical reading
When PLC2 device memory is accessed by a macro, macro completion is delayed when periodical reading of the device 
memory map is executed (as shown in figure A). To avoid this, periodical reading can be stopped temporarily using 
$P2:493 (as shown in Figure B).

$Pn
(n=1 - 8) $s*1 Description Device Type

493 762
(PLC2)

Device memory map reading prohibition flag
0: Periodical reading/synchronized reading executable
Other than 0: Periodical reading/synchronized reading stopped

→ V494 763
(PLC2)

Device memory map TBL_READ/TBL_WRITE macro forced execution
Macro operation setting when a port is not communicating

0: Do not execute the macro with respect to all ports
Other than 0: Execute the macro with respect to connected ports

495 764
(PLC2)

Device memory map writing prohibition flag
0: Periodical writing/synchronized writing executable
Other than 0: Periodical writing /synchronized writing stopped

$Pn:493 $Pn:495
- 0: Periodical reading/synchronized reading is 

always executed.
- 0: Periodical writing/synchronized writing is 

always executed.
- Other than 0: Periodical reading/synchronized reading is 

stopped.
- Other than 0: Periodical writing/synchronized writing is 

stopped.

PLC_CTL $u100 2
PLC_CTL $u110 2
PLC_CTL $u120 2

PLC_CTL $u300 2

T

t

PLC_CTL $u100 2
PLC_CTL $u110 2
PLC_CTL $u120 2

PLC_CTL $u300 2

T+t

T T

$P2:493=1
PLC_CTL $u100 2
PLC_CTL $u110 2
PLC_CTL $u120 2

PLC_CTL $u300 2
$P2:493=0

$P2:493=1
PLC_CTL $u100 2
PLC_CTL $u110 2
PLC_CTL $u120 2

PLC_CTL $u300 2
$P2:493=0

t

Device memory map
Periodical reading

Figure A

Macro A executionMacro A execution

Periodical reading of PLC2
device memory map

V10/V9 unit communication
cycle

Macro B executionMacro B execution

Periodical reading of PLC2
device memory map

Device memory map
Periodical reading

V10/V9 unit communication
cycle

• TEL_READ
• TEL_WRITE
• PLC_CTL
• When using PLC2 device 

memory with MOV, BMOV, 
BSET, BCLR, BINV etc.

Figure B
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12.3 Ethernet Connection between the V10/V9 Series 
Unit and PLC
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12.1 Overview

• PLC ladder programs can be written and monitored via the V10/V9 series unit.
• The supported models and configuration procedure depend on whether the connection between the V10/V9 series unit 

and PLC is serial or Ethernet. Be sure to check the system configuration.

• If the connection between the V10/V9 series unit and PC is USB/Ethernet, use the “LadderComOP Ver. 2” software.

Serial Connection between the V10/V9 Series Unit and PLC 
• There are three methods for connecting the V10/V9 series unit and PC: by USB connection, Ethernet, and serial 

connection.
Example: USB connection

• Of PLCs 1 to 8, ladder communication is possible with the three PLCs connected by serial connection.

Example: Ladder communication with three PLCs using Ethernet ladder transfer function

• “12.2 Serial Connection between the V10/V9 Series Unit and PLC” page 12-3
• “12.3 Ethernet Connection between the V10/V9 Series Unit and PLC” page 12-29

Installation → “12.2.3 Ladder Transfer via USB” page 12-11

For details on the configuration procedure, refer to.
• USB connection → “12.2.3 Ladder Transfer via USB” page 12-11
• Ethernet connection → “12.2.4 Ladder Transfer via Ethernet” page 12-16
• Serial connection → “12.2.5 Serial Ladder Transfer” page 12-22

USB-AUSB-miniB

USB cable

Computer

PLC ladder 
software

Ladder program, monitor, etc.

V10/V9 series unit

PLC

Serial 
RS-232C/422

CN1 MJ2 MJ1

Port1
Port2
Port3

LAN

Computer

PLC ladder 
software

V10/V9 Series

PLC1
Manufacturer A

Ladder program, monitor, etc.

PLC2
Manufacturer B

PLC3
Manufacturer C

* Simultaneous communication with multiple PLCs by 
one computer is not possible. Specify the ladder 
transfer port of the PLC to communicate with using the 
“LadderComOp“ ladder transfer tool on the computer.

Ethernet

Serial

Serial

Serial



12  Ladder Transfer

12-2

Ethernet Connection between the V10/V9 Series Unit and PLC 
• Ethernet connection can be used when the V10/V9 series unit and PC as well as the V10/V9 series unit and PLC are both 

connected via Ethernet.
• Since the LAN ports on the V10/V9 series unit use two channels, only models equipped with LAN2 or WLAN support 

Ethernet connections.

• The ladder transfer function is only available when [Hardware Setting] → [PLC Properties] → [Connection 
Mode] is set to [1 : 1] or [Multi-link2] (with local port number set to “1“) in the V-SFT.
This function cannot be used for 1:n communication (multi-drop) or multi-link communication.

• Simultaneous ladder communication with multiple PLCs by one computer is not possible. Be sure to specify 
the ladder transfer port of the PLC to communicate with using the “LadderComOp“ ladder transfer tool.

• Be sure to use a different ladder transfer port for each PLC.

For details on the configuration procedure, refer to “12.3.3 Setting Procedure” page 12-31.

LAN  IP 192.168.3.5

LAN2  IP 192.168.1.1

IP 192.168.3.100

Computer

PLC ladder
software

Ladder program, monitor, etc.

V10/V9 
series

PLC
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12.2 Serial Connection between the V10/V9 Series Unit and PLC
12.2.1 Operating Environment

Supported V10/V9 Models and Connection Ports

*1 PLC connection ports cannot be used.
*2 Windows Vista, 7, 8, 8.1, 10, and 11 are supported.

If using Windows 11, use V-SFT version 6.1.6.0 or later and LadderComOp version 2.1.2.0 or later.

Supported PLC Models

PLC models that support the ladder transfer function are listed below.

V10/V9 PLC Connection Ports
(V10/V9 - PLC)

Ladder Transfer Ports
(V10/V9 - PC) Used Applications *2

All CN1
MJ1
MJ2

USB-B
V-SFT Ver. 6 / LadderComOp Ver. 2

LAN / LAN2 / WLAN
MJ1 / MJ2 *1 V-SFT Ver. 6

• The ladder transfer function is only available when [Hardware Setting] → [PLC Properties] → [Connection 
Mode] is set to [1 : 1] or [Multi-link2] (with local port number set to “1“) in the V-SFT.
This function cannot be used for 1:n communication (multi-drop) or multi-link communication.

• For details on compatible PLC models, refer to the Connection Manual.

Manufacturer PLC Name Shown in 
Editor Connection CPU/Port

V10/V9 Port
MJ1, MJ2 USB B *1 Built-in LAN

MITSUBISHI 
ELECTRIC

A series CPU

A2A, A3A
A2U, A3U, A4U
A2US(H)
A1N, A2N, A3N
A3V, A73
A3H, A3M
A0J2H
A1S(H), A1SJ(H)
A2S(H)
A2CCPUC24
A1FX

 *2

QnH (Q) series CPU Q02(H), Q06H

QnU series CPU
Q00UJ, Q00U, Q01U
Q02U, Q03UD, Q04UDH
Q06UDH, Q10UDH, Q13UDH 
Q20UDH, Q26UDH

Q00J/00/01 CPU Q00J, Q00, Q01
QnH (Q) series CPU
(Multi CPU) Q02(H), Q06H

Q170MCPU
(Multi CPU) Q170M

FX series CPU
FX1/2 × × ×

FX0N
FX2N/1N
series CPU FX2N, FX1N, FX2NC

FX1S series CPU FX1S
FX-3U/3UC/3G
series CPU FX-3U, FX-3UC, FX-3G

OMRON
SYSMAC C

All ports
SYSMAC CS1/CJ1/CJ2
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Panasonic
FP Series
(RS232C/422)

FP0 tool port
FP2 tool port
FP2SH tool port
FPΣ tool port
FP-e tool port
FP-X tool port
FP0H tool port

FP7 Series (RS232C/422) All ports

Yokogawa 
Electric

FA-M3
Tool port on CPUFA-M3R

FA-M3V × × ×

Fuji Electric

SPB (N mode) & 
FLEX-PC CPU

FLEX-PC CPU port
NJ-B16 RS-232C port
NW0Pxx CPU port

MICREX-SX 
SPH/SPB/SPM/SPE/SPF 
CPU

NP1Px-xx(SPH)
NW0Pxx(SPB)
NA0PAxxx-xx(SPF)

FRENIC series
(loader)

FRENIC5000 VG7S
FRENIC-Mini
FRENIC-Eco
FRENIC-Multi
FRENIC-MEGA
FRENIC-MEGA SERVO
FRENIC-HF
FRENIC-Lift
FRENIC-HVAC/AQUA
FRENIC-VG1
FRENIC-Ace

Allen-Bradley SLC500 SLC5/03 or later, Channel 0

Siemens *1 *3
S7-200PPI S7-200 PPI port *1 *3 *1 *3

S7-300/400MPI S7-300/400 MPI port *1 *3 × *1 *3

SAMSUNG SECNET

N70 COM port
(RS-422)
N70 α COM port 
N700 COM port
(RS-422)
N700 α TOOL port
N7000 COM port
(RS-422)
N7000 α COM1
NX70 TOOL port
NX700 TOOL port

FATEK
AUTOMATION FACON FB series Programming port on CPU

Telemecanique TSX Micro TSX37-xx
TSX57-xx

RS Automation N7/NX Series 
(70/700/750/CCU)

N70 COM port
(RS-422)
N70 α COM port 
N700 COM port
(RS-422)
N700 α TOOL port
N7000 COM port
(RS-422)
N7000 α COM1
NX70 TOOL port
NX700 TOOL port

Manufacturer PLC Name Shown in 
Editor Connection CPU/Port

V10/V9 Port
MJ1, MJ2 USB B *1 Built-in LAN
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*1 Ladder communication is only available in RUN mode. Ladder communication cannot be performed in Local mode.
*2 Uses both MJ1 and MJ2 so the dedicated “V6-CP-A” cable is required.
*3 The following messages may be displayed at the top left of the screen on the V10/V9 series unit during access (mainly when transferring 

a large amount of data, such as programs) to the Siemens S7-200 PPI and S7-300/400 MPI. The V10/V9 series unit automatically returns 
to normal operation after access is complete.
- PLC1  Access denied by Loader
- PLC1  In Reset Service
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12.2.2 LadderComOp Ver. 2
The “LadderComOp” ladder transfer tool is required when connecting the V10/V9 series unit and PC via USB or Ethernet in 
order to monitor or write PLC ladder programs.

LadderComOp Installation

Acquiring the LadderComOp Software
• On the V-SFT Ver. 6 CD-ROM, or download the latest update from our website.
• Download “LadderComOp.exe” from our website.

Installation
If installing LadderComOp during V-SFT Ver. 6 installation, perform the procedure below from step 1.
If installing LadderComOp after downloading “LadderComOP.exe” from our website, perform the procedure below from step 
2.

1. After V-SFT Ver. 6 has been installed or updated, the following dialog box is displayed.
Click the [Yes] button.

2. Click the [Next] button.

3. Select the location to install the tool and click the [Next] button.

Our website URL: www.monitouch.com

Installation location (default)
Windows Vista/7/8/8.1/10/11: MONITOUCH
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4. Click the [Install] button.

5. Installation of LadderComOp starts.

6. The following window is displayed. Install the LadderComOp driver.
This window is display three times so click the [Install] button each time.

7. Installation of the driver starts.

The following window is displayed during installation.
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8. The following window is displayed when LadderComOp installation is complete. Click the [Finish] button.

9. The following message is displayed on the PC’s task bar when installation is complete.

10. Open the Device Manager on the PC.
If installation was successful, “LadderComOp2” is displayed in the Device Manager.

This completes the installation procedure.

If installation was not successful, a yellow exclamation mark (!) is displayed under [Other devices] in the Device 
Manager.
If this happens, uninstall LadderComOp and then reinstall it.
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LadderComOp Ver. 2 Detailed Settings

Item Description
1. Icon Clicking this icon and selecting [About LadderComOp] opens a window that displays the version of 

LadderComOp.
2. Communication Select [Ladder Transfer].
3. Option Configure the option settings.

Connected to the 
MITSUBISHI A series CPU.

Always select this when using a MITSUBISHI ELECTRIC A series CPU for the PLC.

Connected to the TSX Micro. Always select this when using a Telemecanique TSX Micro for the PLC.
Add in the task tray. Select this to add ladder transfer settings to the task tray.

4. PC A total of two COM ports on the PC are used.
• Used Port

Select the COM port to use for ladder transfer from the list.
Range: COM1 to COM256
(COM port numbers that are already assigned on the PC are not shown in the list.)
The COM port number set here needs to be set in each relevant PLC programming software.*

* The range of usable COM port numbers depends on the PLC programming software.
For details, refer to the relevant PLC manual.
Example:
Panasonic FPWIN GR, COM1 to 15
(COM1 to 5 for Ver. 2.2 or earlier)

• Virtual Port
An unassigned COM port number is selected automatically.

5. Monitouch Select the connection method to use between the PC and V10/V9 series unit.
• USB

No settings are required.
• Ethernet

IP address: Set the local IP address of the V10/V9 series unit (built-in LAN port).
Port No: Set the port number of the V10/V9 series unit.

Set the same port number as set under [System Setting] → [Hardware Setting] 
→ [Ladder Transfer].
Range: 1024 to 65533 (default: 1024)

6. ONLINE/OFFLINE Turn ladder transfer ON or OFF between the PC and V10/V9 series unit.
• ONLINE

Establish a connection between the PC and V10/V9 series unit and enable ladder transfer 
mode.

• OFFLINE
Disconnect the PC and V10/V9 series unit.

4.

1.

5.

6.

7.

2.
3.
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7. Hide/END • Hide
Display an icon in the task tray when a connection is established. 
Ladder transfer settings are added to the task tray.
* The [Add in the task tray] checkbox is automatically selected.
- The task tray tool tip indicates “Transferring...”.

- Right-click on the icon in the task tray to display a menu.

• END
Display an icon in the task tray when a connection is not established.
Disconnect the PC and V10/V9 series unit and close the [Ladder Transfer Setting] window.

Item Description

Right-click
Return

Display the [Ladder Transfer Setting] window.
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12.2.3 Ladder Transfer via USB

The V10/V9 series unit and PC can be connected via USB to monitor or write PLC ladder programs through the V10/V9 series 
unit.

Setting Procedure
V-SFT and LadderComOp configuration is required. Refer to the following for the setting procedure.

• V-SFT Ver. 6 settings → “V-SFT Ver. 6 Settings” page 12-11
• LadderComOp settings → “LadderComOp Settings” page 12-13
• PLC programming software settings → “PLC Programming Software Settings” page 12-14

V-SFT Ver. 6 Settings
This section describes the settings for ladder transfer using the MITSUBISHI QnU series CPU as an example.

[Ladder Transfer Setting] window
1. Click [Communication Setting] → [Hardware Setting] to display the [Hardware Setting] window.

For details on supported PLC models, refer to “Supported PLC Models” page 12-3.

• The ladder transfer function is only available when [Hardware Setting] → [PLC Properties] → [Connection 
Mode] is set to [1 : 1] or [Multi-link2] (with local port number set to “1“) in the V-SFT.
This function cannot be used for 1:n communication (multi-drop) or multi-link communication.

• The USB ladder transfer function cannot be used on units to which the USB simulator driver has been 
transferred. Always deselect the [Use Simulator] checkbox when transferring screen programs.

USB-AUSB-miniB

USB cable

PC

PLC ladder 
software

Ladder program/monitor, etc.

V10/V9 series unit

PLC

Serial 
RS232C/422
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2. Click [Ladder Transfer] to display the [Ladder Transfer Setting] window.

3. Select the port to which the PLC is connected and set the port to which the computer is connected (the ladder transfer 
port) to [USB B].

* Be sure to use a different ladder transfer port for each PLC.

4. Click the [OK] button to complete the necessary settings. Transfer the screen program to the V10/V9 series unit.

Notes on ladder transfer via USB
Observe the following when transferring screen programs over a USB cable.

• Change the V10/V9 series unit to Local mode.
(Ladder communication is enabled only in RUN mode.)

• Set LadderComOp Ver. 2 to [OFFLINE] mode.
(For details on this setting, refer to “LadderComOp Ver. 2 Detailed Settings” page 12-9.)

Timeout settings for ladder communication can be configured from [Detail Setting].
Configure these settings when communication is unstable.

Time-out period between 
characters

Set the time for checking that data has been transmitted from the ladder tool. Set a time appropriate for the 
operation environment.

Time-out period between 
frames

Set the time for monitoring whether a response is received from the PLC after the ladder tool has sent data 
to the PLC.
Set a time appropriate for the operation environment.
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LadderComOp Settings
When using the ladder transfer function via USB/Ethernet, the dedicated “LadderComOp” tool must be installed on the PC. 
For details on the LadderComOp installation procedure, refer to “LadderComOp Installation” page 12-6.

[Ladder Transfer Setting] window
1. From the Windows [Start] menu, click [Programs] → [V-SFT V6] → [LadderComOp] → [Ladder Transfer Setting].

2. The [Ladder Transfer Setting] window is displayed.
3. Select [Communication] → [Ladder Transfer].

4. Select the COM port to use for ladder transfer from the [Used Port] list under [PC].
* This port must match the COM port used in the PLC programming software.

5. Select [USB] under [Monitouch].

6. Click the [ONLINE] button.
The display above the ladder transfer settings changes to the connected state.

This completes the LadderComOp settings.
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PLC Programming Software Settings
Set the COM port number configured in the [Ladder Transfer Setting] window of LadderComOp to the following window of 
the relevant PLC programming software to enable access to the PLC.

MITSUBISHI ELECTRIC GX Developer/GX Works2

OMRON CX-Programmer
Be sure to select “SYSMAC WAY” for [Network Type].
[Network Settings] dialog → [Driver] → [Port Name]
For [Baud Rate], specify the same value between the V10/V9 unit and the PLC.

Panasonic “FPWIN GR”
[Communication Settings] dialog → [Port No.]
For [Baud Rate], specify the same value between the V10/V9 unit and the PLC.

Yokogawa Electric “Wide Field2”
[Environmental Settings] dialog → [Communication Settings] → [COM Port No.]

Example: [Ladder Transfer Setting] window, COM port number 9

For [Transmission speed], specify the same 
value as the baud rate between the V10/V9 
series unit and the PLC.
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Fuji Electric SX-Programmer Expert (D300win)

Telemecanique Drivers Manager

For [Baud rate], specify the same value as the baud 
rate between the V10/V9 series unit and the PLC.

UNI-TELWAY Slave Address
Specify the same [Base] and 
[Numbers] values.

V-SFT
[System Setting] → [Hardware Setting] → 
[Ladder Transfer] → [Detailed Setting]

Specify the same baud rate for 
both the V10/V9 series unit and 
PLC.
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12.2.4 Ladder Transfer via Ethernet
The V10/V9 series unit and PC can be connected via Ethernet to monitor or write PLC ladder programs through the V10/V9 
series unit.

Setting Procedure
V-SFT and LadderComOp configuration is required. Refer to the following for the setting procedure.

• V-SFT Ver. 6 settings → “V-SFT Ver. 6 Settings” page 12-16
• LadderComOp settings → “LadderComOp Settings” page 12-18
• PLC programming software settings → “PLC Programming Software Settings” page 12-19

V-SFT Ver. 6 Settings
This section describes the settings for ladder transfer using the MITSUBISHI QnU series CPU as an example.

[Ladder Transfer Setting] window
1. Click [Communication Setting] → [Hardware Setting] to display the [Hardware Setting] window.

For details on supported PLC models, refer to “Supported PLC Models” page 12-3.

The ladder transfer function is only available when [Hardware Setting] → [PLC Properties] → [Connection 
Mode] is set to [1 : 1] or [Multi-link2] (with local port number set to “1“) in the V-SFT.
This function cannot be used for 1:n communication (multi-drop) or multi-link communication.

Ethernet

PC

PLC ladder 
software

Ladder program/monitor, etc.V10/V9 series unit

PLC

Serial 
RS232C/422
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2. Click [Ladder Transfer] to display the [Ladder Transfer Setting] window.

3. Select the port to which the PLC is connected and set the port to which the computer is connected (the ladder transfer 
port) to [LAN2/WLAN] and specify the port number.

* This port is also used in the LadderComOp settings.
Be sure to use a different ladder transfer port for each PLC.

This completes the necessary settings. Transfer the screen program to the V10/V9 series unit.

Timeout settings for ladder communication can be configured from [Detail Setting].
Configure these settings when communication is unstable.

Time-out period between 
characters

Set the time for checking that data has been transmitted from the ladder tool. Set a time appropriate for the 
operation environment.

Time-out period between 
frames

Set the time for monitoring whether a response is received from the PLC after the ladder tool has sent data 
to the PLC.
Set a time appropriate for the operation environment.
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LadderComOp Settings
When using the ladder transfer function via USB/Ethernet, the dedicated “LadderComOp” tool must be installed on the PC. 
For details on the LadderComOp installation procedure, refer to “LadderComOp Installation” page 12-6.

[Ladder Transfer Setting] window
1. From the Windows [Start] menu, click [Programs] → [V-SFT V6] → [LadderComOp] → [Ladder Transfer Setting].

2. The [Ladder Transfer Setting] window is displayed.
3. Select [Communication] → [Ladder Transfer].

4. Select the COM port to use for ladder transfer from the [Used Port] list under [PC].
* This port must match the COM port used in the PLC programming software.

5. Select [Ethernet] under [Monitouch] and set the IP address of the V10/V9 series unit and the port number to use in ladder 
transfer.

* The port number must match the ladder transfer port number specified in the [Hardware Setting] window of 
V-SFT Ver. 6.

6. Click the [ONLINE] button.
The display above the ladder transfer settings changes to the connected state.

This completes the LadderComOp settings.
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PLC Programming Software Settings
Set the COM port number configured in the [Ladder Transfer Setting] window of LadderComOp to the following window of 
the relevant PLC programming software to enable communication with the PLC.

MITSUBISHI ELECTRIC GX Developer/GX Works2

OMRON CX-Programmer
Be sure to select “SYSMAC WAY” for [Network Type].
[Network Settings] dialog → [Driver] → [Port Name]
For [Baud Rate], specify the same value between the V10/V9 unit and the PLC.

Panasonic “FPWIN GR”
[Communication Settings] dialog → [Port No.]
For [Baud Rate], specify the same value between the V10/V9 unit and the PLC.

Yokogawa Electric “Wide Field2”
[Environmental Settings] dialog → [Communication Settings] → [COM Port No.]

Example: [Ladder Transfer Setting] window, COM port number 9

For [Transmission speed], specify the same 
value as the baud rate between the V10/V9 
series unit and the PLC.
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Fuji Electric SX-Programmer Expert (D300win)

Siemens “STEP 7-Micro/WIN”
[Set PG/PC Interface] dialog → [PC/PPI cable (PPI)] → [Properties].

Siemens SIMATIC Manager

For [Baud rate], specify the same 
value as the baud rate between the 
V10/V9 series unit and the PLC.

The baud rate between the V10/V9 unit 
and the PC is fixed to 115 Kbps.

Set [Connection to:] in the range of 
COM1 to 8.
[Transmission rate:] does not need to be 
changed.
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Telemecanique Drivers Manager

UNI-TELWAY Slave Address
Specify the same [Base] and 
[Numbers] values.

V-SFT
[System Setting] → [Hardware Setting] → 
[Ladder Transfer] → [Detailed Setting]

Specify the same baud rate for 
both the V10/V9 series unit and 
PLC.
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12.2.5 Serial Ladder Transfer
The V10/V9 series unit and PC can be connected using a “V-CP” screen program transfer cable to monitor or write PLC ladder 
programs through the V10/V9 series unit.

* For the MITSUBISHI A series CPU, use Hakko Electronics “V6-CP-A” cable to connect the V10/V9 series unit and 
PC.

Executing Screen Program Transfer and Ladder Transfer Using the MJ1 Port
Use the MJ1 port when using the ladder transfer function and performing screen program transfer over a single cable.
Screen program transfer and PLC programming software transfers cannot be performed at the same time. Communication of 
either software is cut off in order to perform transfers.
Screen program transfer is only possible in Local mode. For details, refer to   [Ladder Communication is not Used in Local 
Mode] settings page 12-25 .

Executing Screen Program Transfer Using the MJ1 Port and Ladder Transfer Using the 
MJ2 Port
Screen program transfer and PLC programming software transfers can be performed using separate COM ports and cables.
Screen program transfer and PLC programming software transfers cannot be performed at the same time.

For details on supported PLC models, refer to “Supported PLC Models” page 12-3.

The ladder transfer function is only available when [Hardware Setting] → [PLC Properties] → [Connection 
Mode] is set to [1 : 1] or [Multi-link2] (with local port number set to “1“) in the V-SFT.
This function cannot be used for 1:n communication (multi-drop) or multi-link communication.

COM
MJ1/MJ2

V-CP

PC

PLC ladder 
software

Ladder program/monitor, etc.

V10/V9 series 

PLC

Serial 
RS232C/422

MJ1CN1 COM1
V10/V9

Computer (PC)
PLC

1:1 communication cable
CPU port

Communication between the PLC programming software
and PLC

Communication between the editor and V10/V9 series unit

Communication between the V10/V9 series unit and PLC

V-CP
PLC software

V-SFT

MJ1CN1 COM1

COM2MJ2

V10/V9

Computer (PC)
PLC 1:1 communication cable

CPU port

Communication between the PLC programming software
and PLC

Communication between the editor and V10/V9 series unit

Communication between the V10/V9 series unit and PLC

V-CP PLC software
V-SFT

V-CP



12.2    Serial Connection between the V10/V9 Series Unit and PLC

12-23

1

12

3

4

5

6

7

8

9

10

1
Communication with the MITSUBISHI ELECTRIC A Series CPU
Use Hakko Electronics “V6-CP-A” cable to connect the V10/V9 series unit and PC.

Setting Procedure
V-SFT configuration is required. Refer to the following for the setting procedure.

• V-SFT Ver. 6 settings → “V-SFT Ver. 6 Settings” page 12-23
• PLC programming software settings → “PLC Programming Software Settings” page 12-26

V-SFT Ver. 6 Settings
This section describes the settings for ladder transfer using the MITSUBISHI QnH (Q) series CPU as an example.

[Ladder Transfer Setting] window
1. Click [System Setting] → [Hardware Setting] → [Ladder Transfer]. The [Ladder Transfer Setting] window is displayed.

MJ1CN1 COM1

MJ2
V10/V9

Computer (PC)
PLC 1:1 communication cable

CPU port

Communication between the PLC programming software
and PLC

Communication between the editor and V10/V9 series unit

Communication between the V10/V9 series unit and PLC

V6-CP-A
PLC software

V-SFT
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2. Select the port to which the PLC is connected and set the port to which the computer is connected to [MJ1] or [MJ2].

3. Click the [OK] button to complete the necessary settings. Transfer the screen program to the V10/V9 series unit.

Timeout settings for ladder communication can be configured from [Detail Setting].
Configure these settings when communication is unstable.

Time-out period between 
characters

Set the time for checking that data has been transmitted from the ladder tool. Set a time appropriate for the 
operation environment.

Time-out period between 
frames

Set the time for monitoring whether a response is received from the PLC after the ladder tool has sent data 
to the PLC.
Set a time appropriate for the operation environment.
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[Ladder Communication is not Used in Local Mode] settings

Whether screen program transfer and ladder transfer can be performed in a particular state of the V10/V9 series unit differs 
depending on the combination of this setting and the modular jack function.

• MJ1: Ladder transfer

• MJ1: Not connected, MJ2: Ladder transfer

• MJ1: Not connected/other than ladder transfer, MJ2: Ladder transfer

* Switching to Local mode
Press the [SYSTEM] → [Local] switch to display the local mode screen.
The [System Information] → [Editor Transfer Port] → [Set Port] setting is [----] (ladder transfer mode).
In this case, screen program transfer using the MJ1 port cannot be performed.
When transferring the screen program, press and hold for more than two seconds near the [Set Port] display and switch 
[---] to [MJ1] using the [ ] switch.

[Ladder Communication is not 
Used in Local Mode] V10/V9 Series Unit State Screen Program Transfer Ladder Transfer

Selected
RUN

Local mode

Unselected
RUN

Local mode * *

[Ladder Communication is not 
Used in Local Mode] V10/V9 Series Unit State Screen Program Transfer Ladder Transfer

Selected
RUN

Local mode

Unselected
RUN

Local mode

[Ladder Communication is not 
Used in Local Mode] V10/V9 Series Unit State Screen Program Transfer Ladder Transfer

Selected
RUN

Local mode

Unselected
RUN

Local mode

Editor Transfer Port Screen Program Transfer Ladder Transfer
-----
MJ1

Press and hold for at least 2 seconds.
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PLC Programming Software Settings
Set the COM port number to enable communication with the PLC.

MITSUBISHI ELECTRIC GX Developer/GX Works2

OMRON CX-Programmer
Be sure to select “SYSMAC WAY” for [Network Type].
[Network Settings] dialog → [Driver] → [Port Name]
For [Baud Rate], specify the same value between the V10/V9 unit and the PLC.

Panasonic “FPWIN GR”
[Communication Settings] dialog → [Port No.]
For [Baud Rate], specify the same value between the V10/V9 unit and the PLC.

Yokogawa Electric “Wide Field2”
[Environmental Settings] dialog → [Communication Settings] → [COM Port No.]

Fuji Electric SX-Programmer Expert (D300win)

Siemens “STEP 7-Micro/WIN”
[Set PG/PC Interface] dialog → [PC/PPI cable (PPI)] → [Properties].

For [Transmission speed], specify the same 
value as the baud rate between the V10/V9 
series unit and the PLC.

For [Baud rate], specify the same 
value as the baud rate between the 
V10/V9 series unit and the PLC.

The baud rate between the V10/V9 unit 
and the PC is fixed to 115 Kbps.
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Siemens SIMATIC Manager

Telemecanique Drivers Manager

Set [Connection to:] in the range of 
COM1 to 8.
[Transmission rate:] does not need to be 
changed.

UNI-TELWAY Slave Address
Specify the same [Base] and 
[Numbers] values.

V-SFT
[System Setting] → [Hardware Setting] → 
[Ladder Transfer] → [Detailed Setting]

Specify the same baud rate for 
both the V10/V9 series unit and 
PLC.
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12.2.6 Notes
Screen Program Transfer

• When transferring a screen program via USB cable while executing the ladder transfer function via USB, always perform 
the following.

- Change the V10/V9 series unit to Local mode.
(Ladder communication is enabled only in RUN mode.)

- Set LadderComOp Ver. 2 to [OFFLINE] mode.
(For details on this setting, refer to “LadderComOp Ver. 2 Detailed Settings” page 12-9.)

• When using Siemens S7-200 PPI or S7-300/400 MPI, always change to local mode before transferring the screen 
program. (Ladder communication is enabled only in RUN mode.)

Other Notes
• The ladder transfer function can be used for up to three ports with PLC 1 to 8.
• When using a PC with user privileges enabled, perform the following in advance.

1) Log in with administrator privileges.
2) Start the LadderComOp program and set a COM port for [Used Port].

* When settings are configured initially, LadderComOp may take a few moments to exit.
Also, if a user logs in without administrator privileges, the following message is displayed and the LadderComOP software cannot 
be used.

• The following messages are displayed at the top left of the screen on the V10/V9 series unit during access (mainly when 
transferring a large amount of data, such as programs) to the Siemens S7-200 PPI and S7-300/400 MPI. The V10/V9 series 
unit automatically returns to normal operation after access is complete.

- PLC1  Access denied by Loader
- PLC1  In Reset Service

• The communication states of the PLC programming software and PLC when communication is performed between the 
editor and the V10/V9 series unit are shown below.

• Baud rate
The baud rate used between the V10/V9 series unit and the PLC is the value set in the editor for [Hardware Setting] → 
[PLC Properties] → [Baud Rate].
However, when communication (monitoring etc.) with the PLC programming software occurs with the ladder transfer 
function, the baud rate value changes to that of the PLC programming software. This baud rate is retained until power to 
the V10/V9 series unit is turned off and on again.
For this reason, set the same baud rate setting for [Hardware Setting] → [PLC Properties] → [Baud Rate] as the PLC 
programming software.

• When [Use Ladder Tool] is set to [Yes], monitor registration of the V10/V9 series unit and PLC communication is 
prohibited even if the PLC programming software is not running. This means that the screen display speed is slightly 
slower than usual.

• When transferring ladder programs when the V10/V9 series unit is in RUN mode, the performance of both the V10/V9 
series unit and the PLC programming software decreases because communication between the two is performed in 
synchronization.

Editor PLC Programming Software
Writing to V10/V9 series unit Communication stops (normal communication after writing finishes)
Reading from V10/V9 series unit Normal communication
Checking with V10/V9 series unit Normal communication
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12.3 Ethernet Connection between the V10/V9 Series Unit and PLC
12.3.1 Operating Environment

Supported V10/V9 Models and Connection Ports

*1 PLC connection ports cannot be used.
*2 Windows Vista, 7, 8, 8.1, 10, and 11 are supported.

If using Windows 11, use V-SFT version 6.1.6.0 or later and LadderComOp version 2.1.2.0 or later.

Supported PLC Models
All models that can connect to V10/V9 series units via Ethernet

12.3.2 LadderComOp Ver. 2
The “LadderComOp” ladder transfer tool is required when connecting the V10/V9 series unit and PC via Ethernet in order to 
monitor or write PLC ladder programs.

LadderComOp Installation
Refer to the following procedure.

LadderComOp Ver. 2 Detailed Settings

V10/V9 PLC Connection Ports
(V10/V9 - PLC)

Ladder Transfer Ports
(V10/V9 - PC) Used Applications *2

Advanced All LAN
LAN2

LAN *1

LAN2 *1
WLAN

V-SFT Ver. 6 / LadderComOp Ver. 2

V10 Standard
V9 Standard

V10xxiSLD
V10xxiSLBD
V10xxiSRD
V10xxiSRBD
V9xx0ixLD
V9xx0ixLBD
V9xx0ixRD
V9xx0ixRBD

Installation → “12.2.2 LadderComOp Ver. 2” page 12-6

Item Description
1. Icon Clicking this icon and selecting [About LadderComOp] opens a window that displays the 

version of LadderComOp.
2. Communication Select [Routing].
3. Option Add in the task tray. Select this to add ladder transfer settings to the task tray.

4.

1.

5.

6.

2.
3.
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4. MONITOUCH PC connection port Set the IP address of the LAN port used for connection with the PC.
This serves as the gateway for the routing function.

PLC connection port Set the IP address and subnet mask of the LAN port used for connection with the PLC.
This serves as the network address of the routing function.

5. ONLINE/OFFLINE Turn ladder transfer ON or OFF between the PC and V10/V9 series unit.
• ONLINE

Establish a connection between the PC and V10/V9 series unit and enable ladder 
transfer mode.

• OFFLINE
Disconnect the PC and V10/V9 series unit.

6. Hide/END • Hide
Display an icon in the task tray when a connection is established. 
Ladder transfer settings are added to the task tray.
* The [Add in the task tray] checkbox is automatically selected.
- The task tray tool tip indicates “Transferring...”.

- Right-click on the icon in the task tray to display a menu.

• END
Display an icon in the task tray when a connection is not established.
Disconnect the PC and V10/V9 series unit and close the [Ladder Transfer Setting] 
window.

Item Description

Right-click
Undo

Display the [Ladder Transfer Setting] window.
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12.3.3 Setting Procedure

V-SFT and LadderComOp configuration is required. Refer to the following for the setting procedure.
• V-SFT Ver. 6 settings → “V-SFT Ver. 6 Settings” page 12-23
• LadderComOp settings → “LadderComOp Settings” page 12-32
• PLC programming software settings → “PLC Programming Software Settings” page 12-19

V-SFT Ver. 6 Settings
This section describes the settings for ladder transfer using the MITSUBISHI QnU series (built-in Ethernet) as an example.

[Ladder Transfer Setting] window
1. Click [System Setting] → [Hardware Setting] to display the [Hardware Setting] window.

2. Click [Ladder Transfer] to display the [Ladder Transfer Setting] window.

3. Select the [Use ladder transfer with the PLC connected to LAN] checkbox.
This completes the necessary settings. Transfer the screen program to the V10/V9 series unit.

The ladder transfer function is only available when [Hardware Setting] → [PLC Properties] → [Connection 
Mode] is set to [1:1] in the V-SFT. The simulator cannot be used for 1:n communication.
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LadderComOp Settings
The dedicated “LadderComOp” tool must be installed on the PC. For details on the LadderComOp installation procedure, refer 
to “LadderComOp Installation” page 12-6.

[Ladder Transfer Setting] window
1. From the Windows [Start] menu, click [Programs] → [V-SFT V6] → [LadderComOp] → [Ladder Transfer Setting].
2. The [Ladder Transfer Setting] window is displayed.
3. Select [Communication] → [Routing].

4. Set [PC connection port] and [PLC connection port].
PC connection port: IP address of the LAN port on the PC for connection.
PLC connection port: IP address and subnet mask of the LAN port on the PLC for connection.

5. Click the [ONLINE] button.
The display above the ladder transfer settings changes to the connected state.

This completes the LadderComOp settings.

PLC Programming Software Settings
Specify the IP address of the PLC and establish a connection.

12.3.4 Notes
• Two LAN ports of the V10/V9 series unit are used. Therefore, units with one port cannot be used.
• Ladder transfer can be performed even when communication between the V10/V9 series unit and PLC is unavailable.
• Ladder transfer cannot be used together with the VPN remote access service. Always disable the VPN settings on the 

V10/V9 series unit.
• Always use a different network group for each IP address set for [LAN Setting], [LAN2 Setting], and [WLAN Setting]. If set 

in the same network group, ladder transfer will not function correctly.



13 PDF Viewer





13.1    Overview

13-1

1

2

13

4

5

6

7

8

9

10

13.1 Overview
PDF Viewer

• PDF files can be viewed on the V10/V9 series unit without the need for preparing a computer or a paper manual. By 
saving PDF files of the machine’s operation and troubleshooting manuals to a storage device, they can be easily viewed 
using the dedicated PDF viewer.

• The storage device to refer to can be selected (between the SD card and USB flash drive) from the PDF viewer.
• The PDF viewer can be displayed using switches (a switch part with the [PDF Viewer Display] function or from the system 

menu) or by a command from a PLC.

• On V9 Advanced models (capacitive type), pinch-to-zoom gestures can be used for zooming in and out (50 to 200%).

Search function
The bookmarks of the PDF file can be displayed and text can be searched for. The display can be enlarged for easy viewing as 
well.

For details on the setting method, refer to the following sections.
“13.3.1 Displaying by Switch “Function: PDF Viewer Display”” page 13-3
“13.3.3 Displaying by Commanding from PLC” page 13-6

To search for Japanese text, the [System Setting] → [Japanese Conversion Function Setting] checkbox must be selected.

For details, refer to “13.5 Operating the PDF Viewer” page 13-10.

PDF

PDF

System 
menu

* The PDF viewer can be displayed in Local mode as well by using the system menu.

Bookmark display Search
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13.2 Preparation of PDF Files
This section describes the specifications of PDF files that can be viewed on the PDF viewer and the procedure for saving a PDF 
file to a storage device.

PDF File Specifications
The specifications are as follows:

*1 Larger PDF files and those with many figures and images will take longer to open
*2 PDF files created with font information embedded can be displayed regardless of the fonts selected in the [Transfer Font Setting] tab 

window.

Storing Files on a Storage Device
Either Windows Explorer or the storage manager can be used to store files.

• Windows Explorer
Open the storage device drive and save the necessary PDF files.

• Storage manager (only when folder path is not specified)
Store the necessary PDF files at “C:\MONITOUCH\User\PDF” (default) using storage manager.

Item Specifications
File Name • PDFxxxxx.pdf (xxxxx: 00000 to 99999) (For specification by file number)

• xxxxxxx.pdf (64 or less one-byte characters or 32 or less two-byte characters)
File size No limitation *1

Number of pages Maximum 65,535 pages in one file
Supported languages Languages selected at [System Setting] → [Multi-language Setting] → [Transfer Font Setting] tab window. *2

PDF version 1.0 to 1.7
PDF file storage location • When displaying by selecting on the PDF viewer:

No settings are required.
• When displaying using a switch part or by giving a command (control device memory) from a PLC:

- Folder path specified
Any folder specified

- Folder path not specified (default)
(output drive)\(access folder)\PDF

For details, refer to “8.3.11 Storing PDF Files” page 8-25.

EXT0000 (default access folder name)

PDF

PDF00000.pdf

Trouble.pdf

Update.pdf
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13.3 Setting Example
The PDF viewer can be displayed using a switch part, the [PDF Viewer] switch on the system menu, or by a command from a 
PLC.

13.3.1 Displaying by Switch “Function: PDF Viewer Display”
Press a switch with the [PDF Viewer Display] function to display the PDF viewer.

Conceptual Operation

Settings for PDF Viewer
1. Click [System Setting] → [Other] → [PDF Viewer Setting].

2. In the [PDF Viewer Setting] window, select the [Use PDF viewer] checkbox and select a [Storage Connection].

3. Click [OK]. This completes the configuration of settings.

PDF

PDF viewer

Press the [Open] switch to select and display a PDF file.

Select the default 
setting.
The drive to refer to can 
be changed on the PDF 
viewer as necessary.
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Switch Settings
1. Place a switch part.
2. Select [PDF Viewer Display] in the [Function] settings and make the following settings.

3. Click [Finish]. This completes the necessary settings.

For details on operation on the V10/V9 series unit, refer to “13.5 Operating the PDF Viewer” page 
13-10.

Displaying page 1 of a PDF file named “PDF00000.pdf”
File storage location: \(access folder)\PDF
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13.3.2 Displaying from the System Menu
The PDF viewer can be displayed by pressing the [PDF Viewer] switch on the system menu.

V-SFT Settings
1. Click [System Setting] → [Other] → [PDF Viewer Setting].

2. In the [PDF Viewer Setting] window, select the [Use PDF viewer] checkbox and select a [Storage Connection].

3. Click [OK]. This completes the configuration of settings.

PDF

System 
menu

Select the default 
setting.
The drive to refer to can 
be changed on the PDF 
viewer as necessary.



13  PDF Viewer

13-6

13.3.3 Displaying by Commanding from PLC
The PDF viewer can be displayed by turning the relevant PLC device memory bit ON. The page to display can be specified as 
well.

Conceptual Operation

V-SFT Settings (Settings for PDF Viewer)
1. Click [System Setting] → [Other] → [PDF Viewer Setting].

2. In the [PDF Viewer Setting] window, select the [Use PDF viewer] checkbox and make the following settings.

3. Click [OK]. This completes the configuration of settings.

PLC Commands
Set the control device memory D10001 to “6“. When bit 0 of D10000 turns ON, page 6 of the “PDF00000.pdf“ file is displayed.

For details on operation on MONITOUCH, refer to “13.5 Operating the PDF Viewer” page 13-10.

PDF

Control device memory: D10000, PDF filename: PDF00000.pdf
File storage location: \(access folder)\PDF PDF viewer

Page 6 of 
“PDF00000.pdf“ is 
displayed.

Set “6“ for D10001.
Set bit 0 of D10000 to ON (display)

Select the default 
setting.
The drive to refer to can 
be changed on the PDF 
viewer as necessary.
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13.4 Detailed Settings
PDF Viewer Settings
Select the [Use PDF viewer] checkbox to enable the following items.

Item Description
Storage Connection Select the storage device where PDF files are stored.

This can be changed on the PDF viewer as necessary.
Control devices Showing and hiding is performed according to the value of the least significant bit. *1

Page device Specify the page number to display initially. No.: 1 to 65535 *2

File Designation *3 Specify the method for specifying files.

Path Designation *3 Select this checkbox to specify a folder as the storage location of PDF files.
Storage location:

Unselected: (Access folder)\PDF
Selected: Folder path specified

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Reserved for 
system

PDF viewer
1 → 0: Hide
0 → 1: Show

File No. 0 to 99999 (Filename: PDF00000.pdf to PDF99999.pdf)
File Name Maximum of 64 one-byte characters, or 32 two-byte characters
Device Set the device memory address for specifying the file.

The operation differs depending on whether the [File Name Designation] 
checkbox is selected or not.

File Name 
Designation:
Unselected

Specify a file number.
 0 to 99999 (Filename: PDF00000.pdf to PDF99999.pdf)
(Two words are used.)

File Name 
Designation:
Selected

Specify a filename.
Maximum of 64 one-byte characters, or 32 two-byte characters 
(32 words are used.) *4

* The extension does not need to be specified.

• Limitations
- To be specified within 256 one-byte alphanumeric characters. Two-byte characters are prohibited.
- Slashes “/” are used as the delimiter. The backslash “\” cannot be used.
- A slash “/” is not necessary at the end of the path.
- If specifying a root directory, enter only the first slash “/”.

Path Designation Select the method for specifying the path of the folder where PDF files 
are stored.

Folder Path Enter the desired path directly. The slash “/” at the beginning of the field 
is required.

Device Specify the device memory address for specifying the path. *4
This is to be NULL (0) terminated.
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*1 If the display bit is ON when entering RUN mode, the PDF viewer is displayed.
When the PDF viewer is displayed by turning the display bit ON but the PDF viewer is then closed using the [Close] switch, the display bit 
stays ON.
Turn the display bit OFF by using bit 0 of the information output device memory (0: hide).

*2 If a page number that does not exist is specified and the PDF viewer is displayed, the first page of the PDF file is displayed.
*3 Setting examples

When displaying the following file

*4 Text processing
Internal device memory: Fixed to LSB → MSB
PLC device memory: The [System Setting] → [Hardware Setting] → [PLCx Properties] → [Text Process] setting is effective.

*5 The switch on the PDF viewer is grayed out and inoperable.

Information Output Device The state of the PDF viewer is output.

Page No. output device The page number that is currently displayed is output. No.: 1 to 65535
Allow access only to PDF 
folder in RUN mode

Specify the location to access when the [Open] switch is pressed on the PDF viewer screen in RUN mode.
• Unselected:

All folders of the storage device (SD/USB) can be accessed from the [Open] switch.
• Selected:

Only the contents of the PDF folder in the access folder set for [Storage Connection] are displayed.
The storage device and folder can be selected in Local mode.

Do not display an error 
message if a file does not 
exist

Set the action to take when a PDF file does not exist on the storage device.
• Unselected: 

An error message “The specified file was not found.” is displayed.
• Selected: 

An error message is not displayed.
Open switch prohibited *5 Select this checkbox to invalidate the [Open] switch on the PDF viewer.

Option switch prohibited *5 Select this checkbox to invalidate the option switch on the PDF viewer.

Item Description

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0

Reserved for system 1: Page number does not exist

1: PDF file does not exist

PDF viewer status
0: Hide
1: Show

REPORT

Product1

LotA.pdf

• Specifying the filename and folder path directly

• Specifying the filename and folder path using device memory

Specifying the filename and folder path using PLC commands
D10100 ... : LotA
D10200 ... : /REPORT/Product1

Option Open
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Switch Function

*1 Setting examples
Refer to “Setting examples When displaying the following file” page 13-8 in “PDF Viewer Settings”.

*2 Text processing
Internal device memory: Fixed to LSB → MSB
PLC device memory: The [System Setting] → [Hardware Setting] → [PLCx Properties] → [Text Process] setting is effective.

*3 If a page number that does not exist is specified and the PDF viewer is displayed, the first page of the PDF file is displayed.

Item Description
File Designation *1 Specify the method for specifying files.

Page No. designation *3 Specify the method for specifying the page number.
Page No.: 0 to 65535
Device: Set the device memory address for specifying the page number (No. 1 to 65535)

Path Designation Select this checkbox to specify a folder as the storage location of PDF files.
Storage location:

Unselected: (Access folder)\PDF
Selected: Folder path specified

Path Designation *1 Select the method for specifying the path of the folder where PDF files are stored.
Folder Path: Enter the desired path directly. The slash “/” at the beginning of the field is required.
Device: Specify the device memory address for specifying the path. This is to be NULL (0) 

terminated. *2

• Limitations
- To be specified within 256 one-byte alphanumeric characters. Two-byte characters are prohibited.
- Slashes “/” are used as the delimiter. The backslash “\” cannot be used.
- A slash “/” is not necessary at the end of the path.
- If specifying a root directory, enter only the first slash “/”.

File No. 0 to 99999 (Filename: PDF00000.pdf to PDF99999.pdf)
File Name Maximum of 64 one-byte characters, or 32 two-byte characters *2

Device Set the device memory address for specifying the file.
The operation differs depending on whether the [File Name Designation] 
checkbox is selected or not.

File Name 
Designation:
Unselected

Specify a file number.
 0 to 99999 (Filename: PDF00000.pdf to PDF99999.pdf)
(Two words are used.)

File Name 
Designation:
Selected

Specify a filename.
Maximum of 64 one-byte characters, or 32 two-byte characters 
(32 words are used.) *2

* The extension does not need to be specified.
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13.5 Operating the PDF Viewer
13.5.1 Displaying from the System Menu

The PDF viewer can be displayed by pressing the [PDF Viewer] switch on the system menu. Therefore it can be displayed in 
both RUN mode and Local mode.

Press the [SYSTEM] switch to display the system menu.
Tap the [PDF Viewer] switch to display the PDF viewer.

* If the [PDF Viewer] is not shown on the system menu, scroll the system menu sideways.

13.5.2 Changing PDF Files to Display
Tap the [Open] switch on the PDF viewer. Select the PDF file to display and tap the [Open] switch.

* Larger PDF files will take more time to open.

The PDF viewer can also be displayed in RUN mode by the following methods.
• Switch Function → “13.3.1 Displaying by Switch “Function: PDF Viewer Display”” page 13-3
• PLC Commands → “13.3.3 Displaying by Commanding from PLC” page 13-6

System menu PDF viewer

Tap the switch.

Storage drive 
selection

PDF files saved in folders other than the “PDF“ folder 
can be opened as well.
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13.5.3 Changing the Display Page
Tap the [←] and [→] switches on the PDF viewer or scroll the display to change the displayed page.

13.5.4 Display Scale
Tap the option switch on the PDF viewer. The following menu is displayed.
Tap the [+] and [−] switches to enlarge and reduce the display respectively.

* On V9 Advanced models (capacitive type), pinch-to-zoom gestures can be used for zooming in and out (50 to 200%).

Current page number/Total pages

Scroll

Tap the [→] switch.

Tap the option switch. Tap the [+] switch to 
enlarge the display.

Fit page Reduce Enlarge

[+]: Enlarge by 25% (up to 200%)
[−]: Reduce by 25% (down to 50%)

Tap the option switch again to hide the 
option menu.

Current 
display scale
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13.5.5 Search Function
Text
Tap the option switch on the PDF viewer. The following menu is displayed.
Tap the search switch on the PDF viewer to display the search window.

Tap the [Enter a keyword to search for] field. The system keyboard appears. Enter the text to search for and tap the [←] or [→] 
switch. The cursor moves to text that matches the search.

* To enter Japanese text, the [System Setting] → [Japanese Conversion Function Setting] checkbox must be 
selected.

Tap the option switch.

Tap the search switch.

Tap to display the 
system keyboard.

The cursor moves to text 
that matches the search.

Tap the [→] switch.



13.5    Operating the PDF Viewer

13-13

1

2

13

4

5

6

7

8

9

10

Bookmarks
Tap the option switch on the PDF viewer. The following menu is displayed.
Tap the bookmark switch on the PDF viewer.

Select a bookmark and tap the [View] switch.

Tap the option switch.

Bookmarks

Tap the bookmark switch.

The selected page is displayed.
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14.1 Overview
• Strings that are used many times throughout the screen program can be registered to a string table. Once registered, they 

can be used for text items as well as switches and lamps by simply selecting the string from the string table.
If a string needs to be changed, changing the string in the string table will change all occurrences in the screen program, 
thereby shortening the time required to modify the screen program.

• Additions and modifications can be made on the string table from each item and part as well.

Items and Parts that can Use the String Table
• Switch
• Lamp
• Text
• Multi-text

String table

Screen No. 0 Screen No. 1 Screen No. 2

Refer to the string table and set the string to use for each 
item and part.
(Example string: MENU)

Text Switch Switch

String table
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14.2 Registration Method
This section describes how to register strings to the string table and how to use the registered strings. There are two 
registration methods.

• Registration from the string table
• Direct registration from each part and item

14.2.1 Registration from String Table
This section describes the procedure for preparing the following string table as an example and selecting strings for switches 
from the prepared string table.

1. Click [Home] → [Registration Item] → [String table] to open a string table.

2. Double-click a [Text] field and enter the string.

3. Double-click a [Group Name] field and enter the name for categorizing the string.

4. Register the other strings in the same procedure by following steps 2 and 3.

Text Group Name
MENU
Logging
Alarm History
Operation Screen
Manual Operation

Title

Current
Humidity
Temperature

Logging

When entering multiple lines in the 
displayed field, press the [Enter] key.

This field can be left blank if a group 
name is not required.
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5. Double-click a switch to display its settings window.
6. Click [Char. Prop.] in the left menu pane and select the [String table No. XX] checkbox.

7. Click the down button to display the string table and then select the string to use from the table.

8. Click inside the [Text] field of the settings window. The selected string is displayed in the [Text] field.

This completes the necessary settings.
Configure the font size and color as necessary.

For switch and lamp parts, the text display will vary according to the setting for [Auto-adjust the size according to the style].
- Selected

The part will be resized according to the length of the string.
- Unselected

Only the characters that will fit in the current part size are displayed.
(The number of rows that can be displayed depends on the maximum number of rows for the part/item type. Switches and lamps: 4 
rows, Multi-text:  38 rows)

The available number in 
the string table is 
displayed.

String table

Click
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14.2.2 Direct Registration from Parts and Items
This section describes the procedure for registering a string from a text item to the string table as an example.

1. Click or double-click a text item placed on the screen to display its item view window. Select the [String table] checkbox.

2. Click the down button to display the string table and then enter a string in an available number.

3. Register the group name.

The available number in 
the string table is 
displayed by default.

Text

String table

Direct entry is also possible.
(The group name must be 
registered on the string table.)
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4. With the relevant string table number selected, click on the text field. The string is displayed in the text field.

This completes the registration process.
Configure the font size and color as necessary.

Click
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14.3 Changing Strings
This section describes the procedure for changing a string that is referencing the string table. There are two methods.

• Changing from the string table
• Changing from parts and items

14.3.1 Changing from String Table
1. Click [Home] → [Registration Item] → [String table] to open the string table and modify the relevant string.

2. With the changed string number selected, click the update icon.

All locations where the string is used are updated.

This completes the change.

If a string has been changed, be sure to click the update icon.
Locations where the string is currently in use will not be updated unless the icon is clicked.

When updating changes for multiple string 
numbers at once, hold down the [Shift] key to 
select multiple strings.

Update icon

Select

Switch on screen No. 0

Text

After change

After change
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14.3.2 Changing from Parts and Items
This section describes the procedure for changing the text on a switch.

1. Double-click a switch to display its settings window.
2. Click [Char. Prop.] in the left menu pane.
3. Click the down button to display the string table and then change the relevant string on the table.

4. With the relevant string table number selected, click on the text field. The string is displayed in the text field.
(The string table is updated as well.)

5. Click [Home] → [Registration Item] → [String table] to open the string table. With the changed string number selected, 
click the update icon.

All locations where the string is used are updated.

This completes the change.

String table

Directly changing the text is also 
possible.
(The group name must be registered 
on the string table.)

Click

When updating changes for multiple string 
numbers at once, hold down the [Shift] key 
to select multiple strings.

Update icon

Select
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14.4 Editing the String Table
Click [Home] → [Registration Item] → [String table].

Item Description
No. Indicates the registration number of the string.

No. 0 to 32767
Text Register strings. Press [Enter] to input line breaks.

Maximum of 254 characters, 128 lines
Group Name Register a group name for categorizing the string. This field can be left blank if a group name is not required.

Maximum of 256 characters, 1 line
Sort Sort the table by [No.], [Text], or [Group Name].

List of locations where the 
string is currently in use

List of locations where the selected string is currently in use
Double-click on a location to jump to the relevant location.

Item Description
1. Print preview Preview printer output of the string table.
2. Print current window Print the string table.
3. Refresh Refresh to the latest state.
4. Update Update the locations where the currently selected string is used.

Use this icon for updating after editing strings on the string table.
5. Multi-language edit 

setting
Specify the display language for the [Text] and [Group Name] columns on the string table.

* The window displayed from this icon is also displayed from [Home] → [Registration Item] → 
[Multi-language].

List of locations where the 
string is currently in use

Enlarged view

1. 2. 3. 4. 5.
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14.5 Multi-language Configuration
• When creating a multi-language screen program, a string table can be prepared per language.

Change the language for editing from the [View] → [Display Change] group.

• The [Text] and [Group Name] columns of the string table are displayed in the languages selected in the [Multi-language 
edit Setting] window.
When displaying languages using Windows fonts, the display and editing of such languages is also possible regardless of 
the settings configured in the [Font Setting] window.

* The settings made on the [Multi-language edit Setting] window are saved to the screen 
program.
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14.6 Notes
Multi-language Screen Programs

• When using the string table for a part or item, all of the text displayed on that part or item must be selected on the string 
table.

• When exporting from [System Setting] → [Font Setting], only the string table is exported. The locations where the strings 
are used are not exported.
If strings are changed on the exported file, the locations where the relevant string is used will be updated when the file is 
imported.

• In the [Multi-language Edit] tab window ([Home] → [Registration Item] → [Multi-language]), the string table is displayed 
but the locations where the strings are used are not.
Changes made to the string table on the [Multi-language Edit] tab window are reflected to the locations where the string 
is used.

Other Notes
• When a string registered to the string table with multiple rows is selected for a text item, all line breaks are ignored and 

the entered characters are displayed in one line.
• When all numbers of the string table are used (No. 0 to 32767) and there is no available number, if the checkbox for using 

the string table is selected on any item settings window, No. 0 will be automatically selected.
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15.1 Video Player
15.1.1 Overview

• Video files in MP4 format (.mp4) can be saved to a storage device and played back using the video player on the V10/V9 
series.

• The storage device to refer to can be selected (between the SD card and USB flash drive) from the video player.
• The video player can be displayed using a switch part, the [Video Player] switch on the system menu, or by a command 

from a PLC.

- Switch

- System menu

- PLC command

• Videos can be played back repeatedly by using the [Enable repeat playback] function.
• Operation buttons on the lower part of the video player can be hidden.
• The video player can also be used on portrait-orientated V10/V9 series units.

.mp4

MENU

Movie

.mp4

.mp4

Auto Manual Alarm

ONOFF OFF

Setting

OFF

500 100 1 6000 500

120 750 999 40 650

ON OFF

Auto

PLC bit: ON
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15.1.2 Specifications
Applicable Models

* Connect an external speaker to the AUDIO port for audio output.

Video File Specifications

* Larger files will take more time to load.

Storing Files on a Storage Device
Either Windows Explorer or the storage manager can be used to store files.

• Windows Explorer
Open the storage device drive and save the necessary video files.

• Storage manager
Store the necessary video files at “C:\MONITOUCH\User\VIDEO” (default) using storage manager.

Model Audio 
Output OS SYSTEM PROGRAM V-SFT-6 Other Notes

V10 ○* V1.00 or later V1.000 or later Version 6.2.0.0 or 
later

Storage device
(SD card or USB flash drive)

V910xiWRLD
V910xiWLD
V9150iX
V9150iXD
V9120iS
V9120iSD
V9100iS
V9100iSD
V9080iSD

○*

V2.10 or later V1.130 or later Version 6.0.12.0 or 
later

V9100iC
V9100iCD
V9080iCD
V907xiWRLD
V907xiWLD
V9060iTD

×

Item Specifications
File format MPEG-4 (extension: .mp4)
Resolution 1920 × 1080 maximum
Frame rate Up to 30 FPS
Audio format AAC, MP3
File size No limitation *

Filename File number designation
Device memory 
designation

MOVxxxxx.mp4 (xxxxx: 00000 to 99999)

Filename specification (arbitrary filename).mp4 (64 or less one-byte characters or 32 or less two-byte 
characters)

Storage destination PC
C:\MONITOUCH\User\VIDEO (default)
Store files using the storage manager.

Storage device
• When displaying by selecting on the video player:

No settings are required.
• When displaying using a switch part or by giving a command (control device memory) from a PLC:

(output drive)\access folder\VIDEO

For details, refer to “8.3.12 Storing Video Files” page 8-26.

EXT0000 (default access folder name)

VIDEO

MOV00000.mp4

MOV00001.mp4

PR.mp4
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15.1.3 Setting Example
Displaying Using a Switch Part
The video player can be displayed by using a switch part.

V-SFT settings
1. Click [System Setting] → [Other] → [Video Player Settings].

2. In the [Video Player Settings] window, select the [Use video player] checkbox and select a [Storage Connection].

3. Click [OK].

.mp4

MENU

Movie
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Placing a switch
1. Place a switch from the [Parts] menu.
2. Click [Function] → [Standard] → [Video Player Settings], and configure the necessary settings.

Displaying from the System Menu
The video player can be displayed by pressing the [Video Player] switch on the system menu. Select the file for playback on 
the File List screen.
Video files can be played in Local mode as well by using the system menu.

V-SFT Settings
1. Click [System Setting] → [Other] → [Video Player Settings].

.mp4
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2. In the [Video Player Settings] window, select the [Use video player] checkbox and select a [Storage Connection].

3. Click [OK]. This completes the configuration of settings.

Displaying by Commanding from PLC
The video player can be displayed by setting the relevant PLC device memory bit ON.

V-SFT settings
1. Click [System Setting] → [Other] → [Video Player Settings].

.mp4

Auto Manual Alarm

ONOFF OFF

Setting

OFF

500 100 1 6000 500

120 750 999 40 650

ON OFF

Auto

PLC bit: ON
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2. In the [Video Player Settings] window, select the [Use video player] checkbox and then configure [Storage Connection] 
and [Control devices].

3. Click [OK]. This completes the configuration of settings.

PLC commands
When the control device memory “M0” is set to ON, playback of the “MOV00001.mp4” file begins.
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15.1.4 Detailed Settings
Video Player Settings
Select the [Use video player] checkbox to enable the following items.

*1 If the display bit is ON when entering RUN mode, the video player is displayed.
When the video player is displayed by turning the display bit ON but the video player is then closed using the [Close] switch, the display 
bit stays ON.
Turn the display bit OFF by using bit 0 of the information output device memory (0: hide).

*2 If performing repeated playback with a [File Designation: Device] configuration, the file number that is stored in the specified device 
memory is acquired when the file currently in playback ends and playback starts again.

*3 Even if operation buttons are hidden, the “quit” button is displayed when playback of the video file ends.
*4 When displaying the video player using the system menu, this bit is set to “1” when the File List screen is displayed.

Item Description
Storage Connection Select the storage device to refer to for video files.

This can be changed on the video player as necessary.
Control devices Specify the bit to use for controlling the video player. 

File Designation Specify the method for specifying files.
[File No.]: 0 to 99999 (Filename: MOV00000.mp4 to MOV99999.mp4)
[File Name]: Maximum of 64 one-byte uppercase alphanumeric characters, or 32 two-byte characters
[Device]: Set the device memory address (2 words) for specifying the file number (No. 0 to 99999)

Information Output Use four consecutive words to store the following information.

n

The state of the video player is output.

n+1 The file number of the currently played file is output.  No. 0 to 99999
n+2

n+3
Error Code

0: No errors
1: The specified file does not exist.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0

Reserved for system Video player *1
1 → 0 (edge): Hide
0 → 1 (edge): Show

Repeat playback *2
0: No repeat
1: Repeat

Operation buttons
0: Show
1: Hide *3

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0

Reserved for system

1: Operation buttons are not displayed 1: Repeat playback is valid

Video player
0: Hide
1: Show *4

Error
0: None
1: Occurring
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Switch Function
The following settings are available when a switch is set as [Function: Video Player Settings].

Item Description
File Designation Specify the method for specifying files.

[File No.]: 0 to 99999 (Filename: MOV00000.mp4 to MOV99999.mp4)
[File Name]: Maximum of 64 one-byte uppercase alphanumeric characters, or 32 two-byte characters
[Device]: Set the device memory address (2 words) for specifying the file number (No. 0 to 99999)

Enable repeat playback Repeat playback of a specified file.
[Fixed]: Repeat playback while the video player is displayed.
[Device]: Control repeated playback. 0: No repeat, 1: Repeat

Hide operation buttons Hides the operation buttons on the lower part of the video player.
If this is selected, the “quit” button is displayed when playback of a file ends.



15.1    Video Player

15-9

1

2

3

4

15

6

7

8

9

10

15.1.5 Configuration of Video Player
Video Player

* Supported on V9 OS version 4.80 or later and System Program version 2.800 or later. 

No. Item Details No. Item Details
1 Playback screen Videos are displayed in full-screen 

without changing the aspect ratio.
10 Fast forward 2.0 ×, 4.0 ×, 8.0 ×, 1.0 ×

2 Seekbar Operable from 0 to 100 11 Slow playback 0.8 ×, 0.4 ×, 0.2 ×, 1.0 ×
3 Playing time 12 Next frame* Goes forward by 2 seconds

This is available only when the
video is paused.

4 Quit Returns to RUN or Local mode 13 Repeat Turn on/off repeat
5 Stop 14 Volume slider Volume changeable from 0 to 10
6 Previous frame* Goes back by 2 seconds

This is available only when the
video is paused.

* Invalid 3 seconds before end 
of video.

15 Speaker Turn on/off audio

7 Rewind 2.0 ×, 4.0 ×, 8.0 ×, 1.0 × 16 File Select Displays the File List screen
8 Play 17 Total time
9 Pause 18 Playback speed Displays the current speed of rewind, 

fast forward, or slow playback

1

2

3

4 5          6         7         8          9        10        11      12        13          14  15 16

17

18



15  Video Player

15-10

File List

15.1.6 Notes
• If the playback bit of a control device memory is set to ON while a video is currently being played back on the video 

player that was displayed using a switch part or the system menu, playback of the video file specified by the control 
device memory starts after the current video ends.

• When a video is in playback because a playback bit was set to ON, if that playback bit is set to OFF again, the video player 
is hidden immediately even if the video is still playing.

• The video player screen cannot be displayed via RGB output (GUR-02) or on the VNC viewer screen.
• Display Priority

The video player is displayed superimposed over items and overlap displays placed on the screen.
However, the playback screen is hidden when the system menu or status bar, which have higher priority, are displayed. 
The playback screen is displayed again when the system menu or status bar are hidden.

• When the event recording function is used with a USB camera *, video is recorded continuously during RUN mode and 
the video player is unavailable.
In order to use the video player, stop recording video by using the “USBCAM_REC STOP” macro command or switch to 
Local mode and then play back a video file.

No. Item Details No. Item Details
1 Storage device 

selection
Select the “SD” or “USB” storage 
device.

3 Open Plays the selected file.

2 List of folders and 
files

Select the video to play from the files 
on the storage device selected at “1”.

4 Return Returns to RUN mode.

1

3

2
* By default, the content of the video folder 

located in the access folder specified in the 
screen program is displayed.

4

* Setting to check:
[System Setting] → [Hardware Setting] → [Other Devices] → [USB Camera] → [USB Camera Properties] → [Use Event Record 
Function] is set to [Yes].
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16.1 Overview
• Image files saved to a storage device can be displayed on the V10/V9 series unit. JPEG, bitmap, and PNG format files can 

be displayed.
• The storage device to refer to can be selected (between the SD card and USB flash drive) from the picture viewer.
• The picture viewer can be displayed using a switch part, the [Picture Viewer] switch on the system menu, or by a 

command from a PLC.
- Switch

- System menu

- PLC command

For details on settings, refer to “16.3 Setting Example” page 16-3.

.PNG

.PNG

* Display is also possible in Local mode.

500 100 1 6000 500

120 750 999 40 650

200 300 15 2000 200

110 220 350 80 350

.PNG

PLC bit: ON
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16.2 Specifications
Image File Specifications

*1 Files can have the duplicate filenames if the extension differs. When a PLC command is used to display an image, the file of the format 
selected at [Picture Viewer Setting] → [File Type] is displayed.

*2 Larger files will take more time to load.

Storing Files on a Storage Device
Either Windows Explorer or the storage manager can be used to store files.

• Windows Explorer
Open the storage device drive and save the necessary image files.

• Storage manager
Store the necessary image files at “C:\MONITOUCH\User\PICTURE” (default) using storage manager.

Item Specifications
File types JPEG (.JPG)

PNG (.PNG)
BITMAP (.bmp)

Filename*1 • PICTxxxxx (xxxxx: 00000 to 99999) (For specification by file number)
• Arbitrary filename (64 or less one-byte characters or 32 or less two-byte characters)

File size No limitation *2

Storage location Computer
C:\MONITOUCH\User\PICTURE (default)
Store files to the storage device using the storage manager.

Storage device
• When displaying by selecting on the picture viewer:

No settings are required.
• When displaying using the switch function or by giving a command (control device memory) from a 

PLC:
(output drive)\(access folder)\PICTURE

For details, refer to “8.3.10 Storing Image Files (Picture Viewer)” page 8-24.

EXT0000 (default access folder name)

PICTURE

PICT00000.PNG

PICT00001.PNG

abcde.JPG
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16.3 Setting Example
The picture viewer can be displayed using a switch part, the [Picture Viewer] switch on the system menu, or by a command 
from a PLC.

16.3.1 Displaying Using a Switch Part
The picture viewer can be displayed by using a switch part.

V-SFT Settings
1. Click [System Setting] → [Other] → [Picture Viewer Setting].

2. In the [Picture Viewer Setting] window, select the [Use Picture Viewer] checkbox and select a [Storage Connection].

3. Click [OK].

Placing a Switch
1. Place a switch from the [Parts] menu.
2. Click [Function] → [Standard] → [Picture Viewer Display] and configure the [File Type] and [File Designation] settings.

.PNG
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16.3.2 Displaying from the System Menu
The picture viewer can be displayed by pressing the [Picture Viewer] switch on the system menu. Select the file to display 
from the File List screen.

V-SFT Settings
1. Click [System Setting] → [Other] → [Picture Viewer Setting].

2. In the [Picture Viewer Setting] window, select the [Use Picture Viewer] checkbox and select a [Storage Connection].

3. Click [OK]. This completes the necessary settings.

.PNG

* Display is also possible in Local mode.
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16.3.3 Displaying by Commanding from PLC
The picture viewer can be displayed by setting the relevant PLC device memory bit to ON.

V-SFT Settings
1. Click [System Setting] → [Other] → [Picture Viewer Setting].

2. In the [Picture Viewer Setting] window, select the [Use Picture Viewer] checkbox and configure the following settings.

3. Click [OK]. This completes the necessary settings.

PLC Commands
Turn ON bit 0 of the control device memory WM100 to display the “PICT00000.PNG” file.

500 100 1 6000 500

120 750 999 40 650

200 300 15 2000 200

110 220 350 80 350

.PNG

PLC bit: ON
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16.4 Detailed Settings
Select the [Use Picture Viewer] checkbox to enable the following settings.

*1 If the specified file is not found on the storage device, an error is indicated when the picture viewer is displayed.

*2 If the display bit is ON when entering RUN mode, the picture viewer is displayed.
When the picture viewer is displayed by turning the display bit ON but the picture viewer is then closed using the [Close] switch, the 
display bit stays ON.
Turn the display bit OFF by using bit 0 of the information output device memory (0: hide).

Item Description
Storage Connection*1 Select the storage device to refer to for image files.

This can be changed on the picture viewer as necessary.
Control devices Showing and hiding is performed according to the value of the least significant bit. *2

File Type Select an image file type.
JPEG (.JPG)
PNG (.PNG)
BITMAP (.bmp)

File Designation Specify the method for specifying files.
[File No.]: 0 to 99999 ([File Name]: PICT00000 to PICT99999)
[File Name]: Maximum of 64 one-byte uppercase alphanumeric characters, or 32 two-byte characters
[Device]: Set the device memory address (2 words) for specifying the file number (No. 0 to 99999)

Information Output Device The state of the picture viewer is output.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Reserved for 
system

Picture viewer
1 → 0 (edge): Hide
0 → 1 (edge): Show

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0

Reserved for 
system

1: The specified image file 
is not found.

Status of picture viewer
0: Hidden
1: Displayed



16.4    Detailed Settings

16-7

1

2

3

4

15

16

7

8

9

10

Switch Function
The following settings are available when a switch is set as [Function: Picture Viewer Display].

Item Description
File Type Select an image file type.

JPEG (.JPG)
PNG (.PNG)
BITMAP (.bmp)

File Designation Specify the method for specifying files.
[File No.]: 0 to 99999 ([File Name]: PICT00000 to PICT99999)
[File Name]: Maximum of 64 one-byte uppercase alphanumeric characters, or 32 two-byte characters
[Device]: Set the device memory address (2 words) for specifying the file number (No. 0 to 99999)
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16.5 Configuration of Picture Viewer
Overview

* File information is displayed at the upper right of the picture viewer.

No. Item Details No. Item Details
1 Display area Images are displayed in 

full-screen without changing the 
aspect ratio.

5 Zoom in/out Changes the display scale within 
200% to 50%.

[+]: Enlarge in 25% increments
[−]: Reduce in 25% increments

2 File information Displays information of the 
currently displayed file. *

6 Display scale Shows the current display scale 
(100% = Actual size).

3 Scale to fit Scales the image to fit the display 
area.

7 Open Displays the file selection window.

4 Rotate Rotates the image clockwise in 
90° increments.

8 Close Returns to RUN or Local mode.

1

2        3        4                    5         6 7                   8
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Changing the Displayed Image File
Tap the [Open] switch on the picture viewer. Select the image file to display and tap the [Open] switch.

* Larger image files will take more time to load.

Tap the switch.

Storage device 
selection

Image files saved in locations other than the 
“PICTURE” folder can be opened as well.
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